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Introducing Meridian Enterprise
Meridian Enterprise is a departmental to enterprise-wide engineering information management
(EIM) and asset lifecycle information management (ALIM) system from Accruent. It can be
installed with the following database engines: Accruent Hypertrieve, Microsoft® SQL Server®, or
Oracle®. The number of vaults, documents, and concurrent users is limited only by available
hardware resources on the host server computer. For the supported versions, see the Supported
Software document for this release of Meridian available from your Accruent Partner or the
Meridian Technical Library.

Meridian Enterprise Product Suite
Meridian Enterprise is the core of the Meridian Enterprise product suite—a family of solutions
that extends Meridian Enterprise into the engineering-related business processes for specific
industries:

l Chemical
l Pharmaceuticals
l Oil & Gas
l Metals & Mining
l Utilities

The Meridian Enterprise product suite includes optional modules and alternative channels of data
publishing as shown in the following figure.
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For more information on any of the Meridian Enterprise product suite solutions, contact your
authorized Accruent Partner or visit accruent.com.

Meridian Enterprise Server
Meridian Enterprise Server is the core product in the Meridian Enterprise product suite. It
provides centralized, scalable, web services and administration for use with Meridian Enterprise,
Accruent Project Portal, and other business systems. Besides the shared services, Meridian
Enterprise Server includes the latest generation of Publisher and Meridian Explorer technology.

Although the names Meridian Enterprise Server and Meridian Enterprise are very similar,
Meridian Enterprise Server should not be confused with the application server of Meridian
Enterprise. They are distinct systems that work together. Throughout this documentation, each
name is used explicitly for its corresponding system.

Note:
Meridian Enterprise Server 2013 (and higher) is a replacement for prior versions of Publisher
and Meridian Explorer that has been completely redesigned and reprogrammed. This allows
Meridian Enterprise Server to provide additional functionality over prior versions. Although
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Meridian Enterprise Server has many of the same features as prior versions of Publisher and
Meridian Explorer, the products are not compatible and Meridian Enterprise Server 2022 should
not be considered as a direct upgrade from the older versions.

Meridian Advanced Project Workflow Module
The Meridian Advanced Project Workflow Module establishes a project structure for managing
engineering content work-in-progress. Master documents are available for maintenance and
operations in an as-built area, while working copies are made in project areas. The Meridian
Advanced Project Workflow Module also allows you to manage multiple concurrent projects that
share documents. It provides a way to merge design changes into a new version of the master
document in a controlled manner and lets you handle small changes as well as complex capital
projects based on pre-configured projects and workflow templates. Its advanced tools let you
control and monitor project progress.

Meridian Asset Management Module
The Meridian Asset Management Module enhances, automates, and streamlines asset operations
throughout their lifecycle by linking them with engineering content such as drawings and
technical specifications. The module allows you to integrate with maintenance management
systems like Maximo, SAP PM, Datastream, and Ultimo, and with Facility Management Systems
like Archibus and Famis. This ensures the performance of mission-critical assets and avoids costly
operational disruptions. Maintaining control of and providing access to up-to-date documentation
is crucial in all phases of the asset life cycle.

Meridian Explorer
Meridian Explorer provides a repository separate from the engineering production vault and a
web browser–based view of documents and related information in one or more Meridian
Enterprise vaults. These two components make it possible to provide read-only access to
technical documents on a large scale. Meridian Explorer provides an innovative interface for
quickly and easily finding documents with minimal end-user training.

The main benefits of Meridian Explorer are its powerful search, ease of use, extensive
configurability, and scalability. You can easily navigate your way to the document you need and
view its information with just a few mouse clicks. Meridian Explorer provides you with text search
capability on both custom metadata properties and document text content. You can also find
documents by navigating a folder tree. Best of all, you can search a repository interactively by
selecting from specific property values found in the current search results. With this method, you
can quickly narrow your search from potentially hundreds of thousands of documents to just the
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documents you are interested in. Search results are presented in tabular format or as easily
recognizable thumbnail images.

Meridian Explorer includes the following major features:

l Incremental synchronization of documents and related metadata from one or more
Meridian Enterprise vaults to a Meridian Explorer consolidated repository.

l Zero install, web browser-based read-only client. Engineering change requests and
electronic redlines can be sent to vaults configured with the Meridian Asset Management
Module.

l Support for server-based viewing.
l Configurable property pages, search pages, and views.

Note:
Meridian Explorer manages documents and tags very similarly. Therefore, they are referred to
collectively as items in the topics that refer to both documents and tags.

Meridian FDA Module
The Meridian FDA Module adds U.S. Food and Drug Administration 21 CFR Part 11 regulatory
compliance features to Meridian. Its advanced document control tools are used by
pharmaceutical companies throughout the processes of document creation, review, approval,
revision, and archiving.

Publisher
Publisher helps you publish engineering data managed by Meridian to alternative formats in
other document management systems, file systems, or the Internet. It enables the reliable and
timely availability of documents in other systems such as FileNet, Livelink, SharePoint, web
portals, or email.

Publisher can optionally render documents in the source system to a different file format before
publishing them to the destination system. Publisher combines these two actions—rendering and
publishing—in a publishing job that it can run either on demand, as a scheduled task, or in a
scheduled batch along with other jobs. Publisher provides links to the most common engineering
document management systems. Publisher also includes rendering modules for the most popular
engineering content authoring applications. Additional links and rendering modules are under
development by Accruent.

Publisher includes application links that can be installed to simplify publishing documents from
within source document management systems, such as:
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l Meridian Enterprise
l Meridian Portal
l Accruent Project Portal
l Microsoft SharePoint
l Any Windows file system

The links add documents to the publishing queue, which can be managed through a website
installed on the Meridian Enterprise Server computer or a separate web server. The queue can be
viewed and controlled using any web browser from anywhere on the network.

Confidential and Proprietary © 2022 14 www.accruent.com



What's In This Guide
This guide describes the use of Meridian end-user applications to perform everyday document
management. Meridian server administration is documented in theMeridian Enterprise
Administrator's Guide. Configuration of Meridian vaults is documented in theMeridian Enterprise
Configuration Guide.

This guide describes:

l High-level concepts employed by Meridian
l The capabilities of the client applications, PowerUser and PowerWeb
l How to browse, navigate, and search Meridian vaults
l How to use Meridian to create, view, modify, redline, and print documents
l How to use workflows to manage document changes
l How the Meridian client applications integrate with other applications
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Who Should Read This Guide
This guide is intended for document control staff, documentation managers, authors, editors,
reviewers, and information consumers who are familiar with, and have experience in:

l General personal computing concepts
l The use of various document types in everyday business situations
l Basic document control methodologies such as revision control
l The Windows® operating system, including its use in a network environment
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Technical Support
Technical support for Accruent products is available from a variety of sources if you have an
active support contract. Your first source of support is the authorized contacts designated by your
company to participate in the support contract. They are the persons that are responsible for
resolving problems with Accruent software before contacting outside sources of support. If your
company works with a Accruent Partner, that partner is your second source of support. Accruent
Partners are responsible for providing technical support to their customers in order to maintain
their status as Accruent Partners. Accruent will assist the partner company, if necessary, to help
resolve your problem. If your company is a direct Accruent customer, your authorized contacts
may communicate directly with Accruent to resolve your problem.

Accruent Partners and direct customers have access to all of these Accruent technical support
resources:

l Support Cases – around the clock support issue entry, update, and status
l Meridian knowledge base – continuously updated problem solutions, minor releases,

updates, and how-to articles about advanced techniques
l Email notifications – immediate alerts to support issue status changes
l Telephone support – direct access to highly qualified software support engineers with

extensive experience in Accruent products

The available support contract options, terms, and other details are described in documents that
are available from your Accruent Partner.
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EDM Principles
Engineering data management (EDM) is a generic term for a wide variety of functions. In general,
it is the process of managing engineering documents throughout their life cycle, from inception
through creation, review, storage, and distribution all the way to archiving or destruction.
Depending on specific requirements, document management is different for every customer.

Before computer technology became widely available, a document was generally defined as a
piece of paper: a memo, a letter, a transmittal note, a drawing, or an invoice. The paper
presented information—usually text and graphics—for the purpose of communication. In EDM, a
document is seen as containing numerous types of information: text and graphics as well as data,
spreadsheets, CAD drawings, images, video, and voice. Documents are vessels for information.

There are two specific ways in which documents are used:

l Documents present information.
l Documents develop information.

For example, a marketing manager writes a proposal for a product, and the engineering
manager reviews it and adds information. A CAD designer adds detailed specifications, and
the manufacturing manager uses this information to build a viable product. Documents are
also at the heart of business processes. They are the means of accomplishing an
organization's goals and objectives.

Using documents in both of these ways is part of the EDM process, which can also:

l Provide access to archived documents
l Control the production of new documents
l Modify existing documents

Meridian helps you manage your documents and their revisions and allows you to share them
with others. Meridian helps you with:

l Document management— Document management is built into Meridian with the design
team in mind and allows many types of documents to be managed in different ways. A
document is defined by its business purpose instead of its file extension. This means that
although your project may contain, for example, a .dwg file (an AutoCAD drawing), it can
also contain many different types of drawing files.

Meridian allows you to manage all of these different drawing types in their own unique way
related to the business meaning of the drawing.

l Revision management— Extensive document revision management includes a lock feature
that prevents users other than the editor from working on locked documents. Several
possible revision scenarios may exist, depending on how your system has been configured.
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l Approval and change management— Documents may go through any of several possible
workflows based either on the document type or the change type. This supports change
management so that you can adhere to the business process and quality procedures.

Alternatively, you can manage many documents together using project folders.

Confidential and Proprietary © 2022 19 www.accruent.com



Meridian Enterprise Basic Concepts
The concepts, features, and terminology described in this section will help you follow what comes
later in this guide.
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Meridian Client Applications
The client side of Meridian runs on your local computer. Its applications communicate with the
server processes to retrieve documents and information from the server. Meridian allows several
types of clients to access the server. The following figure shows Meridian PowerUser for use in a
LAN environment. It is described in PowerUser.

The following figure shows PowerWeb for use over the Internet, using the company's intranet or
extranet. It is described in PowerWeb Features.
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The following figure shows the Meridian Application Integration client, which integrates
seamlessly with every Microsoft Windows-compliant file-related dialog box. It is described in
Application Integration.

Application links to popular office and engineering programs also provide interfaces to the
Meridian vault. An up-to-date list of supported application versions is available from your
Accruent Partner or the Accruent extranet.
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Shortcut Menus
Meridian features shortcut menus that can be opened in:

l Views in the navigation pane
l Revisions, References, and Project Copies view in the document pane
l Viewer window

These menus give you quicker access to the commands you use most without having to select
them from the menu bar. The commands that are available are a subset of the commands on the
menu for the selected object type. For example, the shortcut menu shown for a document
contains a subset of the commands that are shown on the Document menu. For descriptions of
the commands, refer to the corresponding menu topic. If you have multiple object types selected
(for example, folders and documents or documents of different types), the shortcut menu may
show commands that are applicable to each of the individual object types. However, some of the
commands may not be applicable to all of the selected objects in the same operation. For the
best results, perform operations with selections of objects that are the same type whenever
possible.

You open shortcut menus by right-clicking the object or selection that you want to work with.
Right-clicking also makes the item the selected item just like left-clicking does. Selecting
additional items for the same operation (by holding down the Ctrl or Shift key while clicking) does
not select a different item.

You open a shortcut menu in the viewer window by right-clicking anywhere within the window.
The shortcut menu of the viewer window lists different commands depending on the format of
the selected document. This shortcut menu is not customizable.

See Personal Options on how to customize the PowerUser document, folder, and vault shortcut
menus to display the commands that you want.
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Vaults
A vault is a combination of a Meridian database and a document store. It contains all of the
documents you place in the vault, the data about those documents, all revisions of those
documents made in the vault, and redline data for the documents. If some of your documents use
references to other documents, such as with CAD files, then those references between
documents will automatically be managed by Meridian. This means that you can move files
between folders within the Meridian vault (such as from one project to another), and the
references will not be lost, because they are managed by Meridian.
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History
The Meridian history feature maintains all changes to vault data over time, including revisions to
documents. History is enabled or cleared for each vault by a System Administrator.

The last released revision of a document is always the default one shown in a vault. However, by
using the Show Revisions command, you can see all previous revisions and their effective dates.
History also allows you to view the entire vault at a particular moment in time and to save a
shortcut to that moment, called a baseline.When you view history, all documents and their
revisions, property values, and references appear as they were at that point in time. The view
includes all released documents at that point in time. New documents and copies of released
documents that are under change and have not yet been released are not shown.

While you are viewing history, the background of the application is gray, indicating that the vault
is read-only. You cannot edit or create documents in the past. In addition, the context bar and the
status bar show the date and time or baseline name that is currently being viewed.

Note:
Support for baselines in PowerWeb must be enabled by a System Administrator.
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Scopes
Meridian manages a wide variety of documents and the information about them. Scopes are a
way of limiting vault functionality and information to named sets that are easier to understand
and use. You may select a scope that more closely meets your needs without experiencing
information overload.

Impact of Scopes
Scopes limit your ability to create or work with the following objects:

l Commands
l Document types
l Folder types
l Workflow types
l Project types
l Reference types
l Navigation views
l Reports

Scopes also limit some Meridian functions:

l Folder access is restricted to a folder and its sub-folders that are defined by the scope.
l Searches are restricted to accessible folders.

Note:
You may not work with any other objects than those defined in a scope. If no scope provides
the functionality or folder access that you need, select a different scope or consult a System
Administrator.

For example, a vault used for managing facilities might define scopes for master documents,
design projects, archived documents, or maintenance management. A vault used for managing
AEC documents might define a different scope for each customer. And a vault used for
manufacturing documents might define different scopes for standard parts, active projects, and
inactive projects.
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Select a Scope
Selecting a scope allows you to specify the vault objects and functions that you want to work with
in the current Meridian Enterprise session. If any scopes are defined in a vault, you must select
one when opening the vault for the first time. Thereafter, you may select a different scope that
more closely meets your needs. If only one scope is defined for a vault, is it selected
automatically. You may select only a scope for which you have the Can Use privilege for the
scope.

PowerWeb Procedures
Use these steps for PowerWeb.

To select a scope:

l In the toolbar, select a scope name from the scope list.

The vault objects and commands that are not available for the selected scope disappear.
The vault objects and commands that have been configured for the selected scope appear.

PowerUser Procedures
Use these steps for PowerUser.

To select a scope:

l Choose between two options:
o On the View menu, point to Change Scope.
o To select a scope from the Context bar:

1. Click the current scope name button in the Context bar.

A shortcut menu of scope names appears. Scopes for which you do not have the
scope's Can Use privilege are cleared.

2. Select a scope name.

The vault objects and commands that are not available for the selected scope
disappear. The vault objects and commands that have been configured for the
selected scope appear.
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Navigation Views
Navigation views are different ways of viewing a vault for different purposes. Each view displays
documents organized in a hierarchical tree structure like Windows Explorer, similar to the
following figure. The tree structure is determined by a predefined set of properties. You can use
Navigation views to find and select documents according to the property values of the
documents. Navigation views help you to find documents based on whatever information you
know about the documents that you want to find.

Finding documents with Navigation views is often quicker and easier than finding documents by
searching. All Navigation views display only the latest, released revision of documents. Status
icons at the left edge of the views show the current workflow status of documents. For
descriptions of the possible icons, see Navigation View Icons.

You cannot modify the configuration of Navigation views. Navigation views are configured by a
System Administrator and may display:

l Different icons to represent each folder level
l Specific document types only
l Documents with specific property values only
l Different columns of information in each view

To set your personal display options for Navigation views, such as colors, fonts, and gridlines, see
Personal Options.
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Default Navigation Views

All vaults have the following five views available by default:

l Folders
l All To-Do Lists
l Document Type - File Type
l My To-Do List
l Status - Person
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Ways to Use Navigation Views
The following list describes how you can use navigation views to easily find the document you're
looking for:

l The Folders view displays where the documents are physically stored within the vault.
l If you need to find a document but only know who is currently working on it, you can

probably find it with the All To-Do Lists view or the Status – Person view.
l If you only know what document type or file type the document is, then you can probably

find it with the Document Type – File Type view.

A System Administrator may create additional views based on your organization's unique needs
and vault configuration. Each vault can have any number of additional Navigation views, each
presenting the contents of the vault in a different structure for different purposes or different
groups of users.

Similarities between Navigation Views and Windows File
Explorer
The folder structure displayed by Navigation views is similar to that shown by Windows Explorer.
However, Navigation views combine the folders that are shown in the left pane of Windows
Explorer with the column data that is only shown in the right pane of Windows Explorer into a
single view that displays both folders and columns in the same pane. Furthermore, file commands
that appear on the Windows Explorer shortcut menu (for example, Print and Open With) also
appear on the Meridian Enterprise Document shortcut menu.

Navigation views work similar to Windows Explorer, too. Depending on your security privileges
and how the vault is configured, you may be able to:

l Expand or collapse folders
l Create and delete folders
l Drag and drop folders and documents between vault folders or between the Navigation

view and Windows Explorer or the desktop
l Run commands on the contents of Navigation view folders (PowerWeb only)
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Select a Navigation View
Selecting a Navigation view allows you to view a vault contents using different criteria than just
the folder names of the Folders view. Selecting a different Navigation view can make performing
some operations easier. You may select only a Navigation view for which your current security
role has been granted access.

PowerWeb Procedures
Use these steps for PowerWeb.

To select a Navigation view:

1. In the toolbar, select a view name from the view list.

The view pane displays the vault contents using the view definition.

2. Click the icon or name of the folder that best matches the information you know about the
document you want find.

The folder opens to reveal its contents. To close the folder, click it again. A green check mark
indicates the current folder.

3. When you find the document you are looking for, click the document name hyperlink in the
Navigation view.

The document's property pages appear. Click the document's icon in the Navigation view
instead to view the document in a viewer window.

PowerUser Procedures
Use these steps for PowerUser.

To select a Navigation view:

l Choose between three options:
o To use the shortcut menu:

1. Click the current Navigation view name button in the Context bar.

A shortcut menu of Navigation views appears. Navigation views for which you do
not have access are cleared.

2. Select a Navigation view.

The view pane displays the vault contents using the view definition.
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o In the Shortcuts pane, click the Views button and then select a new view from the list
that appears.

o From the Viewmenu, point to Change View and then select a new view from the sub-
menu.
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Folders View
The Folders view is special among all of the Navigation views. It displays the documents and
folders as they are actually organized in the vault, similar to Windows Explorer. When you create
new documents and move existing documents, you do so relative to the Folders view structure
regardless of the current view.

The other Navigation views represent logical folder structures based on other document property
values. That is, the documents don't actually reside in the folders shown in Navigation views; the
folders are simply groupings of documents with the same property values. The Folders view also
works like Windows Explorer. The same actions you can take in Windows Explorer, like cut, copy,
paste and drag and drop, also work in the Folders view.

Note:
Meridian security roles are applied at the folder level in the Folders view. Thus, your ability to
perform certain actions may be different in some folders as opposed to others.
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Configure a Navigation View
You can manipulate Navigation views in some of the same ways that you can in Windows
Explorer. The changes that you make are saved between sessions.

PowerWeb Procedures
Use these steps for PowerWeb.

Sort Documents by Column
To sort documents in a Navigation view based on a particular column:

1. Click the column heading that you want to sort on and then click Ascending or Descending.

An arrowhead icon in the column heading indicates the current sorting column and sort
order.

2. Click the column heading again to reverse the sort order.

Change Column Order
To change the order of columns:

l Click the column heading, drag it, and drop it in the desired position.

Change Column Visibility
To change the visibility of columns:

1. Right-click a column heading.

The Columns to Show dialog box appears.

2. Choose one or more of the following options:
l To hide a visible column, clear its check box.
l To show a hidden column, select its check box.
l To restore the default column visibility, click Restore To Defaults.

3. When you are done setting the column visibility, click OK.
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Filter Based on Column Values
In addition to the preceding actions, you may also filter the documents shown in the following
view types based on the property values of the documents that are shown in these views:

l Search Results
l Dynamic collections

You do this by defining a filter similar to defining a filter in Microsoft Excel. You may only define
one filter at a time.

To filter a view based on the values of the columns that are shown:

1. Click the column header of the property upon which you want to filter the view.

2. Click Filter By.

A dialog box appears that lists the values that are used by the documents that are shown in
the view. By default, no property values are selected.

3. Select the property values that you want shown in the view.

4. Click Apply.

The view is refreshed to show only those documents that have the selected property values.
A filter icon appears in the column header to indicate that a filter is active.

Remove Column Filter
To remove a filter on a column:

l Repeat the preceding task and select Reset.

The view is refreshed to show the resulting documents.

PowerUser Procedures
Use these steps for PowerUser.

Sort Documents by Column
To sort documents in a Navigation view based on a particular column:

1. Double-click the column heading that you want to sort on.

An arrowhead icon in the column heading indicates the current sorting column and sort
order.

2. Double-click the column heading again to reverse the sort order.
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Adjust Column Width
To adjust the width of a column:

1. Hover your cursor over the right column divider of the column that you want to resize until
your cursor appears as a double-headed arrow .

2. Click and drag the column divider until the column is the desired width.

3. Release the column divider.

Change Column Order or Visibility
To change the order or visibility of columns:

1. Press and hold the Ctrl key while right-clicking a column heading.

The Configure Columns dialog box appears.

2. To hide a visible column, clear its check box or select it and click Hide.

3. To show a hidden column, select its check box or select it and click Show.

4. To move a column, click and drag it to the desired position or select it and clickMove Up or
Move Down until it is in the desired position.

Filter Based on Column Values

Note:
Filters are disabled when the Load Navigation view data on demand option is enabled as
described in Advanced Options.

In addition to the preceding actions, you may also filter the documents shown in the following
view types based on the property values of the documents that are shown in these views:

l My Search Results
l Dynamic collections

You do this by defining a filter similar to defining a filter in Microsoft Excel.

To filter a view based on the values of the columns that are shown:

1. Right-click the column header of the property upon which you want to filter the view.

A dialog box appears containing filter options and a list of the values for the selected
property. The values are those that are used by the documents that are shown in the view.
By default, all property values are selected.
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2. Clear the property values that you do not want shown in the view.

3. Click OK.

The view is refreshed to show only those documents that have the selected property values.
A filter icon appears in the column header to indicate that a filter is active. The icon also
appears in the context bar to indicate that a filter is active that might not be visible without
scrolling the view pane horizontally.

4. Enable Remember this filter to retain the filter settings between sessions.

The filter will also be applied to the other views that can be filtered.

Remove Column Filter
To remove a filter on a column:

l Choose between two options:
o Option 1:

1. Right-click the column header of the property for which you want to remove a
filter.

A dialog box appears containing filter options and a list of the values for the
selected property.

2. Select Reset this filter.

To remove all filters, select Reset all filters. The view is refreshed to show the
resulting documents.

o Option 2:

1. Click the filter icon in the context bar.

A dialog box appears that prompts you to confirm that you want to reset all
column filters.

2. Click Yes.
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Navigation View Icons
The current workflow status of documents is indicated by an icon at the left edge of each
Navigation view. In addition, a tooltip will display the current status and the current to-do person
if you hover the mouse pointer over the status icon.

The following table lists the possible document status icons and their descriptions.

Icon Description

(no icon) The document is released, that is, not in any workflow.The document name
and all properties shown in the Navigation view columns appear in black text
and no icon is shown in the left edge of the Navigation view.

The document is assigned to you. This blue icon means that there is a
workflow task to be completed and you are the assigned person.

The document is assigned to another user. This red icon means that there is a
workflow task to be completed by another user.

The document is under change by you. The document name and all property
values in the Navigation view columns appear in blue.
If this icon is blue, it means that this document has been edited in your local
workspace.
Other users see a red icon to indicate that this document is being edited in
another user's local workspace.

The document is under change by another user or a project copy is created in
a folder.

The document is in the In Review state of a document type workflow.

The document is in the Retired state.

(other
icons)

Documents currently under the control of a workflow definition may display
with icons not shown in this table.

Navigation view icons
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Property Pages
In the Meridian client applications, the detail pane contains property pages (as shown in the
following figure) that show the basic properties of the currently selected item: document, folder,
or asset tag stored in the vault. Each of these items has at least one property page but may have
more depending on the configuration of the item. Empty or partially empty property pages may
display during the creation of new documents or folders for you to type required and optional
values. The properties shown on a property page may be system properties (Status, Size, and so
on) or custom properties configured by a System Administrator. Property pages can show a
variety of icons, links, and other features.

Meridian Enterprise provides the following standard property pages. Not all may be available in
your system.

l Document — the default page for documents that shows basic system properties and a
thumbnail image of the document

l Rendition — shows property values that determine how the system generates renditions
from the source document

l Retention — shows document retention properties that your organization can use to
enforce its retention policies. Meridian does not enforce document retention with these
properties by default.

l Tags — shows the asset tags (stored in the Tags branch of the vault) that are linked to this
document

l Title Blocks — shows the values of title block properties when multiple sheets exist in a
drawing

l Folder — the default property page for every folder in the Folders view
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The following table describes the unique features of the Properties pane in PowerWeb and
PowerUser.

Number Icon Description

1 The graphics of this icon are different for each file type and depend on
the application registered in Windows on the current computer. Clicking
this icon displays the Advanced Document Information dialog box that
lists all property information for the selected document.

1 Indicates that the selected document or its rendition has electronic
redlines associated with it that can be shown and edited in the viewer.

1 Indicates that the selected document has a rendition associated with it
that is newer than the source document and can be shown in the
viewer.

Property page features
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Number Icon Description

1 Indicates that the selected document has a rendition associated with it
that is older than the source document and should be updated.

1 The graphics of this icon may be different for each folder type. Clicking
this icon displays the Advanced Folder Information dialog that lists all
property information for the selected folder.

2 Indicates that the selected document has references to other
documents in the vault. Click this icon to display a graphical diagram of
the reference relationships as described in View References.

3 Rendition
page

Shows property values that determine how renditions are created from
the source document. For more information about renditions, see
Renditions.

4 Document
name

Also the file name. May be calculated automatically by the system
depending on the configuration of the vault.

5 Comment: Click the hyperlink to display historical workflow information about the
document, which includes comments typed by workflow participants
when they executed workflow transitions.

6 Indicates that the selected document is either a master document or a
project copy. For more information, see Show Master And Project
Copies.

7 Status: Indicates whether the document or folder is in an active workflow. Click
the hyperlink to open a dialog box that shows a graphical diagram of
the workflow. The current workflow state will be shown highlighted in
red. For more information, see View the Current Workflow.

8 Electronic
signatures

link

Shows electronic signature information for the current document.
Typically used only with the Meridian FDA Module.

9 Click this icon to run a search as described in Key Find.

Folders display a similar Folder property page that shows the folder's details and, if the Meridian
Advanced Project Workflow Module is enabled, details about the project type and project
workflow status information. Property pages for existing items may or may not be editable
depending on your security privileges and the configuration of the vault. The icons and hyperlinks
on some property pages activate commands when clicked.
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Documents
Documents in a Meridian Enterprise vault are like files in a file system. They are located in folders
where you can copy, rename, move, and delete them. However, vault documents differ from files
in a file system in some important ways.

The fundamental difference between vault documents and ordinary files is that Meridian
Enterprise distinguishes between a document and its contents. A document's contents may be
regarded as the file to which you are accustomed. Meridian Enterprise considers a document to
be the file and its container (metadata properties). In Meridian, a document can exist without
contents (for example, to represent a hard copy-only document), but contents cannot exist
without a container. The contents of a document can be replaced. It is these containers and how
to work with them that are described in the following topics.
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Document Types
In Meridian, every document is assigned a document type based on the business purpose of the
document, which may not be related to its file extension. Examples of document types are
memos, specifications, drawings, project plans, and so on. Practically every type of document
your organization uses can be a Meridian document type. The same document type can be
assigned to any kind of file such as a vector drawing, a raster image, a text file, a spreadsheet, a
database file, or a word processor file. In addition, the same file type may belong to different
document types. For example, a floor plan drawing is very different from a manufacturing part
drawing. They may both be AutoCAD DWG files, but different document types are assigned to
them.

A Meridian document type determines the following characteristics of a document:

l Naming convention
l Revision numbering
l Available file (content) templates
l Workflow
l Metadata properties
l File type associations
l Data links

The appropriate document types for your organization are defined by a System Administrator.

Security for your system may be implemented on a document type basis. This means that access
to documents will be granted based on what type of document they are, rather than the folder in
which they reside.

The following topics describe each of the preceding characteristics.
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Document Naming And Location
Every vault document has a name and a location. Depending on the vault configuration, these
may be controlled by the system. A document's name may be controlled by its document type. A
document's location may be controlled by a feature of the vault configuration named the Field-
Path definition.

A document type may implement automatic naming or it may not. If it implements automatic
naming, you may or may not be able to type a document's name when you create or import the
document. The document type may calculate the document name automatically based on other
information you select or type about the document at the time of document creation, such as
project number, sheet number, title, and so on. The calculation may also include an incremental
identification number. For example, specified the following naming convention:

<ProjectNumber><DocumentType><SheetNumber>

An automatically calculated document name might be: 2009Plan001. Automatic document
naming ensures that documents are consistently named for easy retrieval and identification.

File systems can store documents in folders to give a logical structure for easier organization and
retrieval. Meridian supports the same kind of logical structure through its Folders view, but it
takes the concept a step further with the Field-Path definition. The Field-Path definition is similar
to the automatic naming convention described previously except that it applies to the vault's
folder structure. This means that the structure and names of the folders in the vault can be
determined by information about the documents they contain. For example, specified a Field-
Path definition that looks like this:
Projects\<ProjectStatus>\<ProjectName>\<SubprojectName>

The Field-Path definition might create the folder path:
Projects\In Design\WellBuilt Addition\Structural Framing

Each vault can implement a different Field-Path definition or none at all. If not, you can create its
folder structure, just as in Windows Explorer.
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Revisions
When you process a document through a workflow, Meridian creates a copy of the original
document to receive the changes. Meridian may or may not keep the original document
depending on the vault configuration. One function of a document type is to determine the
revision number of changed documents. Again, whether or not Meridian calculates the revision
number is defined by the document type. If the revision number is not calculated automatically, it
remains the same after a workflow or may be edited manually.

If the revision number is calculated, the document type determines:

l Whether the number is linear (1, 2, 3, 4, …) or hierarchical (1.0, 1.1, 1.2, …)
l Whether the number is initially blank
l Whether the number includes separator characters (hyphens, underscores, or decimal

points)
l When the revision number is incremented

For example, a newly created document may start with no revision number, but when it is revised
for the first time later, it might become revision 1. Further revisions may be assigned revision
numbers 2, 3, 4, and so on.

Some documents that are for reference only and are not revised, such as photographs, may have
no revision number.

Hierarchical revision numbers are often used to indicate changes made in project folders. That is,
a document may be revision 1 and a copy made to a project folder for revision. When the
document is placed in a workflow, the document may become revision number 1.1 and
subsequent workflows inside the folder will produce revisions 1.2, 1.3, and so on, until the
completed document is released as master document revision 2.

Automatic revision numbering ensures that revisions are consistently numbered for accurate
tracking, retrieval, and identification.
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Document Templates
Almost all application software allows the use of templates when creating new documents. For
example, Microsoft-Word uses .dot template files, and AutoCAD uses .dwt template files. A
document type defines which templates are available for selection when creating new vault
documents. A System Administrator maintains the content and configuration of document
templates as described in the Configuring document templates article in theMeridian Enterprise
Configuration Guide.

The templates that are available for each document type appear in the document type's sub-
menu for easy selection. If no templates are specified for a document type, then the sub-menu
lists the file types that are registered in Windows on the current computer. If one of the file types
is selected, Meridian will create an empty document in the vault with the file extension of the
selected file type. When the empty file is opened for editing from within Meridian, Windows will
start the application that is registered for the file type.

Using a standard set of templates ensures that new documents start from the same set of
templates and you are guided to select the correct template for the document type.
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Document Properties
Meridian stores and displays data about each document calledmetadata. The metadata is stored
in properties, which can be considered database fields. Meridian uses properties in a manner
similar to the way Windows keeps track of a file's name, size, date created, and date modified.
The properties in Meridian are used to track and manage the documents and may include such
properties as Revision Number, Project Number, Status, Title, and many more. The document
type of a document determines which properties are associated with the document.

You will encounter three kinds of properties when working in Meridian:

l Read-only— You cannot change the values of these properties. Examples are Creation Time
and Size.

l Restricted — You can only select a value from a list of standard values.
l Unrestricted — You may type a value you want.

Meridian displays properties on property pages. Each property page contains properties that are
related to one another in some way. The document type of a document determines which
property pages are associated with the document. Every vault document displays at least a
Document property page that contains basic metadata such as workflow Status, To-Do, Location,
Type, and so on. Property pages appear for existing documents and may also appear when you
create new documents so that you can type any known information. That information may be
used to automatically name the document and store it in the correct folder.
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Document Security
Meridian Enterprise security is based on default and System Administrator-defined roles that can
be applied to the folders of a vault. Each role defines the privileges of the members of the role.
The members can be network domain groups, Meridian Enterprise groups (preferred), or
individual user accounts. The roles applied to a folder determine what actions the role's members
can perform on that folder and the documents it contains. Therefore, you might have more
privileges in one folder than another folder.

Document security is also affected by the workflow status of a document. When a document is in
the Under Change state, for example, only the owner of the document has the privileges to
change the document. A document in the Review state can be reviewed and annotated by
multiple users, but can not be edited by the reviewers in that state.
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Document References
Very often, two or more documents may be related to each other. The documents may or may
not reside in the same folder. These relationships may be of several kinds.

One kind of relationship is revision-related. This relationship is characterized by the revisions of
related documents and is established by Meridian when the revisions or versions are created.
Examples of revision-related documents are:

l Documents created by the Derive command — A new document is derived from an existing
document.

l Documents created by the Replace command — A new document is created that replaces
an existing document.

l Microsoft Outlook messages and their attachments.
l Master documents and project copies — One or more copies of a master document are

created for concurrent editing in different projects. These documents can be managed by
the Managed Change features of Meridian described in Project Folders or by the Meridian
Advanced Project Workflow Module described in Introducing Meridian Enterprise.

Another kind of relationship is content-related. This relationship is characterized by the content
of the related documents and is established by the applications used to create the documents.
Examples of content-related documents are:

l AutoCAD X-Refs — X-Refs are drawings that either reference other drawings or are
themselves referenced by other drawings. This applies to all derivations of AutoCAD,
including Architectural and Mechanical Desktop products.

l AutoCAD sheet sets — Sheet sets are drawing layouts that are printed together as sets.
l Autodesk Inventor assemblies, parts, and drawings — Autodesk Inventor assembly models

reference part models, and Autodesk Inventor drawings reference views of assembly or part
models.

l SolidWorks assemblies, parts, and drawings — Same as for Autodesk Inventor.
l MicroStation model references — MicroStation models reference drawings to other models

or layout views.

The last kind of relationship is business-related. This relationship is characterized by the business
processes that use the related documents and must be established by the users of the
documents. Examples of business-related documents are:

l Drawings and a bill of materials or a sheet schedule.
l Drawings and specifications, installation and operations manuals, or design calculations.
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l Project plans, schedules, and meeting minutes.
l Documents and their related asset tags.
l Any arbitrary combination of documents that are not otherwise related to one another.

In order to represent these relationships in a vault, Meridian uses links called references. A
reference is a link from one document to another that represents a specific relationship. A
document may have any number of references to another document, called outgoing references.
Conversely, a document may be referenced by any number of other documents, called incoming
references. Like many other things in Meridian, references are created from templates called
reference types. Reference types are defined by a System Administrator in the vault's
configuration.

References between documents can be created in two ways:

l Automatically by Meridian for the first two kinds of relationships previously described.
l Manually in the Meridian client applications for the third kind of relationship.

Once they are created, references allow you to quickly find related documents regardless of
where they reside in a vault. Referenced documents can be automatically included in search
results.

Meridian references are links in addition to, and stored apart from, any links contained within the
document file itself. For example, if you insert an external reference into an AutoCAD drawing
that resides in the vault to another document that also exists in the vault and you save the
drawing, an X-Ref is created in the drawing and a reference is created in the Meridian vault to
represent the X-Ref. From then on, Meridian ensures that both references are maintained
regardless of where the documents reside in the vault. The same principle applies to the other
applications for which there are Meridian application links.

Note:
Microstation does not support hybrid documents.

For example, in the following figure, the current drawing (08797008.dwg) references four
other documents (asset tags). These references can also be seen from the other documents.
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References let you see the possible effects that revising the selected document may have on
other documents that may need revising also.
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Hybrid Documents
A hybrid document is a document whose data is stored in more than one file in the vault.
However, the files are treated as one document by Meridian.

All of the files that make up a hybrid document share the same properties (including revision
number), workflow, and life cycle. An example of a hybrid document is a CAD drawing that has
scanned images inserted into it, similar to the following figure, which depicts a DWG file as the
main part of the hybrid document and the TIF file as a subordinate part of the hybrid document.

Which files display as the main part of a document and which files display as subordinate parts of
the main document are determined by the configuration of the document type of the main file.
Everything that you do to the main document also applies to its parts. For example, if you move a
hybrid document to another folder, its parts move with it. If you start a workflow for a hybrid
document, its parts follow the workflow too and all member files are editable at the same time.
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It is important to distinguish between a hybrid document and a hybrid drawing. Hybrid documents
are created in Meridian. Hybrid drawings are created in a CAD application such as AutoCAD or
MicroStation.

A hybrid drawing may also be a hybrid document in Meridian, but not necessarily so. For
example, a hybrid drawing may have a raster image inserted into it that resides outside of the
Meridian vault. Such a drawing is a hybrid drawing, but it is not a Meridian hybrid document
because all of its parts do not reside in the vault. Another example would be a hybrid drawing in
which all of the files reside in a vault, but they have not been assigned a hybrid document type.
They can still function as a hybrid drawing from within the CAD application, but they will not
function as a hybrid document in Meridian.

Likewise, a Meridian hybrid document may not be a hybrid drawing. For example, a word
processor document may have a PDF version of it attached to the source file as a subordinate
part.
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Workflow Types
Meridian Enterprise features different types of workflow that can be used for various purposes. A
System Administrator decides which types a vault uses, depending on your organization's
business processes and needs. The workflow types are divided into two major categories: project
workflow and document workflow. Within each category are different workflow types that can be
used either alone or together. Project workflow can be implemented with project folders.
Document workflow can be implemented with document type workflow (the workflow defined
for each document type), workflow definitions (workflows defined independent of document
types), or working copies.
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Document Workflow Types
The document workflow types in Meridian allow you to revise individual documents. Document
workflows ensure that the steps to produce a new revision are followed in the correct order by
the correct persons. For example, a simple document workflow might require that a revision be
reviewed before it is released for use. Document revisions can only occur within certain states of
the workflow. The commands that change a document from one state to another are called
transitions. Meridian has different types of document workflow such as: document type
workflow, workflow definitions, and working copies.

Working Copy and Legacy Quick Change
Working copies is the simplest of the document workflow types. It consists of only two states
performed by two commands, Create Working Copy and Submit Working Copy. This type of
workflow is sometimes referred to as check-out/check-in. It is typically used for master
documents that are changed in the course of a project and that require revision control.

You can also revoke a working copy workflow with the Revoke Working Copy command.

Quick change works in a similar way to the working copies workflow. The revision number may
not be incremented depending on the document type configuration set by your System
Administrator. You can use this for master documents that are not changed in the course of a
project and do not require revision control.

With legacy Quick Change you can:

l Start Quick Change
l Release Quick Change
l Revoke Quick Change — aborts a Quick Change.

Important!
Revoking deletes the copy of the document that is being changed in the workflow and
reinstates the released revision of the original document as the highest revision. If the
document was created new in the workflow, it is also deleted but there is no original document
to reinstate so be certain that the document will not be needed or a backup copy is kept
elsewhere before revoking the document's workflow.

As of Meridian 2021 R2, if your vault is configured to do so, you can use Quick Change as a
configurable workflow. This allows more configuration possibilities for your administrator. If your
vault is configured to use new Quick Change, workflow events are triggered instead of working
copy events and Quick Change privileges are replaced with Workflow settings.
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Document Type Workflow
The Document type workflow is moderately complex among the different document workflow
types. It controls the major phases of document revision:

1. Initiation of work

2. Work in progress

3. Review and approval

4. Retirement

The progress of documents through these phases can be controlled by a workflow manager who
is assigned at the start of the workflow. A System Administrator selects options for these phases
that determine which states and transitions the workflow will include. The commands for using
document type workflow are named for the transitions between the states and include names
like Start Change, Submit, Start Review, Approve, Release, Retire, and Unretire. In this workflow
type, retiring a document freezes it at its current revision and prevents it from further revision
unless it is unretired.

The following figure shows all of the possible states and transitions of a document type workflow.
Your organization might not use all of them or only allow users with certain privileges to perform
some of the transitions.
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Workflow Definition
Workflow definitions are the most configurable of all the document workflow types. System
administrators have full control over the configuration of a workflow definition. Like document
type workflow, the commands for using workflow definitions are named for the transitions
between the states that the commands run and as such have whatever names the System
Administrator specifies.

As of Meridian 2021 R2, if your vault is configured to do so, you can use Quick Change as a
configurable workflow. This allows more configuration possibilities for your administrator. If your
vault is configured to use new Quick Change, workflow events are triggered instead of working
copy events and Quick Change privileges are replaced with Workflow settings.

With the Quick Change workflow definition, you can:
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l Start Quick Change
l Release Quick Change
l Revoke Quick Change — aborts a Quick Change.

These actions can be applied to a single document or to a batch of documents.

To navigate through the Quick Change workflow:

1. Select one or more documents.

2. Choose between two options:
l On theWorkflow ribbon, select one of the actions in the Quick Change section.
l Right-click anywhere within your selection, point toWorkflow, point to Quick Change,

and then select the appropriate action.
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Project Workflow Types
The project workflow types in Meridian are used to perform the revision of related documents as
a group. Project workflow controls the overall revision process of the entire group of documents
that the project includes. Project workflow ensures that the steps of a project are executed in the
correct order by the correct people. The documents within a project are revised individually using
one of the types of document workflow. For example, a simple project workflow might require
that all document revisions be reviewed as a completed set before they can be released for use.

Meridian provides project workflow for project folders. Project folders that can have a workflow
are a feature of the optional Advanced Project Workflow Module. The commands for using the
workflow of a project folder are named for the transitions between states that the commands run
and as such have whatever names the System Administrator specifies. Project folders without
workflow are part of the Managed Change feature set of Meridian Enterprise.
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Industry-Specific Considerations
Certain industries present unique challenges in document management. When configuring
Meridian Enterprise for these industries, consideration must be given to: document workflow,
revision control, and project workflow.

The following sections offer recommendations on how these features should be used to meet
these needs.
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Reference Relationships
Choosing the right revision methodology is vital to managing reference relationships. There are
two basic strategies for controlling reference relationships:

l Use document workflow — Parent documents always reference the last released revision of
child documents.

l Use derived documents — Parent documents reference the child document revision that
was released when the parent was last released.

The following sections discuss each of these strategies and their ramifications on reference
relationships. Regardless of the strategy used, the document history displayed in the Show
Revisions dialog will be maintained as expected.

Note:
When project copies are used, the last released master documents will continue to resolve to
the other masters until the project copies are released as new master revisions. When the
project copies are released, the master documents will resolve based on the revision
methodology used to modify the project copy.
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Document Workflow
If you use document workflow (either document type workflow or a workflow definition) to revise
a document, when it is placed under change, all parent documents will automatically reference
the latest released revision of the document. Under this methodology, it is the responsibility of
the editor to ensure that the changes do not negatively impact any of the parent documents. The
Show Where Used command may be used to assist the editor in identifying the affected
documents as described in View References.
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Derived Documents
When a document is replaced, as opposed to being placed under change using document
workflow, several things occur:

l The original version of the document is retired, but is still visible in the vault Folders view.
All parent documents continue to reference the original, retired version of the document.

l A new version of the document is created as a new, unique document. A reference is
created to tie it to the original version of the document.

l When a document is modified that references the original version, the retired document is
detected when the document is opened in a CAD application. The user is shown the option
to replace the original version with the new version of the document.

This strategy is useful for ensuring that parent documents are only updated when an explicit
decision has been made to revise the parent. Replacing versions also ensures that a specified
version of a parent document will always resolve the correct child documents, even in historical
contexts.
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Library Components In Manufacturing Environments
Many CAD applications today include vast arrays of library parts that can be used on the fly, but
there are some serious points to consider before these should be used. Whereas document
management should enforce control over documents, many of these CAD applications are
inadvertently providing ways to bypass standards and allow users to select from an unlimited
array of component types and sizes.

From a standards management point of view, it would be preferable to disable (that is, not install)
the libraries for most users, and only install them on the computer of the persons responsible for
creating and maintaining company standards. This person would then create all company-
standard models, and store them in the correct vault location for general users to access. In this
way, users may only select the standard, approved components that are stored in the Meridian
vault.

Using this methodology realizes the following advantages:

l Company standards are enforced.
l Meridian references displaying the assembly structure and where components are used

accurately reflect all components used in assemblies.
l Models of raw material items, such as tubing and beams, can be derived to individual

models to reflect the correct cut length for that instance.
l Standard items are approved once and simply reused in projects rather than creating

duplicate components for each project.

We recognize that these libraries are often a selling point for the CAD applications and that the
initial creation of the standard library models and drawings may require significant effort.
However, document control, standards, and stock levels are also very important issues for the
end-user company. Manufacturing companies simply cannot afford to keep the infinite varieties
of stock that would be required to allow designers to use any hardware type available.
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PowerWeb Features
PowerWeb allows you to work with vaults in a supported web browser. It's a lightweight and
easy to use alternative to PowerUser. In combination with the Local Workspace Client app,
PowerWeb provides the same level of integration with CAD applications, Microsoft Office, and
Windows applications in general as PowerUser.

Important!
PowerWeb saves session information on a per-user basis. This differs from PowerUser, which
saves information on a per-session basis. To prevent errors and lost data, do not log on to
multiple sessions of PowerWeb simultaneously with the same user account.

If you will be viewing documents or making changes to them with PowerWeb, only log on to
Meridian with the same account with which you logged on to Windows. This will ensure that the
correct versions of documents are managed in your local workspace.

If you will be making changes to documents and your connection to the Meridian application
server is not over a LAN, set Application Integration to Remote mode as described in Application
Integration Options. This will synchronize the vault with your changes using the Internet for best
performance and reliability.

Features
When browsing a vault, the PowerWeb window has these features:

Name Description

Ribbon/menu
bar

Ribbon of Meridian commands. The commands listed on the various menus are the
same as those on the shortcut menu. At the right end of the bar are a list for
changing the current vault and an icon to log off.
If the Show ribbon menus option is disabled as described in Personal Preferences,
the menu bar appears below the context bar instead of the ribbon.

Context bar On the left side, provides a quick search tool and lists for changing the navigation
view and current scope. On the right side, provides icons to change your preferences,
view this User's Guide in a browser window, and log off.
If the Show ribbon menus option is enabled as described in Personal Preferences, the
ribbon appears above this bar instead of the menu bar (5).

Features of the PowerWeb window
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Name Description

Property page
tabs

Click to display sets of related properties for the selected item. The quantity and
names of property pages varies with the currently selected item or document type. If
the document is a hybrid, a special Hybrid Parts property page tab appears at the
right side that will show a list of the available hybrid parts for the selected document.

Document pane Displays the property pages for the selected item, if one is selected. Activate shortcut
menus as described in Shortcut Menus.
If no document or folder is selected, a General property page shows applicable
information for the various types of views that are active in the navigation pane:

l Navigation views — shows a hierarchical view of the properties that
define the selected branch and their values

l Collection views — shows the collection search criteria, which can be
changed to refine the collection

l Search Results— shows the search criteria, which can be changed to
refine the search

Navigation
pane

One of various hierarchical views of the vault contents. Select another view from the
list in the context bar. Activate shortcut menus as described in Shortcut Menus.

URLs Addresses of the selected document and its rendition (if available) that you can copy
to the Clipboard and paste in other documents or systems to create a link to the
document.

View bar Click an icon to show related read-only data in the document pane. The available
views depend on the selected document from among: Document, View Document,
View Rendition, Revisions, References,Master and Project Copies,Workflow
Diagram, and Tags. Each view (except Document) can be undocked as a separate
window.

PowerWeb hyperlinks are indicated by blue text. These allow you to open folders and the
document log.

Differences between PowerWeb and PowerUser
PowerWeb is almost identical to PowerUser with these limitations:

PowerUser PowerWeb

Configurable window layout Not supported

PowerWeb compared to PowerUser
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PowerUser PowerWeb

Local PC document templates Not supported

Thumbnail view Planned

Assembly import tool Packages

Briefcases Packages

Email integration Email Documents

History baselines Not supported

Global Collaboration Framework support Not supported

Saved search settings Create And Edit a Collection

Unlock a master document that is the current
document

Unlock a Master Document From the Project Copy

Expand all folders in navigation trees Not supported

Some VBScript objects, properties, and
methods

See the VBScript and PowerWeb article in theMeridian
Enterprise VBScript API Reference Guide.

Automatic Inventor, SolidWorks, Revit, Office
title block/property synchronization

Not supported

Not supported Meridian Cloud Analytics property page for projects

Not supported Workflow diagram accessibility and usability
optimizations

Not supported Open documents from within the assembly browser

Not supported Unlink From Meridian Portal command.

Add unlisted values to Lookup List Not supported
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Log On
By default, Meridian Enterprise uses your Windows user account to automatically log you on. If
enabled for a vault, the Meridian Enterprise FDA Module can provide an added level of security
by prompting you to manually log on. This feature is configurable by a System Administrator and
affects all Meridian Enterprise client applications.

PowerWeb Procedures
Use these steps for PowerWeb.

To log on:

1. Open a shortcut provided to you by a System Administrator or enter the URL of the your
Meridian server in your browser's address bar like:

<ServerName>/Meridian/Start

The vault selection page appears.

2. Click a vault name in the Available Vaults list.

PowerUser Procedures
Use these steps for PowerUser.

To log on:

1. Double-click the PowerUser icon on your desktop or the Windows Start menu.

For information on starting PowerUser with optional command-line arguments, see
Command-Line Arguments.

If the Meridian Enterprise FDA Module authentication is enabled, instead of opening
immediately, the Open Vault dialog box appears.

2. Type your user name and password in User name and Password and click OK.

Different results will occur depending on the outcome of the authentication:
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l If the user name and password you typed are correct, and they match those of the
user account currently logged on to the computer, the client application will open.

l If the user name or password is incorrect or if one of them does not match that of the
user account currently logged on to the computer, an error message will display and
the vault will not open. You will be specified another chance to log on. After an
administrator-configured number of invalid logon attempts, Meridian will lock the
computer until the correct credentials are typed.

All logon attempts (successful and unsuccessful) are logged to the Meridian audit log.
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Personal Preferences
Although most aspects of PowerWeb behavior are controlled by a System Administrator, you can
modify some options to suit your own preferences.

Use these steps for PowerWeb.

Set Personal Preferences
To set your personal preferences:

1. Choose between two options:
l In the context bar, click your name, and then click the Preferences.
l Select Preferences from theMiscellaneous section of the document, folder, or

selection shortcut menus.

The Change Preferences page appears.

2. Select options using the descriptions in the following table and click OK.

Reset Preferences to Default
To reset your personal preferences to their default settings:

1. Choose between two options:
l In the context bar, click your name, and then click the Preferences.
l Select Preferences from theMiscellaneous section of the document, folder, or

selection shortcut menus.

The Change Preferences page appears.

2. Click Reset Profile at the bottom of the page.
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Personal Preference Options

Option Description

Use Oracle AutoVue Client/Server
deployment to view documents

Replaces the viewer with the AutoVue Client/Server (Java
applet) viewer. Your organization must have an available
AutoVue rendering server and AutoVue application server to
use this option. Consult a System Administrator for the URLs
to type for this option.

Site cache mode Select this option if a System Administrator has configured a
site cache server for the users at your location and has given
you the URL to enter as described in Configure Local
Workspace.
Meridian Application Integration must be installed on your PC.
If any file conflicts occur with the local workspace copies, the
errors will appear in the progress dialog box that is shown
when the command runs.
If you will work under a different account in the site cache
server's domain or if the site cache server is behind a proxy
server, configure the settings described in Configure a Site
Cache Connection.

Important!
Do not work on the same document from more than one PC
in Remote mode with this option enabled or document
content inconsistencies can occur.

If a user attempts to open a document where the version in
the vault is newer than the version in their local workspace,
PowerWeb and Application Integrations warn the user that
the document may contain updates from other users, and
that any local changes may be lost after synchronization. The
user can then abort the operation.

Personal preference options
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Option Description

ActiveX compatibility mode Select this option if PowerWeb components are installed on
your PC. This option and those shown by Document Transfer
Options and Viewer Options are supported only on Internet
Explorer.
Click Document Transfer Options to set your personal
preferences for downloading documents. Only available if Site
cache mode is disabled, ActiveX compatibility mode is
enabled, and the ActiveX components are installed on the PC.
Click Viewer Options to set your personal preferences for the
viewing window. For more information, see Change Viewers.
Only available if ActiveX compatibility mode is enabled and
the ActiveX components are installed on the PC.

Workstation The name of the PC on which you are working. This is used to
lock files that you modify to the PC and to prevent them from
being overwritten by changes made at another PC. This is set
automatically by default under most circumstances and
cannot be changed.
If this option is empty in your environment, enter the name of
the PC on which you are working. If you typically work from
multiple PCs, enter the name of the PC where you typically
make changes and the documents will be locked to that PC.
You cannot transfer documents that are currently locked from
one PC to another. To make changes to documents that are
currently locked to a different PC, first unlock them on that PC
and then lock them on the other PC as described in Lock And
Unlock Documents.

View renditions Displays the rendition of the selected document instead of
the source file when comparing documents and when viewing
the full screen property window for revisions.

View hotspots Whenever a document is viewed, hotspots are automatically
displayed.

Create thumbnails on import of
document

Generates thumbnail images of new documents you upload to
the vault.

Remember location in vault between
sessions

When you start a new PowerWeb session, opens the vault to
the last document you viewed.

Update thumbnails when releasing
Quick Change

Refreshes thumbnail images of documents you upload after
making changes.
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Option Description

Enable viewing the vault at a baseline
or specific date or time

This option enables History mode, which allows you to select
a specific point in the past and view the contents of the Vault.
When you are viewing the vault in History mode, your
documents are read-only.

Current time zone Select your local time zone so that time data is displayed
correctly.

Use custom color scheme Displays PowerWeb using an alternate color scheme. Select a
scheme from the list.
For information about customizing the available color
schemes or creating new ones, see the Create a Custom Color
Scheme article in theMeridian Enterprise Configuration Guide
.

Language Select your preferred language for the user interface text.

Note:
l The selected language should match the specified

Windows locale.
l This setting does not currently affect the viewing

window or the ActiveX download dialog.

Locale Select your preferred locale for the format of dates and
decimals in numbers. For more information about how this
setting affects date formatting, see the HKEY_LOCAL_
MACHINE\Software\Cyco\AutoManager
Meridian\CurrentVersion article in theMeridian Enterprise
Administrator's Guide.
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Configure Browser Security
Because PowerWeb uses your Internet browser, the browser's security settings also affect
PowerWeb. Depending on your organization's security policies, the version of Windows installed
on your computer, and your permissions on the computer, the browser security settings might
interfere with proper operation. This is particularly true for the default settings in newer versions
of Windows. Following are the recommended security settings for Microsoft Internet Explorer for
use with PowerWeb:

l Meridian vaults should be added as trusted sites
l Internet Explorer Protected Mode should be disabled

Use these steps for PowerWeb.

To configure these Internet Explorer settings:

1. In Internet Explorer, on the Toolsmenu, select Internet Options.

The Internet Options dialog box appears.

2. Click the Security tab.

The security options appear.

3. Select the Trusted sites zone.

The zone's current security level is shown.

4. Click the Sites button.

The Trusted sites dialog box appears.

5. Type the address of the PowerWeb server, for example, http://MyServer and click Add.

The server is added to theWebsites list.

6. Click Close.

7. Clear the Enable Protected Mode check box, if it is selected.

8. Click OK.
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Read-Only PowerWeb Access
A System Administrator may give you read-only access to a vault through PowerWeb. This will let
you see the results of a saved search. In this read-only mode, you are restricted to viewing
documents and the properties shown in the Folders view. You cannot view or edit the property
pages. If you have the appropriate privileges, you can download documents. You might also have
the privilege to edit the shared collection search criteria to obtain different results.
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Configure a Site Cache Connection
A site cache is a temporary storage location for frequently used documents. The site cache is
located on a web server that is geographically closer to you than the Meridian Enterprise server
from which the documents came. This improves performance when you work with the
documents that are cached in the site cache. In certain cases, you must configure the connection
parameters for the site cache before you can use it.

Meridian site caches support several types of user identities:

l User account logged on to PowerWeb. This is the default and you do not need to configure
your account credentials.

l Foreign user account credentials provided to you by the vault owner.
l OpenId single sign-on account credentials

Normally, you work in Meridian under your own account – the account with which you logged on
to Windows and your organization's security domain. There might be circumstances in which you
need to work in Meridian using a different account, such as an account provided to you by the
vault's owner, which can be a different organization with a separate security domain.

An example of such a circumstance is if you are contractor working for another organization. You
log on to your own network and use PowerWeb but you need to access the other organization's
vault with different account credentials that they provided to you. Meridian allows you to enter a
different account name and password to connect to the vault while remaining logged on to your
own Windows account and local security domain.

Note:
Working under a different account will create document copies in a new subfolder of the local
workspace on your PC. By default, the local workspace folder is located at C:\BC-
WorkSpace . The subfolder name will be the different account name, not your normal account
name.

You must configure the connection parameters for the site cache if you will connect using:

l Foreign account credentials as described above
l OpenId account credentials that are also used for single sign-on to your Meridian Cloud

account
l A proxy server with any account credentials

Note:
These tasks require that Meridian Application Integration is installed on your PC.

Use these steps for PowerWeb.
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Configure a Site Cache Connection
To configure a site cache connection:

1. Sign in to PowerWeb.

2. Set the Site Cache URL option for your local workspace to the URL of the vault owner's site
cache server as described in Configure Local Workspace.

3. Right-click the Accruent Site Cache Log icon in the system tray and click View Log.

The Accruent Site Cache Log dialog box appears.

4. Click the down arrow next to the Connect toolbar button and then click Connection
Settings from the shortcut menu that appears.

The Connection Settings dialog box appears.

5. Click options or type values using the descriptions in the following table.

6. Click OK.

You are connected to the site cache.

Group Option Description

General Use external
authentication

Enable this option if your connection to the site cache server will be
authenticated by the same OpenId authorization service that is used
by your Meridian Cloud account.

General Tenant Name The name of your organization's Meridian Cloud account. The OpenId
authentication provider information will be retrieved from Meridian
Cloud and used by the local workspace client to connect to the site
cache server.

General User Name Type the user name that was provided to you by the foreign vault's
owner.

General Password Type the password that was provided to you by the foreign vault's
owner.

General Use workspace When enabled, places temporary copies of documents in your normal
local workspace just as if you were working in a vault in your own
domain.
When disabled, places temporary copies of documents in a separate
local workspace folder with the name of the account specified for
User Name.

Site cache connection options
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Group Option Description

Proxy
Settings

Proxy address Type the URL of the proxy server through which to connect to the site
cache server.

Proxy
Settings

Proxy user name Type the name of a user account that is authorized to connect to the
proxy server.

Proxy
Settings

Proxy user
password

Type the password of the account specified for Proxy user name.

Proxy
Settings

Save credentials If enabled, the connection credentials are stored encrypted in the
registry of the PC and are reused to connect the next browser session.

Resume Working in Your Network
To resume working in a vault in your own network with your own account:

1. Repeat step 2 in the procedures above and reset the Site Cache URL option for your local
workspace to the URL of your organization's site cache server.

2. If you will be working in PowerWeb with external (OpenId) account credentials, clear your
browser's cookies, which retain your previous connection info.

3. Repeat step 4 in the procedures above and but click Logout.

You will be logged out and the Meridian Cloud authentication page will appear to confirm
this. After a few seconds, the login page will appear and you can enter your normal
credentials.
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Log Off
Doing this properly ends your current session and releases any licenses that you were using.
Simply closing the browser tab by clicking the icon or closing the browser will not immediately
release any licenses you were using, which may prevent other users from using them.

Use these steps for PowerWeb.

To log off:

l Click the Log Off icon in the upper-right corner of the window.
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PowerUser
PowerUser is the legacy Windows desktop application for working with Meridian documents. It is
designed for use by engineers, designers, and document controllers.

You can find topics that describe how to use PowerUser to perform common tasks throughout
this guide.

Note:
Title block and reference synchronization is not supported in the 32-bit PowerUser.

The following figure identifies the various areas of the application window.

The following table describes each area of the application window.

Number Name Description

1 Title bar Contains the name of the current vault.

2 Find toolbar Common search tools. May be moved, docked, and hidden.

Features of the Meridian Enterprise desktop application
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Number Name Description

3 Menu bar Context-sensitive menus of Meridian Enterprise commands. May
be moved and docked.

4 Main toolbar Buttons for frequently used commands. May be moved, docked,
and hidden.

5 Context bar Buttons for changing the current scope, Navigation view, and
time contexts. The button labels display the current selection of
each.

6 Manager toolbar Buttons for frequently used manager commands. May be moved,
docked, and hidden.

7 Properties pane Property values for the currently selected item. The number and
names of property pages vary with the currently selected item.
This pane may be hidden or shown by clicking the Show or hide

properties button . For more information see Property Pages.

8 Viewer Close
button

Closes the viewer window. Click the Show or hide viewer button

on the Main toolbar to reopen the viewer window.

9 Viewer pane Displays the contents of the selected document or its rendition.
Double-click the viewer pane title bar to open the document in a
new viewer window. Right-click the document name and select
the Show Native or Show Rendition options to view the different
document versions.

10 Viewer toolbar Buttons for viewer tools. Different tools are available depending
on the current file format and the current viewer.

11 Show
native/rendition
button

Click to toggle display in the viewer pane of the source document
or its rendition. The button icon identifies the format of the
rendition file.

12 Status bar Displays the current vault name, time context, user name, and
selected items count. Double-click the vault name, and time
context to change them. Double-click the user name to view your
user info such as group membership, Windows account names,
and email addresses. This information may only be edited by a
System Administrator.

13 Navigation view One of various hierarchical views of the vault contents. Select
another view from the Shortcuts pane or click the Navigation
view button in the context bar. For information about
manipulating Navigation views, see Configure a Navigation View.

14 Shortcuts pane Buttons for easy access to Navigation views, saved searches,
baselines, and recently opened vaults.
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Log On
By default, Meridian Enterprise uses your Windows user account to automatically log you on. If
enabled for a vault, the Meridian Enterprise FDA Module can provide an added level of security
by prompting you to manually log on. This feature is configurable by a System Administrator and
affects all Meridian Enterprise client applications.

PowerWeb Procedures
Use these steps for PowerWeb.

To log on:

1. Open a shortcut provided to you by a System Administrator or enter the URL of the your
Meridian server in your browser's address bar like:

<ServerName>/Meridian/Start

The vault selection page appears.

2. Click a vault name in the Available Vaults list.

PowerUser Procedures
Use these steps for PowerUser.

To log on:

1. Double-click the PowerUser icon on your desktop or the Windows Start menu.

For information on starting PowerUser with optional command-line arguments, see
Command-Line Arguments.

If the Meridian Enterprise FDA Module authentication is enabled, instead of opening
immediately, the Open Vault dialog box appears.

2. Type your user name and password in User name and Password and click OK.

Different results will occur depending on the outcome of the authentication:
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l If the user name and password you typed are correct, and they match those of the
user account currently logged on to the computer, the client application will open.

l If the user name or password is incorrect or if one of them does not match that of the
user account currently logged on to the computer, an error message will display and
the vault will not open. You will be specified another chance to log on. After an
administrator-configured number of invalid logon attempts, Meridian will lock the
computer until the correct credentials are typed.

All logon attempts (successful and unsuccessful) are logged to the Meridian audit log.
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Personal Options
Options for the way documents, workflows, and views work are configured by a System
Administrator. But you can configure many options for the way the Meridian client applications
appear and work.

Use these steps for PowerUser.

To set your personal options:

1. Click Options on the Viewmenu.

The Options dialog box appears.

2. Select options on the tabs using the descriptions found in the following topics.
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Arrange the Window Layout
The size, position, and visibility of several of the PowerUser window panes can be changed to suit
your preferences:

l Shortcuts
l Properties
l Viewer

They can be individually moved, docked, and collapsed to any side of the PowerUser window,
each other, or be dragged into position anywhere on the Windows desktop. This makes it easy to
arrange the panes that you use the most to locations that are the most comfortable to you.

Use these steps for PowerUser.

Make a Window Pane Docked or Floating
To make a window pane docked or floating:

l Right-click a window pane and select Docking or Floating.

The window pane appears docked or floating, respectively. You may also drag a window
pane to the Windows desktop to make it floating.

Move a Docked Pane to a Different Location
To move a docked pane to a different location within the PowerUser window:

1. Click and drag the title bar of the window pane that you want to move until docking guides
appear, similar to the following figure.
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2. Drop the window pane onto the docking guide icon nearest to the window edge where
you want the pane to appear.

The area where the tab will be docked will appear shaded to help you select the correct
position. To place the pane within the space occupied by another window pane, drop the
pane onto a docking guide within the docking guide cluster shown in the following figure.

The docking guide cluster will apply the change to the window pane over which you hover
your cursor.

When a window pane is docked, it may be automatically hidden when not in use by enabling
its Auto Hide option.
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Auto Hide Option of Window Panes
To enable or disable the Auto Hide option of a window pane:

l Right-click a window pane and enable Auto Hide.

The window pane collapses to the vertical edge of the window to which it is docked. You

may also enable Auto Hide by clicking the pane's pin icon . To temporarily show a hidden
window pane, hover your cursor over the pane's tab. The pane will automatically hide when
your cursor is moved away from the pane.

l Right-click a window pane and disable Auto Hide.

The window pane anchors to the vertical edge of the window to which it is docked. You may
also disable Auto Hide by clicking the pane's pin icon .

Reset Window Layout
To reset the window layout to its default arrangement:

l On the View menu, select Reset Layout.

The layout is restored to the default arrangement.
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Configure the Application Look
The visual window style of the PowerUser window can be selected from among many common
standards. The selected style is applied to the window regardless of the visual style used by the
version of your computer's operating system.

Use these steps for PowerUser.

To configure the application look:

l On the View menu, point to Application Look, and select a style from the sub-menu.

The window's style is changed to your selection.

Confidential and Proprietary © 2022 89 www.accruent.com



General Options
The options on the General tab control startup. Most Meridian users prefer to enable both
options in the Startup group. The following table lists the options and their descriptions.

Option Description

Remember last document
between sessions

Remembers the last selected document when you reopen a vault.

Note:
The active view is not saved between vaults, so the document will be
opened in the default view, if possible.

Remember last document
between views

Remembers the last selected document when you change Navigation
views.

I prefer online help Shows online webhelp content in a web browser when you press F1 from
within any Meridian client application.

I prefer local help Shows local help content when you press F1 from within any Meridian
client application.

General options
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Appearance Options
The options on the Appearance tab control redline display, Navigation view pane display,
shortcut menu customization, and other options.

The following table lists the options and their descriptions.

Option Description

Redline width The width in pixels to display redlines in the viewer window. Values greater
than 1 display redlines bolder than most other drawing entities except wide
polylines. Click Viewer Options to set other options.

Show renditions by
default

Enables the display of renditions in the viewer and shows them by default
instead of the source document.
Even if this option is cleared, renditions will be shown in the viewer by default
if you have not been granted the View Content privilege.

Show grid lines Displays horizontal grid lines between items in Navigation views, similar to a
spreadsheet.

Column headers Click Font to change the font used to display column headers.

Scope Click Font to change the font used to display document property values.

Under change Click the color swatch to select a different color for the property values of
documents in workflows.

Shortcut menus Click Configure to select commands to appear on the various shortcut menus.

Show user initials in
status bar

Displays your initials in the status bar instead of your logon name.

Warn when opening a
document in a read-
only workflow state

Displays a warning message if you attempt to open a document that cannot be
saved to the vault due to its current workflow status.

Appearance options
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Actions Options
The options on the Actions tab control how Meridian reacts when you take certain actions.

The following table lists the options and their descriptions.

Option Description

Selecting a document
refreshes the viewer
pane

Select your preference:
l Automatically — immediately displays the selected document
l After clicking the Refresh button — displays the selected document only

when you click Refresh
This option is useful to improve the responsiveness of the Meridian client
application and to reduce unnecessary network traffic

Double-clicking the
viewer pane

Select your preference:
l Expands the viewer to full screen — expands the viewer to full

screen when you double-click the viewer window
l Opens the document in its native application — opens the

document in its native application when you double-click the
viewer window

l Does nothing — does nothing when you double-click the viewer
window

Double-clicking a
thumbnail

Select your preference:
l Toggles the viewer pan visibility — toggles the viewer pan

visibility when you double-click the document's thumbnail image
l Expands the viewer to full-screen — expands the viewer to full-

screen when you double-click the document's thumbnail image
l Opens the document in its native application— opens the

document in its native application when you double-click the
document's thumbnail image

l Refreshes the thumbnail — refreshes the thumbnail when you
double-click the document's thumbnail image

l Does nothing — does nothing when you double-click the
document's thumbnail image

Actions options
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Advanced Options
The options on the Advanced tab control when thumbnail images are generated; various
performance, viewer behavior, and warning messages; and miscellaneous options.

The following table lists the options and their descriptions.

Option Description

After document
import

Creates a new thumbnail image.
Select this option to ensure that new documents display a thumbnail.

After releasing a
Quick Change or
submitting a
working copy

Creates a new thumbnail image.
Select this option to ensure that changed documents display an updated
thumbnail.

After changing the
document
workflow state

Creates a new thumbnail image.
Select this option to ensure that thumbnail images containing title blocks that are
linked to vault data are updated.

Use existing
preview image, if
available

Displays the preview image embedded in certain files instead of creating a
redundant image.
Select this option to improve system responsiveness and save disk space.

Warn when a
folder contains
more documents
than

Displays a warning message when expanding a folder or selecting another view
might take longer than expected because it contains many documents.
Limiting the number of documents per folder maintains system performance. The
optimum number of documents per folder depends on the system configuration.

Maximum size of a
tableview per call

Limits the amount of information that the Meridian client application requests
from the server at one time.
Optimizing this setting may improve system performance. The optimum size
depends on network performance and the average number of items per folder.

Automatically
refresh property
pages

Causes Meridian to refresh the values shown on property pages automatically
when you return to Meridian from other applications. Otherwise, the values are
refreshed when a document is selected.
Enable this option if critical property values are changed from within other
applications, such as via title block links. Enabling this option may reduce system
responsiveness.

Advanced options
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Option Description

Refresh the viewer
pane with every
document
selected

Causes Meridian to refresh the property values shown in Navigation views
automatically every time you select another document. Otherwise, the values are
refreshed when a view is opened.
Enable this option if critical property values may be changed by other users.
Enabling this option may reduce system responsiveness.

Load Navigation
view data on
demand

Causes Meridian to retrieve only the data for the number of items that can be
shown in the current Navigation view, depending on its size. More data will be
retrieved only when more items need to be shown.
Enable this option to improve system performance, especially when folders
contain fewer than 1,000 items.
When this option is enabled, the column filters that are described in Configure a
Navigation View are disabled.

Threshold The number of records above which on-demand Navigation view loading will be
used.
Decrease this number to the approximate average number of items per folder.

Suspend viewing
the document

Causes Meridian to release the document shown in the viewer to prevent conflicts
when the document is opened in another application, such as by the Open in
application command. Otherwise, Meridian keeps the document open in the
viewer.
This setting has no effect on AutoVue client/server deployments.

When focus is
returned, reopen
document after
(msec)

The number of milliseconds for Meridian to wait before reopening a suspended
document in the viewer. This allows other applications, such as those opened by
the Open in Application command, to save and close the file before Meridian
reopens it.

Debug event script Enables the Script Debugger sub-menu on the Toolsmenu if a valid debugger is
installed on the computer.

Leave data on the
Clipboard when
opening another
vault

Enable this option if you want to paste documents between vaults.
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Command-Line Arguments
The Meridian Enterprise desktop client applications support command-line arguments that open
the applications with either a specified object or the results of specified search criteria. You can
use the command line to create desktop shortcuts or to run the startup search anywhere that a
command line is accepted.

Use these steps for PowerUser.

To use the command-line arguments:

1. Create a shortcut or open a command-line window.

2. Specify the path to the PowerUser executable.

For example, for 64-bit:
"C:\Program Files\BC-Meridian\Program\PowerUser.exe"

Or for 32-bit:
"C:\Program Files (x86)\BC-Meridian\Program\PowerUserU.exe"

3. Specify the command-line arguments using the descriptions in the following table.

Argument Description

/AMFS The vault in which to find the objects specified by the other command-line
arguments. Use the following syntax:
/AMFS=M-<ServerName>,D-<DatastoreName>,S-<VaultName>
For example:
/AMFS=M-EngServer,D-MyCompany,S-BigVault

/O The ID of the object where you want to application to open. To specify the ID of a
document, use its Document ID value. To specify the ID of a folder, use the Parent
Folder ID value of a document or subfolder contained in the folder. If this argument
is specified, do not specify the /DT or /PF arguments.

/DT Document type search criteria specified as a list of the internal or display names of
the documents types in which to search.
For example:
/DT="GenericDocument,Drawing,EmailDocType"
This argument may be specified in combination with the /PF argument. If this
argument is specified, do not specify the /O argument.

Command-line arguments
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Argument Description

/PF Property search criteria specified using the following syntax:
/PF=<PropertySet.PropertyName>,<PropertyValue>,<Operator>
For example:
/PF="Custom.DrawingNumber,D-09-12345,OP_STARTWITH"
The Operator argument is specified as a shortened version of one of the IC_
OPERATOR constants that can be found in the Constants branch of the Object
Browser in the Meridian Enterprise VBScript Editor. The default is OP_EQUALS.
This argument may be specified in combination with the /DT argument. If this
argument is specified, do not specify the /O argument.

An example of a complete command line that opens PowerUser and searches for documents of a
specific document type and that have specific property values is:
"C:\Program Files\BC-Meridian\Program\PowerUser.exe" /AMFS=M-
PRECISION,D-TM,S-TM /DT=Submittal
/PF="AMDocumentWorkflowPropertySet.Status,Under Change,OP_EQUALS"

The preceding example would open PowerUser directly to a list of documents of the Submittal
document type that have the value Under Change for the Status property.

The results of opening the vault with command line arguments will be shown in a view named
Startup Search.

Confidential and Proprietary © 2022 96 www.accruent.com



Application Integration
Application Integration is the name of the Meridian client components that provide:

l Batch document upload/download functionality in addition to single document transfers
l Site cache connectivity and local workspace management
l Links with standard Windows applications

It is optional for users who need the benefits above. Users who do not need those features do not
need to install Application Integration. The components are installed by the Application
Integration feature in the Meridian Enterprise client installation package as described in Control
Windows Installer Packages in theMeridian Enterprise Administrator's Guide. Meridian Cloud
users can install the components by downloading the Meridian Cloud Client installation package
from the Meridian Cloud home page.

Application Integration is designed to help you find documents, open them for editing, save them,
and route them in workflows all from within the applications where you create and edit
documents. The Application Integration window looks and works very similar to PowerUser
except that Application Integration:

l Has no menu bar
l Has only a single toolbar
l Has no shortcut bar
l Has no status bar
l Cannot display history
l Shows limited file and workflow status information in the properties pane. Click the View or

edit properties button on the toolbar to view or edit all properties.

l Shows a thumbnail in the viewer pane. Click the View selected document button to
open a new viewer window.

l Supports only the Quick Find search tools described in Quick Find.

Otherwise, you can perform many of the same tasks with Application Integration that you can
with PowerUser, but conveniently from within your favorite editing applications. Most tasks work
the same from both Application Integration and PowerUser. For information on performing
common document management tasks with Application Integration, see the topics elsewhere in
this guide.

When Application Integration is installed on your computer and you select any commands such as
Open, Save, or Save As, you will see one of two things:
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l The Application Integration window.

l A standard Windows file dialog box with the Meridian vault button in the toolbar. If
you click the vault button, the Application Integration window appears.

Note:
Microsoft Word ignores any selection you make from the Files of type list in the Application
Integration window. If you want to save a Word file as a different file type, select the file type
from the Save as type list in the Word Save As dialog box first before you click on the Meridian

vault button in the toolbar to save the document in the vault.

The Application Integration window can be opened from within any application that uses
standard Windows file browser dialogs (and can therefore display the vault button) for its
commands. 
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Application Integration Options
Application Integration offers a number of options that you can configure to modify its behavior
to suit your preferences.

Use these steps for PowerUser and PowerWeb.

To set Application Integration options:

1. Right-click the Accruent Application Integration icon in the system tray.

A shortcut menu appears.

2. Click options or type values using the descriptions in the following table.

Command Description

About Accruent
Application
Integration

Displays information about the currently installed version.

Run on Startup Causes Application Integration to always load automatically whenever Windows
starts.

Set Default
Context

Select which vault to use by default with Application Integration. For Meridian Cloud
users, enter <CloudAccountName>.meridian360.com.

Default Behavior Always Show Accruent Dialog— Skips showing the application's standard file dialog
and immediately opens the Application Integration window. You can access the
application's own file dialogs by clicking the application icon button in the
Application Integration window. Select this option if you mostly work on vault
documents.
Always Show Standard File Dialog— Displays the standard file dialog with the
Meridian vault icon in the toolbar so you can decide where to open and save files
from. Select this option if you mostly work on documents that reside outside of a
vault.

Edit Exclusion
List

Allows you to select applications from which Application Integration should not be
available.
If there are multiple versions of the same program installed on your PC, they will all
be excluded regardless of their paths.

Show Accruent
Dialog For

Allows you to select applications that should only use Application Integration.
If there are multiple versions of the same program installed on your PC, they will all
be included regardless of their paths.

Application Integration options
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Command Description

Disable Accruent
Application
Integration

Disables the integration with all applications.

Mode Online: Normal mode for LAN operation.
Remote— Enables the application links to work more efficiently over a WAN or
from remote offices with modest network bandwidth. This mode require at least a
full time Internet connection to the Meridian web server. For more information, see
Application Links In Remote Mode.
Offline—Uses the Internet to access the vault for only the most critical information
and uses local workspace for the data you create. For information, see Offline Mode
And Remote Mode.

Local Workspace Displays a sub-menu of commands for managing your local workspace. For more
information, see Local Workspace.

Site Cache Log Opens the site cache log for troubleshooting.
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Reset Application Integration Dialog Boxes
If you open a file dialog in a Windows application that is unknown to Meridian, a Meridian dialog
box will appear, prompting you to select whether the command you just executed opens files or
saves files. This is a one-time-only request so that Meridian then understands the purpose of the
dialog box. If you make an incorrect choice, the wrong Meridian application integration dialog box
will appear and the same type of files cannot be opened from or saved in the vault, depending on
which choice you made.

Use these steps for PowerUser.

To reset your application integration dialog box choices:

1. Open the Windows Registry Editor and locate the following key:

HKEY_CURRENT_USER\Software\Cyco\AutoManager Meridian\Current
Version\AM Hook\Contexts

2. Delete the registry key that corresponds to the application's executable, for example,
ACAD.exe.

You may then choose correctly the next time you are prompted.
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Offline Mode And Remote Mode
Application Integration can work in one of three modes: Online, Remote, or Offline. Online mode
is appropriate if you are connected to your organization's local area network (LAN). It is the
default and works as described in the rest of this guide.

Remote mode
Remote mode enables the application links to work more efficiently over a wide area network
(WAN) or over the Internet (Meridian Cloud). Remote mode requires at least a full-time Internet
connection to the Meridian web server.

Offline mode
Offline mode is specifically for users who have a low-bandwidth connection to the Meridian
server and find online mode to be too slow. Offline mode causes Application Integration to use
the Internet to access the vault for only the most critical information and to use local workspace
for the data that you change or create. This means that, to work on vault documents, you must
first download them to your local workspace. You can do this with either PowerUser or
PowerWeb. Then you can work in Offline mode until your changes are sent back to the Meridian
vault by local workspace synchronization.

Confidential and Proprietary © 2022 102 www.accruent.com



Prepare To Work Offline
Before you can safely work on documents in Offline mode, you must first download them to your
local workspace. The documents also need to be locked to prevent editing by others.

Application Integration must be in Online mode to prepare documents for working in Offline
mode. You must have an active connection to the Meridian server to use PowerUser or an active
connection to the Meridian web server to use PowerWeb. You must restart any authoring
applications that use Meridian application links for the links to detect the correct mode.

PowerWeb Procedures
Use these steps for PowerWeb.

To prepare to work offline:

1. In PowerWeb, select the documents you want to work with in Offline mode.

2. Choose between two options:
l If you selected one document, on the Documentmenu, select Download Document.
l If you selected multiple documents, on the Selection shortcut menu, select Download

Documents.

The documents are downloaded to your local workspace.

3. Log off.

4. Right-click the Accruent Application Integration icon in the system tray.

A shortcut menu appears.

5. Point toMode (Online) and select Offline.

PowerUser Procedures
Use these steps for PowerUser.

To prepare to work offline:

1. In PowerUser, select the documents you want to work with in Offline mode.

2. On the Documentmenu, click Lock Documents and Sync Workspace.

The documents are locked and downloaded to your local workspace.

3. Close PowerUser.
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4. Right-click the Accruent Application Integration icon in the system tray.

A shortcut menu appears.

5. Point toMode (Online) and select Offline.
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Work Offline Or Remote
You work offline or remote from within your favorite editing applications just as if you were in
Online mode by using Application Integration to select and save vault documents. One difference
is that, before displaying the Application Integration window with a view of the vault, Application
Integration prompts you to select a remote vault through PowerWeb, similar to the following
figure.

Note:
l You must have an active Internet connection to the PowerWeb server to work in Offline

mode or Remote mode.
l Errors can occur if you download documents to your local workspace using 32-bit Internet

Explorer as described in Prepare To Work Offline but later open the documents for editing
in a 64-bit application. Always use either the 32-bit or 64-bit editions of Meridian
components together, not a mixture of both.

l To synchronize the vault with your local changes, you must return to Online mode and
either synchronize your local workspace manually or wait until the next automatic
synchronization occurs.

Open a Remote Vault
To open a remote vault:

1. Click Open, Save, or Save As in your editing application.

The Open Remote Vault dialog box appears.

2. Type http://<MyServer>/Meridian where <MyServer> is the name of your
organization's Meridian web server.

Do not use the PowerWeb URL.
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Another difference is that the Application Integration dialogs show you the status of vault
documents compared to the information stored on your computer that has not yet been
synchronized with the vault. It shows you the status by the color of the document
properties in the navigation views.

The meanings of the colors are described in the following table.

Option Description

Black The document is released and synchronized.

Blue The document is checked out to you and synchronized

Red The document is checked out to you but not yet synchronized with the
vault.

Green The vault does not contain any information about the document and is
not yet synchronized. It is either new on your computer, deleted from
the vault, or new in the vault but there is no offline information about
the document on your computer.

Offline mode colors

Reference synchronization in Offline mode has certain constraints:
l Reference resolution is fully supported for the referenced documents that are cached

in the same context in the local workspace. This includes resolution of existing
references and creation of new outgoing references also cached in the local workspace
in the same context.
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l Cross-context reference resolution is also supported for existing references. Cross-
context reference resolution is not supported for newly created references in Offline
mode.

Switch Modes
Important!
Do not work on the same document from more than one PC in Remote mode with the Use site
cache option enabled in your personal preferences or document content inconsistencies can
occur.

Use these steps for PowerUser and PowerWeb.

To switch modes:

1. Right-click the Accruent Application Integration icon in the system tray.

A shortcut menu appears.

2. Point toMode (<CurrentMode>) and select a different mode.

To help you recognize the current mode when you work with the Application Integration
dialogs, an icon at the right end of the toolbar indicates the current mode. The icons are
described in the following table.

Icon Description

Online mode. Not applicable to Meridian Cloud.

Remote mode. Recommended for virtual private network (VPN)
connections and Meridian Cloud.

Offline mode. The dialog box title text reads Open from local cache of
<Vault> on <LocalComputerName>.

Application Integration mode icons

Confidential and Proprietary © 2022 107 www.accruent.com



Create New Documents
When in online mode or remote mode, the application integration detects files in the local
workspace that do not exist in the vault and allows you to import them as new documents.

You can create documents in Offline mode by saving them in your local workspace instead of
saving them in a vault. You can use any file name you want. When the local workspace is
synchronized with the vault, the new documents are automatically uploaded to the vault.

Note:
To attach new parts to a hybrid document in Offline mode, the main document must exist in the
vault and the new part must not already exist in the vault.
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Local Workspace
Local workspace is the name of the area on your computer's hard disk where Meridian Enterprise
copies vault documents when you view or edit them in a workflow. Meridian also copies all
referenced documents to your local workspace and makes them read-only. This process is similar
to the way web browsers cache web pages, images, and other content to improve performance.
Local workspaces especially improve the performance of working with large files and assemblies.
Unlike with a web browser, however, you can edit documents in your local workspace and even
add new documents. The key to this ability is synchronization.

Synchronization
The local workspace is automatically synchronized with the vault by Application Integration while
you continue to work. Meridian does the tedious job of keeping track of which files are newer,
which files are under change and by whom, and which vault files should be updated from the
local workspace copies. Vault synchronization can be configured to occur periodically or you can
run it manually, if needed.

The synchronization components are installed with the Application Integration feature by the
Meridian Enterprise client installation package as described in Install the Client Components in the
Meridian Enterprise Administrator's Guide. Meridian Cloud users can install the components by
downloading the installation package from the Meridian Cloud home page.

Note:
The files that are synchronized to the vault are determined, in part, by the file filters that are
configured for the vault by a System Administrator. If files with a particular extension are
missing from the vault but are present in the local workspace, consult a System Administrator
to see if they are being excluded by a file filter.

Open in Application
By default, all documents copied to local workspace are read-only. When you run the Open in
Application command within one of the Meridian applications (or use Application Integration
from within other applications), the local workspace copy is detected, made writable, and opened
in the application. When synchronization occurs, any documents that have been changed and
have been submitted or released in workflows are uploaded to replace the vault copies, and the
local copy is set to read-only again.
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Storage
Local workspace uses a limited amount of disk space. As more documents are downloaded and
this limit is reached, the oldest documents that are read-only (and their parent folders, if
empty) are automatically deleted until sufficient space is freed for newer documents. The least
recently used files are deleted first. This disk cleanup happens in the background without your
intervention. No documents that are being actively edited are deleted.

Notes About Storage
l If you download an updated revision of a document to your local workspace when you had

previously downloaded an older revision, Meridian will create a new folder for the updated
revision and append a unique identifier to the end of the folder name. Essentially, each
folder is specific to the revision it contains.

As long as your changes have been saved in PowerWeb, it is safe to remove folders that
contain prior revisions of the document from your local workspace.

l Some documents may reside in folders that are configured to use a shared network folder
as a workspace instead of your local workspace. For information about working with
documents in shared workspace folders, see Shared Workspace Folders.

l When a document property is changed in PowerUser that causes the document to be
moved in the vault, any local workspace copies are deleted during synchronization. This
does not occur if the property is changed in PowerWeb, which might be contrary to your
organization's file retention policy. If so, consider setting the ForceClean value in the
following registry key:

HKEY_CURRENT_USER\Software\Cyco\AutoManager
Meridian\CurrentVersion\AMSync\Settings

This registry key is documented in theMeridian Enterprise Administrator's Guide.
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Configure Local Workspace
You can configure numerous options that control the way local workspace behaves. Depending
on how your System Administrator has configured the RemoteOnly registry key setting for
Meridian, you may not have access to all options. Learn more by reading the HKEY_LOCAL_
MACHINE\Software\Cyco\AutoManager Meridian\CurrentVersion article in theMeridian
Enterprise Administrator's Guide.

Use these steps for PowerUser and PowerWeb.

To configure your local workspace options:

1. Right-click the Accruent Application Integration icon in the system tray, point to Local
Workspace, and select Options.

The Local Workspace Options dialog box appears.

2. Select options using the descriptions in the following table and click OK.

Page Option Description

General page Enabled Select this option to enable local workspace synchronization in
the background while you work. If this option is cleared, changed
and new documents will not be synchronized to the vault.

General page Start
synchronization
every

The interval in minutes between synchronization attempts.
Reduce this interval if other users need to see your changes
sooner. Increase this interval if there are many users on the
system or performance is low. The default is every 30 minutes.
If you also want synchronization to occur at a specific time, at the
beginning or end of your work day, for example, click Set
Schedule and create a background task.

General page Use in Offline and
Remote modes

Enable this option to synchronize the vault while you continue to
work in Offline or Remote mode.

General page Synchronize
recently accessed
writable
documents only

Skips synchronization of changed documents that are read-only,
such as any documents that are still open in other applications
that open documents in exclusive mode.

General page Disk space on
drive C:

The amount of disk space used, free, and used by local
workspace.

Local workspace options
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Page Option Description

General page Maximum
amount of disk
space to use for
Local Workspace

The amount of disk space used for local workspace can affect
system performance. The more documents that are stored there,
the more documents Meridian Enterprise must compare against
the vault copies. Set this option to the lowest size that retains the
documents you are actively working on. The default is 750 MB.
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Page Option Description

Site Cache
page

Site Cache URL Important!
Do not work on the same document from more than one PC in
Remote mode with this option enabled or document content
inconsistencies can occur.

If you always use the same site cache, click Select manually and
then type the URL of the site cache server for your location. If
you do not know the URL, ask a System Administrator. If you use
Meridian Cloud, enter
https://
<CloudAccountName>
/meridiancloud.net/BCSiteCache and also set the Use
external authentication and Tenant Name options described in
Configure a Site Cache Connection.
If you use more than one site cache (with a notebook PC at
different geographical locations, for example):
1. Click Select from list.

2. In Enter the Meridian web address (URL), type the URL of
your nearest Meridian Enterprise web server.

3. Click Get Site Caches.
The names of the site cache servers that are registered on
the specified Meridian Enterprise web server are added to
the drop-down list.

4. Select the desired site cache server from the drop-down
list.
The site cache server that your System Administrator has
set as the optimum one for your current IP address will
appear with the prefix Preferred:. The name is also set in
the Select manually field so that the server will be
automatically reconnected if the connection is dropped.

5. Click Apply.

6. Click OK.
You connect to the new site cache server.

Also enable these options:
l Use in Offline Mode option above.

l Set Application Integration to Remote mode as described
in Work Offline Or Remote.

l Site cache mode in PowerWeb as described in Personal
Preferences.
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Manually Synchronize the Local Workspace
You can manually synchronize the vault from your local workspace whenever necessary, such as
after completing changes to an important document that needs somebody's immediate attention.
You do not have to wait until the next automatic synchronization takes place.

PowerWeb Procedures
Use these steps for PowerWeb.

In the scenario where there are changes in both the vault and in the local workspace, the user will
be prompted to choose the appropriate changes and resolve the merge conflict.

If the Sync Workspace, Synchronize Now, or Lock Documents and Sync Workspace commands
are disabled, enable Site Cache Mode in your preferences. This mode enables a communication
channel between the server and the local client. To synchronize from the web interface, it is
required that the server send a command to the local client via this channel.

Synchronize While Online
If you attempt to synchronize your local workspace when a document has a version in the vault
newer than the version in your local workspace, the local workspace client warns you that the
document may contain updates from other users, and that any local changes may be lost after
synchronization. You can then abort the operation.

To manually synchronize while working in Online mode:

l Choose one of the following options:
o On the Editmenu, in theWorkspace group, select Sync Workspace.
o To synchronize from the Navigation pane:

1. Right-click your selection.

2. Point to Edit.

3. Select Sync Workspace.
o From the Thumbnails view:

1. Right-click a thumbnail of a document.

2. Point to Edit and then select Sync Workspace.
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Synchronize While Offline

Important!
When using Offline mode, be sure to synchronize your local workspace before switching back to
Online mode. Failing to do so can compromise the integrity of document references. In Offline
mode, references are updated to local workspace locations. Synchronization corrects the
reference location information so that the references will work correctly from within the vault.

To manually synchronize while working in Offline mode:

1. Right-click the Accruent Application Integration icon in the system tray.

2. Point to Local Workspace.

3. Select Synchronize Now.

Lock Document and Sync Workspace
You can also choose to simultaneously lock documents and synchronize the workspace. This
functionality prevents changes from being made by other users while the files are on your to-do
list. It also ensures that your local files are up-to-date. You can then proceed to edit the contents
of the documents.

To lock and synchronize one or more selected documents:

1. Choose between two options:
l Select the Search Results heading.

This will apply the command you select to all results in your search, including results
on subsequent pages.

l Select the documents you want to lock and synchronize.

2. Choose one of the following options:
l To take action from the Edit menu:

a. On the Editmenu, in theWorkspace group, click the down arrow on the Lock
Document command.

b. Select Lock Documents and Sync Workspace.
l To take action from the Navigation pane:

a. Right-click your selection.

b. Point to Edit.

c. Point to Lock Document.

d. Select Lock Documents and Sync Workspace.
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l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Select Edit > Lock Document > Lock Documents and Sync Workspace.

PowerUser Procedures
Use these steps for PowerUser.

To manually synchronize while working in Online mode:

l Choose between two options:
o On the Documentmenu, select Sync Workspace.
o To synchronize from the Document property page:

1. Click the document icon on the Document property page.

The Advanced Document Information dialog box appears.

2. Click the Local Workspace tab.

3. Click Synchronize.
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Lock And Unlock Documents
Documents are locked to prevent modification or copying under some circumstances, such as
when they are added to a package. You can also manually lock a document to keep it in your local
workspace if it is editable but not yet locked.

A document that is locked in another user's local workspace may need to be manually unlocked
so that it can be edited elsewhere or by another user. This is especially useful if a user has to work
on a different computer than where the document is currently locked. The document can be
unlocked (and synchronized to the vault automatically) from the first computer; then the user can
start working on the second computer, and the vault document (now up to date) will be copied to
the second computer.

Note:
You must have the Unlock from Briefcase privilege to unlock documents that are locked to you
or the Unlock Document for Others privilege to unlock documents that are locked to other
users.

PowerWeb Procedures
Use these steps for PowerWeb.

Lock a Document
To lock a document:

1. Select the document that you want to lock.

2. Choose one of the following options:
l In the Edit ribbon, in theWorkspace group, click Lock Document.

The Lock Document dialog box appears.
l Right-click the document, then select Edit > Lock Document > Lock Document.
l From the Thumbnails view:

a. Right-click a thumbnail of a document.

b. Select Edit > Lock Document > Lock Document.

3. Click Yes.

The document is locked.
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Unlock a Document
To unlock a document:

1. Select the document that you want to unlock.

2. Choose one of the following options:
l In the Edit ribbon, in theWorkspace group, click Unlock Document or Unlock Another

User's Document.

The Unlock Document dialog box appears.
l Right-click the document, then select Edit > Lock Document > Unlock Document or

Unlock Another User's Document.
l From the Thumbnails view:

a. Right-click a thumbnail of a document.

b. Select Edit > Lock Document > Unlock Document or Unlock Another User's
Document.

3. Click Yes.

The document is unlocked.

Unlock a Batch of Documents
To unlock a batch of documents:

1. Conduct a search.

2. Select the Search Results heading.

This will apply the command you select to all results in your search, including results on
subsequent pages.

3. Select the Unlock Document command on the Edit tab.

If the Unlock command is applicable for all files in the search results, the operation
succeeds. Otherwise, the system executes the Unlock command for the files where the
command is applicable.

Lock Documents and Synchronize Workspace
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PowerUser Procedures
Use these steps for PowerUser.

Lock a Document
To lock a document:

1. Click the document icon on the Document property page.

The Advanced Document Information dialog box appears.

2. Click the Local Workspace tab.

3. Click Lock.

The document is locked.

Unlock a Document
To unlock a document:

1. Click the document icon on the Document property page.

The Advanced Document Information dialog box appears.

2. Click the Local Workspace tab.

3. Click Unlock.

The document is unlocked. To unlock a document that is locked in another user's local
workspace, consult a System Administrator.
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Resolve Local Workspace Conflicts
A local workspace conflict occurs when there is a discrepancy between the local workspace copy
of a document and the version in the vault. This most often happens when a new document is
manually added to the local workspace. It can also happen if a local workspace copy is modified
without using Meridian in any way, such as with the Open in Application command or with
Application Integration. When conflicts occur, Meridian needs you to decide how to resolve them.

If the local workspace locked copy is newer than the unlocked vault copy, the value of the Local
copy property on the Document property page is displayed in red. When synchronization takes
place, the conflict is displayed as a balloon in the system tray, and the Accruent Application
Integration icon in the system tray flashes.

Use these steps for PowerUser and PowerWeb.

To resolve the conflict:

1. Right-click the Accruent Application Integration icon in the system tray.

2. Point to Local Workspace and click View Log.

The Accruent Local Workspace dialog box appears, similar to the following figure.

3. Right-click the conflicting document in the lower pane and select an option from the
shortcut menu.

The following table describes each option.

Confidential and Proprietary © 2022 120 www.accruent.com



Command Description

Compare Displays the differences between the local workspace and
vault copies so that you can choose which revision of the
document to keep.

Delete from Workspace Removes the local workspace copy.

Import Imports the local workspace document into the vault.

Open Parent Folder Opens the local workspace subfolder that contains the
conflicting document.

Remove Clears the error message from the log. If the conflict
persists, the error message will reappear.

Remove All Clears all error messages from the log. If the conflicts
persist, the error messages will reappear.

Update Local Workspace from vault Overwrites the local workspace copy from the vault. All
changes made to the local workspace copy of the document
are lost and the read-only attribute is reapplied.

Update vault from Local Workspace Uploads the local workspace document to the vault. You can
update the vault copy only if you are the current To-Do
person.

View Displays the local workspace copy of the document in a new
viewer window.

Local workspace conflict resolution options
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Add Documents to Local Workspace
We recommend you use the Site Cache Client to upload large documents to your local workspace.
The Site Cache Client chunks large files and communicates with the server directly, which allows
for a faster upload. PowerWeb cannot chunk files, and as a result, large uploads lead to
performance issues while PowerWeb communicates with IIS.

This functionality was added in the 2022 release of Meridian Enterprise, and in the 2022.3 version
of Cloud.

To add documents via the Site Cache Client:

1. Right-click the Accruent Application Integration icon in the system tray.

2. Point to Local Workspace and click View Log.

The Accruent Local Workspace dialog box appears, similar to the following figure.

3. Click the Add Document button in the toolbar.

The Add Document / Select Files window opens.

4. Select the vault you want to add the document to.

5. Select the folder you want to add the document to.

6. Choose between two options:
l Drag and drop the files you want to add into the Add Document / Select Files window.

There is a known issue in the 2022 release that prevents this option from working
when using the 32-bit application integration.
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l Click Add and select the files you want to import.

The files you added appear in the Add Document / Select Files window.

7. If you want to synchronize your references from the files after the upload is complete, select
the check box.

8. Click Import.
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Local Workspace Log Toolbar Details
The local workspace log window features a toolbar similar to the following figure.

The following table describes each button.

Button Command Description

Sync All in Local
Workspace

Synchronizes all documents in local workspace with the vault
regardless of their status.
This can take a long time depending on the speed of your
connection to the Meridian server and the size of your local
workspace.

Sync Recently
Accessed

Only synchronizes documents in the local workspace that have been
modified since the last synchronization.

Stop Sync Stops the current synchronization process.

Clear Log Clears all conflict messages from the log.

Trace success Display only messages of successful synchronization. These will be
indicated with a green checkmark icon.

Trace information Display only information messages. These are indicated with a blue i
icon. For example, when you have saved a document directly to the
local workspace, the error message will be “No related document in
the vault.”

Trace warnings Display warning messages. These are shown with the yellow ! icon.
For example, if you have tried to bypass the system by manually
removing the read-only flag on the document in the local
workspace and then you edit it, you will see the message, “This file
is modified outside of the vault.”

Trace errors Display only error messages. These are shown with the red ! icon.

Open Local
Workspace

Opens the local workspace folder in Windows Explorer.

Add Document Opens the Add Document / Select Files window.

Indicates synchronization activity between the vault and local
workspace.

Local workspace log toolbar buttons
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Searches
Besides using Navigation views, Meridian Enterprise offers you multiple search methods for
finding documents that are described in the following table.

To do this... Use this...

Quickly search a single property for values that start with certain text. Key Find from a
property page

Quickly search a single property value using more conditions than available with
Key Find or to quickly search memo or the contents of documents.
Meridian uses the Windows Search engine to find text in document content. By
default, it will search in open standard file types such as .txt and .xml, as well
as the Microsoft Office file types such as .docx, .xlsx, .pptx, and so on.
Image file formats cannot be searched without first processing them with optical
character recognition (OCR) software. Files without name extensions can only be
found by property searches, not by content searches.
Your System Administrator can add support for more file types, for example, .pdf
(including renditions), .dwg, .idw, .sldrw, and .dgn. Meridian also searches
the redline comments created by AutoVue in renditions.

Quick Search from
the toolbar

Search any properties, use the most conditions, search multiple vaults, or save the
results for future reference and share them with other users.

Find from the
toolbar or ribbon

Create shortcuts that open PowerUser and immediately run a simple search and
display the results.

See Command-
Line Arguments.

Search methods

All Meridian Enterprise search methods are case-insensitive. Searches are limited to the current
scope.
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Key Find
Key Find is the simplest of the Meridian PowerUser search methods. A System Administrator can
designate especially important properties in a vault as Key Find properties. Key Find properties
are typically those that get searched frequently and store a different value for every document in
a vault. Key Find properties can be identified on property pages by the Key Find icon to the
right of the property value.

Use these steps for PowerUser.

To perform a Key Find search on a property:

1. Click the Key Find icon to the right of the property you want to search.

The Key Find dialog box appears. The search property defaults to the property nearby the
icon that you clicked. The search value defaults to the value of that property for the selected
document. The search condition is always Starts with and cannot be changed.

2. Select a different property from Property or accept the default.

Only properties designated by a System Administrator as Key Find properties appear in the
list.

3. Type a different search value or accept the default and click Find Now.

If any documents are found, the dialog expands to list the results. Only the first 250
documents appear in the list.

4. Click 250 More to view additional documents.

5. Double-click a document or select a document and click Go to to make the selected
document the selected document.

Although Key Find is easy to use, there are several common actions that you cannot do with Key
Find:

l You cannot save or share the results of a Key Find search.
l You cannot view additional properties.
l You cannot view the document in a viewer window.
l The Document shortcut menu is not available in the Key Find window.
l You cannot run a report on the results of a Key Find search.

To perform these actions and others, use one of the more advanced search methods.
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Quick Find
Quick Find is a more advanced search method than Key Find but simpler than Find.

PowerWeb Procedures
Use these steps for PowerWeb.

Note:
l By default, Quick Find does not search in the document content (full-text) unless

configured to do so by a System Administrator.
l Your search criterion is saved for the current session only and is reset to the default after

you log off.

To search using Quick Find:

1. In the toolbar, click the down arrow next to the search icon and select the property that
you want to search.

The properties listed are those designated by a System Administrator as Key Find
properties.

2. Type the text that you want to find in the text box.

3. Click the icon or press Enter.

The Search Results view appears.

PowerUser Procedures
Use these steps for PowerUser.

To search using Quick Find, use the lists on the toolbar as follows:

1. Select a property or option to search.

The properties listed are those designated by a System Administrator as Key Find properties.
Besides the Key Find properties, the following options may be selected:

l Name— The Name (document name) property is available by default.
l Document Content— Searches for text that is contained within a document.
l Memo Content— Searches for text that is contained in memo type properties.
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l Text and Memo Content— Search for text contained within any text type or memo
type properties.

l Text and All Content— Searches all of the above: text properties, document content,
and memo properties.

Note:
The exact match and fuzzy search options for document content and memo content
determine how substrings in text are detected. They can be important for finding, for
example, the same date formatted for different locales (1-2-2013 vs. 2-1-2013) or a
document, tag, or part number that contains punctuation characters (71-3810.10).

2. Select a search operator:
l Equals— The search property must match the search value.
l Contains— The search property must contain the search value
l Starts with— The search property must start with the search value.
l Contains multiple words (separate words with a space) — The search property must

contain all of the search values.

3. Specify one of the following search terms:
l If the property uses a lookup list, a value from the text box list.
l A previous search term. PowerUser remembers the last 10 search terms.

Note:
To clear the search value list, right-click the text box and select Clear Search History.

l Type all or part of the text that you want to search for in the text box.

4. Select a search context:
l This Vault.
l All Vaults— Includes all vaults on the same Meridian server as the current vault. This

option is not available if a scope is active.

5. Click the Execute Search button or press Enter to start the search.

If the search is successful, the Navigation view automatically changes to Find Results with
the found documents listed. The Find Results view can be configured and filtered the same
as other views as described in Configure a Navigation View. If the search is unsuccessful, an
information dialog box appears.

Click OK to stop searching.

Click Cancel to modify the search parameters and try again.
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Note:
The Run Search button is cleared when a search condition is selected that is not valid for
the current search property or option. The following table indicates the valid conditions
for each property type or search option.

Search Type Equals Contains Starts
With

Contains Multiple
Words

Name Supported Supported Supported Supported

Key Find properties Supported Supported Supported Supported

Document Content Not
Supported

Supported Not
Supported

Supported

Text and Memo
Content

Not
Supported

Supported Not
Supported

Supported

Text and All Content Not
Supported

Supported Not
Supported

Supported

Supported search conditions

If you select the search context All Vaults and your search is successful, the results are shown in a
new window instead of in the Find Results navigation view. Select a document and click Details to
show the thumbnail and a limited number of properties for the selected document. If you select a
document that resides in a different vault and either click the Go To button or double-click the
document, a new PowerUser window opens and the document you selected is made the selected
document.
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Find
Find is the most advanced search method in Meridian; it can find either documents or folders. It
gives you complete flexibility of the search scope, properties, and conditions. Find can include
referenced documents in its results and its results can be saved and shared with other users.

PowerWeb Procedures
Use these steps for PowerWeb.

Find Documents
To find documents:

1. Choose one of the following options:
l In the Search ribbon, in the Find group, click Find or Find in This Folder.

The Find Documents dialog box appears.

Find allows you to specify the scope of your search as multiple vaults, the current vault
or a specified folder. Find in This Folder limits the scope of your search to the selected
folder as indicated by this icon , which is not necessarily the folder containing the
highlighted document. They can be different.

l Right-click the folder, point to Search, and then select Find or Find in This Folder.
l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Point to Search, and then select Find or Find in This Folder.

2. If you chose Find in step 1, choose between three options:
l Select Entire Vault if you want to search the entire vault.
l If you want to search a folder:

a. Select This folder.

b. Select the folder you want to search.

c. If you want to include sub-folders in your search, select the and subfolders check
box.

l If you want to search a collection:
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a. Select This collection.

b. Select the collection you want to search.

3. On the Search tab, type all or part of the document name in Name.

The wildcard characters ? (any single character) and * (any string of characters) are
accepted. The effective search criteria will be the combination of the Name criterion and
the criteria in the Current criteria list.

The default criteria in the Current criteria list are properties configured by a System
Administrator and criteria that you have used recently.

4. Choose between two options:
l Select any of the default criteria that you want included in the search.
l Click Reset.

5. To add a criterion to the list:

a. Select an option from Property.

The properties available in this list depend on the vault's configuration and your
security privileges.

b. Select a search condition from Condition.

c. Type your desired search text in Value.

d. Click Add to List.

e. Repeat steps a to d to add more criteria.

f. Choose between two options:
l Use the default search operator, OR.
l Select All these criteria must be met to combine all the selected criteria (AND

operator).

6. If you clicked Find to search in multiple vaults:

a. Select Selected vaults.

b. On the Vaults tab, select the vaults to search in the right column.

c. Click the left arrow button to add them to the left column.

7. To search in only specific document types, select them on the Document Types tab as
described in Document Types Options.

8. To include documents that are related by Meridian references to your search results, select
options on the References tab as described in References Options.

9. Click Find Now to run the search.

The Search results page appears.

10. To reset all your search criteria and start a new search, click Reset.
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Find Folders
To find folders:

1. Choose one of the following options:
l In the Search ribbon, click Find Folders.

The Find Folders dialog box appears.

The default folder search scope is the entire current vault.
o To limit the scope to a specific folder, select This folder and type its name.
o To search recursively through its subfolders, enable and subfolders.

l Right-click the folder, point to Search, and then select Find Folders.
l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Point to Search, and then select Find Folders.

2. On the Search tab, type all or part of the folder name in Name.

The wildcard characters ? (any single character) and * (any string of characters) are
accepted. The effective search criteria will be the combination of the Name criterion and
the criteria in Current criteria list.

The default criteria in the Current criteria list are properties configured by a System
Administrator and criteria that you have used recently.

3. Choose between two options:
l Select any of the default criteria that you want included in the search.
l Click Reset.

4. To add a criterion to the list:

a. Select an option from Property.

b. Select a search condition from Condition.

c. Type your desired search text in Value.

d. Click Add to List.

e. Repeat steps a to d to add more criteria.

f. Choose between two options:
l Use the default search operator, OR.
l Select All these criteria must be met to combine all the selected criteria (AND

operator).

5. To search in only specific folder types, select them on the Folder Types tab.
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6. Click Find Now to run the search.

The Search results page appears.

7. To reset all your search criteria and start a new search, click Reset.

PowerUser Procedures
Use these steps for PowerUser.

To use Find:

1. Choose one of the following options:
l On the Editmenu, select Find.

l Click the downward pointing arrow next to the Find button on the Main toolbar
and then select Find documents or Find folders.

The command that you choose then becomes the default button in the toolbar.
l Press Ctrl+F.
l On the shortcut menu of a folder within which you want to search, select Find.

The Find Documents or the Find Folders dialog box opens, depending on which method you
used to start the command. If you selected Find on a folder shortcut menu, search criteria
are automatically typed in the dialog for you. The criteria match the contents of the folder
where you started the search.

Note:
Depending on the value of KeepSearchSettings in the following registry key, your previous
search settings are restored.

HKEY_CURRENT_USER\Software\Cyco\AutoManager
Meridian\CurrentVersion\AMFind\Settings

2. Click options and type text using the descriptions in the following topics.

3. After you have configured the search options that you want, click Find Now.

If the search is successful, the dialog expands to list the results. Only the first 250 items
appear in the list.

4. Click 250 More to view additional items.

5. Select an item and click Details to show the thumbnail and a limited number of properties
for the selected item.

6. Double-click the thumbnail to open the selected document in a new viewer window.

7. Double-click the property page to open a new Properties dialog box that shows all of the
item's property pages for viewing or editing.
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8. Click the Go To button or double-click the item to close the dialog and to make the selected
item the current item.

9. Click New Search to clear all selections and reset the dialog to its default settings, ready to
begin a new search.

10. Click Save or Save As to save the current results as a collection.

For details, see Create And Edit a Collection.

11. Click Close.

Confidential and Proprietary © 2022 134 www.accruent.com



What & Where Options
TheWhat & Where tab in the PowerUser determine the item names and locations that will
appear in the search results. The following table describes these options.

Option Description

Document name
or Folder name

Type some or all of the item name that you want to find. The wildcard characters ?
(any single character) and * (any string of characters) are accepted.

This vault Searches only the current vault.

This folder Click the Select Folder icon to select a folder within which to limit the search. Select
and sub-folders to also search with the sub-folders of the selected folder.

This collection Searches only within the selected collection. The existing static and dynamic
collections are listed.

All vaults Searches in all vaults that reside on the same server as the current vault. This option
is not available if a scope is active. Not available in PowerWeb.

Selected vaults Click Change to select specific vaults to search. Not available in PowerWeb.

What & Where options
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More Criteria Options
TheMore Criteria tab options in the PowerUser determine which property values the search
results must match. The following table describes these options.

Note:
Meridian supports partial word searches on document content or memo content (full text
search).

Option Description

All of these
criteria

Search results must match all of the listed criteria. Also known as an AND search.

Any of these
criteria

Search results can match any of the listed criteria. Also known as an OR search.

Property Double-click an empty cell in the Property column or click Add to display a list of search
properties and options from which to select. The list includes the names of properties
designated as Key Find properties.
To select other properties, enable List all properties.
Click Remove to remove a criterion. Click Remove All to start over.
The exact match and fuzzy search options for document content and memo content
determine how substrings in text are detected. They can be important for finding, for
example, the same date formatted for different locales (1-2-2013 vs. 2-1-2013) or a
document, tag, or part number that contains punctuation characters (71-3810.10).
Routed properties (properties inherited from parent objects) are shown in the list as
<FolderType>:<PropertyDefinition>.<PropertySet>.

Condition Select an appropriate condition from the list. The conditions listed are those valid for the
data type of the selected property.

More Criteria options
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Option Description

Value Type a value to search for. Only values valid for the data type of the selected property
are allowed.
Partial word searches are supported for document content or memo content (full text
search). For example, searching for “ship” will find “ship” or “ships” or “shipyard.”

Note:
If a date type property is selected, the Value can be specified either by selecting a date
from the calendar (default) or by entering an expression.
To type an expression, right-click the current value, select Type date expression and
type the expression. The expression can use the %CURRENTDATE% variable to
calculate acceptable dates. The variable supports addition and subtraction operations.
For example, %CURRENTDATE% + 10 will include property values for the next ten days.

If the selected property is associated with a lookup list, the Value text box becomes a list
from which you can select a lookup list value so that you do not need to know the
precise value to type.

List all
properties

Enable this option to include all property names in the Property list.
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Document Types Options
The Document Types tab allows you to select the document types to which to restrict document
searches.

The Folder Types tab allows you to select the folder types to which to restrict folder searches.
The Exclude regular folders from search results option limits the search results to include only
folders created from folder type definitions.
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References Options
The References tab options determine which documents that are related to documents in the
search results will also appear in the search results. The References tab is only available for
document searches. The following table describes these options.

Option Description

Include documents by reference Includes documents by reference in the search results.

Include documents referenced by
the found documents

Includes only documents that are referenced by (outgoing
references) documents in the search results.

Include documents that reference
the found documents

Includes only documents that reference (incoming references)
documents in the search results.

Include both Includes all documents with references to documents in the
search results.

Recursively Includes all documents contiguously associated by any type of
references.

Restrict to the following reference
type

Includes only documents with references of the selected type.

Include drawing and presentation
files

Includes Autodesk Inventor drawing and presentation files in the
search results.

Include hybrid parts in search
results

Includes hybrid parts in the search results.

References options
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Search Settings Options
The Search Settings tab in the PowerUser let you save and load the search settings on all of the
tabs in the Find dialog box. This can be useful to reuse and share complicated searches. The
following table describes these options.

Note:
By default, your previous search settings are reloaded automatically. To disable this feature, see
the note about the KeepSearchSettings registry value in Find.

Option Description

Load Click to load previously saved search settings.

Save Click to save the current search settings with a name that you specify.

Delete Click to delete the selected search settings.

Search Settings options
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Collections
A Meridian collection is a set of documents that can be created for various purposes, reused,
edited, and optionally shared with other users. Meridian allows you to save the results of a Find
search as a collection. You can then use the collection with most commands such as Build Report,
Draft Print, and workflow transitions.

Note:
l Only the Find search method supports saving searches as collections.
l A search that includes results from other vaults cannot be saved as a collection.

Collections can be of two types:

l Static — A saved list of document names. A static collection can be created as a new, empty
list or with the results of a search. Individual documents can then be manually added to the
collection and selected documents removed from the collection. New documents that are
created and that also match the search criteria are not automatically added to the
collection.

Every Meridian user has a permanent, personal static collection namedMy Search Results
that can be reused and to which the results of other searches can be added.

l Dynamic — Saved search criteria, not the search results, are saved and then re-evaluated
when you or others view the collection. New documents that are created and that also
match the search criteria are automatically added to the collection. Non-matching
documents cannot be manually added to the collection.

A dynamic collection can be shared with other users, used as the scope for System
Administrator-defined reports, and used as a starting page for read-only PowerWeb users.
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View a Collection
Collections appear as a view in the View list, similar to navigation views.

Collection views can be filtered and manipulated like other Navigation views as described in
Configure a Navigation View.

Note:
Collections created in a different time zone and based on search criteria that include a literal
date comparison may show unexpected results. This is because of the difference in time zones
between where the collection was created and where it is viewed. Date comparisons that use
variables like %CURRENTDATE% are not affected.

PowerWeb Procedures
Use these steps for PowerWeb.

View a Collection
To view a collection:

l In the view list, click the name of the collection that you want to view.

The collection contents appear in the navigation view pane.

Note:
When the collection is configured as described in Configure a Dynamic Collection and the
Allow user to edit the condition and value option and theMake this query available to
PowerWeb users option are enabled, you might see different results in PowerWeb than in
PowerUser when you initially view this collection. This is because it is assumed that you
will edit the search criteria first before running the search. Criteria other than the
properties and name (for example, folder and object type filters) are ignored when the
collection is first shown.

Sort Documents in Collection Based on a Column
To sort the documents in a collection based on a particular column:

1. Click the column heading that you want to sort on.

An arrowhead icon in the column heading indicates the current sorting column and sort
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order.

2. Click the column heading again to reverse the sort order.

PowerUser Procedures
Use these steps for PowerUser.

To view a collection:

l Choose between two options:
o In the context bar, click the view button and then click the name of the collection that

you want to view.

The collection contents appear in the Navigation view pane.
o On the View menu, point to Change View, and click the name of the collection that

you want to view.

The collection contents appear in the Navigation view pane.
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Create And Edit a Collection
You can create a collection as either a new, empty list or from the results of first searching for
documents.

Note:
Use caution when creating collections in one time zone that may be viewed in a different time
zone. If the search is based on criteria that includes a literal date comparison, the collection
may show unexpected results. This is because of the difference in time zones between where
the collection was created and where it is viewed. Date comparisons that use variables like
%CURRENTDATE% are not affected.

PowerWeb Procedures
Use these steps for PowerWeb.

Create an Empty Collection
To create an empty collection:

1. Choose one of the following options:
l In the Search ribbon, in the Collection group, click New Collection.

The New Collection dialog box appears.
l Right-click the folder, point to Search > Collection, and then select New Collection.
l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Point to Search > Collection and then select New Collection.

2. Type a name for the new collection.

3. Click OK.

Create a Collection from Search Results
To create a collection from search results:

1. Run a search using Find as described in Find.

2. To save the results as yourMy Search Results static collection, click the Search Results icon
.
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The documents may then be manipulated in the Navigation view instead of in the Find
dialog. The collection is created if it does not yet exist or is overwritten if it does exist.

3. To save the results as a new dynamic collection with a different name:

a. If the Properties page is not visible, click Search Results in the navigation view to show
the current search criteria.

b. Click options or type values using the descriptions in the following table.

4. Click Save.

To open the new collection for further editing, click Execute.

Option Description

Save as new dynamic
collection

Type a descriptive name for the new collection.

Available for all users Enable this option to make this collection available to other users, as a
starting page for read-only PowerWeb users, or to select it as the
scope of a report definition.

Add criterion Allows you to add criteria to your collection.
To add criteria:
1. Select a property from the property list.

2. Select a search operator from the operator list.

3. Type keywords in the text box.

4. Click the Add to List icon .
The criterion is added to Current criteria.

5. To apply the new criteria and preview the current search results,
click Find Now.

Collection options

Edit Criteria of an Existing Collection
To edit the criteria of an existing collection:

1. Open the collection as described in View a Collection.

2. Click the collection name in the navigation view to show the current search criteria.

3. Click Edit.

4. Choose between two options:
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l To remove a criterion, deselect it in Current criteria.
l To add a criteria, click options or type values using the description of Add criterion in

the preceding table.

5. Click OK.

Add Documents to an Existing Collection
Adding new documents to the vault while viewing a collection also adds the documents to the
active collection.

To add documents to an existing collection:

1. Run a search using Find as described in Find.

2. Select the documents that you want to add to the collection.

3. Choose one of the following options:
l In the context menu, point to Search and then click Add to Collection.

The Add to Collection dialog box appears.
l In the Search ribbon, in the Collection group, click Add to Collection.

The Add to Collection dialog box appears.
l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Point to Search and then select Add to Collection.

4. In the collection list, click the name of the collection to which you want to add the selected
documents and click OK.

The documents are added to the selected collection.

Remove Documents from an Existing Collection
To remove documents from an existing collection:

1. Open the collection from which you want to remove documents as described in View a
Collection.

2. Select the documents that you want to remove from the collection.

3. Choose one of the following options:
l In the context menu, point to Search and then click Remove from Collection.
l In the Search ribbon, in the Collection group, click Remove from Collection.

The documents are removed from the collection.
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l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Point to Search and then select Remove from Collection.

PowerUser Procedures
Use these steps for PowerUser.

Create an Empty Collection
To create an empty collection:

1. On the Vault menu, click Collections.

The Collections in <VaultName> dialog box appears.

2. In the toolbar, click the New static collection button .

A collection named New Collection is added to the list and the name is editable.

3. Type a name for the new collection and press Enter.

Create a Collection from Search Results
To create a collection from search results:

1. Run a search using Find as described in Find.

2. To save the results as yourMy Search Results static collection, click Save.

The documents may then be manipulated in the Navigation view instead of in the Find
dialog. The collection is created if it does not yet exist or is overwritten if it does exist.

To add the results to your existingMy Search Results collection, click the arrowhead and
select Add to My Search Results or Add to My Search Results and close.

Note:
Individual documents and folders may also be added to your existingMy Search Results
collection by clicking Add to My Search Result on the document shortcut menu.

3. To save the results as a new static or dynamic collection with a different name or to add or
remove it from it an existing static collection, click Save As.

The Save Search dialog box appears.

4. Click options or type values using the descriptions in the following table.

5. Click OK.
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Option Description

Create static
collection with
name

Type a descriptive name for the new collection.

Create dynamic
collection with
name

Type a descriptive name for the new collection.

Available for all
users

Enable this option to make this collection available to other users, to select it as the
scope of a report definition, or as a starting page for read-only PowerWeb users.

Advanced Displays additional options to add or subtract the results from an existing static
collection. Enabled only if one or more static collections exist.

Saved search options

Add Documents to an Existing Collection
Adding new documents to the vault while viewing a collection also adds the documents to the
active collection.

To add documents to an existing collection:

1. Select the documents that you want to add to the collection.

2. On the Document menu, click Add to Collection.

The Collections in <VaultName> dialog box appears.

3. In the collection list, click the name of the collection to which you want to add the selected
documents and click OK.

The documents are added to the selected collection.
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Remove Documents from an Existing Collection
To remove documents from an existing collection:

1. Open the collection from which you want to remove documents as described in View a
Collection.

2. Select the documents that you want to remove from the collection.

3. On the Document menu, click Remove from Collection.

The selected documents are removed from the active collection.
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Configure a Dynamic Collection
Because a dynamic collection saves the criteria of a search and not the search results, you can
later edit those criteria to modify the search results. You can also configure other features of a
saved dynamic collection for use by read-only PowerWeb users.

To configure a dynamic collection:

1. Select an existing dynamic collection from the Navigation views list in the shortcut bar or
the current view button.

2. Select the root node of the collection.

Property pages of the collection appear in the properties pane.

3. To modify the search criteria, select options on the General, Property Filters, and
References tabs as described in What & Where Options, More Criteria Options, and
References Options respectively.

4. To change the columns that are displayed by the collection:

a. On the Columns tab, add columns to the Displayed columns list.

b. Arrange their order with the arrow buttons.

The top to bottom order of the columns (properties) on the Columns tab determines
the left to right order of the columns in the collection view.

5. To configure the collection for read-only PowerWeb access, on the Custom Find tab, select
options and type text using the descriptions of the options in the following table.

Option Description

Make this
query
available to
PowerWeb
users

Enable this option to make the collection accessible by read-only PowerWeb users via a
URL. For information on the syntax of the URL, consult a System Administrator or refer
to Configure a PowerWeb Location in theMeridian Enterprise Administrator's Guide.

Caption Type a descriptive name to display as the page caption. This name will help users to
recognize what the collection represents.

Sort search
results on

Select a property to sort the collection on. By default, it is sorted on the Name property.

Quick Search Enable this option to display the Name and Quick search options on the Find page in
addition to the collection's search criteria.

Custom Find options
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Option Description

Show
property
filters

Enable this option to allow users to see the property filters that comprise the
collection's search criteria.

Allow user to
edit the
condition
and value

Enable this option to allow users to select other search conditions and type other search
values than those that define the collection's search criteria.
When this option and theMake this query available to PowerWeb users option are
enabled, you might see different results in PowerWeb than in PowerUser when you
initially view this collection. This is because it is assumed that you will edit the search
criteria first before running the search. Criteria other than the properties and name (for
example, folder and object type filters) are ignored when the collection is first shown.
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Delete a Collection
Deleting a collection deletes the document list or search criteria that define the collection's view.
It does not delete the documents themselves. To delete the documents within a collection, see
Delete and Undelete Documents and Folders.

Note:
l Before deleting a dynamic collection, resolve any dependencies on the collection such as

report definitions and read-only PowerWeb start pages.
l TheMy Search Results collection cannot be deleted. To replace its contents, save the

results of a new search to the collection as described in Create And Edit a Collection.

PowerWeb Procedures
Use these steps for PowerWeb.

To delete a collection:

1. Open the collection that you want to delete as described in View a Collection.

2. In the Search ribbon, in the Collection group, click Delete this Collection.

The collection is deleted.

PowerUser Procedures
Use these steps for PowerUser.

To delete a collection:

1. On the Vault menu, select Collections.

The Collections in <VaultName> dialog box appears.

2. Select the collection that you want to delete and click the Delete button .

A dialog box opens, asking you to confirm your choice.

3. Click Yes.

The collection is deleted.

4. Click Cancel to close the dialog.
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Commands on Search Results Heading
You can perform bulk updates on files by executing commands after clicking the Search Results
heading. This will apply the command you select to all results in your search, including results on
subsequent pages. This functionality allows you to make changes to your documents more
quickly.

This functionality is only available in PowerWeb.

Important!
You can only execute commands that you otherwise have access to based on your user
permissions. For example, if you do not have the ability to add documents to an export package,
you cannot use the Add to Export Package command on the Search Results heading.

To execute a command on search results:

1. Conduct a search.

2. Select the Search Results heading.

This will apply the command you select to all results in your search, including results on
subsequent pages.

3. Select a command.

The available commands on the Edit tab are:
l Download Document
l Lock Documents and Synchronize Workspace
l Set a Property Value
l Unlock

The available commands on the Exchange tab are:
l Add to Export Package

The available commands on theWorkflow tab are:
l Run a Workflow Transition

If the command you select is applicable for all files in the search results, the operation
succeeds. Otherwise, the system will execute the command for the files where the
command is applicable.

The available commands on the Commands tab are:
l Auto-Commands, or Custom Commands

Learn more about Custom Commands.

Confidential and Proprietary © 2022 153 www.accruent.com

CustomCommands.htm


Documents in PowerWeb
Meridian makes working with documents easy. Everything you can do with a file in Windows
Explorer, you can do in Meridian, and much more. Meridian takes care of the tedious organizing,
tracking, and standardization of documents and lets you concentrate on using documents in your
business.

You can just as easily work with documents from within your favorite editing applications. For
more information, see Application Integration.

Note:
Almost everything you can do with one document in Meridian, you can do with a selection
(batch) of documents or folders. All you have to do differently is to select the items that you
want to work with before executing the command.
If the command requires it, processing pauses for your input, which can also be applied to the
remainder of the items. While the command is busy working, a progress dialog lists the number
of items already processed, the number of items that remain to be processed, and the number
of items that failed processing for any reason. A scrolling text log shows the result of each
action for troubleshooting. You can pause, resume, or cancel processing at any time.
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Open a Vault
This article describes how to open a vault in PowerWeb and PowerUser.

PowerWeb Procedures
Use these steps for PowerWeb.

To open a vault:

1. Open a supported web browser.

2. Type the address of the Meridian website and press Enter.

The format of the address is: http://<server name>/Meridian/start

Check with a System Administrator if you are unsure of the address. The administrator may
also have created a desktop shortcut for you.

3. Depending on how your system is configured, you may need to log on.

4. The vault selection page appears.

5. Click the name of the vault that you want to open.

If you have not yet selected a default scope for the vault the scope selection page appears.

6. Click the name of the scope that you want to use.

The Folders view appears.

PowerUser Procedures
Use these steps for PowerUser.

To open a vault:

1. Start BC-Meridian PowerUser from the Windows Start menu or a desktop shortcut.

The program opens the vault that you worked in last.

2. On the Vault menu, click Open.

The Open Vault dialog box appears.

3. Select a vault from the list or select a different server from the Server list to open a vault
located there.

4. To open a vault at an existing baseline or a specific moment in history, select options in the
Open at group.
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5. Click OK.

If more than one scope has been configured for a vault by a System Administrator, the
Select Scope dialog box appears. Otherwise, the vault is opened and the default navigation
view appears.

6. Select a scope from the list.

7. Click OK.

The vault opens and the default navigation view appears. For more information about
scopes, see Scopes.
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View Documents
Meridian Enterprise includes the AutoVue viewer developed by Oracle, Inc. for viewing
documents. It is the easiest way to view your documents. You can view documents in AutoVue
without the documentʹs native application installed. The viewer pane displays buttons in a toolbar
that you can use to view documents in various ways and inspect them. Depending on your
security permissions, you may also be able to draft print or redline documents. Regardless of
what you do in the viewer pane, it will not change the document—all viewer actions are either
temporary or are saved elsewhere.

Note:
l If your system is configured to use AutoVue, you might be prompted for your user name

and password the first time that you view a document for each Meridian Enterprise client
session.

l Oracle, Inc. may add or remove file formats in each release of the software at its
discretion.

All documentation for AutoVue products is available on the Oracle website. This includes the
Oracle AutoVue Userʹs Manual in several languages and a Supported File Formats document that
lists the supported file formats.

To install a viewer for a file format that is not supported by AutoVue, see Install Third-Party
Viewers. To use a different viewer for a particular file format, see Change Viewers.

PowerWeb Procedures
Use these steps for PowerWeb.

To view a document:

l Choose one of the following options:
o Click the document name in any navigation view.

o
In the view bar, click the View Document icon .

o On the Document page, click the thumbnail image.
o On the Document shortcut menu, click Show Document.

The viewer page appears in the document pane.
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PowerUser Procedures
Use these steps for PowerUser.

To view a document:

l Choose between two options:
o To view a document when the viewer pane is not visible:

1. Click the document name in any navigation view.

2. Click the Show or Hide viewer tool button or double-click the thumbnail
image.

The document appears in the viewer pane.
o To view a document using the Document menu:

1. Click the document name in any navigation view.

2. On the Document menu, click View.

The document appears in a new window.

The viewer info bar is shown in the following figure. It displays information about the document
that is shown. The icons on the info bar are described in the following table.

Number Description

1 Native/rendition toggle – click to toggle the viewer between showing the native file
and the rendition if it exists

2 Redlines icon – hover your cursor over the icon to see whether the native file or the
rendition or both files have redlines

3 File icon

4 Filename

Info bar icons
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Hotspots
A hotspot defines a rectangular area in one document that is hyperlinked to another document.
When you click inside the hotspot, the viewer shows the hyperlinked document. You can use this
to link any type of hierarchical document set such as: 

l overview maps to detailed maps
l assembly drawings to sub-assembly or part drawings
l site plans to building plans
l schematic diagrams to detail diagrams.

You can navigate between documents graphically instead of textually (by name or other
properties).

l Hotspot information is stored separate from the document to which it refers. If the scale or
coordinate space of a document is changed, the hotspot information is not changed
accordingly and must be manually updated.

l Hotspot changes that are made to a project copy overwrite the hotspots of the master
document when the document is released as the latest revision.

l Hotspots appear as filled rectangles by default. To show outlines in an AutoVue desktop
deployment, set the option in the Viewer Options dialog box described in Change Viewers.
To show outlines in an AutoVue Client/Server deployment, add HOTSPOTSTYLE=1 to the
allusers.ini file described in Deploy standard viewer settings in theMeridian
Enterprise Administrator's Guide.

Hotspots can be created manually or automatically. A document may contain an unlimited
number of hotspots. Text for reference can also be assigned to a hotspot similar to the memo or
sticky notes features in other applications. Hotspots may be created for the DWG, DGN, TIFF, and
PDF file formats.

Hotspots can be generated automatically for drawing tags and linked to tag objects in the vault.
Only the blocks that have been configured for tag extraction by a System Administrator will
display drawing tag hotspots. This functionality is not supported by AutoVue.
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Create, Edit, and Delete Hotspots
You can create and edit hotspots in the viewer window to navigate quickly to related documents
or tags or to show related text.

Note:
The display style of hotspots can be configured with the Hotspots render style option on the
General Options page of the Viewer Options dialog box as described in Change Viewers.

PowerWeb Procedures
Use these steps for PowerWeb.

To add or edit a hotspot in a PDFTron rendition, you must first view the rendition you want to
change and the select hotspot edit mode.

To select hotspot edit mode:

1. Click Edit.

The Edit toolbar opens

2. Click Edit Hotspots

The redline tools disappear. You can now add, edit or delete hotspots as described below.

3. To end the editing session and save the hotspots to the rendition, click Save in the toolbar.

Add Hotspot
To add a hotspot:

1. At the location where you want the hotspot, click and drag to draw the hotspot you want.

The Hotspot dialog box opens.

2. In the Tag number field, enter the Asset Number of the document you want to link to.

3. Click Refresh.

The Linked documents pane lists the documents that you can link to from the hotspot.

4. To set the Type:

a. Click the ellipsis button.

b. In the Tag type field that appears, enter the Asset Type for the object you want to link
to.
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5. If you want the hotspot to link to multiple targets, in the Expression field enter the wildcard
or expression to generate the targets.

6. Click Save.

Edit Hotspot
To edit a hotspot:

1. Select the hotspot you want to edit

The Hotspot dialog box opens.

2. If you want to change the hotspot target of a manually created hotspot:

a. In the Tag number field, enter the Asset Number of the document you want to link to.

The Linked documents pane lists the documents that you can link to from the hotspot.

b. If you want the hotspot to link to multiple targets, in the Expression field enter the
wildcard or expression to generate the targets.

If both Tag number and Expression are set, the hotspot will refer to all documents which
exactly match Tag number and all documents which match the Expression.

3. To set the Type:

a. Click the ellipsis button.

b. In the Tag type field that appears, enter the Asset Type for the object you want to link
to.

4. Click and drag the handles around the hotspot until you have the size and shape you want.

5. Click Save.

Delete Hotspot
To delete a hotspot in edit mode:

1. Select the hotspot you want to delete.

2. Press the Delete key on your keyboard.

Delete All Hotspots
To delete all hotspots from a rendition:

1. Select the document or batch of documents you want from the Documents list.

2. On the Edit ribbon in the Organize group, select Delete > Delete Hotspots.

3. Click OK.
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PowerUser Procedures
Use these steps for PowerUser.

To create and edit hotspots one of the AutoVue viewers must be the active viewer for the
selected document. For information on configuring the viewer for different file formats, see the
Change Viewers.

Create a Hotspot
1. While viewing the document within which you want to create a hyperlink, click the Edit

Hotspots button .

The hotspot toolbar appears.

2. Click the New button .

The cursor changes shape to crosshairs .

3. Click and drag a rectangle in the document to specify the hotspot outline.

A shaded rectangle with square grips appears.

4. Click the Set Info button .

The Hotspot Information dialog box appears.

5. Click the browse button .

The Select Documents dialog box appears.

6. Select a document to link to the hotspot and click OK.

The path and file name of the selected document appears in the Hotspot Information
dialog.

7. Type optional descriptive text in Description.

8. Click OK.

9. Click the Edit Hotspots button again to hide the hotspot toolbar.

Edit a Hotspot
To edit a hotspot:

1. Click the Edit Hotspots button .

The hotspot toolbar appears. All existing hotspots appear as shaded rectangles.
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2. Choose one or more of the following options:
l To move a hotspot:

a. Move the cursor into the hotspot until the cursor becomes a four-sided arrow

.

b. Click and drag the hotspot to the new location.
l To resize a hotspot:

a. Move the cursor over the grip closest to the part of the hotspot that you want to
resize until the cursor becomes a two-sided arrow . The arrowheads indicate
the directions in which you can resize the hotspot with the selected grip. If you
want to resize the hotspot in a different direction, move the cursor over a
different grip.

b. Click and drag the grip to resize the hotspot into the shape and size that you
want.

l To edit the hotspot hyperlink information, select the hotspot that you want to edit and
perform steps 4 through 8 above.
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Navigate Hotspots
You can click hotspots in the viewer window to navigate quickly to related documents or tags or
to show related text. Hotspots can be created manually as described in Create, Edit, and Delete
Hotspots.

Viewing hotspots requires that one of the AutoVue viewers be the active viewer for the selected
document and that the hotspots are visible. For information on configuring the viewer for
different file formats, see Change Viewers.

Use these steps for PowerUser.

To navigate drawing tag hotspots:

1. In the viewer window toolbar, click Hide/Show Hotspots .

A blue rectangle appears for each hotspot. To hide the hotspots, click Hide/Show Hotspots
again.

If the document contains a lot of blue entities that making distinguishing the hotspots
difficult, you might want to turn off display of some blue colored layers.

2. To navigate to a linked object or display related text, click anywhere within the hotspot.

If the hotspot is linked to related text, the text is shown but the selected document remains
open in the viewer window.

If the hotspot is linked to a document or object, it is opened in the viewer window.

If so configured by a System Administrator, a Select Destination dialog will appear showing
the linked object and the other vault tags that it references. Select a destination object and
click OK.
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Install Third-Party Viewers
File formats for some applications are not directly supported by Meridian Enterprise. If you need
to view an unsupported format, a free viewer is often available for download from the application
developer's website or installed with the application. To integrate with Meridian Enterprise, a
third-party viewer must be an ActiveX control. Some viewers are detected automatically by
Meridian Enterprise if they are installed on the same computer. Some other third-party viewers
can be detected by Meridian Enterprise if support for them is installed on the computer.

A number of registry files are installed with Meridian Enterprise that enable this support for some
of the more popular third-party file formats and viewers. For a list of the viewers that are
supported by this version, see the Third-Party Viewers article in theMeridian Enterprise
Supported Software document.

Important!
Consult your System Administrator if you are unsure how to perform this procedure and before
installing any of the registry files. You may not have sufficient security permissions to install
them.

Use these steps for PowerUser.

To install support for a third-party format or viewer:

1. Install the third-party viewer on your computer.

2. Using Windows Explorer, navigate to C:\Program Files\BC-
Meridian\Program\Viewers.

3. Select the registry file that corresponds to the file format or viewer installed on your
computer.

4. Double-click the registry file to add its information to your registry.

5. Restart Meridian Enterprise if it was running when you installed the registry information.

6. Select a document in the format for which you just installed support.

The document should appear in the viewer. If the file does not display and you have
installed a third-party viewer for the format, see Change Viewers.
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Change Viewers
You might prefer the way one viewer displays a particular file format over another viewer or the
way the tools work in one viewer better than another viewer.

When you display a document, PowerUser or PowerWeb tries to use the first viewer in its list of
available viewers for each file type. If the first viewer fails, it moves on to the next viewer in the
list.

To use this feature, you must be an administrator of the computer or User Account Control (UAC)
must be disabled.

Note:
l System administrators can disable this feature.
l For information about third-party viewer tools, refer to that viewer's documentation.

PowerWeb Procedures
Use these steps for PowerWeb.

In PowerWeb, this feature is only available Internet Explorer when ActiveX compatibility mode is
selected. When this is not the case, only PDFTron and Forge are supported.

To change the order of the viewers:

1. Select your user.

2. In the context menu that opens, select Preferences.

The Change preferences for YourUser page opens.

3. Select the ActiveX compatibility mode check box if it is not already selected.

4. Click Viewer options.

TheMeridian View Control dialog box opens. The Viewer Priority page, under Use viewers
in order contains the list of available viewers for the selected file type.

5. Select the viewer you want then move it to the top of the list using the button.

6. Click OK.
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PowerUser Procedures
Note:

If hyperlinks in PDF documents do not work as expected, click the Options icon with the
Acrobat viewer selected as described below and then enable Embed Acrobat viewer into Web
Browser control.

Use these steps for PowerUser.

To change the order of the viewers:

1. Select a document of the format for which you want to select a different viewer.

For example, select an AutoCAD drawing file if you want to use a different viewer for this file
format.

2. Right-click in the viewer pane and select Viewer Options.

TheMeridian View Control dialog box appears. On the Viewer Priority page, under Use
viewers in order is the list of available viewers for the selected file type.

3. Select the desired viewer from the list and move it to the top of the list using the
button.

4. Click OK.

You should now see the document displayed with the chosen viewer in the viewer pane.
This procedure applies to all file formats and all viewers.
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Install the AutoVue Document Converter
The AutoVue viewer features the ability to convert documents to Adobe PDF format. It does this
with the AutoVue Document Converter printer driver. By default, this driver is not installed with
Meridian Enterprise but you can install it if you want to use the Convert command.

Use these steps for PowerUser.

To install the AutoVue Document Converter:

1. Start the setup program C:\Program Files\Common Files\Cyco
Shared\AutoVue\InstallPdfPrintDriver.exe.

The AutoVue Document Converter window appears and shows the installation progress
and results.

2. Click OK.

You may then use the Convert command as described in the Oracle AutoVue Userʹs Manual
that is available in the Meridian Enterprise distribution package and at the Oracle website.
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Create a New Document From A Template
Meridian makes it easy to create new documents either from templates or from existing files.

PowerWeb Procedures
Use these steps for PowerWeb.

Import an Existing File
To import an existing file:

l See Upload Documents.

Create New Document from Template
To create a new document from a template:

1. Select the folder where you want the new document to reside.

If the location of new documents is controlled by the vault's Field-Path definition, you can
select any folder because the Field-Path definition will store the document in the correct
folder regardless.

2. Choose between three options:
l In the New ribbon, in the Documents group, click New Document.

The Add Document/Select Document Type dialog box appears.
l Right-click the folder, point to New, and then select New Document.
l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Point to New, and then select New Document.

3. Select a document type from Document type and click Next.

4. Select a template from Document template and click Next.

Any property pages assigned to the document type for new documents appear.

The default values of the properties on these pages are the names of the corresponding
folders in the path that you selected in step 1.

5. Type any known values in the property pages and click Finish when you are done.
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The new document is created in the current folder or, if its location is controlled by the
vault's Field-Path definition, it is created in that folder. The configured document type
workflow (if any) is started and the document's General property page appears.

PowerUser Procedures
Use these steps for PowerUser.

Import an Existing File
To import an existing file:

l See Import Files Using Drag And Drop.

Create New Document from Template
To create a new document from a template:

1. Choose one of the following options:
l On the Vaultmenu:

a. Point to New.

b. Select a document type from the sub-menu.

c. Select a template from the next sub-menu.

l Click the New Document button on the Main toolbar.
l In any Navigation view:

a. Right-click the destination folder to display the Folder shortcut menu.

b. Point to New.

c. Select a document type from the sub-menu.

d. Select a template from the next sub-menu.
l Select a document type and template and then click Create.

The vault might be configured to prevent access to certain document types. If so,
instead of sub-menus appearing as described above, the available document types and
templates are presented in a dialog box. If a scope is active, document types that are
not enabled for that scope will not appear for selection.

If the document type you selected has property pages associated with it, they will
appear for you to type any known information.
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2. Complete each property page and click Next or Finish.

A new document is created in the current folder or in the folder calculated by the Field-Path
definition of the vault configuration.

The default values of the properties on these pages are the names of the corresponding
folders in the path that you right-clicked.

If the document type you selected performs automatic document naming, Meridian assigns
a calculated name. If not, a default document name is assigned that you may overwrite with
any name you want.

Note:
Document names that begin with a period are not allowed, although periods may be used
elsewhere in the name.
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Upload Documents
With PowerWeb, you can upload files to the vault either as new documents, to replace the
content in existing documents, or as new or updated renditions.

Note:
l To upload more than one document at a time, the ActiveX compatibility mode option

must be enabled as described in Personal Preferences.
l If errors occur while uploading large files, a System Administrator might need to configure

the web server to accept larger files than the default size.
l The document type that is assigned to imported documents is determined by the

following precedence:
o Document type assigned to the file extension.
o Default document type of the active vault if available in the active scope.
o Default document type assigned to the active scope.

PowerWeb Procedures
Use these steps for PowerWeb.

Upload Files as New Documents
To upload files as new documents in the vault:

l See Import Files Using Drag And Drop.

Upload File to Replace Document

Note:
l To prevent errors, the document must be in a released workflow state or the vault must

be customized to release the document upon replacement of the content.
l By default, the redlines for the existing document content will be deleted. If the redlines

should be retained (to check that changes to the document have been done properly, for
example) consult a System Administrator about disabling this behavior.
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To upload a file to replace the content of an existing document in the vault:

1. Locate the document for which you want to replace its content.

2. In a navigation view, right-click the name of the document and on the shortcut menu that
appears, point to Document and then click Replace Content.

The Replace Content dialog box appears.

3. Click Browse and select the file that you want to upload.

4. Click Yes.

Upload File as Rendition of Existing Document
To upload a file as a rendition of an existing document in the vault:

1. Locate the document for which you want to upload its rendition.

2. Choose between two options:
l In a navigation view, right-click the name of the document and on the shortcut menu

that appears, point to Document and then click Attach Rendition.
l If a rendition is already attached to the document, click Upload Rendition.

The corresponding dialog box appears.
l From the Thumbnails view:

a. Right-click a thumbnail of a document.

b. Point to Edit and then select Attach Rendition or Upload Rendition.

3. Click Browse and select the file that you want to upload.

4. Click Yes.

The file is uploaded to the selected document as its rendition.

PowerUser Procedures
Use these steps for PowerUser.

To upload files as new documents in the vault:

l See Import Files Using Drag And Drop.
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Download Documents
When you place documents under change to yourself in a workflow as described in Route a
Document In a Workflow, the documents are automatically downloaded to your local workspace,
ready for editing. In other situations when you want a local copy of documents, you must
download them manually. To download the rendition of a document, see Download Renditions.

PowerWeb Procedures
Use these steps for PowerWeb.

Download Documents to Local Workspace
To download documents to the local workspace on your computer:

1. In any navigation view, select the documents that you want to download.

2. Choose one of the following options:
l In the Edit ribbon, in the Download group, click Download Document.
l Right-click over your selection, point to Edit, and then click Download Selected.

If your computer is configured to use a site cache, a confirmation dialog box appears if:
o This is the first time that you have used the site cache.
o You are working from a different computer than the last time that you used the

site cache.
l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Point to Edit and then select Download Document.

3. Click Yes.

The documents download to the local workspace folder on your computer in the
background.

Download Documents to Specific Location

Note:
l This task requires the ActiveX compatibility mode option be enabled as described in

Personal Preferences.
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l It is not possible to use this option to download documents with their references.
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To download documents to a specific location on your computer:

1. In any navigation view, select the documents that you want to download.

2. In the Edit ribbon, in the Download group, click Download to Folder.

TheMeridian Upload/Download Control dialog box appears.

3. Select the desired options and then click OK.

The documents download to your computer in the background.

Download a Batch of Documents
To download a batch of documents:

1. Conduct a search.

2. Select the Search Results heading.

This will apply the command you select to all results in your search, including results on
subsequent pages.

3. Select the Download Document command from the Edit tab.

If your computer is configured to use a site cache, a confirmation dialog box appears if:
l This is the first time that you have used the site cache.
l You are working from a different computer than the last time that you used the site

cache.

4. Click Yes.

The documents download to the local workspace folder on your computer in the
background.

PowerUser Procedures
Use these steps for PowerUser.

To download documents to your computer:

1. In a navigation view, select the documents that you want to download.

2. Drag and drop the documents onto your desktop or the Windows Explorer location where
you want to work with them.
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Import Documents
There are many ways to get documents into a vault, including:

l Creating documents from templates as described in Create a New Document From A
Template.

l Copying existing vault documents (including deriving and replacing documents) as described
in Copy Commands.

l Saving documents into a vault from their native applications as described in Application
Integration.

l Importing with drag and drop as described in the following topic.
l Importing with packages as described in the following topic.
l Importing from a database (by a System Administrator)
l Importing with the Document Import Tool
l Importing CAD drawing assemblies with the Assembly Import Wizard

All of these methods create new documents, but the method you choose should be determined
by the type and quantity of documents that you want to import and convenience.
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Import Files Using Drag And Drop
Drag-and-drop is a convenient and easy way to add small quantities of files to a vault. For larger
quantities, see Document Import Tool. To import documents with PowerWeb, see Upload
Documents.

Important!
After files have been imported to a vault, document properties that were not explicitly set
during the import (from title blocks, default property assignments, and so on) contain no values.
Those properties will not be synchronized to the imported content files by the Meridian
application links. This is by design to prevent overwriting existing values.
The properties can be synchronized from the imported content files. Such properties must be
set in the vault to an explicit value at least once before the properties will be synchronized to
the content files.

Additional Notes about Functionality
l Your Administrator can configure the maximum file size you are allowed to import. Files

exceeding this limit cannot be uploaded. To upload these files, use the Local Workspace
client.

l If the vault is configured to use the same document type for all Autodesk Inventor assembly
files (.iam, .idv,.ipt,.idw,.ipn), all of the files will become one hybrid document
if you drop them at the same time into the vault. Instead, first drop those files that you do
not want to be part of the hybrid document (.ipt,.idw, and .ipn), and then drop
the assembly (.iam and .idv) files.

l Importing files with external references in this way will not create Meridian references.
l The document type that is assigned to imported documents is determined by the following

precedence:
o Document type assigned to the file extension.
o Default document type of the active vault if available in the active scope.
o Default document type assigned to the active scope.

l Drag and drop also works to export documents from Meridian to Windows Explorer or your
desktop.
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PowerWeb Procedures
Use these steps for PowerWeb.

The behavior of PowerUser and PowerWeb differ in a small number of ways and this is one of
them. Some document types that are allowed to be imported using drag and drop in PowerUser
might not be allowed to be imported in the same way in PowerWeb depending on the Document
type availability setting in the configuration of the document type. For assistance with this issue,
consult with a System Administrator.

To import using drag and drop:

1. Open the folder where you want to import the documents.

If you want to import the files to an existing document, select it.

2. Choose one of the following options:
l To import directly into the PowerWeb window:

a. Drag the files from Windows Explorer, Microsoft Outlook, or your desktop onto
the PowerWeb window and drop them.

If the selected document is locked or read-only, a dialog box appears for you to
select an action.

b. Select an import action from the dialog box that appears.

The available actions depend on the selected document, the number of files
dropped, and their file extensions.

l To import from the ribbon:

a. In the New ribbon, in the Documents group, click Import Documents.

The Import Documents dialog box appears.

b. Drag the files from Windows Explorer, Microsoft Outlook, or your desktop into
the Import Documents window and drop them.

l To import from the folder context menu:

a. Right-click any folder, point to Folder, and click Import Documents.

The Import Documents dialog box appears.

b. Drag the files from Windows Explorer, Microsoft Outlook, or your desktop into
the Import Documents window and drop them.

l To import from the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Point to New, and then select Import Documents.

The Import Documents dialog box appears.
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c. Drag the files from Windows Explorer, Microsoft Outlook, or your desktop into
the Import Documents window and drop them.

3. Choose between two options:
l To select more files to import, drag the files onto the file list and drop them.
l To select the files to import using a file browser:

a. Click Add.

b. Select the files to upload.

c. Click Open.

The file names are added to the file list.

Select a file and click Remove to remove it from the list.

4. If you also want to create Meridian references between the files that have external
references, enable Synchronize References from Files.

5. If the current view is not the Folders view, the Import Document/Select Folder dialog box
appears.

If necessary, select a different folder in the Folders view where you want the imported
document to reside.

6. Click Next.

7. If a page appears prompting you to select a document type for the files that you uploaded,
select one from Document type and click Next.

8. If any property pages appear for the documents you are importing, type any known values
in the property pages and click Finish when you are finished.

A progress dialog box shows the results while the files are imported. The files are uploaded
to the selected folder or, if their location is controlled by the vault's Field-Path definition,
they are created in the appropriate folders.

PowerUser Procedures
Use these steps for PowerUser.

To import using drag and drop:

1. Open the vault folder that will be the destination of the documents.

2. Select the files that you want to import from Windows Explorer, Microsoft Outlook, or your
desktop.

3. Drag and drop them onto the destination folder or onto any document in the destination
folder.
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If you selected only one document and dropped it onto an existing document, a shortcut
menu appears:

a. Select As New Revision to import the file as a new revision of the document upon
which you dropped it.

This command is only available if the vault document is released.

Because this action will create a new revision and the document is in a released state,
this command must be customized to place the document in the correct state of a
workflow according to your organization's business process for this action. If the
command is not customized, an Access is denied error will result and the action will
fail.

b. Select Replace Document Content to overwrite the vault document's content with the
file.

The file extension is updated if it is different. This command is only available if the
vault document is under change in a workflow.

c. Select As New Document to import the file as a new document in the selected folder.

Meridian then detects the file extension of each dropped file that will become a new
document in the vault and finds the document types associated with the file extension. If a
file extension is associated with more than one document type, a dialog box listing the
associated document types appears.

4. Select the document type you want applied to the imported document.

If a scope is active, document types that are not enabled for that scope will not appear for
selection.

If the document type is configured to support hybrid documents and you are importing
multiple files with the same name but different extensions, the files are imported as main
parts and attached parts depending on the file extensions. If a default file extension for
renditions is configured and documents with the same names but different extensions exist
in the vault, the files are attached as renditions of the vault documents.

If the document type of the first imported file has property pages associated with it, they
will appear next for you to type any known information.

5. If you want to apply the same information to all of the imported documents that have the
same document type, select Apply for all other documents of this type.

The default values of custom properties are the names of the corresponding folders in the
path where the documents are created. However, if files are dropped on a subfolder of the
selected folder, the values may be incorrect.

6. Complete each property page and click Next or Finish.

Property pages then appear for each of the remaining imported files, in turn, unless you
selected Apply for all other documents of this type.
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7. Complete each property page and click Next or Finish.

A progress dialog box shows the status of the overall import process until all of the files are
imported. Meridian creates new documents for each of the imported files and places them
in the current folder or in the folder calculated by the Field-Path definition of the vault
configuration.

If the document types of the imported files perform automatic document naming, Meridian
assigns a calculated name to each new document. If not, a default document name is
assigned that you may overwrite with any name you want.
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Document Import Tool
The Document Import Tool is a powerful way to import large numbers of documents into a vault
more conveniently than with drag and drop. It works like the Database Import Wizard available
to System Administrators in the Configurator, but is a little simpler and easier for end users to
manage. With the Document Import Tool, you can:

l Import any number of documents from various locations using a single data file
l Import property data from standard ODBC-compatible data files
l Let the import run unattended while you do other things
l Import multiple hybrid document files into a single hybrid document
l Import data from CAD drawing title blocks
l Import entire assemblies or subassemblies while maintaining references
l Populate the properties of imported documents from the data file or with fixed values
l Import new revisions of documents already residing in a vault
l Save different combinations of import options as templates for reuse later
l Monitor import progress and statistics

Configuring these options correctly takes a little time, but the settings can be saved to
configuration files and reused for similar import projects.

Important!
Before attempting a large import, back up the vault first. That way, if the import does not go as
planned, you can reverse the import easily by restoring the backup. Contact your System
Administrator about performing the Prepare For Backup operation before using the Document
Import Tool.

Note:
l To import CAD assemblies and their references, use the Assembly Import Wizard

described in Import Assemblies.
l This tool is not supported in PowerWeb. Consider using import packages as described in

Packages instead.
l Perform very large imports after business hours so that server performance is maintained

for production work.
Importing thousands of documents with the Document Import Tool can cause delays that
are unacceptable to other users.
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Create An Import Data Source File
The success or failure of a bulk import performed by the Document Import Tool is very often
determined by the quality of the data source file. Creating an accurate and powerful data source
file doesn't require a computer science degree. You can create one in an application you probably
already know, just by being prepared, being organized, and paying close attention to details. After
you've created a working data source file, you can reuse the basic structure of the file over and
over again for future imports just by changing the data.

Following are guidelines and suggestions for creating a data source file for the Document Import
Tool:

l Choose the file format you know best. Practically any ODBC data file will work equally well
with the Document Import Tool; there are few advantages of any one over another. The
important thing is to be able to easily create the necessary data structure of the file and
document type metadata.

If you regularly import documents from other departments, divisions, or external business
partners, you might be able to get them to create the data file for you if you give them
these guidelines, especially if they have the document data readily available and you do not.
Alternatively, you might have to accept their document data in whatever format you can get
from them and then convert or clean up the data yourself into a format usable by the
Document Import Tool. Popular data file formats include Excel, Access, comma-separated
value (CSV), and plain text.

Note:
If you decide to create the data in a MS Office format, select a file type that is compatible
with the combination of the versions of Meridian and Office that are installed on your PC.
The Document Import Tool only supports the Office 2007 or higher file types (for
example, .xlsx) when both applications are either 32-bit or 64-bit. With a mix of 32-bit
and 64-bit applications, the Document Import Tool only supports the older (for example,
.xls) file types. Using the .xls file format with the Document Import Tool running on
Microsoft Windows 7 or later requires installation of the Microsoft Office Access database
engine 2007. Alternatively, save the file in the CSV format and import it.

l You will need the following document metadata at a minimum, in order to successfully
import documents into a vault:

o Path — To the source file to be imported. This path should be relative to the computer
that will be running the Document Import Tool. Use URLs to specify paths on other
computers rather than mapped drive letters that may not exist or match. Any files not
found in this location will not be imported, so this field is the most important of all.
Confirm that every file exists before you start an import.
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o File name— In addition to the full path to the file above. This value will be used to
assign the document's name in the vault. If you can, use a query inside your
application to create this data for you if you don't have it in a separate field already.

o Revision number— This is another critical piece of metadata. Without it, Meridian will
assign the first revision number from the revision scheme of the destination document
type to your imported documents. This number may be lower than the actual revision
number of the document. Without accurate revision numbers, you can never fully
trust the documents to be accurate.

o Document type— This data is less critical than the others listed here because the
document type of a document can be changed later, although you don't want to have
to change the type of many documents. Without this data, Meridian will assign the
vault's default document type to imported documents. If this is the type you want
them to be, that's good. If not, that's not so good. Better yet, specify the document
type in your data file and be sure. This is necessary data if you want to import a mix of
document types in the same batch.

l If you have additional metadata, or you can make it from other fields or sources, you will be
glad if you import it so that it is available for reference and searching. Optional, but
important, metadata fields include:

o Status— The workflow state of the documents being imported (Under Change,
Released, Retired, In Review, and so on).

o Created by/Modified by— These fields can either be operating system file data or
data maintained in another data file. Either way, knowing who created and/or
modified the document last will be valuable.

l If you have any other legacy metadata about the documents being imported, take time to
carefully consider every piece. Any data that will help identify documents should be a
candidate for import. Numbers, names, codes, document titles, departments, comments,
sizes, and so on can all be valuable when it comes time to search for and revise the
imported documents with confidence.

Note:
Consult a database expert within your organization to help you create the best possible data
file. They may be able to save you a lot of time and effort and help produce a better result.
When the documents are in the vault, the metadata will be more difficult to change.
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Load a Configuration File
If a Document Import Tool configuration file exists for the documents you want to import, you
can quickly load its settings and begin importing documents almost immediately.

Use these steps for PowerUser.

To open the Document Import Tool and load an existing import configuration file:

1. Open the destination vault in PowerUser.

2. From the Vaultmenu, select Document Import Tool.

3. Click DataSource in the left pane.

4. Select a configuration file from the Configuration list or click Browse and select a file, and
then click Load Configuration.

5. Click the Start Import button to begin the import.

Whenever an import is not running, you can create a new import configuration file by clicking the

New button . Click the Open button to select a different import configuration file to work

with. Click the Save button to save the current configuration options to an open or new
configuration file.

Confidential and Proprietary © 2022 186 www.accruent.com



Control the Document Import Tool
After all the options necessary to complete a document import have been set or an existing
import configuration file has been loaded in the Document Import Tool, you are ready to start
the actual import process.

Important!
Beware of importing the same documents more than once. The Document Import Tool will
create copies of documents previously imported, with names like <DocumentName>
(2).<Extension>.

The Document Import Tool has several buttons that allow you to control the import process:

l Start Import— Begins the data import process.

This button is cleared if the field containing path information to the source documents has
not yet been selected in the File path field option.

l Stop Import— Stops the data import process entirely.

If the import has been stopped, it must be restarted from the beginning.

l Pause Import— Pauses the data import process.

This stops the import temporarily but allows it to be resumed by clicking Start Import.
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Monitor an Import
When an import is running, you can monitor its progress and estimate when it will be done by
viewing the Import Details property page. Click Import Details in the left pane to display the
Import Details property page containing import statistics, individual file results, and any errors.

When the import has completed, a summary dialog displays the final results. If you specified an

XSL style sheet on theMiscellaneous Settings page, click the Generate Report button to
generate an HTML report file of the results. The button is cleared if no XSL style sheet is selected.
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Configure Data Source Settings
The data source settings of the Document Import Tool determine:

l Where the import configuration file will be saved (for later reuse)
l Where the data file containing the imported documents' property values is located and, if

the data file contains multiple tables, which table to import
l The name of the field in the data file that contains pointers to the document files to be

imported

To configure the data source settings:

1. Click DataSource in the left pane.

The DataSource property page opens in the right pane.

2. Select options and type text using the descriptions in the following table.

Option Description

Configuration To create a new configuration file, click Browse, select a destination folder for the
import configuration file, type a name in File Name, and click Open.
To load an existing configuration file, see Load a Configuration File.

Unattended
Operation

Processes the entire import database without interruptions from errors. Any
errors will be listed in the Errors tab of Import Details.

Database Click Browse, select the appropriate file type in Files of type, and select an existing
file containing the path and property data for the documents you want to import.
See Create An Import Data Source File for guidelines on creating a suitable file.

Select the table to
import from

If the import data source file contains multiple tables or worksheets, select the
one containing the data you want to import from.

File Path Field If the data source includes a field that contains the fully qualified file names of the
source files to import, select The field contains the full path.
If the data source field contains a relative path or only file names, select The field
contains relative path and type either the base path (that is common to all
relative paths) or the parent folder (of all the file names) in Base path.

Select the field
that contains the
path of the
document

Select from the list the field within the data source file that contains the path to
the documents to be imported.

DataSource options
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Configure the Miscellaneous Settings
The miscellaneous options of the Document Import Tool determine:

l The vault folder where documents will be imported
l How hybrid document parts will be joined together
l If drawing title block fields will be read during import to populate the new documents'

properties
l If external references between CAD files will be resolved after import
l What document type to assign to the imported files
l An optional XSL style sheet that can customize the report of results

To configure the miscellaneous settings:

1. ClickMiscellaneous Settings in the left pane.

TheMiscellaneous Settings property page displays in the right pane.

2. Select options and type text using the descriptions in the following table.

Option Description

Destination
Folder

Select a folder inside the vault to receive the imported documents. If properties that
are controlled by the Field-Path definition are populated during import, the files will be
imported into the corresponding folder structure or newly created folders, as
necessary, instead of this folder.

Create an
empty
document if
file to import
doesn't exist

Enable this option to create documents in the vault that have no file content. This
option is useful for creating asset tags in the vault to support the Meridian Asset
Management Module or to manage hard copy documents for which no electronic file
exists.

Hybrid
Mapping

Enable Import hybrid components as parts of the hybrid document type, if desired,
and select a database field from the list that contains values that are common between
the hybrid part files. All files imported with the same values in this field will be created
as a single hybrid document using the document types configured in the vault.
Consult a System Administrator for information on the file extensions that are
configured as hybrid documents.

Miscellaneous options
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Option Description

Import title
block data

Enable this option to cause the Document Import Tool to read the title blocks of CAD
drawings. The title block settings must be configured for the selected document type by
a System Administrator in Meridian Enterprise Configurator.
Consult a System Administrator for information on your vault's title block import
configuration.

Resolve
references

Enable this option to cause the Document Import Tool to attempt to resolve any
external references stored within CAD drawings to other documents that are also being
imported by the tool or that already exist in the vault.

From
database
field

Select a field in the data source file that contains values that match the names of
existing document types to assign to the imported documents. If no field is selected or
no matching document type is found, the documents will be assigned the default
document type.
If a data source field name contains the text Type (for example, Document Type), it will
be selected by default.
If a scope is active, document types that are not enabled for that scope can still be used
for the imported documents and the documents will be imported.

Same type
for all
documents

Select a document type from the list to assign to all documents in the current batch.
If a scope is active, only the document types that are enabled for that scope are listed.

Add the
rendition file
to the
document

Creates a rendition for the imported document using a separate file. Select the field in
the data source that contains the rendition path from the list.

XSL style
sheet

Select an optional style sheet to be used to format the import results report. A sample
style sheet is provided in the C:\Program Files\BC-Meridian\Program
folder.
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Configure the Initialize Properties Settings
The Initialize Properties settings of the Document Import Tool determine:

l How the properties of imported documents will be populated with data, if at all
l Whether new versions of documents will be created for existing documents

Important!
After files have been imported to a vault, document properties that were not explicitly set
during the import (from title blocks, default property assignments, and so on) contain no values.
Those properties will not be synchronized to the imported content files by the Meridian
application links. This is by design to prevent overwriting existing values.
The properties can be synchronized from the imported content files. Such properties must be
set in the vault to an explicit value at least once before the properties will be synchronized to
the content files.

To configure the Initialize Properties settings:

1. Click Initialize Properties in the left pane.

The Initialize Properties property page opens in the right pane. The custom properties
defined in the vault's configuration are listed along with their property set and data type.
This view of the properties is one of several provided by the Document Import Tool.

If the data source field name matches either a Meridian property internal name or display
name, it will be mapped automatically.

2. Click the Properties Page Layout button to select other views.

3. For each field (except the file path field specified on the DataSource page) contained in the
data file selected for the import operation, select a corresponding vault property in the list.

4. Enable Initialize in the lower-right pane.

5. Select options and type text using the descriptions in the following table.

6. Repeat steps 2 through 4 for each field in the data source file.

Option Description

Use naming
expression to
calculate file
name

If enabled, the name of the imported document will be calculated by the expression set
for the document type that is assigned to the file instead of from any particular
database field.
This option is only available when the Name property is selected.

Property initialization options
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Option Description

With fixed
value

Assigns a single value to the selected field for every imported document. Type the
value in the text box.
If the property's validation configuration limits its values, select an existing value from
the list.

From
database field

Imports the value for each document from the data file. Choose a field from the list
that corresponds to the selected property.

Document
key property

Causes the Document Import Tool to search for existing documents in the vault in
order to add new revisions using the imported documents. The Document Import Tool
will search for a matching value between the selected field and the selected property.

With result of
expression

Type a VBScript expression to calculate the value you want to set in the selected
property. Click theMeridian Script Editor button to display theMeridian Script
Editor dialog to help you build and validate an expression.

Check
property
validation

Validates the property value from the database against the rules configured for the
property in the vault. If the validation fails, the value is not imported and an error is
added to the Errors tab in the Import Details property page.
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Configure the Revisions Settings
The Revisions settings of the Document Import Tool determine:

l Whether or not new revisions are created in the vault from imported documents
l How to handle existing documents undergoing changes in a workflow
l Whether imported revisions should be created as derivatives or replacements of existing

documents
l How imported revisions and existing documents are matched based on the source data file

To configure the Revisions settings:

1. Click Revisions in the left pane.

The Revisions property page opens in the right pane.

2. Click options or type values using the descriptions in the following table.

Option Description

Create new
revisions for
updated
documents

Updates documents within workflows from the imported documents. This is most
useful if you regularly receive document updates from an external business partner.

Replace
contents for
documents in
workflow

Prevents the creation of a new revision and updates the existing file.

Create new
revision for
document in
workflow

Leaves the current revision intact and creates a new revision with the imported
document.

Import files as
new documents

Prevents any revision creation and imports the files as new documents in the vault.

Import
revisions as
derivatives of
the same
document

Creates a derivative for the matching document with the imported document.

Revisions options
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Option Description

Import
revisions as
replacements
of the same
document

Creates a replacement for the matching document with the imported document.

Skip document
if it already
exists

Prevents importing documents that already exist in the vault.

Import existing
documents to
the specified
folder

Vault folder to import documents into that have the same name and revision as
specified by the Property in the vault that identifies document revision and
Database field that identifies revision options.

Property in the
vault that
identifies
document
revision

Select a property in the vault that identifies the document revision number of existing
documents. In almost all cases, this should be the Revision Number – Versioning
property.
Cleared if Import files as new documents is enabled.

Database field
that identifies
revision

Select a field in the data source file that contains values in common with the vault
documents to which the imported documents should become revisions. This should
be a field that contains metadata like the document name, file name, document
number, drawing number, and so on.
Cleared if Import files as new documents is enabled.

Database field
that contains
the revision
number

Select a field in the data source file that contains the revision number of the imported
documents. The values in this field will be placed in the property chosen for Property
in the vault that identifies revision, which identifies the document revision.
Cleared if Import files as new documents is enabled.
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Import Assemblies
The Meridian Enterprise Assembly Import Wizard can be used to import a variety of CAD
assemblies into a vault. After you select the top level file of an assembly, the tool scans the file for
links to other files that are referenced by the selected file. It then imports all of the files and
creates Meridian Enterprise references that represent each link found.

Supported Formats
The Assembly Import Wizard supports the following CAD drawing formats:

l AutoCAD/Mechanical Desktop
l AutoCAD sheet sets
l AutoCAD Electrical projects
l AutoCAD Plant 3D projects
l Autodesk Inventor
l SolidWorks
l MicroStation

Notes about Functionality
l Importing an assembly that has circular references will create matching Meridian references

correctly except for the returning references to the main assembly.
l The Assembly Import Wizard is not capable of importing assemblies that were last saved in

an older version of Autodesk Inventor than is currently installed. For example, if the
assembly was last saved in Autodesk Inventor 2011, and the installed version is Autodesk
Inventor 2012, the assembly first needs to be migrated to Autodesk Inventor 2012, before
the Assembly Import Wizard is capable of importing it. For assistance in automating this
task with Meridian Enterprise, consult a System Administrator.

l The references that are created between Autodesk Inventor parts, assemblies, and drawings
are influenced by the SupportInventorDWG registry value that is described in the HKEY_
LOCAL_MACHINE\Software\Cyco\AutoManager Meridian\CurrentVersion\InventorLink
article in theMeridian Enterprise Administrator's Guide.

l Before importing SolidWorks assemblies, disable the SolidWorks option Search file locations
for external references.
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l Before importing a large assembly or many smaller assemblies to a vault that has been
configured to use local workspace, temporarily disable local workspace synchronization as
described in Configure Local Workspace until the import is completed. The synchronization
could interfere with the import and result in error messages like The specified file cannot
be opened.

l AutoCAD sheet sets cannot be imported with 32-bit Windows 10.
l If the Assembly Import Wizard appears to have stopped working, it can actually be because

another application that is used during the import has stopped and is showing messages
that are hidden behind the visible windows. Minimize all visible windows to expose these
messages, or use Alt-Tab to switch to the other application.

l To correct an imported assembly that does not have Meridian references, use the
Synchronize References from File command as described in Synchronize References.

Import an Assembly
To import an assembly:

1. If you want to create a new folder structure in the vault to contain the assembly, create it
on your PC and copy or move the assembly files there before proceeding.

The Assembly Import Wizard can either recreate the existing assembly source folder
structure in the vault or create a new folder in the root of the vault in which to recreate the
source folder structure. You can move the files after you import them if you want to place
them in a different location.

2. Start the Assembly Import Wizard program.

By default, it is located at C:\Program Files (x86)\BC-
Meridian\Program\BCAssemblyImport.exe. TheWelcome to Assembly Import
Wizard wizard page appears and lists the types of assemblies that you can import.

3. Select an assembly type and click Next.

The Assembly Location page appears.

4. Click Browse.

5. Select the assembly that you want to import.

If you want to import all assemblies in the selected folder, select Import Folder.

6. Click Next.

The Vault Location page appears.

7. Click Select.
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8. Select a vault for the destination of the assemblies.

If you want to create a new subfolder for the imported assemblies, type its name in the text
box.

9. Click Next.

TheManage Preferences page appears.

10. Click options or type values using the descriptions in the following table.

Option Description

Raise new
object
events

Causes the VBScript events that are related to new document creation to occur.
Select this option if you want the vault script to react to the imported assembly
files the same as if the files were imported using other methods.

Import title
blocks

Imports title block properties if they have been configured in the vault by a System
Administrator.

Assembly import options

11. Click Next.

The Completing Assembly Import Wizard page appears.

12. Click Finish.

The import status of each assembly is shown along with a progress bar while the files are
imported.

When the import is finished, the results are shown on-screen and saved in the file
BCAssemblyImport.log located in the same folder as the program. By default, this is
C:\Program Files (x86)\BC-Meridian\Program. If any errors occurred during
the import, you can click Add to log to append the error messages to the log file for later
analysis.

13. Click New Import to repeat the process with a different assembly.

14. Click Close.
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Open a Document From Within Meridian
You can open a document for editing from within Meridian if the document's source application is
installed on your computer.

It is also very convenient to open vault documents from within their native application instead of
from within Meridian Enterprise. For more information, see Application Integration.

Troubleshooting
If the document opens in the source application as read-only even if the Open read-only option
was not selected in the preceding task, there can be several reasons:

l The Suspend viewing the document option in PowerUser is not enabled as described in
Advanced Options.

l Due to inadequate network or server performance, the application did not detect that the
viewer in PowerUser had released the file. If the situation persists, temporarily disable the
viewer and reopen the file.

l The file is corrupted and needs to be repaired.

To open an AutoCAD drawing read-write so that it can be repaired:

1. Close the drawing.

2. Disable the viewer in PowerUser.

3. Reopen the drawing in AutoCAD.

4. Use the AUDIT command in AutoCAD to repair the file.

PowerWeb Procedures
Use these steps for PowerWeb.

If you attempt to open a document where the version in the vault is newer than the version in
your local workspace, PowerWeb warns you that the document may contain updates from other
users, and that any local changes may be lost after synchronization. You can then abort the
operation. If you choose to abort the operation, nothing is changed in the local workspace or the
vault.
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To open a document for editing from within Meridian:

1. Choose one of the following options:
l Double-click the document name.
l In a navigation view:

a. Right-click the name of the document that you want to download.

b. Point to Edit, and then click Open.
l In the Edit ribbon, in the Upload/Download group, on the Download Document

menu, click Open.
l View the document as described in View Documents and click Open.

If the document is under change by you in a workflow, it will open immediately. If not,
a dialog will show the actions that are available to you.

l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Point to Edit and then select Open.

2. Click options or type values using the descriptions in the following table.

3. Click OK.

A progress dialog box appears while the document is downloaded from the server to your
computer where it opens in the Windows application that is registered for the file extension
of the document.

PowerUser Procedures
Use these steps for PowerUser.

To open a document for editing from within Meridian:

1. Choose one of the following options:
l Double-click the document.
l On the Documentmenu, select Open in Application.
l Click the Open in Application button in the Main toolbar. The icon on this button is

different for each file type.
l Right-click the document to display the shortcut menu and then click Open or Open

With.

If the document is under change by you in a workflow, it will open immediately. If not,
a dialog will show the actions that are available to you.

2. Click options or type values using the descriptions in the following table.
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3. Choose between three options:
l Click OK to perform the selected action.
l Click Skip to perform no action on the document named in the dialog title bar and

proceed to the next document in the current batch, if applicable.
l Click Cancel to stop processing the selected documents.

Document Open Actions

Option Description

None (don't save changes) Opens the document in its application read-only. You will not be
able to save any changes that you make. However, this is useful
for viewing, printing, and other purposes and will not create a
new revision of the document.

Start Quick Change Checks the document out to you in a Quick Change workflow
and opens the document in its application. If you have not been
assigned the Start Quick Change privilege as described in the
Security Privilege Descriptions article in theMeridian Enterprise
Configuration Guide, this option is unavailable.

<TransitionName> Executes the selected transition in the workflow that is
configured for the document type, checks the document out to
you, and opens the document in its source application. If you do
not have the privilege to start a workflow, you are redirected to
the document in Meridian Explorer.

You can enter a short comment in
the document log...

Type a brief explanation as to why you are editing the
document, the changes that you will make, or other comments
that could be valuable to other users or for historical reference.

Apply to all documents Applies the selected action and the typed comments to all
documents in the current batch and you will not be prompted
again.

Document open actions
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View the Current Workflow
Viewing a document's current workflow information allows you to identify which workflow the
document is in, its current status in the workflow, and the possible transitions to the next state in
the workflow.

Use these steps for PowerUser and PowerWeb.

To view the current workflow:

1. Choose between two options:
l On the document's Document property page, click the Status hyperlink.

l In the view bar, click theWorkflow Diagram icon .

The Document Workflow window or page opens.

Each state of the workflow appears as a colored rectangle. The current state of the
document is boldly outlined in black. The names of workflow transitions (actions) are
shown in white rectangles. Lines connect each transition from one state to another
state. The direction of each transition is indicated by an arrowhead. In PowerWeb, you
can hover the mouse pointer over a transition box in the diagram, the unrelated states
and transitions are dynamically hidden.
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If the current workflow type is a workflow definition, the outgoing transitions of the
current state are listed at the bottom of the dialog with the current status of each one.
If the Meridian Advanced Project Workflow Module is enabled, document workflow
transitions may be interlocked with project workflow definitions. The status of these
interlocks will also be shown in Status. The possible states of the interlocks are
described in the following table.

2. To inspect complex workflows, use the zoom tools in the toolbar or scroll the mouse wheel.

3. Click and drag the diagram to pan.

4. Click OK.

Interlock
Type

Status Description

Document There are no
conditions defined for
this transition

The transition is not interlocked with another workflow. You
can attempt to run it but it might be blocked by a security
check.

Document This transition is
filtered out by applied
criteria

You cannot run the transition because it is blocked by an
interlock with another workflow or a property value.

Document There is no Metadata
for this transition

The transition is not interlocked with another workflow, you
can attempt to run it but it might be blocked by a security
check.

Document Transitions <Name>
condition script failed.

You cannot run the transition because it is blocked by a
script condition.

Document Access Denied You do not have sufficient rights to run the transition.

Project Folder There are no
conditions defined for
this transition

The transition is not interlocked with another workflow. You
can attempt to run it but it might be blocked by a security
check.

Project Folder Conditions have been
validated for this
transition

The script assigned to the transition has passed. You can
attempt to run it but it might be blocked by a security check.

Project Folder This transition is
filtered out by applied
criteria

You cannot run the transition because it is blocked by an
interlock with another workflow or a property value.

Project Folder Transitions <Name>
preconditions script
failed.

There is a problem with the script assigned to the transition.
Contact a System Administrator.

Interlock statuses
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Interlock
Type

Status Description

Project Folder There is no Metadata
for this transition

The transition is not interlocked with another workflow. You
can attempt to run it but it might be blocked by a security
check.

Project Folder Transitions <Name>
condition script failed.

You cannot run the transition because it is blocked by a
script condition.

Project Folder Interlock <Name>:
Passed

Shown for each interlock that has been satisfied.

Project Folder Access Denied You do not have sufficient rights to run the transition.
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Route a Document In a Workflow
Routing a document through a workflow produces a new revision of the document. Documents
may be routed through one of three types of document workflows. A vault may use one or more
of them for different purposes. Consult a System Administrator for the document workflow types
configured for the vaults you use. For more information on document workflow types, see
Document Workflow Types.

Regardless of the types of workflow that may be configured for a vault, the available workflow
transitions for each document depend on many rules. The workflow transitions available to you
for any particular document depend on your security role for the folder in which the document
resides. If you are starting a workflow, you may have more than one workflow available to you. If
you are continuing a workflow, you may have more than one transition in the current workflow
available to you. To view a diagram of the current workflow and other status information, see
View the Current Workflow.

Important!
Revoking a workflow deletes the copy of the document being changed in the workflow and
reinstates the released revision of the original document as the highest revision. If the
document was created new in the workflow, it is also deleted but there is no original document
to reinstate so be certain that the document will not be needed or a backup copy is kept
elsewhere before revoking the document's workflow.
Throughout a document workflow, the current status of the document, the next task to be
performed, the person assigned to that task, and the person who initiated the workflow are all
shown on the Document property page of each document in the workflow.

Routing batches of documents is only possible if:

l The documents are all in the same workflow state
l The documents are in different states of the same workflow, but transition equivalence has

been configured for the transitions of all of the states that the documents are in. Transition
equivalence is configured by a System Administrator. If any one of the documents in the
batch does not have an equivalent transition, the entire batch will fail to be routed.
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Notes About Functionality
l If rendering certain Revit files (.rvt) consistently leads to any error which does not seem

applicable, check if opening the .rvt file in the Revit version installed on the render node
causes an upgrade dialog to appear. If so, the file should be upgraded in an interactive Revit
session before trying to render again.

PowerWeb Procedures
Use these steps for PowerWeb.

To route a document:

1. Select the document that you want to route in a workflow.

The workflow transitions that are valid for the document's current status and document
type appear in theWorkflow ribbon.

2. Select a workflow transition from theWorkflow ribbon or click Reroute Documents.

3. Choose one of the following options:
l If you select a Quick Change transition, a confirmation dialog box appears.

o Click Yes.
l Otherwise, a dialog box appears for intermediate transitions.

a. Select a user name.

b. Type an optional comment to add to the document log.

c. Click OK.
l If your computer is configured to use a site cache, a confirmation dialog appears if this

is the first time that you have used the site cache or you are working from a different
computer than the last time that you used the site cache.

o Click Yes.

The document's workflow properties are updated to reflect its current status. If the
transition places the document under change by you, the document is downloaded to your
local workspace for editing by you.
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PowerUser Procedures
Use these steps for PowerUser.

Important!
When a new revision is made of a document, any references to or from other documents will be
updated to reference the new revision, not the original revision. This may have serious
consequences for configuration management that may apply to your organization. If so,
consider using Replace Document or Derive Document instead.

To route a document:

1. Select the document you want to route.

2. On the Documentmenu, point to Document Workflow, and then select a transition from
the shortcut menu or click Reroute Documents.

Depending on the workflow type and the current state of the document, dialogs may appear
to prompt you for more information.

3. Complete any dialog boxes that may appear and click OK.

If the vault is configured to generate workflow event notifications, email messages are sent
to the persons to which the documents were routed and, optionally, to the workflow
managers and to the subscribers of the documents. Event notifications that are generated
as part of a batch operation are grouped together as a single email message.

The document is also added to the Recent Items list on the Windows Start menu for easy
access.
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Sign Documents
When you sign a document, Meridian verifies:

l Your identity with your Windows user account
l You are the current user logged on to the computer
l You are the current user logged on to Meridian

Meridian allows you to electronically sign multiple documents in a single batch. When signing the
first document in the batch, you will be required to type both your user name and password.
Depending on the system configuration, you will be required to type both your user name and
password, or just your password, for each additional document in the batch.

As of the 2022 release, separate events are added to the audit log for each document in the
batch, regardless of whether authentication succeeded, failed, or if you exited out of the
authentication dialog without attempting to authenticate.

Use these steps for PowerUser and PowerWeb.

To sign documents:

1. Run the workflow transition that approves the documents as you normally would.

2. Complete any property pages that appear that are related to the transition.

The <TransitionName> dialog box appears showing the name and revision number of the
document that you are about to sign.

3. Type your user name and password in User name and Password, respectively.

4. If appropriate, select a user name from the Select a user to work on the documents list.

5. Click OK.

Different results will occur depending on the outcome of the verification:
l If authentication passes, your electronic signature information is saved with the

document in the vault. Depending on the system configuration, the information might
also appear on a signature page attached to the document's rendition and if you click
the Electronic signatures link in theWorkflow group on the Document property page.

l If authentication fails, you are logged out of PowerWeb.

Both successful and unsuccessful electronic signature attempts are logged in the audit
log. A separate event will be logged for each document in the batch.
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Document Properties
Meridian stores and displays data about each document calledmetadata. The metadata is stored
in properties, which can be considered database fields. Meridian uses properties in a manner
similar to the way Windows keeps track of a file's name, size, date created, and date modified.
The properties in Meridian are used to track and manage the documents and may include such
properties as Revision Number, Project Number, Status, Title, and many more. The document
type of a document determines which properties are associated with the document.

You will encounter three kinds of properties when working in Meridian:

l Read-only— You cannot change the values of these properties. Examples are Creation Time
and Size.

l Restricted — You can only select a value from a list of standard values.
l Unrestricted — You may type a value you want.

Meridian displays properties on property pages. Each property page contains properties that are
related to one another in some way. The document type of a document determines which
property pages are associated with the document. Every vault document displays at least a
Document property page that contains basic metadata such as workflow Status, To-Do, Location,
Type, and so on. Property pages appear for existing documents and may also appear when you
create new documents so that you can type any known information. That information may be
used to automatically name the document and store it in the correct folder.
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View And Edit Properties
For most purposes, you can view the properties of a document on the property pages that are
described in Property Pages. If you have the appropriate privilege, you can also view the same
properties plus advanced information and hidden properties.

Editing properties is important to keep the values accurate for effective searching. Without
accurate metadata, searching for documents can result in finding the wrong documents or no
documents at all.

Important!
PowerWeb is limited to sending a total of 24 KB of data when properties are edited. This limit
can be exceeded if the document type includes a large number of text properties or one or
more memo properties that contain a lot of data. When this occurs, you will be shown an
Invalid arguments error and your changes in some properties may not be saved correctly. If this
happens to you, contact a System Administrator for help.

Notes about Functionality
l Your ability to edit properties is determined by the document's current workflow status,

your security privileges, and the vault configuration. In most cases, you will only be able to
edit properties while a document is under change by you.

l If the properties that you want to edit are for an AutoCAD drawing that contains multiple
layouts that represent separate drawing sheets, each with a title block, a special property
page titled Title Blocks may be available if it is enabled by a System Administrator. This page
lets you enter different values for the title block in each layout (PowerUser only).

l If the same property appears on multiple pages and you change its value on only one page,
only the value from the last page shown will be saved.

l To edit the properties that control rendition generation, see Edit the Rendition Properties.

Edit Document Properties
Use these steps for PowerUser and PowerWeb.

To edit the properties of a document:

1. Select the document that you want to change.

2. If the Document page is not visible, click the Document icon in the view bar.

3. Click the tab to show the property page that contains the property that you want to edit.
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4. Click Edit.

The properties become editable.

5. Change the value of the properties by typing text, selecting values, or selecting check boxes.

Properties that require you to set a value are indicated by a red triangle icon .

6. Click OK.

(PowerWeb) View Advanced Document Information and
Hidden Properties
Use these steps for PowerWeb.

To view a document's advanced information and hidden properties:

1. On the Document property page of the document, click the document icon in the upper-left
corner of the page.

The Advanced and Stored Properties tabs appear.

You cannot edit properties on these pages.

2. Choose one or more of the following options:
l Click the Advanced tab to show the advanced information.
l Click the Stored Properties tab to show all properties of the document grouped by

property set.
l To see the properties in a property set, click the expand icon next to the property set

name.
l If a column isn't wide enough to show all of a property value, double-click the column

heading to expand it.

(PowerUser) View Advanced Document Information and
Hidden Properties
Use these steps for PowerUser.

To view a document's advanced information and hidden properties:

l On the Document property page of the document, click the document icon in the upper-left
corner of the page.

The Advanced Document Information dialog box appears. You cannot edit properties in this
dialog box.
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Compare Document Property Values
Comparing property values allows you to easily see the differences between the property values
of two similar documents. It also allows you to update the property values in custom property
sets of one of the documents with the values of the other document. You cannot update internal
property values.

Note:
To update property values requires the Set Property Value privilege.

Use these steps for PowerUser and PowerWeb.

To compare document property values:

1. Select two documents and open the Compare dialog as described in Compare Files.

You can open the Compare Property Values dialog immediately by pressing the Ctrl key

while clicking the Compare button .

2. In the Compare dialog, click Compare property values.

The Compare Property Values dialog box appears similar to the following figure.

The names and revision numbers of the selected documents are shown at the top of the
dialog box so that you can distinguish between the two documents. The names of each
property used by the documents appear in the Property column below each document
grouped by property sets, which appear as shaded rows.
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Properties that have the same value for both documents appear in black text in the Value
column. Property values that are different between the two documents appear in red text.
Properties that are empty display <No Value>. By default, only the properties in the Custom
property set are shown.

3. To show the properties contained in the internal property sets, select Show internal
properties.

4. To show only the properties that are different between the two documents, select Show
differences only.

5. To update the property of one document with the property value of the other document:

a. Select the check box next to the property value that you want to apply.

b. Click the arrow button that points to the document to which you want to apply the
selected value.

The value is applied to the other document and the text color changes to black to
indicate that the property values are identical.

The validation settings of custom properties are not evaluated when properties are
updated this way.

6. Click OK to close the Compare Property Values dialog.
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Synchronize File Properties
File and title block properties can be synchronized between the document and its property pages
in the vault. This is useful for several purposes:

l Filling in some or all document properties when new documents are created
l Adding data to the Meridian properties when text is typed in empty properties
l Keeping the properties synchronized when changes to either are made (PowerUser client

only)

Synchronization occurs automatically when a document is opened in its native application with
one of the Meridian application links loaded. This synchronization is from Meridian to the
document. This ensures that any changes made to Meridian properties are reflected in the
document properties. Synchronization also occurs automatically when a document is saved in its
native application. This synchronization is from the document to Meridian. This ensures that any
changes made to the document properties are reflected in the Meridian properties.

Meridian properties can be updated from document properties when:

l Documents are imported into a vault
l Documents are uploaded with PowerWeb

File properties can be updated when documents are:

l Created new from a template or by using the Meridian Copy, Derive, or Replace commands
l Routed to a different state in a document workflow
l Checked out with PowerWeb

This topic pertains to the standard Windows file properties (Title, Subject, and so on, viewable in
Windows Explorer) as well as to the proprietary properties that are provided by some
applications. These properties are called various names depending on the application, for
example, AutoCAD attributes and MicroStation tags. Each of the application links described in this
chapter supports these proprietary properties except the Lotus Notes link.

Notes About Functionality
l If you insert a Word field and link it to a Word property that is itself linked to a Meridian

property, the field will also show the value of the Meridian property. This requires that the
properties are mapped to one another in the vault configuration by a System Administrator.
However, this synchronization is only in one direction from the Word property to the Word
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field. Changes to the field will not be synchronized to the Meridian property.
l Due to limitations in Revit, properties cannot be synchronized automatically.
l Blocks with mtext entities that are mapped to the drawing custom properties are not

updated.
l The events upon which synchronization occurs automatically are configured by a System

Administrator.
l A System Administrator may configure some Meridian properties as read-only or write-only

so that synchronization only occurs in one direction. For example, the revision number in a
title block may only be able to be updated fromMeridian, but not toMeridian.

l We recommend you close files in AutoCAD or synchronize files from within AutoCAD. With
some versions of AutoCAD, synchronizing properties with some AutoCAD files—such as
sheet set files—while the file is open in AutoCAD can produce an error.

l Meridian uses Autodesk Inventor itself to update properties. Because Meridian will start and
close Autodesk Inventor for each document, this will add a significant delay to actions that
involve multiple documents, for example releasing an entire assembly.

To improve performance significantly, launch Autodesk Inventor and keep it running in the
background before starting the update.

l Microsoft Office versions 2007 and higher allow you to save files to older version formats
(97 - 2003) that use different file extensions (.doc, .xls, and so on) than the newer
format (.docx, .xlsx, and so on). When files are saved in the old format, the Office
application link does not work as expected because it is registered with the default file
extensions that are created by the new applications. The workaround to this problem is to
add the old file extensions to the Windows registry in the following key:

HKEY_CLASSES_ROOT\CLSID\{6D61257C-66B5-4210-B963-
2C15F9BC44DE}\SupportedDocTypes

PowerWeb Procedures
Use these steps for PowerWeb. Synchronization can be applied to AutoCAD, MicroStation, and
Microsoft Office files only. References can be synchronized from different file types.

The Properties from File action triggers the publishing job configured for the Read title block
properties setting. The Properties to File action triggers the publishing job configured for the
Write title block properties setting. Both settings are described in Configure a Vault For Publisher
in theMeridian Enterprise Configuration Guide.
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Properties from File
To manually update the Meridian property pages from a document:

l In the Document ribbon, in the Title Block group, click Properties from File.

Properties to File
To manually update the properties of a document from its Meridian property pages:

l In the Document ribbon, in the Title Block group, click Properties to File.

PowerUser Procedures
Use these steps for PowerUser.

The Properties from File action triggers the publishing job configured for the Read title block
properties setting. The Properties to File action triggers the publishing job configured for the
Write title block properties setting. Both settings are described in Configure a Vault For Publisher
in theMeridian Enterprise Configuration Guide.

Properties from File
To manually update the Meridian property pages from a document:

l In the Documentmenu, point to Synchronize, and then click Properties from File.

Properties to File
To manually update the properties of a document from its Meridian property pages:

l In the Documentmenu, point to Synchronize, and then click Properties to File.

Other Applications
The following procedures apply to other linked applications other than Lotus Notes.

The Synchronize Properties from File action triggers the publishing job configured for the Read
title block properties setting. The Synchronize Properties to File action triggers the publishing
job configured for theWrite title block properties setting. Both settings are described in
Configure a Vault For Publisher in theMeridian Enterprise Configuration Guide.
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Properties from File
To manually update the Meridian property pages from a document:

l Depending on the application, on theMeridianmenu, in theMeridian ribbon, or in the
Meridian toolbar in the native application, click Update Vault or Synchronize Properties
From File.

You may also type AMMUPDATE at the AutoCAD command line.

Properties to File
To manually update the properties of a document from its Meridian property pages:

l Depending on the application, on theMeridianmenu, in theMeridian page of the ribbon,
or in theMeridian toolbar in the native application, click Update Document or Synchronize
Properties to File.

You may also type UPDATETITLE at the AutoCAD command line.
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Set a Property Value
Set Property Value is a very powerful command intended for use by System Administrators only.
It is available only if you have the Change Properties and Set Property Value privileges as
described in the Security Privilege Descriptions article in theMeridian Enterprise Configuration
Guide.

It is useful for several purposes:

l To set the value of a property that is not visible on a property page and therefore cannot be
set manually otherwise.

l To set the value of a property for many documents at one time, such as after importing a
batch of documents for which the data was not available for import.

l To copy the value of one property to another.
l To calculate the value of a property based on the values of other properties.

(PowerWeb) Set Property Value for a Batch of Files
Use these steps for PowerWeb.

This command only functions if your search results contain less than 100,000 files.

To set a property value for a batch of files:

1. Conduct a search.

2. Select the Search Results heading.

This will apply the command you select to all results in your search, including results on
subsequent pages.

3. Select the Set a Property Value command from the Edit tab.

4. Follow steps 3-8 in the Set a Property Value procedures below.

If the Set a Property Value command is applicable for all files in the search results, the
operation succeeds. Otherwise, the system will execute the command for the files where
the command is applicable.
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Set a Property Value
Use these steps for PowerUser and PowerWeb.

To set a property value:

1. Select the documents for which you want to set the property value.

2. Choose one of the following options:
l On the Edit ribbon, in the Organize group, click Set Property Value.
l Right-click a selected document, then select Edit > Organize > Set Property Value.

The Set Property Value dialog box appears.
l From the Thumbnails view:

a. Right-click a thumbnail of a document.

b. Select Edit > Organize > Set Property Value.

3. Select the property that you want to set from the Property list.

4. Select one of the options in the Set to group and then specify a value for that option using
the descriptions in the Property Value Options section below.

5. Click the Add to List icon to add your property specification to the property list.

To prevent setting a specified property , deselect it in the Property list.

6. Repeat steps 3 to 5 for each property that you want to set for the selected documents.

7. Enable the Ignore validation rules option, if desired.

8. When you are ready to set all of the specified properties, click OK.

The specified properties are updated for the selected documents.

In PowerWeb, a log of actions is shown. Each document name is a link for navigating to
problem documents. The log can be copied to the clipboard for pasting into other
applications.

Property Value Options

Option Description

Property If you select a property that uses a lookup list, the available values will appear as a list
of the Fixed value option. The list of available properties is configured by a System
Administrator as described in the Configure Column Layouts article in theMeridian
Enterprise Configuration Guide.

Set Property Value options
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Option Description

Fixed value Type or select the value that you want to set in the property selected for Property.

Value of
property

Select a different property than you selected for Property, the current value of which
you want to set in the selected property.

Script
expression

Type a VBScript expression to calculate the value that you want to set in the selected

property. Click theMeridian Script Editor button (if available)  to display the
Meridian Script Editor dialog to help you build and validate an expression. For
information on using VBScript for configuration expressions including their limitations,
see the Configuration Expressions article in theMeridian Enterprise VBScript
API Reference.

Ignore
validation
rules

Enable this option to bypass any lookup list and input restriction rules configured for
the property. This option is only available for users with the Advanced Set Property
Value privilege described in the Vault Privileges section of the Security Privilege
Descriptions article in theMeridian Enterprise Configuration Guide.
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Copy Commands
Meridian provides various commands for copying documents to create new revisions or versions.
Each command behaves differently with respect to:

l Revision numbers of the source and copied documents
l References between the source and copied documents
l References to and from the source document and other documents such as subassemblies

and parts
l Workflow status of the source document after the copy is made

Each can be useful in different situations depending on the document being copied, the purpose
of the copied documents, and your organization's engineering change process.

The following table summarizes the differences between the Meridian copy commands on the
source and copied documents to help you understand which command to use in your particular
situation.

Command Revision
Number
of Copy

Status of
Source

References
to/from
Source

Reference
Between
Source and

Copy

Initiate a document
workflow

Incremented
before or after the
workflow

Unchanged Redirected to the
copy (new
revision)

None

Copy, Copy Document,
Copy Multiple, Paste, and
Paste Multiple

Unchanged Unchanged Unchanged None

Copy with References Unchanged Unchanged Copied to the
copy

None

Derive Document Unchanged Unchanged Unchanged Derived From /
Derived To

Derive with References Unchanged Unchanged Copied to the
copy

Derived From /
Derived To

Copy commands comparison
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Command Revision
Number
of Copy

Status of
Source

References
to/from
Source

Reference
Between
Source and

Copy

Replace Document Incremented Retired Redirected to the
copy

Replaced By /
Replacement
For

Create Project Copy Unchanged Unchanged Copied to the
copy

Master Project
Copy
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Copy a Document
Copying an existing vault document creates a new document with the same file content as the
original. The metadata of the original document is also copied to the new document, including
the revision number. However, references to and from the original document are not copied to
the new document. To also copy the references, use the Copy with References command and see
Duplicate References.

For a comparison of the various copy commands, see Copy Commands.

If the document type of the copies is not configured to calculate the file name, the file names of
the new documents are set to Copy of <OriginalFilename>. Otherwise, the new
documents receive newly calculated file names. No references are made to the original
documents such as is created by the Derive Document and Replace Document commands.

If the document type is configured to use a document type workflow, the new documents are
automatically placed under change to you.

Note:
The Paste Multiple command creates just one copy of the source document regardless of the
number of copies that you specify. Each subsequent copy is made from the previous copy. This
might produce unexpected results depending on any configuration or customization of the
source document type when copies are made. If this produces unacceptable results, use the
Copy Document command multiple times or consult a System Administrator.

PowerWeb Procedures
Use these steps for PowerWeb.

Copy Existing Documents Once
To copy existing documents once:

1. Select the source documents that you want to copy.

2. Choose one of the following options:
l On the Edit ribbon, in the Copy group, click Copy.

If the document type of the original document has been configured to show property
pages for the Copy Document command, the pages are shown with the original
document's property values as defaults.

l Right-click the selected document, and select New > Copy > Copy.
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l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Point to New and select New > Copy > Copy.

3. If necessary, type or change property values for the new document and click OK.

A new document is created in the current folder with the same file content as the original
document.

Copy Existing Documents Multiple Times
To copy existing documents multiple times:

1. Select the source documents that you want to copy.

2. Choose one of the following options:
l On the Edit ribbon, in the Copy group, click Copy Multiple.
l Right-click the selection and select New > Copy > Copy Multiple.
l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Point to New and select New > Copy > Copy Multiple.

3. In the Add Document / Select Folder dialog box that appears, select the folder where you
want the copies.

4. Click Next.

If the document type of the original document has been configured to show property pages
for the Copy Document command, the pages are shown next for the first copy with the
original document's property values as defaults.

5. In the Copy Multiple dialog box that appears, enter the Number of copies you want.

6. Click OK.

The documents are copied to the chosen folder.
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PowerUser Procedures
Use these steps for PowerUser.

Copy Existing Documents Once
To copy an existing document once:

1. Select the source document that you want to copy.

2. On the Editmenu, select Copy Document.

If the document type of the original document has been configured to show property pages
for the Copy Document command, the pages are shown with the original document's
property values as defaults.

3. If necessary, type or change property values for the new document and click OK.

A new document is created in the current folder with the same file content as the original
document.

Copy Existing Documents Multiple Times
To copy an existing document multiple times:

1. Select the source document that you want to copy.

2. On the Editmenu, select Copy or press Ctrl + C.

3. Select the folder where you want to create the copies of the document or select a
document in that folder.

4. On the Editmenu, select Paste Multiple.

The Paste Multiple dialog box appears.

5. Type the number of copies that you want to make and click OK.

If the document type of the original document has been configured to show property pages
for the Copy Document command, the pages are shown with the original document's
property values as defaults.

6. Type or change property values for the first copy.

7. If you want to apply the same property values to the remaining copies, select Apply for all
other documents of this type.

8. Click OK.

The copies are created in the current folder with the same file content as the original
document.
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Derive a Document
Deriving a document is the same as copying a document except that a reference is made to the
original document so you can easily locate the origin of the derived document. The revision
number of a derived document is not incremented. References to and from the original document
are not copied to the new document. To also copy the references, use Derive with References
and see Duplicate References. You may derive new documents only from existing released
documents.

Unlike a new revision (created by a document workflow) or a replaced document in which
references to its source document are updated to refer to the new revision, references to the
source of a derived document are not updated to refer to the derived document. This can be
important if you need to maintain the existing configuration of references between assemblies,
subassemblies, and parts.

Another difference between the Derive Document and Replace Document commands is that
derived documents are not retired, but replaced documents are retired and may not be revised
again unless they are unretired.

For a comparison of the various copy commands, see Copy Commands.

PowerWeb Procedures
Use these steps for PowerWeb.

Derive New Document from Existing Document
To derive a new document from an existing document:

1. Select the source document that you want to copy.

2. On the Edit ribbon, in the Copy group, click Derive.

If the document type of the original document has been configured to show property pages
for the Copy Document command, the pages are shown with the original document's
property values as defaults.

3. If necessary, type or change property values for the new document and click OK.

A new document is created in the current folder with the same file content as the original
document.
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View Reference
To view the reference:

1. Select either the derived document or its original document.

2. On the Document ribbon, in the Information group, click Show References.

The References page appears. For descriptions of the features of this page, see View
References.

3. Select either the Derived from or Derived to reference type from the Show reference type
list.

PowerUser Procedures
Use these steps for PowerUser.

Derive New Document from Existing Document
To derive a new document from an existing document:

1. Select the source document for the derived document.

2. On the Editmenu, select Derive Document.

If the document type of the original document has been configured to show property pages
for the Derive Document command, the pages are shown with the original document's
property values as defaults.

3. If necessary, type or change property values for the derived document and click OK.

A new document is created in the current folder with the same file content as the original
document.

If the document type is not configured to calculate the file name, the file name of the new
document is set to Copy of <Originalfile name>. Otherwise, the new document
receives a newly calculated file name.

A reference is made from the original document to the derived document with the
reference type Derived To.

View Reference
A reference is made from the original document to the derived document with the reference type
Derived To.
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To view the reference:

1. Select either the derived document or its original document.

2. On the Documentmenu, click Show Derivatives.

The Derivatives dialog box appears. For descriptions of the features of this dialog, see View
References.

If the document type is configured to use a document type workflow, the new document
may be automatically placed under change to you. The status of the original document is
not changed.
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Replace a Document
Replacing a document is the same as copying a document except that a reference is made to the
original document so that you can easily locate the origin of the replacement document. The
Status of the original document is changed to Retired and it may not be revised again unless it is
unretired. The revision number of the replacement document is also incremented. If a document
needs to be replaced, it should be in an editable workflow state on the user's to-do list.

Unlike a new revision (created by a document workflow) in which references to its source
document are updated to refer to the new revision, references to the source of a replacement
document are not updated to refer to the replacement document. This can be important if you
need to maintain the existing configuration of references between assemblies, subassemblies,
and parts.

The difference between the Derive Document and Replace content commands is that derived
documents are not retired but replaced documents are retired and may not be revised again
unless they are unretired.

For a comparison of the various copy commands, see Copy Commands.

Notes about Functionality
l If the document type is not configured to calculate the file name, the file name of the

replacement document is set to Copy of <OriginalFilename>. Otherwise, the
replacement receives a newly calculated file name.

l A reference is made from the original document to the replacement document with the
reference type Replaced By. To view the reference, see View References.

l If the document type is configured to use a document type workflow, the new document
may be automatically placed under change to you.

l When you open a document in Autodesk Inventor, AutoCAD, MicroStation, or SolidWorks
and the document has references to other documents that have been replaced with the
Replace content command, you will be prompted to update the document to refer to the
replacements. The appropriate Meridian application link must be installed.

l You cannot use the Replace content action to replace documents in a batch.
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PowerWeb Procedures
Use these steps for PowerWeb. You cannot use the Replace content action to replace documents
in a batch.

To replace a document:

1. Select the document that you want to replace.

2. Choose between two options:
l On the Edit ribbon, in the Upload group, click Replace.

If the document type of the original document has been configured to show property
pages for the Replace content command, the pages are shown with the original
document's property values as defaults.

l From the context menu:

a. Right-click the selected document.

b. Select New > Copy > Replace.

3. If necessary, enter or modify property values for the new document.

4. Click OK.

A replacement document is created in the current folder with the same file content as the
original document.

PowerUser Procedures
Use these steps for PowerUser.

To replace a document:

1. Select the document you want to replace.

2. On the Editmenu, select Replace Document.

If the document type of the original document has been configured to show property pages
for the Replace Document command, the pages are shown with the original document's
property values as defaults.

3. If necessary, type or change property values for the replacement document and click OK.

A replacement document is created in the current folder with the same file content as the
original document.

Confidential and Proprietary © 2022 230 www.accruent.com



Duplicate References
The Copy with References, Derive with References, and Create Project Copy commands can
duplicate the Meridian references to and from a source document to the new document.
Alternatively, the referenced documents themselves can also be copied by the commands. These
commands use the Reference Explorer to help you see the documents with references to and
from the source document and to decide which references and/or documents to copy. This can
be useful if you want to create a new assembly or sub-assembly based on an existing document
and want to retain the references to existing subassemblies and parts or copy them also.

The default action of the commands can be either to create and reference copies of the original
assembly or to only reference the source assembly documents. This action is configurable by a
System Administrator for each document type. Your ability to override the default action (for
example, by selecting a referenced document for copying when the default action is to reference
the source document) is controlled by a security privilege that is part of your security role for the
source document folder. Likewise, referenced documents that are under change in a document
workflow cannot be copied and will display an error message.

By default, the Copy with References and Derive with References commands are only available
for AutoCAD, Autodesk Inventor, SolidWorks, and MicroStation files. Additional file types can be
enabled with the ExtForDuplicator value of the following registry key on your computer:
HKEY_LOCAL_MACHINE\Software\Cyco\AutoManager
Meridian\CurrentVersion\Client

PowerWeb Procedures
Use these steps for PowerWeb.

To duplicate references:

1. Select the document that you want to copy.

2. Choose one of the following options:
l From the Edit ribbon:

a. In the Copy group, click the arrow next to Copy.

b. Click Copy With References or Derive With References.

The page refreshes to show only the selected document and its references.
l Right-click the document, point to Copy and then select Copy with References or

Derive with References.
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l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Point to New and then select Copy with References or Derive with References.

3. If the document that you selected is a CAD assembly, in the Assembly ribbon, select options
in the Options group to show additional references as described in the following table.

In the Folder Structure group, select the option for how you want a folder structure created
for the referenced documents as described in the following table.

By default, all of the related documents are selected for the copy operation. If you have the
privilege to override the default, you can toggle the Select for Copy option to Select
Entire Branch for Copy or to Use Original for any documents that you do not want to
copy.

4. When you have finished selecting documents, click Start Copy.

The Copy with references dialog shows the reference structure of the documents that will
be copied.

If the document type of the source document or its referenced documents has been
configured to show property pages for copy commands, the pages are shown with the
original document's property values as defaults.

5. Type or change property values for the document that is highlighted in the reference
structure view.

6. If you want to apply the property values to all the referenced documents as well (assuming
they are of the same type), enable Apply for all documents of this type.

7. Click Next or Finish.

If you did not enable Apply for all documents of this type, additional property pages will be
shown for each reference to be copied. Documents with completed property pages are
indicated with this icon .

When all required property pages have been completed, a new document is created in the
current folder with the same file content and references as the original document. If the
default action is configured to create copies of referenced documents, copies of them are
created also. The Operation Log panel shows the result of the copy process.

8. When you are finished making copies, enable Go to copied assembly if you want to work on
the copy next, and then click Close.
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PowerUser Procedures
Use these steps for PowerUser.

To duplicate references:

1. Select the document that you want to copy or derive from.

2. Select the appropriate copy command depending on whether or not you want a reference
made between the original and new documents or you want to create a project copy.

The Select Folder dialog box appears.

3. Select a destination folder for the new document and click OK.

The Reference Explorer appears, listing the original document and the other documents that
either reference or are referenced by the original document. The entire assembly structure
can be displayed by expanding each referenced document. For information on using the
Reference Explorer, see Reference Explorer.

4. To configure command options, click the Options button .

The Assembly Copy Options dialog box appears.

5. Select options using the descriptions in the following table and click OK.

6. In the Reference Explorer, select (highlight) the documents for which you want to copy
references and/or documents and click OK.

If you do not have the privilege to override the default action, selected documents will
display a red X icon nearby.

Hold down the Ctrl key and click to select additional documents. Hold down the Shift key
and click to select a range of documents.

If the document type of the original document or its referenced documents has been
configured to show property pages for the Copy Document command, the pages are shown
with the original document's property values as defaults.

7. If necessary, type or change property values for the new document and click Next or Finish.

A new document is created in the selected folder with the same file content and references
as the original document. If the default action is configured to create copies of referenced
documents, copies of them are created also.
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Assembly Copy Options

Option Description

Display manual references Shows references that were created manually as well
as those created automatically by the CAD application
links.

Display inactive project copies Along with active project copies, also show project
copies that have been released as new master
revisions, have been superseded by the master
document, or have been merged with the master
document.

Copy drawing and presentation documents Copies any Autodesk Inventor presentation
documents related to the selected model. Enabled by
default.

Include connecting assemblies Copies the parent and child referenced documents in
addition to the selected document. If disabled,
references from the selected document remain
connected to the master documents. Enabled by
default.

Rebuild folder structure relative to the main
assembly

Builds a folder structure to contain the referenced
documents. It is built in the selected folder relative to
the main assembly. This is the default option.

Rebuild folder structure relative to each
subassembly

Builds a folder structure to contain the referenced
documents. It is built in the selected folder relative to
each sub-assembly.

Do not rebuild folder structure Does not build new folders to contain the referenced
documents.

Assembly copy options
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Meridian Clipboard
When you need to copy or move multiple items, PowerWeb provides a clipboard to make these
tasks easier. The clipboard works similar to the Windows clipboard except that it doesn't contain
a copy of the items' content. The clipboard remembers the items that you have added to it
regardless of your current view of the vault.

You can cut (move) or copy items to the clipboard from one location and then paste them into a
different location. Each time you place items on the clipboard, its previous contents are cleared
so that you can start over with a different set of items.

To copy or move items using the clipboard:

1. In any navigation view, select the items that you want to move.

2. Choose between two options:
l In the Vault ribbon, click Cut to Clipboard or Copy to Clipboard.
l In the shortcut menu, expand Vault and then click Cut to Clipboard or Copy to

Clipboard.

The current contents of the clipboard, if any, are cleared and the selected items are
placed on the clipboard. A corresponding icon appears in the navigation view to the
left of the name of each item on the clipboard, whether cut or copied .
A clipboard icon appears in the toolbar and indicates how many items are on the
clipboard.

3. Navigate to the location where you want to copy or move the items to.

4. Choose between two options:
l In the Vault ribbon, click Paste from Clipboard.
l In the shortcut menu:

a. Expand Vault.

b. Click Paste from Clipboard.

If the current view is a navigation view and not the Folders view, a folder
selection dialog box appears.

c. Select a destination folder and then click OK

If the document type of the source item has been configured to show property
pages for the Copy Document command, the pages are shown with the source
item's property values as defaults.
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d. If necessary, type or change property values for the items and click OK.

The items are copied or moved to the selected location depending on how they
were placed on the clipboard.

o If you clicked Cut to Clipboard in step 2, they are moved to the folder
selected in step 3.

o If you clicked Copy to Clipboard in step 2, they are copied to the folder with
the same file content as the source items.
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Change the Type Of a Document
Changing the document type of a document causes the document to take on all of the
characteristics of the destination document type: its file naming convention, workflow, revision
numbering, and so on. This is useful to transition a document from a pre-production phase to a
production phase of its life cycle. Another example is to change a document with a normal
document type to a hybrid document type.

Important!
If the document type you change to does not use the same properties as the original document
type, you will lose access to that information.

PowerWeb Procedures
Use these steps for PowerWeb.

To change a document's type:

l Choose one of the following options:
o From the context menu:

1. Select one or more documents.

2. Right-click your selection, point to Edit, then Organize, and select Change
Document Type.

The Change Document Type dialog box appears.

3. Select a new document type.

If a scope is active, document types that are not enabled for that scope will not
appear for your selection.

4. Click OK.

The document type of your selection is changed. PowerWeb will return an error
message for any documents in the batch that are locked.

o From the ribbon:

1. Select one or more documents.

2. In the Edit ribbon, in the Organize group, click Change Document Type.

The Change Document Type dialog box appears.
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3. Select a new document type.

If a scope is active, document types that are not enabled for that scope will not
appear for your selection.

4. Click OK.

The document type of your selection is changed. PowerWeb will return an error
message for any documents in the batch that are locked.

o From the Thumbnails view:

1. Right-click a thumbnail of a document.

2. Select Edit > Organize > Change Document Type.

3. Select a new document type.

If a scope is active, document types that are not enabled for that scope will not
appear for your selection.

4. Click OK.

The document type of the selected document is changed.

PowerUser Procedures
Use these steps for PowerUser.

To change a document's type:

1. Select the document that you want to change.

2. On the Documentmenu, select Change Document Type.

The Select Document Type dialog box appears.

3. Select a new document type.

If a scope is active, document types that are not enabled for that scope will not appear for
selection.

4. Click OK.

The document type of the selected document is changed.

Because changing the document type of a document cannot be performed on locked
documents, they will be automatically unlocked when the Change Document Type
command is executed.
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Delete and Undelete Documents and Folders
Deleting a document or folder removes it from view. However, it does not remove it permanently
from the vault. The item can be restored to its original location, similar to restoring files from the
Windows Recycle Bin. The difference is that Meridian does not store all deleted documents in one
location but rather tracks deleted documents according to their parent folder.

Notes About Functionality
l Folders are deleted recursively by both PowerUser and PowerWeb, similar to Windows. This

means that deleting a folder that contains sub-folders will also delete the sub-folders and
the documents they contain. The confirmation dialog box shows how many child items
would be deleted if the user proceeds.

l Folders and their contents are undeleted recursively by PowerUser but not undeleted
recursively by PowerWeb. Undeleting a folder in PowerWeb only restores the folder, not its
contents. You must undelete the child folders and documents individually.

l Deleted documents that have never been released in the vault cannot be undeleted. In
other words, new documents cannot be undeleted until after they have been released at
least once.

l References to deleted documents are not restored by Undelete.

PowerWeb Procedures
Use these steps for PowerWeb.

Delete a Document or Folder
To delete a document or folder:

1. Choose one of the following options:
l Right-click the document or folder that you want to delete, point to Edit and then click

Delete.

A dialog box opens, asking you to confirm your choice.
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l From the ribbon:

a. Select the document or folder that you want to delete.

b. In the Edit ribbon, in the Organize group, click Delete.

A dialog box opens, asking you to confirm your choice.
l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Select Edit > Delete.

A dialog box opens, asking you to confirm your choice.

2. Click OK.

The document or folder is deleted.

Undelete a Document or Folder
To undelete a document or folder:

1. Choose one of the following options:
l Right-click the folder from where the document was deleted, then select Edit >

Organize > Undelete.

The Deleted folders and documents dialog box appears.
l From the ribbon:

a. Select the folder from where the document was deleted.

b. In the Edit ribbon, in the Organize group, click Undelete.

The Deleted folders and documents dialog box appears.
l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Select Edit > Organize > Undelete.

2. Select the items that you want to undelete.

3. Click Undelete.

The items are restored.
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PowerUser Procedures
Use these steps for PowerUser.

Delete a Document or Folder
To delete a document or folder:

1. Select the document or folder you want to delete.

2. Choose one of the following options:
l On the Editmenu, select Delete.
l Right-click the item and select Delete on the shortcut menu.
l Press Ctrl+D.
l Press Delete.

You are prompted to confirm that you want to delete the item. If the item is a
document and it has incoming references, you are prompted to confirm that you want
to delete the document.

3. Click Yes.

Undelete a Document or Folder
To undelete a document or folder:

1. Select the parent folder of the item that was deleted.

2. On the Document or Foldermenu, select Undelete.

The Deleted Folders and Documents dialog box appears, listing items that have been
deleted from the selected folder but have not yet been purged from the vault.

3. Select the item you want to restore and click Undelete.

4. Click Close.

The item is restored to its original location.
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Purge Documents And Folders
Deleted documents and folders are removed from view, but not permanently removed from the
vault. To permanently remove a document or folder and all of its data so that it cannot be
undeleted, you must purge it. A document or folder must first be deleted before it can be purged.

Important!
Purged documents and folders cannot be restored except by restoring the entire vault from
backup. Doing so loses all changes made to the vault since the backup was made. Be absolutely
certain that you want to proceed.

PowerWeb Procedures
Use these steps for PowerWeb.

To purge a document or folder:

l Choose between two options:
o From the context menu:

1. Right-click the folder from where the document or folder was deleted, point to
Edit, and then click Undelete.

The Deleted folders and documents dialog box appears listing items that have
been deleted from the selected folder but have not yet been purged from the
vault.

2. Select the items that you want to purge and click Purge.

A dialog box opens, asking you to confirm your choice.

3. Click Yes.

The items are purged from the vault.

4. Click Close.
o From the ribbon:

1. Select the folder from where the document or folder was deleted.

2. In the Folder ribbon, in the Action group, click Undelete.

The Deleted folders and documents dialog box appears.

3. Select the items that you want to purge and click Purge.

A dialog box opens, asking you to confirm your choice.
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4. Click Yes.

The items are purged from the vault.

5. Click Close.

PowerUser Procedures
Use these steps for PowerUser.

To purge a document or folder:

1. Select the parent folder of the document or folder that you want to purge.

2. On the Foldermenu, select Undelete.

The Deleted Folders and Documents dialog box appears listing items that have been
deleted from the selected folder but have not yet been purged from the vault.

3. Select the item that you want to purge and click Purge.

A dialog box opens, asking you to confirm your choice.

4. Click Yes.

The item is purged from the vault.
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View Prior Revisions
If the vault is configured to maintain history, you can view the prior revisions of a document. If
not, you can only view the current released revision and the copy in progress, if any.

PowerWeb Procedures
Use these steps for PowerWeb.

To view the prior revisions of a document:

1. Choose between two options:

l In the view bar, click the Revisions icon .
l Select the document for which you want to view prior revisions.

2. In the Document ribbon, in the Information group, click Show Revisions.

The Revisions page of the document appears in the document pane.

3. Click a revision's name to view the selected revision of the document in a new browser tab.

Right-click a revision and select commands from the shortcut menu to perform various
actions described in the Shortcut Menu Commands section below.

PowerUser Procedures
Use these steps for PowerUser.

To view the prior revisions of a document:

1. Select the document for which you want to view prior revisions.

2. On the Documentmenu, select Show Revisions.

The Revisions dialog box appears, similar to the following figure. The Revisions tab lists the
prior revisions of the selected document. The Baselines tab lists the existing baselines that
include specific revisions of the document.
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Note:
If a revision of a document has hybrid document parts attached to it, plus and minus (+
and -) symbols will appear to the left of the document name similar to those shown in
Navigation views. You can click these symbols to expand or collapse display of the hybrid
document parts. The revisions of the hybrid document parts that are shown are the
revisions that were effective when the main document part was released.

3. Choose between two options:
l Select a revision and click a command button on the toolbar.

The available commands are described in the Revisions Window Commands section
below.

l Right-click a revision and select a command from the shortcut menu.

The available commands are described in the Shortcut Menu Commands section
below.

Revisions Window Commands

Button Command Description

Open in
Application

Opens the selected revision in the application registered in Windows
for the revision's file extension. The icon on this button is different
for each file type. This example is for an AutoCAD drawing file. Prior
revisions will be opened read-only.

Revisions window toolbar buttons
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Button Command Description

View Document Opens the selected revision in a new viewer window.

Compare Select any two revisions and click this button compare the revisions
graphically. See also Compare Files.

Properties Opens a new window displaying the property pages of the selected
revision. Prior revisions will be opened read-only.

Display revisions as large icons, small icons, a list, or a detailed list,
respectively.

Shortcut Menu Commands

Shortcut
Menu
Command

Description

Compare Select any two revisions and click this button to compare the revisions graphically.
See also Compare Files.

Revert to This
Revision

Creates a copy of the selected revision as a new revision of the document,
increments the revision number, and places the revision under change to you.
In PowerUser you can revert to the latest released revision, but in PowerWeb you
can only revert to an outdated revision. You cannot revert to an 'intermediate'
revision that was created when a document was under change.

Restore This Part Restores the selected revision of a hybrid document part to the current revision of
the main document.

Shortcut menu commands
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View Vault History
Viewing vault history allows you to see the contents of the vault as it existed at a specific moment
in time: its documents, revisions, references, content, and so on.

PowerWeb Procedures
Use these steps for PowerWeb. To access this feature, you must enable viewing the vault at a
baseline in your personal preferences.

This feature was added in the 2022 release.

To view vault history:

1. Click the Now filter to the right of the Collections menu.

A menu opens.

2. Select Go to specific date or time.

The Go to Date/Time window opens.

3. Use the fields to select the date and time you want to view.

4. Click OK.

The vault is opened to the date and time you selected. The Now filter is replaced with the
date and time you selected, and the background of the page changes to a light gray to
indicate you are viewing the vault in the past. All editing commands are disabled.

5. Choose between two options:
l To return to viewing the vault in the present time:

a. Click the history filter.

This filter is labeled with the date and time you are currently viewing.

A menu opens.

b. Select Now.

The vault is returned to the present time.
l To view another point in the past:

a. Click the history filter.

This filter is labeled with the date and time you are currently viewing.

A menu opens.

b. Follow steps 2-4 above.
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PowerUser Procedures
Use these steps for PowerUser.

To view vault history:

1. Click the current time context button in the context bar.

This button has a clock and the word Now on it.

The Go to Date/Time dialog box appears.

2. Select Baseline or set Specific Date/Time to the moment you want to view.

3. Click OK.
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Create a Baseline
To create a baseline:

1. View the vault at the moment in time for which you want to create the baseline.

2. Click Baselines on the Vaultmenu.

The Baselines dialog box appears.

3. Click the New button .

A new baseline is added to the list.

4. Type a name for the baseline and press Enter.

5. Click Close.

You can now view this baseline at any time by selecting it either in the Baselines dialog or
from the list shown by clicking the context button on the context bar.
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Compare Files
To compare files, PowerWeb displays a unique viewing page that shows the renditions of the
selected documents. The two files can be two revisions of the same rendition file or two similar
but unrelated renditions that you want to compare visually. The page allows you to see either of
the renditions alone or a simultaneous view of both renditions that displays the additions,
deletions, and unchanged objects between the two files in symbolic colors:

l Green — additions
l Red — deletions
l Black — unchanged

To compare files, PowerUser displays a unique multi-pane window. Two of the panes show two
files side-by-side. The two files can be two revisions of the same source or rendition file or two
similar but unrelated files that you want to compare visually. The area of the files shown in the
two panes are synchronized with one another. When you change the view of one file, the view of
the other file is changed automatically to match the first file. This makes it easy to compare files
without adjusting the views, sizes, and positions of separate windows.

If the files being compared are supported vector (CAD) graphics files, the lower-right pane shows
the additions, deletions, and unchanged objects between the two files in configurable colors. The
lower-left pane contains options to change the colors. This graphical representation of changes is
valuable for quickly determining the differences between two complex files. You can print a hard
copy of the differences and also generate a report of the non-graphical differences between two
files, for example, layer names, system variables, and so on.

Note:
l Comparing source files is only supported by the AutoVue viewer (available separately).

Comparing renditions is supported by the built-in PDFTron viewer or the AutoVue viewer
(available separately).

l In Meridian 2021, comparing renditions using the built-in PDFTron viewer does not
automatically recalculate the difference after you pan the document. To recalculate the
difference, click Refresh.

l Graphics that have been moved but that are otherwise unchanged are considered by
Compare as a deletion from one document and an addition to the other document.
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PowerWeb Procedures
Use these steps for PowerWeb.

To visually compare two renditions:

1. Select two documents that you want to compare.

2. Choose between two options:
l Right-click one of the documents, point to Document, and then click Compare

Renditions.

The Compare Renditions page appears.
l In the Document ribbon, in the Action group, click Compare Renditions.

The Compare Renditions page appears.

3. Use the options of the page as described below.

4. Click Exit.

Option Description

Keep in sync When enabled and you switch from one rendition to the other, the viewing area
remains the same so that you don't have to manually match the viewing area of
one rendition to the other. When disabled, the viewing area is not synchronized so
that you can easily view different areas of each rendition and switch between
them.

Rev.<lowest> Displays only the first rendition.

Rev.<highest> Displays only the second rendition.

Difference Displays both renditions simultaneously with the colors indicated by the legend in
the bottom right corner of the page.

Refresh Refreshes the current view to show any changes that have been made to renditions
since you first opened the page.

Swap Reverses the comparison order of the renditions.

Compare Renditions page options
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PowerUser Procedures
Use these steps for PowerUser.

To visually compare two files:

1. Use Ctrl+click to select one of the following:
l Two similar documents from a Navigation view
l Two revisions of the same document from the Revisions dialog
l One document in a briefcase to compare with its original in the vault. Meridian

Enterprise will automatically select the original document

2. Click the Compare button .

The Compare dialog box appears, similar to the following figure.

3. Use the tools in the toolbar or the shortcut menu to change the view of the documents.

All panes remain synchronized on the same area of the documents.

Note:
Automatic pane synchronization is not supported for all formats in all viewer plug-ins, for
example, PDF by the AutoVue 2D Professional viewer plug-in. When working with an

unsupported combination, click the Synchronize button to manually synchronize the
views.
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Use the browse buttons or corresponding shortcut menu commands to load
different revisions of the same documents, different documents from the vault, or
documents that reside outside the vault for comparison.

4. Click options or type values using the descriptions in the following table.

Option Description

Show
additions

Displays graphics in the right document that do not exist in the left document. Select a
color to display additions from the list.

Show
deletions

Displays graphics in the left document that do not exist in the right document. Select a
color to display deletions from the list.

Show
unchanged

Displays graphics that are identical in both documents. Select a color to display
unchanged graphics from the list.

Report Displays a report of the invisible changes between the two documents. The information
can be saved to a file where it can be printed. Not available for raster documents. This
option is only available if the current viewer is the ICViewPlugin viewer.

Print
Differences

Prints the graphics in the Compare Result pane to a printer.

Compare
property
values

Compares and optional updates the property values of one document with the property
values of another document. To compare the property values of the two documents,
see Compare Document Property Values.

Compare window options
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Compare Document Property Values
Comparing property values allows you to easily see the differences between the property values
of two similar documents. It also allows you to update the property values in custom property
sets of one of the documents with the values of the other document. You cannot update internal
property values.

Note:
To update property values requires the Set Property Value privilege.

Use these steps for PowerUser and PowerWeb.

To compare document property values:

1. Select two documents and open the Compare dialog as described in Compare Files.

You can open the Compare Property Values dialog immediately by pressing the Ctrl key

while clicking the Compare button .

2. In the Compare dialog, click Compare property values.

The Compare Property Values dialog box appears similar to the following figure.

The names and revision numbers of the selected documents are shown at the top of the
dialog box so that you can distinguish between the two documents. The names of each
property used by the documents appear in the Property column below each document
grouped by property sets, which appear as shaded rows.

Confidential and Proprietary © 2022 254 www.accruent.com



Properties that have the same value for both documents appear in black text in the Value
column. Property values that are different between the two documents appear in red text.
Properties that are empty display <No Value>. By default, only the properties in the Custom
property set are shown.

3. To show the properties contained in the internal property sets, select Show internal
properties.

4. To show only the properties that are different between the two documents, select Show
differences only.

5. To update the property of one document with the property value of the other document:

a. Select the check box next to the property value that you want to apply.

b. Click the arrow button that points to the document to which you want to apply the
selected value.

The value is applied to the other document and the text color changes to black to
indicate that the property values are identical.

The validation settings of custom properties are not evaluated when properties are
updated this way.

6. Click OK to close the Compare Property Values dialog.
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Print a Document
The Meridian document viewer allows you to print all or selected pages of a document to any
Windows system printer.

PowerWeb Procedures
Use these steps for PowerWeb.

Before printing a document, you can zoom to a particular part of the document and then you can
use the Print view button on the Print dialog box to print that view.

Note:
When you print a document whose source is a PDF, and the PDF does not have a rendition,
PowerWeb prints the source PDF instead of generating a rendition.
If the PDF has a rendition, PowerWeb will print the rendition.

To print a document:

1. Click the Print toolbar button.

The Print dialog box opens.

2. Select the print options you want:
l All— All pages.
l Current— Current page.
l Page numbers— Enter specific page numbers to print separated by commas such as

1,2,5 or enter a range of pages for example 2-6. Total indicates the number of pages to
be printed.

l Include Comments— Include comments on the printout. This has no effect when
printing a view.

l Include Annotations— Include annotations on the printout. This has no effect when
printing a view.

3. Choose between two options:
l If you want to only print the current view, click Print view.
l Otherwise, click Print.

The browser print dialog opens. If the document is configured to so, a watermark
appears on the printed document.

4. Click Print.
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PowerUser Procedures
Use these steps for PowerUser.

To print a document:

1. Click the Print button .

The Pages dialog box appears.

2. Select All to print the entire document or type page numbers separated by commas (1,2,5,
for example) or type a page range (1-5, for example) in the text box.

Total updates to indicate the number of pages that will be printed.

3. Click Print.

A progress bar updates as the specified pages are prepared for printing and the Windows
Print dialog box appears.

4. Select the printer where you want to send the pages, set other options as necessary, and
click Print.

The specified pages are printed on the selected printer.

5. Repeat steps 2 to 4 if you want to print additional pages or click Done if you are finished
printing.
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Email Documents
You can send vault documents by email either as attachments to messages from the PowerUser
or as shortcuts from PowerWeb.

Note:
The attachments or shortcuts that you send in email messages correspond to the latest released
revision of the documents in the context from which they were added to the message.

PowerWeb Procedures
Use these steps for PowerWeb.

To send document shortcuts from within PowerWeb:

1. In any Navigation view, click the document name hyperlink of the document that you want
to send.

The document's property pages appear.

2. On the Document property page, select the URL that appears at the bottom of the page and
copy it to the Windows Clipboard.

The URL can be useful for more than just email messages. The URL can be pasted into any
application that supports hyperlinks.

3. In your email application, paste the URL as a link using the email application's normal
command.

4. Select recipients, type a message subject, type additional text as desired, and send the
message as you normally would.

PowerUser Procedures
Note:
The Messaging Application Programming Interface (MAPI) must be enabled on your PC for this
command to be available.

To send documents from PowerUser:

1. In any Navigation view, select the documents that you want to send.

2. On the Document menu, select Send to Email Recipient.

The Email Documents dialog box appears.
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3. Click options or type values using the descriptions in the following table.

4. Click OK.

A new email message is opened in your default email application with the document
attachments or shortcuts that you selected added to the message.

5. Select recipients, type a message subject, type additional text as desired, and send the
message as you normally would.

Option Description

Attach
document

Attaches a copy of each selected document to the email message. No workflow is
started for the document and the copy is not tracked by Meridian.
You can also attach vault documents to an email message by dragging them from any
Navigation view and dropping them onto an open message window just as you would
from Windows Explorer.

Add
PowerUser
Shortcut

If Microsoft Outlook is installed on your PC, Meridian adds a shortcut to the body of the
email message that the recipient can click to open the document in PowerUser.
If Microsoft Outlook is not installed on your PC, Meridian adds a vault query for the
document to the body of the email message. Recipients can copy and paste the query
into Windows Explorer to open the Meridian vault in PowerUser with the document
selected.

Add
PowerWeb
URL

Adds the URL of the document to the body of the email message. Recipients can copy
and paste the URL into Internet Explorer to open the vault in PowerWeb with the
document selected.

Attach
rendition

Attaches a copy of the current rendition of the document to the email message.

Email options
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Subscribe To Changes
When you are responsible for important documents that could be changed by others, you might
want to be notified when changes occur of which you are not aware. You can subscribe to those
documents to receive email messages when events occur that you are interested in. You may also
subscribe to receive reminders for specific documents for which a System Administrator has
configured periodic reminders. If you have the Allow Management of Subscriptions for others
privilege, you can add or remove subscriptions for other users.

Notes About Functionality
l You might also receive event notifications or reminders for documents to which you did not

subscribe. These could be the result of automatic notifications configured by a System
Administrator.

l For folder subscriptions you can subscribe to events that occur on documents contained in
the folder at that moment. If a document is added to the folder later, you are not
automatically subscribed to that document. For project subscriptions, you can subscribe to
events that occur on the project, such as project workflow transitions.

l Subscriptions require some configuration by a System Administrator. Also, you must be a
member of a group that has been granted the Allow Subscriptions or Allow Management
of Subscriptions for others privileges in the folder containing the documents that you want
to subscribe to. See the Security Privilege Descriptions section of theMeridian Enterprise
Configuration Guidefor more information.

l Notifications are only sent to your primary email address as set by a System Administrator
and as described in the Create and edit user accounts article in theMeridian Enterprise
Administrator's Guide.

PowerWeb Procedures
Use these steps for PowerWeb.

Subscribe to Document or Folder
To subscribe to changes on a document or folder:

1. In any navigation view, select the documents or folders that you want to change
subscriptions for.

Confidential and Proprietary © 2022 260 www.accruent.com



2. Choose one of the following options:
l In the Document or Folder ribbon, in the Action group, click Subscribe.
l Right-click anywhere within your selection, point to Document, and then click

Subscribe on the shortcut menu that appears.

The Subscribe dialog box appears and lists the available events and reminders that you
can subscribe to. The events to which you have already subscribed are selected.

l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Choose between two options:
o Select Folder > Subscribe.
o Select Document > Subscribe.

3. Select events you want to subscribe to for the selected documents or folders.

4. Click Next.

The next page of the dialog box opens.

5. Choose between two options:
l If you have the Allow Management of Subscriptions for others privilege, select the

users who should receive notifications about the selected documents.

You can only deselect yourself if at least one other user is selected.
l If you do not have the Allow Management of Subscriptions for others privilege,

proceed to step 6.

6. Click Next.

The next page of the dialog box opens. This page lists the changes you have made and asks
you to confirm them.

7. Click OK.

Unsubscribe from Document or Folder
To unsubscribe from changes on a document or folder:

1. In any navigation view, select the documents or folders that you want to change
subscriptions for.

2. Choose one of the following options:
l In the Document or Folder ribbon, in the Action group, click Unsubscribe.
l Right-click anywhere within your selection, point to Document, and then click

Unsubscribe on the shortcut menu that appears.
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The Unsubscribe dialog box appears and lists the available events and reminders that
you can unsubscribe from.

l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Choose between two options:
o Select Folder > Unsubscribe.
o Select Document > Unsubscribe.

3. Select events you want to unsubscribe from for the selected documents or folders.

4. Click Next.

The next page of the dialog box opens.

5. Choose between two options:
l If you have the Allow Management of Subscriptions for others privilege, select the

users who should no longer receive notifications about the selected documents.

You can only deselect yourself if at least one other user is selected.
l If you do not have the Allow Management of Subscriptions for others privilege,

proceed to step 6.

6. Click Next.

The next page of the dialog box opens. This page lists the changes you have made and asks
you to confirm them.

7. Click OK.

Subscribe to Project
To subscribe to changes on a project:

1. In any navigation view, select the projects that you want to change subscriptions for.

2. Choose one of the following options:
l To take action from the Folder ribbon:

a. In the Folder ribbon, in the Action group, click the down arrow next to Subscribe.

b. Select Subscribe to Project from the menu that appears.
l Right-click anywhere within your selection, point to Folder, and then click Subscribe to

Project on the shortcut menu that appears.

The Subscribe dialog box appears and lists the available events and reminders that you
can subscribe to. The events to which you have already subscribed are selected.
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l From the Thumbnails view:

a. Right-click a thumbnail of a folder.

b. Select Folder > Subscribe to Project.

3. Select events you want to subscribe to for the selected projects.

4. Click Next.

The next page of the dialog box opens.

5. Choose between two options:
l If you have the Allow Management of Subscriptions for others privilege, select the

users who should receive notifications about the selected documents.

You can only deselect yourself if at least one other user is selected.
l If you do not have the Allow Management of Subscriptions for others privilege,

proceed to step 6.

6. Click Next.

The next page of the dialog box opens. This page lists the changes you have made and asks
you to confirm them.

7. Click OK.

Unsubscribe from Project
To unsubscribe from changes on project:

1. In any navigation view, select the project that you want to change subscriptions for.

2. Choose one of the following options:
l To take action from the Folder ribbon:

a. In the Folder ribbon, in the Action group, click the down arrow next to
Unsubscribe.

b. Select Unsubscribe from Project from the menu that appears.
l Right-click anywhere within your selection, point to Folder, and then click Unsubscribe

from Project on the shortcut menu that appears.

The Unsubscribe dialog box appears and lists the available events and reminders that
you can unsubscribe from.

l From the Thumbnails view:

a. Right-click a thumbnail of a folder.

b. Select Folder > Unsubscribe from Project.

3. Select events you want to unsubscribe from for the selected documents.
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4. Click Next.

The next page of the dialog box opens.

5. Choose between two options:
l If you have the Allow Management of Subscriptions for others privilege, select the

users who should no longer receive notifications about the selected documents.

You can only deselect yourself if at least one other user is selected.
l If you do not have the Allow Management of Subscriptions for others privilege,

proceed to step 6.

6. Click Next.

The next page of the dialog box opens. This page lists the changes you have made and asks
you to confirm them.

7. Click OK.

PowerUser Procedures
Use these steps for PowerUser.

To subscribe to or unsubscribe from changes:

1. In any navigation view, select the documents that you want to change subscriptions for.

2. On the Document or Foldermenu, select Change Subscription.

The Change Subscription dialog box appears and lists the available events and reminders
that you can subscribe to. The events to which you have already subscribed are selected.

Changes to the selected events in this list are not saved if you click the Subscribers button
and will be reset when that dialog is closed. If you want to change the subscriptions of other
users, select the subscribers in the next step first and then change the events to which they
are subscribed.

3. To change the subscriptions of other users:

a. Click Subscribers.

The Subscribers dialog box appears and lists all system users. By default, your name is
selected to change only your subscription options.

b. Select or clear user names to change their subscriptions to the selected items.

c. Click OK.

4. Select or clear events and reminders to change the subscriptions to the selected items for
the users that you selected.

The check boxes shown by this dialog box can represent three states that indicate how
many of the selected subscribers are subscribed to the corresponding event.
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5. To view the names of the subscribers for a specific event, select the event and click
Subscribers.

The Subscribers dialog box appears and lists the users that are subscribed to the selected
event.

6. Click OK.
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View And Remove Subscriptions
You can view all of your subscriptions at once with the subscriptions viewer in a web browser.
There you can filter and sort subscriptions to meet your needs and remove unwanted
subscriptions.

Note:
A System Administrator must install and configure subscriptions to use this command.

PowerWeb Procedures
Use these steps for PowerWeb.

To open the subscriptions viewer:

1. In any navigation view, select the documents or project folders that you want to change
subscriptions for.

2. In the Document or Folder ribbon, in the Actions group, click Change Subscription.

A page titledMeridian: Subscriptions viewer opens in a new tab. The subscriptions are
sorted on the column indicated by the arrow icon in the column heading. Your privileges to
manage the subscriptions are shown at the bottom of the page.

3. To change the sort order or select a filter:

a. Point to a column heading.

b. Click the arrow button that appears.

c. Click the sort option or filter that you want on the shortcut menu that appears.

If you selected a sort option, the arrow icon appears in that column heading. If you
selected a filter, the filter icon appears in that column heading.
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PowerUser Procedures
Use these steps for PowerUser.

Open Subscriptions Viewer
To open the subscriptions viewer:

1. In the Tools menu, click View Subscriptions.

A page titledMeridian Enterprise 2022: Subscriptions viewer opens in a browser window.
The subscriptions are sorted on the column indicated by the arrow icon in the column
heading. Your privileges to manage the subscriptions are shown at the bottom of the page.

2. Continue as described in step 2 above.

Remove Subscriptions
To remove subscriptions:

l Select the subscriptions that you want to remove, select Unsubscribe in the command list,
and click Execute.

The view refreshes to show the subscriptions removed.
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Change a Document's Revision Number
Under most circumstances, the revision number of an existing document will not need to be
changed. That is, if the document is created new within the vault, Meridian Enterprise will assign
the correct revision number. When the document is revised in a workflow, its revision number is
updated accordingly. Even if existing documents are imported into the vault, as long as accurate
metadata is imported or application link data exchange is configured, the revision numbers of
documents should be correct. But occasionally there are circumstances when the revision number
of a document must be changed manually.

Regardless of the current value of the Revision property, revisions of the document will display in
chronological order in the Revisions dialog displayed by invoking the Show Revisions command.

You must be granted the Change Revision Number Manually privilege to perform this action, as
described in the Security Privilege Descriptions article in theMeridian Enterprise Configuration
Guide.

PowerWeb Procedures
Use these steps for PowerWeb.

To change the revision number of an existing document:

1. Select the document that you want to change.

2. Choose one of the following options:
l In the Edit ribbon, in the Organize group, clickModify Revision Number.

The Confirm Revision Number Change dialog box appears.
l Right-click the document, then select Edit > Organize >Modify Revision Number.
l From the Thumbnails view:

a. Right-click a thumbnail of a document.

b. Select Edit > Organize >Modify Revision Number.

3. Type a new revision number in New revision number.

4. Click Yes.

The revision number is changed.

PowerUser Procedures
Use these steps for PowerUser.

To change the revision number of an existing document:
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1. Select the document that you want to change.

2. Click the Document tab to display the Revision property.

3. Click Edit.

The Revision property becomes editable.

4. Change the value of Revision and click OK.

The revision number is changed.
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Issue a New File Name
Under most circumstances, the file name of an existing document will not need to be changed.
That is, if the document is created new within the vault, Meridian will assign the correct file name
if the document is assigned a document type that is configured to calculate file names. But
occasionally there are circumstances when the file name of a document must be reissued, such as
after importing documents with file names that do not conform to the document type standard.

The Issue New File Name command executes the same process as that which occurs when a new
document is created. If the document type is configured to calculate file names with a sequence
number, the next available sequence number is used.

PowerWeb Procedures
Use these steps for PowerWeb.

To issue a new file name for a document:

1. Select the document for which you want to issue a new file name.

2. Choose one of the following options:
l In the Edit ribbon, in the Organize group, click Issue New File Name.

The file is renamed.
l Right-click the document, then select Edit > Organize > Issue New File Name.
l From the Thumbnails view:

a. Right-click a thumbnail of a document.

b. Select Edit > Organize > Issue New File Name.

PowerUser Procedures
Use these steps for PowerUser.

To issue a new file name for a document:

1. Select the document for which you want to issue a new file name.

2. On the Documentmenu, select Issue New File Name.

The file is renamed.
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Rename Document
This article describes how to rename a document. You cannot rename a document if it is under
change or locked.

PowerWeb Procedures
Use these steps for PowerWeb.

To rename a document:

1. Select the document that you want to rename.

2. Choose one of the following options:
l In the Edit ribbon, in the Organize group, click Rename.

The Confirm Document Rename dialog box appears.
l Right-click the document, then select Edit > Organize > Rename.

The Confirm Document Rename dialog box appears.
l From the Thumbnails view:

a. Right-click a thumbnail of a document.

b. Select Edit > Organize > Rename.

The Confirm Document Rename dialog box appears.

3. Type a new name in New name of the document.

4. Click Yes.

The name is changed.

PowerUser Procedures
Use these steps for PowerUser.

To rename a document:

1. Select the document that you want to change.

The document must be available for changes before you can rename it.

2. Click the Editmenu in the toolbar and select Rename.

Alternatively, you can press F2 on your keyboard.

The document name becomes editable.

3. Rename the document.
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You cannot change the file extension for the document using the Rename action.

4. Click off the document or press Enter on your keyboard.

The document is renamed.
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References
If a vault only uses reference types that are managed automatically by Meridian, then your
responsibility in managing references is minimized to simply viewing and verifying references. But
if a vault also uses reference types that are created manually, then reference management can
also include creating and deleting references.
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View References
Meridian makes it easy to view and understand the references between documents.

PowerWeb Procedures
Use these steps for PowerWeb.

To view the references of the selected document:

1. Choose between two options:

l In the view bar, click the References icon .
l On the Document ribbon, in the Information group, select Show References.

The References page of the document appears in the document pane. It shows
manually created references plus any CAD external references. Information about the
selected document is shown at the top of the page.

References to the selected document are listed in the Incoming references panel.
References from the selected document to other documents are listed in the Outgoing
references panel. To the right of each document name is an icon that shows the
document's status and the revision number of the document.

2. From this page, you can view more or fewer documents:
l To view only the references of a particular reference type, click Select and then select

the reference types that you want to see from the Select reference types list.

By default, all reference types are shown.
l To make one of the referenced documents the selected document and display its

property pages, click its name.
l To view a referenced document in a viewer window, click its document icon.
l To select a referenced document and view its respective references, click the Change

to this document icon .
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PowerUser Procedures
Use these steps for PowerUser.

View all References for a Document
To view all references of the selected document:

l Click the Show Referenced Documents button on the Document property page.

A dialog box appears, similar to the following figure. The file name of the selected document
appears in bold. References to and from other documents appear as arrows; the arrowhead
indicates the direction of the reference, either incoming or outgoing. The type of the
reference appears as a yellow label in the middle of the arrow.

Note:
Project copies that have already been released as new revisions of the master documents
appear crosshatched if the Display inactive project copies option is enabled as described
in Show Master And Project Copies.

View Only Certain Types of References
This command is ideal for viewing references without regard to the location of the referenced
documents in the vault. An alternative method of viewing references is with the Reference
Explorer. It displays the same referenced documents, but it also displays each document's
location in the vault. It also provides tools for previewing, comparing, and viewing revisions. For
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more information, see Reference Explorer.

To view only references of a certain type:

l Select the reference type from the list in the toolbar.

The toolbar buttons are described in the following table.

Button Description

Show the property pages of the selected document.

Deletes the selected reference.

Opens the selected document in its native application. Also available on the
context menu that is shown by right-clicking a document.

Makes a referenced document the selected document. Also available on the
context menu that is shown by right-clicking a document.

Opens the selected document in a new viewer window.

Reference browser toolbar buttons
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Create References
Creating a reference establishes a link between two documents so that they can be found
together, the effect of a revision can be traced, and the origins of derivative or replacement
documents can be traced.

Note:
Meridian does not support circular references. That is, any combination of documents that,
when referenced to one another, create a circular path.

PowerWeb Procedures
Use these steps for PowerWeb.

Create References by Selecting Documents

Note:
The reference source document and destination documents must be visible in the same view to
create references.

To create references by selecting documents:

1. Select the documents that you want to link.

2. Right-click the document that you want to be the destination of the links.

3. Point to Document and then click Create References.

The Create References dialog box appears.

4. To reverse the direction of the references, click Reverse.

5. Select a reference type from Reference Type and then click OK.

The references are created as indicated by the Show Referenced Documents icon on
the Document property pages of the linked documents.
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Create References by Searching for Documents
To create references by searching for documents:

1. Choose one of the following options:
l From the context menu:

a. Right-click one of the documents that you want to link.

b. Point to Document and then click Create References.

The Find destination documents for reference dialog box appears.
l In the Document ribbon, in the Action group, click Create References.

This option is not available if multiple documents are selected.

The Find destination documents for reference dialog box appears.
l From the Thumbnails view:

a. Right-click a thumbnail of a document.

b. Select Document > Create References.

The Find destination documents for reference dialog box appears.

2. Select a reference type from Reference Type.

3. Type the beginning or all of the name of the documents that you want to link to in Name or
type keywords for other properties in Quick Search and press Enter.

The matching document names appear in the list.

4. Select the documents that you want to link to the source document and then click Create
References.

The references are created as indicated by the Show Referenced Documents icon on
the Document property pages of the linked documents.

PowerUser Procedures
Use these steps for PowerUser.

To create a reference:

1. Select one of the documents to be linked.

If the other document to be linked is also visible, select it also.

2. On the Documentmenu, select Create Reference.

If you only selected one document, the Select Documents dialog box appears.

3. Select the other document to be linked and click OK.
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The Create Reference dialog box appears listing the documents to be linked.

4. To reverse the direction of the reference, click Reverse.

5. Select a reference type from Reference Type and then click OK.

The reference is created as indicated by the Show Referenced Documents icon on the
Document property pages of both documents.
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Synchronize References
Note:
This topic refers to all of the application links described in this chapter except the Lotus Notes
link.

The references that are created by Meridian to manage the external references of a document
can be synchronized from the document. This helps keep the Meridian references synchronized
when external references are added or deleted in the document's native application. It is also
necessary when external references are added to the vault by methods that bypass the native
application.

Reference detection and management is primarily performed by the Meridian application link
from within the native application. It is also performed by the Meridian import tools. But if the
link is not loaded in the native application or documents with references are imported to the
vault without using the Meridian import tools, the external references are not detected and
Meridian references are not automatically created. In that case, synchronization must be
performed manually.

Meridian references are created and synchronized in the following ways:

l Importing new documents with the Document Import Tool and the Resolve references
option enabled as described in Document Import Tool.

l Importing new documents with Assembly Import tool described in Import Assemblies.
l Opening or saving documents in the vault from within an application that has a Meridian

application link loaded. This is also supported by Remote mode as described in Offline Mode
And Remote Mode and in Application Links In Remote Mode.

l By the References from File or Synchronize References command as described in the
following procedures.

Note:
We recommend you close files in AutoCAD or synchronize files from within AutoCAD. This is
because with some versions of AutoCAD, synchronizing references with some AutoCAD files—
such as sheet set files—from within PowerUser while the file is open in AutoCAD can produce
an error.
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PowerWeb Procedures
Use these steps for PowerWeb. Synchronization can be applied to AutoCAD, MicroStation, and
Microsoft Office files only. References can be synchronized from different file types.

The References from File action triggers the publishing job configured for the Synchronize
References setting in your vault settings. This setting is described in Configure a Vault For
Publisher in theMeridian Enterprise Configuration Guide.

To manually synchronize Meridian references of a document:

l In the Document ribbon, in the Title Block group, click References from File.
l To synchronize from the Navigation pane:

1. Right-click your selection.

2. Point to Document.

3. Select Synchronize References from Files.

PowerUser Procedures
The References from File action triggers the publishing job configured for the Synchronize
References setting in your vault settings. This setting is described in Configure a Vault For
Publisher in theMeridian Enterprise Configuration Guide.

To manually synchronize Meridian references of a document:

l In the Documentmenu, point to Synchronize, and then click References from File.

Other Applications
The Synchronize References action triggers the publishing job configured for the Synchronize
References setting in your vault settings. This setting is described in Configure a Vault For
Publisher in theMeridian Enterprise Configuration Guide.

To manually synchronize Meridian references of a document:

l In theMeridianmenu, in theMeridian page of the ribbon, or in the Accruent toolbar in the
native application, click Synchronize References.
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Reference Explorer
The Reference Explorer is an advanced tool for viewing references between documents. It is used
by several Meridian commands to display different reference types:

l Show Assembly Structure— Shows only outgoing CAD external reference types
l Show Where Used— Shows only incoming CAD external reference types and custom

reference types
l Show Derivatives— Shows Derived From and Derived To reference types
l Show Project Copies— Shows the copies made in folders of a master document with

Advanced Project Workflow Module.
l Copy with References— Copies a document and its references to a new document
l Derive with References— Derives a document and references from a source document
l Create Project Copy— Copies a master document to a folder as a project copy

The Reference Explorer is built into the Copy with References and Derive with References
commands, so the Reference Explorer appears automatically when creating references. The other
commands display the Reference Explorer only to show different reference types.

Note:
If a part is used in more than one sub-assembly, each occurrence of the part in the Reference
Explorer tree is considered as a separate document for the purpose of selection. However, that
does not affect the resulting copy operation.

PowerWeb Procedures
Use these steps for PowerWeb.

To open a document in the Reference Explorer and view its references:

1. Select the document for which you want to view its references.

2. Choose one of the following options:
l In the Document ribbon, in the Information group, select one of the first three

commands listed above, depending on the reference type that you want to view.

The Reference Explorer opens and shows documents that are linked to the selected
document by the applicable reference type.
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l From the context menu:

a. Right-click the document, and point to Document > Information.

b. Select one of the first three commands listed above, depending on the reference
type that you want to view.

The Reference Explorer opens and shows documents that are linked to the
selected document by the applicable reference type.

l From the Thumbnails view:

a. Right-click a thumbnail of a document.

b. Point to Document > Information.

c. Select one of the first three commands listed above, depending on the reference
type that you want to view.

The Reference Explorer opens and shows documents that are linked to the
selected document by the applicable reference type.

3. Choose one or more of the following options:
l To show a different reference type, click Assembly Structure,Where Used, or

Derivatives.
l To show references that were created manually, in the Assembly ribbon, in the

Options group, enable Display Manual References.
l To show project copies that have already been released, superseded, or merged with

the master document, in the Assembly ribbon, in the Options group, enable Display
Inactive Project Copies.

l To display a sub-set of a document's properties in the right pane, select a document in
the left pane.

These properties are configurable by a System Administrator as described in Configure
Reference Browser Properties in theMeridian Enterprise Configuration Guide .

l To make one of the reference documents the selected document, select the document

in the left pane and click the Document icon in the view bar.
l To download the document and open it in its registered application, in the Assembly

ribbon menu, click Open Document.
l To show a shortcut menu of all commands that are applicable to the selected

document, right-click a document.
l To close the Reference Explorer, click Exit.

Confidential and Proprietary © 2022 283 www.accruent.com



PowerUser Procedures
Use these steps for PowerUser.

To open a document in the Reference Explorer and view its references:

1. Select the document for which you want to view its references.

2. On the Documentmenu, select one of the first four commands listed above depending on
the reference type that you want to view.

The Reference Explorer opens and shows documents that are linked to the selected
document by the applicable reference type.

3. Select a document in the left pane to display its location in the Folders view of the vault in
the right pane.

4. Select options from the toolbar using the descriptions in the following table or right-click a
document to show a shortcut menu of commands that are applicable to the selected
document.

To select or deselect an entire assembly with all parts and subassemblies related to it, hold
down the Shift key while clicking either Select for copy or Use original.

Option Description

Opens the selected document in a new viewer window.

Compares two selected documents.

Shows the revisions of the selected document.

Show the property pages of the selected document.

Refreshes the Reference Explorer to display the most recent changes.

Shows outgoing CAD external reference types.

Shows incoming CAD external reference types and custom reference types.

Shows Derived From and Derived To reference types.

Shows project copies and their master documents. Requires the Advanced Project
Workflow Module.

Reference Explorer toolbar buttons
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Option Description

When creating copies, shows the assembly copy options. When viewing
references, shows visibility options for manual references and inactive project
copies:

l Display manual references— Show only references that can be created
manually and are not created automatically by application links. Enabled by
default.

l Display inactive project copies— Along with active project copies, also
shows project copies that have been released as new master revisions, have
been superseded by the master document, or have been merged with the
master document. Enabled by default.

5. To make one of the reference documents the selected document, select the document in
the left pane and click Go to.
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Hybrid Documents
Meridian hybrid documents are multiple files that are treated as one document by Meridian
commands. To edit any one part of a hybrid document, the main part must be placed in a
workflow. Only then can a part be edited.

Hybrid document types are often used to manage hybrid drawings, but they can also be used for
other documents that should be treated as one document but stored as separate files. Hybrid
document types are not enabled by default. Consult a System Administrator for the names,
associated file types, and purposes of hybrid document types in your vaults.

Note:
Microstation does not support Hybrid documents.
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View Hybrid Parts
You can view the parts that comprise a hybrid document like any other document in the vault.

No custom property pages appear for hybrid parts. Hybrid parts adopt the property values of the
main document to which they are attached.

PowerWeb Procedures
Use these steps for PowerWeb.

To view the parts of a hybrid document:

1. Display the property pages for the hybrid document for which you want to view its parts.

2. Click the Hybrid Parts tab in the upper-right corner of the page.

The Hybrid Parts page appears, listing the names of the hybrid parts attached to the
selected document.

3. Select the hybrid part that you want to view.

The Document property page for the selected part appears.

4. Click the Viewer tab to show the hybrid part in a viewer window.

PowerUser Procedures
Use these steps for PowerUser.

To view the parts of a hybrid document:

1. In any navigation view, click the plus icon to the left of the document icon.

If the document is a hybrid document, the parts appear indented below the main document.

2. Click one of the part names to show its Document property page and to show the part in
the viewer.
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Import Hybrid Documents
Importing hybrid documents is almost as easy as importing non-hybrid documents. The
configuration of a hybrid document type does most of the work. That is, determining which
document should be the main hybrid part and which documents should be subordinate parts.

Consult a System Administrator for the names, associated file types, and purposes of hybrid
document types defined in your vaults. You will need to know which document type to assign to
the imported documents depending on the file types of the documents.

PowerWeb Procedures
Use these steps for PowerWeb.

To import a hybrid document:

1. Upload the main document as described in Upload Documents.

The document appears in the current view.

2. Attach each hybrid part to the main document as described in .

3. Upload a file for each hybrid part as described in Upload Hybrid Part Content.

PowerUser Procedures
Use these steps for PowerUser.

To import a hybrid document:

1. Drag and drop all of the files that you want to join as a hybrid document from Windows
Explorer into the folder in the Folders view where you want the hybrid document to reside.

If only one document type is configured for the file types that you are importing, that
document type is assigned to the main part of the hybrid document. If more than one
document type is configured for the file types that you are importing, a dialog box appears
in which you can select from among the document types. The dialog box may reappear for
each file you are importing. If you do not select the same document type for all of the files
you are importing, the files will not be joined into a single hybrid document.

2. Select the appropriate document types for the documents.

If the document type that you are assigning to the files is configured to display property
pages during import, they will appear next.
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3. Complete the property pages the same as if you were creating a new non-hybrid document.

If the files that you are importing share the same file name but have different file
extensions, for example, 12345678.dwg and 12345678.cal, the files are automatically
joined as a single hybrid document. The file type defined in the document type as the main
part of a hybrid document will determine which file becomes the main part of the hybrid
document and which files become subordinate parts.

If the files you are importing do not share the same file name, the files import as separate
documents assigned the document types that you selected in step 2.

4. Select the document that you want to become a subordinate part of the hybrid document
and drag and drop it onto the file that you want to become the main part of the hybrid
document.

5. Select Attach as Hybrid Part from the shortcut menu that appears.

The main part of the hybrid document must be in a workflow for the Attach as Hybrid Part
command to be enabled. Depending on the configuration of the vault, newly imported
documents may not be in a Quick Change (default) workflow. Start a workflow, if necessary,
before joining the documents.

The complete hybrid document should now appear similar to the following figure, with the
subordinate part documents attached to the main part of the hybrid document.
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All properties of the main part of the hybrid document apply to the subordinate part
documents as well. All commands executed on the main part of the hybrid document will
also be applied to the subordinate part documents.
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Download Hybrid Parts
Downloading a hybrid part creates a copy of the file on your computer.

PowerWeb Procedures
Use these steps for PowerWeb.

To download a hybrid part:

1. Display the property pages for the hybrid document for which you want to download a part.

2. Click Hybrid Parts in the upper-right corner of the page.

The Hybrid Parts page appears, listing the names of the hybrid parts attached to the
selected document.

3. Select the hybrid part that you want to download.

The Document property page for the selected part appears.

4. On the Documentmenu, select Download Document.

The document is downloaded.

PowerUser Procedures
Use these steps for PowerUser.

To download a hybrid part:

1. In any navigation view, click the plus icon to the left of the document icon.

If the document is a hybrid document, the parts appear indented below the main document.

2. Drag and drop the document onto your desktop or the Windows Explorer location where
you want to work with it.
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Attach Parts To a Hybrid Document
Attaching parts to a hybrid document joins multiple documents together as a single hybrid
document that share the same properties and workflow.

Notes About Functionality
l Consult a System Administrator for the names, associated file types, and purposes of hybrid

document types defined in your vaults. You will need to know which document types are
designated as hybrid document types and which file types are associated with each.

l The main document must be under change by you in a workflow before you can attach parts
to it. For information about using workflows, see Route a Document In a Workflow.

l An alternative method is possible for creating a hybrid drawing if all hybrid parts reside in
the same vault and have the same hybrid document type applied. Simply open the main
part of the hybrid drawing in the CAD application, attach the subordinate parts using the
application's command, and save the drawing. The application link will detect that the parts
should be joined as a hybrid document and prompt you to confirm that you would like it to
do so. The appropriate Meridian Enterprise application link must be installed.

l Creating hybrid documents with application links is not possible in Offline Mode if one of
the documents exists only in the local workspace and does not yet exist in the vault. Such
documents must be synchronized with the vault first so that they are assigned document
types that define the hybrid part relationships.

PowerWeb Procedures
Use these steps for PowerWeb.

To attach parts to a hybrid document:

1. Select the main document to which you want to attach part documents.

The property pages of the selected document appear.

2. On the Edit menu, select Create New Part.

The Create New Hybrid Part dialog box appears with the name of the main document as
the default name for the new hybrid part.

3. Verify the name of the hybrid part and click OK.

The new part appears in the Available hybrid parts list on the Hybrid Parts page. To upload
a file as content for the new part, see Upload Hybrid Part Content.
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PowerUser Procedures
Use these steps for PowerUser.

To attach parts to a hybrid document:

1. Arrange the Folders view so that all of the parts of the hybrid document are visible, if
possible.

2. Select the documents that you want to become subordinate parts of the hybrid document
and drag and drop them onto the file that you want to become the main part of the hybrid
document.

3. Select Attach as Hybrid Part from the shortcut menu that appears.
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Upload Hybrid Part Content
Uploading hybrid part content attaches a new file to the current hybrid part document.

The main document must be under change by you in a workflow before you can upload hybrid
part content to it. For information about using workflows, see Route a Document In a Workflow.
The ActiveX compatibility mode option must be disabled as described in Personal Preferences.

PowerWeb Procedures
Use these steps for PowerWeb.

To upload hybrid part content:

1. Select the name of an existing hybrid part as described in View Hybrid Parts or create a new
hybrid part.

The Document property page of the hybrid part appears.

2. On the Editmenu, select Upload Document.

The Upload Document dialog box appears.

3. Click Browse.

4. Select the file that you want to upload as content for the current hybrid part.

5. Click Open.

The filename appears in the Upload Document dialog box.

6. Click Yes.

The selected file is uploaded as the hybrid part content and the Upload Document dialog
box disappears.

PowerUser Procedures
Use these steps for PowerUser.

To upload hybrid part content:

1. Navigate to the main document to which you want to upload a new hybrid part.

2. In Windows Explorer or on your desktop, select the file that you want to upload.

3. Drag and drop it onto the main hybrid document.

A shortcut menu appears.
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4. Select As Hybrid Part.

The uploaded file is attached as a new part to the main hybrid document.
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Remove Hybrid Parts
Detaching a part of a hybrid document separates the part and makes it an independent
document.

Note:
l You can only remove a part from a hybrid document that is in the Released state.
l In Meridian 2021 PowerWeb, you can delete hybrid parts from locked documents if Site

Cache Mode or no mode is selected. Deleting hybrid parts from locked documents does
not work if ActiveX Compatibility Mode is selected.

PowerWeb Procedures
Use these steps for PowerWeb. In the 2022 release, we made it easier to remove hybrid parts.

To remove a part from a hybrid document:

1. Display the property pages for the hybrid document for which you want to detach parts.

2. Click Hybrid Parts in the upper-right corner of the page.

The Hybrid Parts page appears, listing the names of the hybrid parts attached to the
selected document.

3. Right-click the hybrid part you want to remove.

The context menu opens.

4. Select Edit > Delete.

A dialog box opens, asking you to confirm your choice.

5. Click OK.

The hybrid part is removed.

PowerUser Procedures
Use these steps for PowerUser.

To remove a part of a hybrid document:

1. Right-click the part document that you want to detach.

2. Select Detach Part from the shortcut menu that appears.

If only one document type is configured for the file type that you are detaching, that
document type is assigned to the detached document. If more than one document type is
configured, a dialog box appears in which you can select from among the document types.
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Rename Hybrid Parts
The main hybrid document must be under change by you in a workflow before you can rename it.
For information about using workflows, see Route a Document In a Workflow.

PowerWeb Procedures
Use these steps for PowerWeb.

To rename a hybrid part:

1. Display the property pages for the hybrid document for which you want to rename a part.

2. Click Hybrid Parts in the upper-right corner of the page.

The Hybrid Parts page appears, listing the names of the hybrid parts attached to the
selected document.

3. Select the hybrid part that you want to rename.

The Document property page for the selected part appears.

4. On the Editmenu, select Rename.

The Confirm Document Rename dialog box appears.

5. Edit the current name or type a new name.

6. Click Yes.

The new name appears on the General property page of the hybrid part.

PowerUser Procedures
Use these steps for PowerUser.

To rename a hybrid part:

l Edit the name property as described in View And Edit Properties.

Confidential and Proprietary © 2022 297 www.accruent.com



Convert Normal Documents Into Hybrid Documents
A common type of hybrid document is a hybrid drawing. The drawing's vector file contains
references to one or more separate raster images. The images are shown in the drawing but do
not reside in the drawing. Together, the files comprise one drawing.

A hybrid drawing often begins as an image file and then later is inserted as a reference into a new
vector file with an application like AutoCAD. If the image file resides in Meridian and the new
vector file is created in Meridian, the files will remain separate by default. They will not be
managed as a single hybrid document. Each document will have its own properties, revision
history, and so on.

In order to create a proper Meridian hybrid document, the following steps should occur:

l The vector document created as the main part of a hybrid document type
l The properties of the raster document transferred to the hybrid document (to maintain the

revision history, and so on)
l The raster document made a part of the main hybrid document
l The raster document inserted as a reference in the main part

You can perform all these steps manually, but Meridian Enterprise provides a command that does
all but the last step for you. The command can be run on individual documents or on a selection
of multiple documents.

Requirements
The following are prerequisites for conversion to succeed:

l The starting document must be under change by you.
l The starting document must be of a hybrid document type
l The hybrid document type must have at least one template configured
l The starting document file extension must be listed as a hybrid part (not the main part) in

the import settings of the document type
l You must have the Convert to Hybrid privilege
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PowerWeb Procedures
Use these steps for PowerWeb.

To convert a normal document into a hybrid document:

1. Select the starting documents.

2. On the Document ribbon, in the Hybrid group, click Convert to Hybrid.

The Convert to Hybrid dialog box lists the available templates.

3. Select the template from which you want the new main file of the hybrid document to be
made.

4. Click OK.

The view refreshes to show the new main hybrid file with the starting document attached as
a part. The properties of the starting document (including its name) are transferred to the
main file and apply to the parts as well. Text specified in the document type is added to the
end of the starting document names to make them unique.

PowerUser Procedures
Use these steps for PowerUser.

To convert a normal document into a hybrid document:

1. Select the starting documents.

2. On the Document menu, click Convert to Hybrid.

If more than one template is assigned to the document type, the Select Document
Template dialog box lists the available templates.

3. Select the template from which you want the new main file of the hybrid document to be
made.

4. Click OK.

The view refreshes to show the new main hybrid file with the starting document attached as
a part. The properties of the starting document (including its name) are transferred to the
main file and apply to the parts as well. Text specified in the document type is added to the
end of the starting document names to make them unique.

You may now open the main file and insert the part files as references and save the
document.
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Renditions
A rendition is a copy of a document in a format other than the original. Typically, the rendition is
in a non-editable format and is distributed only for reference or hard copy printing while the
original, editable source document is not distributed outside of the organization. Examples of
rendition formats are Portable Document Format (PDF) and Autodesk Drawing Web Format
(DWF). See the Rendering Modules article in theMeridian Enterprise Server Administrator's Guide
to learn more about the rendering modules Meridian Enterprise supports. Renditions can often
be created by the same application that is used to edit the original document or they can be
created by a different application. In some cases, the renditions are stored in a separate vault or
document management system than the source documents.

To learn how to configure renditions, see

Meridian Enterprise supports renditions in numerous ways:

l Import of renditions with the Document Import Tool as described in Document Import Tool.
l Rendition viewing as described in View Renditions.
l Rendition viewing options as described in Appearance Options and Personal Preferences.
l Viewing of rendition properties as described in View And Edit Properties.
l Printing renditions as described in Print Renditions.
l Automatic updating of renditions upon running a workflow transition.
l Updating of renditions on demand as described in Update Renditions.
l Attaching renditions to a document as described in Attach Renditions.
l Attaching renditions to email messages sent from PowerUser as described Email

Documents.
l Automatic inclusion of renditions with source documents in packages.
l Specific rendition security privileges.
l Redlining renditions.

Meridian integrates with Meridian Enterprise Server to render and publish renditions.

A document has a rendition associated with it if it shows one of the rendition icons on its
Document property page described in Property Pages.

Working with renditions is described in the following topics.
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View Renditions
When you view documents as described in View Documents, you see either the source document
or a read-only rendition of the document. By default, when you view a document in the
PowerUser viewer, you see the source document even if a rendition is present in the vault. The
default view in PowerWeb is configured by a System Administrator but is typically of the
rendition, not the source document.

Notes About Functionality
l You may only view documents that reside in folders for which you have been granted the

View Content privilege.
l To view documents with PowerWeb, you must also have the Copy Outside Vault privilege

to download the document a read-only to your local workspace.
l Renditions are shown in the viewer that is assigned to the Acrobat file type as described in

Change Viewers unless a System Administrator has configured the system to use only a
specific viewer.

l To open properly in its default (Windows registered) application, the
BCRenditionPropertySet.Format property of the rendition must be set to the file extension
of the rendition. Meridian will attempt to open the file in Adobe Reader if the property is
empty.

l 3D PDFs are not supported. Renditions with PRC support ON are not shown in PowerWeb.

PowerWeb Procedures
Use these steps for PowerWeb.

View the rendition
To show the rendition in PowerWeb:

l In the Document ribbon Rendition group, click Show.
l Right-click over your selection, point to Edit, and then click Open Rendition.
l From the Thumbnails view:

1. Right-click a thumbnail of a document.

2. Point to Edit and then select Open Rendition.
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View the Rendition Using the Forge Rendering Module
To perform these procedures, you must have Forge configured as a rendering application and
started rendering a document sent to Forge. Learn more about configuring an application for
rendering and viewing renditions in Meridian PowerWeb.

To view a document's advanced information and hidden properties:

1. On the Document property page of the document, click the document icon in the upper-left
corner of the page.

The Advanced and Stored Properties tabs appear.

2. Click the Stored Properties tab.

In the Stored Properties tab, expand Document.

The URL of the result appears in Forge ID part 1(2).

The document icon shows that the rendition is up to date.

3. Click the Advanced tab.

In the Streams group, the Rendition field appears empty.

After a successful rendering, the Publisher log shows data about the rendition job, similar to
the following:

1[RENDERING] INVOKE RENDERING MODULE "FORGE SERVICE"

2[FORGE SERVICE] UPLOAD FILE TO BLOB. FILEPATH: C:\<PATH>\RP_FRGE_
100.DWG, FILEID: E716BE7B-DAC3-424B-B204-1F656FCE7D38

3[FORGE SERVICE] SEND CONTENT PROCESSING REQUEST. FILEID:
E716BE7B-DAC3-424B-B204-1F656FCE7D38, RELATIVEFILEPATH: <ROOT
FOLDER>\<PATH>\RP_FRGE_100.DWG, FILEREFERENCES: 0,

4[FORGE SERVICE] REQUEST ACCEPTED. MANIFESTID: ABB55726-EBF0-4030-
88D7-F2BF743EF5CB

5[FORGE SERVICE] WAIT CONTENT PROCESSING COMPLETION. MANIFESTID:
ABB55726-EBF0-4030-88D7-F2BF743EF5CB

6[FORGE SERVICE] PROCESSING COMPLETED. TENANTID: [TENANT ID],
STATUS: COMPLETED, STATUSMESSAGE: ,

7[FORGE SERVICE] CLEAN TEMPORARY DATA

8[FORGE SERVICE] DELETE PROCESSING MANIFEST. MANIFESTID: ABB55726-
EBF0-4030-88D7-F2BF743EF5CB

9[FORGE SERVICE] DELETE BLOB FILE. FILEID: E716BE7B-DAC3-424B-
B204-1F656FCE7D38

10[FORGE SERVICE] CLEAN COMPLETED

Confidential and Proprietary © 2022 302 www.accruent.com

RenderProfile_AutodeskForge.htm
RenderProfile_Create.htm
RenderProfile_Create.htm


11[RENDERING] RENDER COMPLETED: "<ROOT FOLDER>\<PATH>\RP_FRGE_
100.DWG"

4. In the Document ribbon Rendition group, click Show.

The Use Forge integration page opens.

5. Click the Show rendition by Forge Native Viewer link.

The Native Viewer window opens and shows the rendition.

Make the Rendition the Default File Shown
To make the rendition the default file shown when you view a document:

l Set the View renditions option as described in Personal Preferences.

View Hotspots and Redlines on PDFTron Rendition
You can opt to view hotspots by default when you view a rendition or you can toggle hotspots
and redlines on or off when viewing a rendition. If you view a rendition of an outdated version,
hotspots are not shown.

To view hotspots by default when you view a rendition:

1. Select your user > Preferences.

2. Select the View hotspots check box.

3. Click OK.

Toggle Hotspots and Redlines
To toggle hotspots and redlines when viewing a rendition:

1. View the rendition as described earlier on this page.

2. Click the Hotspot and Redline toolbar button .

3. In the context menu that opens, select Redlines and/or Hotspots depending on whether
you want to show or hide redlines or hotspots.

4. Move the cursor over a hotspot to view properties of the target for that hotspot such as:
l target identification number
l tag type
l tag number
l target filename
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l name and values of properties in the Hotspot Properties column. Properties with no
value for the target document are hidden.

If there are multiple targets for the hotspot, the box that appears showsMultiple Targets. If
this occurs, you can View a target in the Details pane that appears when you click the
hotspot.

Highlight a Hotspot
To highlight a hotspot in the diagram:

1. In the viewer, click the Panel toolbar button .

2. Click the Hotspots button.

The Panel pane opens with a list of hotspots.

3. Use the Zoom In , Zoom Out orMarquee Zoom buttons to set the zoom level you
want.

4. To filter the hotspot list, in the Search hotspots field enter the Asset Number or Asset Type
or part of it.

5. Select the hotspot you want to view from the list.

The selected hotspot is highlighted on the drawing in the current zoom.

View a Target
When you view the target of a hotspot, it opens in a new browser tab. A rendition is shown if one
exists for that target. If no rendition exists, the document properties are shown.

To view the target of a hotspot:

1. In the viewer, click the hotspot you want to view.

The hotspot is highlighted in the current browser tab. If only one target exists, the target of
the selected hotspot opens in a new browser tab. If more than one target exists, the Details
pane opens with the available targets for that hotspot.

2. If you want to view a target listed on the Details pane, click the View button next to that
target.

The selected target opens in a new browser tab.
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View Layers
When you view a rendition that has layers, the rendition is shown in accordance with the
translation rules that have been configured in the Meridian Enterprise Server Administration
Console layer translation tables. Layers that were translated as mandatory are always shown and
cannot be hidden. Layers translated with the Default option are shown by default.

To change the layers shown on a rendition:

1. In the viewer, click the Panel toolbar button .

2. Click the Layers button.

The pane lists the layers that you can show or hide. Mandatory layers are locked and cannot
be hidden.

3. Select the check boxes of the layers you want to show.

4. Clear the check boxes of the layers you want to hide.

View Rendition in Default Application
To open the rendition in its default application:

l In the Edit ribbon Upload/Download group, select Download Document > Open.

PowerUser Procedures
Use these steps for PowerUser.

Make the Rendition the Default File Shown
To make the rendition the default file shown when you view a document:

l Set the Show renditions by default option as described in Appearance Options.

Switch Viewer between Source Document and Rendition
To switch the viewer from the source document to the rendition or vice versa:

l In the viewer window, click the Show native/rendition button .
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View Rendition in Default Application
To open the rendition in its default application:

1. In any navigation view, select the document that you want to view.

2. On the Document menu, click Open Rendition.
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Navigate a Document
Following are the ways that you can navigate a document with the document viewer.

Thumbnails
To navigate by thumbnails:

1. Click the Toggle Side Panel icon to open the left side panel if it is not open already.

2. Click the Thumbnails icon to show the thumbnails list if it is not open already.

3. Click the thumbnail in the list of the page that you want to view.

The view refreshes to show the selected page.

Document Outline
To navigate by document outline:

1. Click the Toggle Side Panel icon to open the left side panel if it is not open already.

2. Click the Outline icon to show the document outline if it is not open already.

3. Click the heading in the outline of the page that you want to view.

The view refreshes to show the selected page.

Page Number
To navigate by page number:

l Click the Previous Page icon or Next Page icon to show the page that you want to
view.

The view refreshes to show the selected page.
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Change the Viewing Area
Following are the ways that you can change the document viewing area in the document viewer.

The viewer works in two modes: pan mode and zoom mode. The pan mode icon is darker

when pan mode is active. The zoom mode icon is darker when zoom mode is active. Only
one mode can be active at a time. You switch modes by clicking the icon of the inactive mode.

Zoom
To use zoom mode, choose one of three options:

l Click and drag a fence around the desired viewing area.

l Click the Zoom Out icon or the Zoom In icon to zoom in steps

l Drag the Zoom slider to zoom dynamically

Pan
To use pan mode:

l Click in the document and drag to show the desired viewing area.

Layout
To change the page layout:

1. Hover the mouse pointer over the Page Layout icon to show the page layout palette.

2. Hover the mouse pointer over a layout icon to show the layout mode in a tooltip.

3. Click a layout icon to select the desired mode.

The view refreshes to show the selected mode.
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Fit the page
To make the document fit the page, choose one of two options:

l Click the Fit Width icon to fit the page width within the viewer window.

l Click the Fit Page icon to fit the entire page in the viewer window.

The view refreshes to show the selected mode.

Full screen
To switch to full screen mode:

l Click the Full Screen icon .
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Search a Document
The document viewer provides two search tools for simple or more advanced searches.

Simple Search
To run a simple search:

1. Type the text that you want to find in the Search field.

2. Press Enter or click the Search icon .

The first occurrence of the text is highlighted.

3. Click the Search icon repeatedly to jump to each successive occurrence of the text in the
document.

Advanced Search
To run an advanced search:

1. Click the Toggle Side Panel icon to open the left side panel if it is not open already.

2. Click the Full Document Search icon to show the search options if it is not open already.

3. Type the text that you want to find in the text box.

4. Click options or type values using the descriptions in the following table.

Option Description

Whole word only Finds only the text that you entered and not alternative forms of the same
word.

Case Sensitive Finds only text that matches the case of the text that you entered.

Search options

5. Press Enter or click Go.

The left side panel lists the occurrences of the text within the document and shows the
surrounding context.

6. Click an occurrence to jump to that location in the document.
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Compare Files
To compare files, PowerWeb displays a unique viewing page that shows the renditions of the
selected documents. The two files can be two revisions of the same rendition file or two similar
but unrelated renditions that you want to compare visually. The page allows you to see either of
the renditions alone or a simultaneous view of both renditions that displays the additions,
deletions, and unchanged objects between the two files in symbolic colors:

l Green — additions
l Red — deletions
l Black — unchanged

To compare files, PowerUser displays a unique multi-pane window. Two of the panes show two
files side-by-side. The two files can be two revisions of the same source or rendition file or two
similar but unrelated files that you want to compare visually. The area of the files shown in the
two panes are synchronized with one another. When you change the view of one file, the view of
the other file is changed automatically to match the first file. This makes it easy to compare files
without adjusting the views, sizes, and positions of separate windows.

If the files being compared are supported vector (CAD) graphics files, the lower-right pane shows
the additions, deletions, and unchanged objects between the two files in configurable colors. The
lower-left pane contains options to change the colors. This graphical representation of changes is
valuable for quickly determining the differences between two complex files. You can print a hard
copy of the differences and also generate a report of the non-graphical differences between two
files, for example, layer names, system variables, and so on.

Note:
l Comparing source files is only supported by the AutoVue viewer (available separately).

Comparing renditions is supported by the built-in PDFTron viewer or the AutoVue viewer
(available separately).

l In Meridian 2021, comparing renditions using the built-in PDFTron viewer does not
automatically recalculate the difference after you pan the document. To recalculate the
difference, click Refresh.

l Graphics that have been moved but that are otherwise unchanged are considered by
Compare as a deletion from one document and an addition to the other document.
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PowerWeb Procedures
Use these steps for PowerWeb.

To visually compare two renditions:

1. Select two documents that you want to compare.

2. Choose between two options:
l Right-click one of the documents, point to Document, and then click Compare

Renditions.

The Compare Renditions page appears.
l In the Document ribbon, in the Action group, click Compare Renditions.

The Compare Renditions page appears.

3. Use the options of the page as described below.

4. Click Exit.

Option Description

Keep in sync When enabled and you switch from one rendition to the other, the viewing area
remains the same so that you don't have to manually match the viewing area of
one rendition to the other. When disabled, the viewing area is not synchronized so
that you can easily view different areas of each rendition and switch between
them.

Rev.<lowest> Displays only the first rendition.

Rev.<highest> Displays only the second rendition.

Difference Displays both renditions simultaneously with the colors indicated by the legend in
the bottom right corner of the page.

Refresh Refreshes the current view to show any changes that have been made to renditions
since you first opened the page.

Swap Reverses the comparison order of the renditions.

Compare Renditions page options
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PowerUser Procedures
Use these steps for PowerUser.

To visually compare two files:

1. Use Ctrl+click to select one of the following:
l Two similar documents from a Navigation view
l Two revisions of the same document from the Revisions dialog
l One document in a briefcase to compare with its original in the vault. Meridian

Enterprise will automatically select the original document

2. Click the Compare button .

The Compare dialog box appears, similar to the following figure.

3. Use the tools in the toolbar or the shortcut menu to change the view of the documents.

All panes remain synchronized on the same area of the documents.

Note:
Automatic pane synchronization is not supported for all formats in all viewer plug-ins, for
example, PDF by the AutoVue 2D Professional viewer plug-in. When working with an

unsupported combination, click the Synchronize button to manually synchronize the
views.
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Use the browse buttons or corresponding shortcut menu commands to load
different revisions of the same documents, different documents from the vault, or
documents that reside outside the vault for comparison.

4. Click options or type values using the descriptions in the following table.

Option Description

Show
additions

Displays graphics in the right document that do not exist in the left document. Select a
color to display additions from the list.

Show
deletions

Displays graphics in the left document that do not exist in the right document. Select a
color to display deletions from the list.

Show
unchanged

Displays graphics that are identical in both documents. Select a color to display
unchanged graphics from the list.

Report Displays a report of the invisible changes between the two documents. The information
can be saved to a file where it can be printed. Not available for raster documents. This
option is only available if the current viewer is the ICViewPlugin viewer.

Print
Differences

Prints the graphics in the Compare Result pane to a printer.

Compare
property
values

Compares and optional updates the property values of one document with the property
values of another document. To compare the property values of the two documents,
see Compare Document Property Values.

Compare window options

Confidential and Proprietary © 2022 314 www.accruent.com



Copy Text To the Clipboard
The document viewer allows you to copy text from a document to the Windows clipboard so you
can paste it in other documents.

To copy text to the clipboard:

1. Click the Text Select icon to switch from pan mode to text selection mode if is not active
already.

The mouse pointer appears an I beam icon when it is over the document area in text
selection mode.

2. Click in the document and drag to select the desired text.

3. Click Copy.

The text is copied to the clipboard.
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Print a Document
The Meridian document viewer allows you to print all or selected pages of a document to any
Windows system printer.

PowerWeb Procedures
Use these steps for PowerWeb.

Before printing a document, you can zoom to a particular part of the document and then you can
use the Print view button on the Print dialog box to print that view.

Note:
When you print a document whose source is a PDF, and the PDF does not have a rendition,
PowerWeb prints the source PDF instead of generating a rendition.
If the PDF has a rendition, PowerWeb will print the rendition.

To print a document:

1. Click the Print toolbar button.

The Print dialog box opens.

2. Select the print options you want:
l All— All pages.
l Current— Current page.
l Page numbers— Enter specific page numbers to print separated by commas such as

1,2,5 or enter a range of pages for example 2-6. Total indicates the number of pages to
be printed.

l Include Comments— Include comments on the printout. This has no effect when
printing a view.

l Include Annotations— Include annotations on the printout. This has no effect when
printing a view.

3. Choose between two options:
l If you want to only print the current view, click Print view.
l Otherwise, click Print.

The browser print dialog opens. If the document is configured to so, a watermark
appears on the printed document.

4. Click Print.
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PowerUser Procedures
Use these steps for PowerUser.

To print a document:

1. Click the Print button .

The Pages dialog box appears.

2. Select All to print the entire document or type page numbers separated by commas (1,2,5,
for example) or type a page range (1-5, for example) in the text box.

Total updates to indicate the number of pages that will be printed.

3. Click Print.

A progress bar updates as the specified pages are prepared for printing and the Windows
Print dialog box appears.

4. Select the printer where you want to send the pages, set other options as necessary, and
click Print.

The specified pages are printed on the selected printer.

5. Repeat steps 2 to 4 if you want to print additional pages or click Done if you are finished
printing.
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View and Reply To Notes
Notes are the text of the text-type annotations described in Annotate a Document:

l Free text
l Callouts
l Comment Notes
l Text that can be added to any non-text annotation

Notes appear in the Notes panel in the document viewer. The text of the notes also appears in
the Comments or Collated Comments list on the Document Details page of the document.

View Notes
To view the notes for a document:

1. Open the document in the document viewer.

2. Click the Toggle Notes Panel icon at the right end of the toolbar if the panel is not
already open.

Be careful to not confuse it with the similar looking Comment Note icon in the
annotation tools palette. The Notes panel opens and lists all of the notes that have been
added to the document.

3. Click a note box to see the annotation to which it is attached.

Change Sort Order
To change the sort order of notes:

1. Click the note options icon .

The note options panel appears.

2. Choose between two options:
l Click Document to sort the notes panel according to the location of the notes in the

document.
l Click Time to sort the notes panel according to the time in which the notes were

added to the document.
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Search in Notes
To search in notes:

l Type keywords in the search box.

The matching text is highlighted in the note boxes.

Show or Hide Annotations
To show or hide the annotations:

l Click the Show/Hide button to toggle the visibility of the annotations.

Reply to a Note
To reply to a note:

1. Type in the text box that shows the prompt Enter a reply.

2. Click Reply.

Save Changes
To save changes to the notes:

l Click Save.
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Annotate a Document
The document viewer provides a rich set of tools to add annotations to documents as follows. The
tools appear in the toolbar at the top of the viewer. If the tool you want to use is not visible, click

theMore Tools icon to show the tool palette so that you can select it.

After you add each annotation, a note box appears in the Notes panel with your name, the type
of annotation, and the date and time that you added the annotation. You can click Edit in the
note box to enter or edit a note for the annotation. Click Delete in the note box to delete the
annotation.

Free Text
To add text:

1. Click the Free Text icon .

2. Click in the document where you want to place the text.

3. Drag the cursor to draw a bounding box that indicates the shape and size of the area where
you want the text to appear.

The text Insert text here appears highlighted.

4. Type the text that you want to add.

You may press enter to type multiple lines.

5. When you are finished typing, click outside the text area.

Highlight Document Text
To highlight document text:

1. Click the Text Highlight icon .

2. Click and drag the cursor to highlight existing text within the document.
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Draw Freehand
To draw freehand:

1. Click the Free Hand icon .

2. Click and drag the cursor to draw freehand.

Text Underline
To underline text:

1. Click the Text Underline icon .

2. Click and drag the cursor to underline existing text within the document.

Text Strikethrough
To strike through text:

1. Click the Text Strikeout icon .

2. Click and drag the cursor to strikeout existing text within the document.

Text Squiggly Underline
To add a squiggly underline to text:

1. Click the Text Squiggly Underline icon .

2. Click and drag the cursor to add a squiggly underline to existing text within the document.

Arrow
To add an arrow:

1. Click the Arrow icon .

2. Click to place the location of the arrowhead and then drag the cursor to draw the leader.
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Line
To add a line:

1. Click the Line icon .

2. Click to place one end of the line and then and drag the cursor to place the other end.

Signature
To add a signature:

1. Click the Signature icon .

2. Click the location where you want to place your signature.

The signature dialog box appears.

3. Draw your signature with the cursor above the horizontal line.

4. EnableMake Default Signature to save the current signature as the default so that you can
reuse it.

5. Click Add Signature.

Your signature appears at the selected location.

Comment Note
To add a comment note:

1. Click the Comment Note icon .

2. Click the location where you want to place the note.

The note is highlighted in the Notes panel.

3. Type text in the text box and click Save.

Callout
To add a callout:

1. Click the Callout icon .

2. Click once to place the location of the arrowhead.

3. Click a second time to place the location of the leader vertex.
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4. Click a third time to place the location of the callout text.

5. Type the callout text.

You may press enter to type multiple lines.

6. When you are finished typing, click outside the text area.

Rectangle
To add a rectangle:

1. Click the Rectangle icon .

2. Click and drag to draw a rectangle.

Ellipse
To add an ellipse:

1. Click the Ellipse icon .

2. Click and drag to draw an ellipse.

Polygon
To add a polygon:

1. Click the Polygon icon .

2. Click to indicate the location of each vertex.

3. Double-click to finish drawing.

Polyline
To add a polyline:

1. Click the Polyline icon .

2. Click to indicate the location of each vertex.

3. Double-click to finish drawing.
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Edit Annotation
To edit an annotation:

1. Click the Edit Annotation icon .

2. Click the annotation that you want to edit.

3. Continue as described in Modify an Annotation.
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Modify an Annotation
A common set of editing tools is available to modify any annotation type, regardless of the
current annotation tool.

Resize or Move Annotation
To resize or move an annotation:

1. Click the annotation that you want to edit.

The original bounding box is highlighted.

2. Click a grip and drag it to resize the bounding box.

3.  If the annotation is not applied to text in the document itself, you can click inside the
bounding box and drag the annotation to move it to a different location.

Edit Text Annotation
To edit a text annotation:

1. Click the annotation that you want to edit.

The original bounding box is highlighted.

2. Click Edit Text to edit the text.

Add Note to Non-Text Annotation
To add a note to a non-text annotation:

1. Click the annotation to which you want to add a note.

The original bounding box is highlighted.

2. Click Note.

The note is highlighted in the Notes panel.

3. Type text in the text box.

4. Click Save.
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Change Style of Annotation
To change the style of an annotation:

1. Click the annotation that you want to modify.

The original bounding box is highlighted.

2. Click Style to set the text color, size, background color, margins, and opacity.

Delete Annotation
To delete an annotation:

1. Click the annotation that you want to delete.

The original bounding box is highlighted.

2. Click Delete.

Modify Multiple Annotations
To modify multiple annotations:

1. Click the Edit Annotation icon .

2. Click and drag a fence that intersects the annotations that you want to edit.

The bounding boxes of all the selected annotations appear and the note boxes in the Notes
panel are highlighted.

l Type text in the note box of each annotation.
l Click and drag to move the annotations.
l Click Delete.
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Update Renditions
Renditions are typically updated automatically when an updated source document is released
from a workflow. However, there may be circumstances in which you want to update renditions
without initiating a workflow or editing the source documents, such as:

l You have replaced the content of the source document with a file from an outside
organization

l You receive updated renditions from an outside organization and will not receive an
updated source document until later

l Your organization does not use workflow definitions for the source document workflows;
automatic updating is not supported by the Quick Change or document type workflows.

l You synchronize Meridian properties to a drawing title block and need to update the
rendition to reflect the new values.

In these and similar circumstances, you can update renditions manually.

How the rendition will be created depends on the configuration of the publishing job that is
assigned to the vault by a System Administrator and on the properties on the Rendition tab of the
document. When the update will occur depends on the configuration of the publishing job.

The Update Rendition action triggers the publishing job configured for the Create Rendition
setting in your vault settings. This setting is described in Configure a Vault For Publisher in the
Meridian Enterprise Configuration Guide.

When rendering has completed, the new rendition will appear in the viewer. For information
about setting the rendition properties and monitoring the Publisher queue, see View the
Publisher Queue.

Notes About Functionality
l The document will be locked by the Rendition Server account until the rendition has

completed.
l Only documents that are unlocked in your local workspace or that are already locked by the

Rendition Server account may have their renditions updated.
l The resulting rendition may contain additional information such as an electronic signature

page or a watermark, depending on your system's configuration.
l If Enable XOD Viewing is turned off, updating a rendition may fail if EDM server and

Meridian Enterprise Server are located on the same machine, and Content Indexing
(Windows Search) is ON.
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The Enable XOD Viewing setting is described in the Configure the Viewer Options article in
theMeridian Enterprise Server Administrator's Guide.

To address this issue, you can adjust the RetryWriteRendition andWaitWriteRendition
settings. Learn more about these settings in the Configure a Vault For Publisher article in the
Meridian Enterprise Administrator's Guide.

l If rendering certain Revit files (.rvt) consistently leads to any error which does not seem
applicable, check if opening the .rvt file in the Revit version installed on the render node
causes an upgrade dialog to appear. If so, the file should be upgraded in an interactive Revit
session before trying to render again.

PowerWeb Procedures
Use these steps for PowerWeb.

To update a rendition manually:

1. Select the document for which you want to update its rendition.

2. Choose one of the following options:
l On the Document ribbon, in the Rendition group, click Update Rendition.

The document is added to the Publisher queue for rendering.
l Right-click the document, then select Document > Rendition > Update Rendition.

The document is added to the Publisher queue for rendering.
l From the Thumbnails view:

a. Right-click a thumbnail of a document.

b. Select Document > Rendition > Update Rendition.

The document is added to the Publisher queue for rendering.

PowerUser Procedures
Use these steps for PowerUser.

To update a rendition manually:

1. Select the document for which you want to update its rendition.

2. On the Documentmenu, select Update Rendition.

The document is added to the Publisher queue for rendering.
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Print Renditions
You can print renditions using the viewer and output them to a Windows system printer.

Note:
Printing a batch of renditions requires the installation of Adobe Reader and a site cache
connection. In the 2022 release, if you print documents in a batch, Meridian will call the
appropriate script and apply the watermark in PDFTron. The Site Cache Client is required for
this functionality. A minimized Adobe Reader window might remain after printing and must be
closed manually.
If the rendition of the document was created using the Forge engine, an error message might
appear.

Use these steps for PowerUser and PowerWeb.

To print renditions:

1. Select the documents for which you want to print renditions.

2. On the Documentmenu, select Print Renditions.

The Print Renditions dialog box appears.

3. Select or type options for the desired printer and then click OK.

The Print Renditions dialog shows the progress while the rendition of the selected
documents are printed using the viewer.
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Attach Renditions
Attaching a rendition imports a file into the vault and stores it with the selected document's
source content. The new file will then be shown as the document's rendition.

The document to which you want to attach a rendition must be under change by you.

Important!
The attached file might be overwritten if a new rendition is generated automatically by the
system as the result of a workflow transition or manually as described in Update Renditions.

PowerWeb Procedures
Use these steps for PowerWeb.

To attach a file as a rendition:

1. In any navigation view, right-click the name of the document for which you want to attach a
rendition, point to Rendition, and then click Attach Rendition.

The Attach Rendition dialog box appears.

2. Click Browse and select the file that you want to attach.

3. Click Yes.

The file is attached and replaces the current rendition, if any.

PowerUser Procedures
Use these steps for PowerUser.

To attach a file as a rendition:

1. In any navigation view, drag a file from outside the vault and drop it onto the destination
document's name in the view.

The shortcut menu appears.

2. Select Attach as Rendition.

The file is attached and replaces the current rendition, if any.
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Download Renditions
Downloading a rendition makes a copy on your PC that you can work with when you are not
logged on to Meridian.

Note:
If in site cache mode and the ActiveX compatibility mode option is enabled as described in
Personal Preferences, only the selected document is downloaded.
If the rendition of the document was created using the Forge engine, an error message might
appear.

Use these steps for PowerWeb.

To download renditions to a specific location on your computer:

1. In any navigation view, select the documents for which you want to download their
renditions.

2. Choose one of the following options:
l In the Edit ribbon, in the Download group, click the down arrow next to Download to

Folder and then click Download Renditions to Folder.

TheMeridian Upload/Download Control dialog box appears.
l Right-click your selection, point to Edit, and then click Download Rendition.
l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Point to Edit and then select Download Rendition.

3. Select the desired options and then click OK.

The renditions download to your computer in the background.
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Unlock Renditions
While a rendition is being generated by the system, renditions are locked by the Rendition Server
account so that the rendition files can be replaced. This prevents the source document from
being routed in a workflow. If rendering fails for some reason, the rendition may remain locked.
The lock must be released manually in such cases.

PowerWeb Procedures
Use these steps for PowerWeb.

To unlock a rendition:

1. Select the document for which you want to unlock its rendition.

2. In the Document ribbon, in the Rendition group, click Unlock Rendition.

The rendition is unlocked.

PowerUser Procedures
Use these steps for PowerUser.

To unlock a rendition:

l Choose between two options:
o To unlock a rendition from the Document menu:

1. Select the document for which you want to unlock its rendition.

2. On the Document menu, select Unlock Rendition.

The rendition is unlocked.
o To unlock a rendition by right-clicking:

1. Right-click the document for which you want to unlock its rendition.

2. Select Unlock Rendition on the shortcut menu that appears.

The rendition is unlocked.
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Publisher Queue
Publisher is a component of Meridian Enterprise Server for publishing (copying) documents from
one document management system to another. Publisher can optionally render documents from
the source system to a different file format before publishing them to the destination system.
Lastly, the system can add watermarks to renditions (including the prior revision), append
electronic signature pages to the final output, and merge related renditions into a single file.

Publisher combines these actions—rendering, post-processing, and publishing—in a publishing
job that it can run either on demand or as a scheduled task. Publisher includes links to common
document management systems. Publisher also includes rendering modules for popular
engineering content authoring applications. Publisher is configured and publishing jobs are
created using the Meridian Enterprise Server Administration Console, the central tool for
managing several Accruent applications.

Publisher includes application links that can be installed to simplify publishing documents from
within source document management systems, such as Meridian Enterprise, SharePoint, Accruent
Project Portal, and a Windows file system. The links add documents to the publishing queue that
can be managed through a website installed on the Meridian Enterprise Server computer. The
queue can be viewed and controlled using a web browser from anywhere on the network.

The following topics describe how to manage the Publisher queue to publish documents.
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View the Publisher Queue
The Publisher queue lists documents that have been submitted for rendering and/or publishing.
This is the most useful way to see the documents that are waiting to be published by the next
scheduled publishing job. The queue holds all documents to be published regardless of how they
were added to the queue, automatically or manually from any source system. You can also view
the queue to see what documents have already been published or that failed to publish for some
reason and details (the process log) for each document.

You will only see jobs in the Publisher Queue that originated from the current vault.

Note:
You may not modify a publishing job if you are not the job owner or a member of the Publisher
Configurators group or the Application Administrators group as described in the Publishing
Jobs chapter in theMeridian Enterprise Server Administrator's Guide.

(PowerWeb) Open the Publisher Queue
Use these steps for PowerWeb.

To open the Publisher Queue:

l In the Vault ribbon, in the View group, click Publisher Queue.

The All Queue page appears and lists all of the documents currently in the queue regardless
of their status.

To open the Publisher queue in a new web browser window:

1. Open Internet Explorer.

2. Type the following address where <PublisherComputerName> is the name of computer
where Meridian Enterprise Server is installed:

http://<PublisherComputerName>/BCEnterprise/Queue

3. Press the Enter key on your keyboard.

The All Queue page appears and lists all of the documents currently in the queue regardless
of their status.
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(PowerUser) Open the Publisher Queue
Use these steps for PowerUser.

Internet Explorer must be configured as your default web browser or the following error may
occur: Cannot start process because a file name has not been provided.

To open the Publisher queue:

l On the Tools menu, click Open Publisher Queue.

The All Queue page appears and lists all of the documents currently in the queue regardless
of their status.

View Document Status
To view the current status of a particular document:

l Select the document in the queue list.

The current status appears in the Status group on the right side of the page. Below the
status is the Process Logs group that shows all of the processing activity and can be used for
troubleshooting.

View Jobs with Specific Status
To view only the jobs with a specific status:

l Click the name of the status in the menu.

The page refreshes to show only the jobs with the selected status.

View Jobs with Specific Property Value
The properties that can be searched are configurable as described in Configure the Queue Display
Options.

To view only the jobs with a specific property value:

1. Type at least the beginning of the property value in the search box.

The search operator that will be used is Starts With.

2. Click the search icon .

The list refreshes to show the results of your search.

3. To reset the filter results, clear the search box and click the icon again.
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Filter the List
The properties that can be filtered on are configurable as described in Configure the Queue
Display Options.

To filter the list:

1. Click the downward arrow to the right of the column name that you want to filter on.

2. Point to Columns.

3. Select or deselect columns accordingly.

Sort Column
To sort the jobs on a particular column:

1. Click the heading of the column that you want to sort on.

The sort icon indicates the current sorting column and direction.

2. To reverse the sort order, click the heading again.

Change Column Order
To change the order of columns:

l Drag a column heading and drop it in the desired position.

Show or Hide Columns
To show or hide columns:

1. Click the downward arrow next to any column name.

2. Point to Columns.

3. Select or deselect columns accordingly.
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View Job Details
To view the details of a job:

l Click the icon of the job.

The details of the job appear in the right pane. The properties that are shown in the
Other group are the ones that are selected in the Details column as described in Configure
the Queue Display Options.

The data that is listed in the Process Logs group is output from the publishing job if it has
run already. If multiple attempts were made to publish the document, the data for each
attempt is collapsible and expandable and the last attempt is expanded by default. Any
error messages appear in red text.
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Edit the Rendition Properties
How renditions are generated is controlled by a set of properties for each document. You can
modify these properties to meet your specific rendition requirements.

Notes About Functionality
l Publisher supports hybrid document publishing and rendering when the source and

destination systems are both Meridian Enterprise. It is supported only if no rendering is
performed or if the AutoCAD rendering module is used. Hybrid parts are not rendered or
published if the AutoVue rendering module is used.

l These properties only affect renditions created by Publisher rendering jobs. They do not
affect viewing PDF source documents, which uses the default settings and are not
configurable.

l These properties may be set for batches of documents using the Set Property Value
command described in Set a Property Value. However, in PowerUser only the properties
with lookup lists are available for setting. They are all available in PowerWeb. You may not
set unlisted values for properties with lookup lists even if you have the privilege to do so. No
error message will be displayed and the value will not be changed.

Procedures
Use these steps for PowerUser and PowerWeb.

To edit the properties of a document that control how it is rendered:

1. Select the document for which you want to edit its rendition properties.

2. Click the Rendition tab.

The Rendition property page appears.

3. Click Edit.

The properties become editable.

4. Click options or type values using the descriptions in the following table.

5. Click OK.
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Property Description

Page Layout The view within the source document to render.

Page size The size of the page to render to. The available sizes are those that are defined
on the Meridian Enterprise Server computer where the document will be
rendered. Select ~Not specified~ to use the page size specified in the source file
(AutoCAD Page Setup Manager only).
If ~Not specified~ is selected and an electronic signature watermark will be
applied to the rendition, the default watermark settings for location and font size
are used. The default page size is A0.

Page orientation The orientation of the page to render to: Landscape (default) or Portrait. Select
~Not specified~ to use the page orientation specified in the source file (AutoCAD
Page Setup Manager only).
If ~Not specified~ is selected and an electronic signature watermark will be
applied to the rendition, the default watermark settings for location and font size
are used.

Render color The color depth to render to: Color or Black and white (default).

Pen settings file An AutoVue pen settings filename to apply to the rendition. File names are those
that are available on the Meridian Enterprise Server computer. Applicable only if
the publishing job is configured to use the AutoVue rendering module. For
information about the available pen settings files, consult a System
Administrator.
Select ~Not specified~ to use the pen settings file specified in the source file
(AutoCAD Page Setup Manager only).

XOD Resolution Select a value at which to view and generate renditions with PDFTron. Lower
values may lack sufficient clarity. Higher values may cause slower viewing and
publishing.
This setting is only relevant if you have the Enable XOD Viewing setting enabled.
This setting allows users to view XOD files instead of native PDFs in PDFTron. To
learn more about this setting, see the Configure the Viewer Options section of the
Meridian Enterprise Server Administrator's Guide.

Rendition properties
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Property Description

Print Quality Print quality to use with PDFTron. You can enter a value between 1 and 15.
Higher values result in higher quality, but takes longer to render. Values between
3 and 6 are suitable for most purposes. Beyond 6, quality increases by
diminishing amounts.
If no value is set, the default value of 1 is used.

Note:
If you have the Enable XOD Viewing setting enabled, you should not enter a
value greater than 7 for the print quality setting. This causes the Print dialog to
freeze and the rendition not to be printed.

Layer translation
table

Layer translation table to use for translating the document layers when
generating a PDF rendition from the document. Translation tables are created by
your administrator in the Meridian Enterprise Server Administration Console.
Depending on the configuration your System Administrator has chosen, you can
choose from the layer translation tables available for your vault.
This field is hidden if the vault has no layer translation tables.
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Publish Documents From a Windows Folder
Publisher supports the Windows file system as a source for publishing documents. A System
Administrator configures a service running on a Windows file server to monitor a specified folder.
When documents are created or moved to that folder, the service automatically registers them
for publishing. Consult a System Administrator for the locations of folders that are configured for
publishing.

Use these steps for PowerUser.

To publish documents from a Windows folder:

l Choose between two options:
o Save new documents to the folder from any authoring application.
o Copy or move documents to the folder using any method that Windows supports.

Note:
If the documents contain references to other files, those files must also reside in the same
folder.

When the publishing will occur depends (among other factors) on the configuration of the
publishing job that is assigned to the vault by a System Administrator.

You can view the documents that you submitted as described in View the Publisher Queue.

After the documents have been successfully published, they are moved to the Published sub-
folder.
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Cancel a Document
Canceling a document in the Publisher queue prevents it from being published to the destination
system. The document's registration remains in the Publisher database for auditing and other
purposes. A canceled document may be restarted for publishing at a later time unless it is marked
as obsolete as described in Mark a Document As Obsolete.

Use these steps for PowerUser and PowerWeb.

To cancel a document:

1. Open the Publisher queue as described in View the Publisher Queue.

2. Select the documents that you want to cancel.

Press and hold the Ctrl key while clicking to select individual items. Press and hold the Shift
key while selecting the first and last of a range of items.

3. In the toolbar, click Cancel.

The status of the document changes to Canceled.
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Restart a Document
A document with a Status of Failed or Canceled can be restarted. Restarting a document activates
it for publishing once again. Only users with Administrative rights or the owner of a document can
restart a failed document.

Use these steps for PowerUser and PowerWeb.

To restart a document:

1. Open the Publisher queue as described in View the Publisher Queue.

2. Select the documents that you want to cancel.

Press and hold the Ctrl key while clicking to select individual items. Press and hold the Shift
key while selecting the first and last of a range of items.

3. In the toolbar, click Restart.

The status of the document changes to Pending.
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Mark a Document As Obsolete
Marking a document as obsolete prevents it from being published. This action is typically done
when the document has been added to the queue more than once and the Publisher has not
been configured to ignore duplicates. When the document has been published successfully once,
the other registrations in the queue should be marked obsolete to prevent overwriting previous
files on the destination system. The document's registration remains in the Publisher database for
auditing and other purposes.

Use these steps for PowerUser and PowerWeb.

To mark a document as obsolete:

1. Open the Publisher queue as described in View the Publisher Queue.

2. Select the documents that you want to mark as obsolete.

Press and hold the Ctrl key while clicking to select individual items. Press and hold the Shift
key while selecting the first and last of a range of items.

3. In the toolbar, click Obsolete.

The status of the document changes to Obsolete.

For information about reversing this change, see Unmark a Document As Obsolete.
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Unmark a Document As Obsolete
Unmarking a document as obsolete allows it to be restarted for publishing. This reverses the
effect described in Mark a Document As Obsolete.

Use these steps for PowerUser and PowerWeb.

To unmark a document as obsolete:

1. Open the Publisher queue as described in View the Publisher Queue.

2. Select the documents that you want to unmark as obsolete.

Press and hold the Ctrl key while clicking to select individual items. Press and hold the Shift
key while selecting the first and last of a range of items.

3. In the toolbar, click Undo Obsolete.

The state of the document reverts to its previous status.
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Configure the Queue Display Options
By default, the Publisher Queue shows basic information that is suitable for most uses. You may
configure the display differently to meet your own requirements.

Use these steps for PowerUser and PowerWeb.

To configure the queue display options:

1. Open the Publisher Queue as described in View the Publisher Queue.

2. In the app bar, click Settings.

The Queue Options dialog box appears. Each row shows the names and display options for
each property in the queue.

3. Select a row that you want to configure.

4. Click options or type values using the descriptions in the following table.

5. Click OK.

The queue page is refreshed to reflect your changes.

Option Description

Rename To change the name that is shown for a property in the column heading:

1. Click the edit icon .
The Rename dialog box appears and shows the current display name of the
property.

2. Edit the name and click Rename.
The property display name updates.

Grid Shows the property in the queue grid on the left side of the page.

Details Shows the property in the Other group on the right side of the page when a document is
selected.

Filter Enables the property to be a filter as described in View the Publisher Queue.

Autoload For better performance, loads unique values in the property filter list when the page
loads instead of when the filter is configured. Enable this option if the property contains
many unique values and the Filter option is also enabled.

Searchable Enables the property to be searched as described in View the Publisher Queue.

Publisher Queue display options
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Option Description

Display
Name

The name of the property as it appears on the queue page.

Name The internal name of the property used by the system.
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Build a Report
You can build reports based on report definitions configured by a System Administrator. A report
can be based on the documents contained within a folder in the Folders view or on a selection of
documents in any navigation view.

PowerWeb Procedures
Use these steps for PowerWeb.

To build a report:

1. Choose between two options:
l Browse in the Folders view to the folder containing the documents you want the

report to contain.
l Select the documents that you want the report to contain in any Navigation view.

2. Right-click the folder name or selection, point to Folder or Selection accordingly, and select
Build Report.

The Build Report dialog box appears.

3. Click options or type values using the descriptions in the following table.

Option Description

Select a report Select a report definition from the list. This option specifies which document
or folder properties are included in the report.

Report format Select an output format for the report:
l CSV— Comma Separated Values format for import into other

applications
l XML— eXtensible Markup Language format for import into other

applications
l HTML— Hypertext Markup Language that can be opened in a web

browser already styled and ready to print or send to others
If the HTML option is grayed out, it means that your System
Administrator needs to specify an XSLT stylesheet for the report
template. This setting is described in the Format Report Output article
in theMeridian Enterprise Configuration Guide.

Report generation options
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Option Description

Report scope Verify that the report scope is correct. If necessary, click Cancel and modify
your selection.

Recursively Includes the documents contained within sub-folders of the selected folder.
This option is only available if a folder is selected.

4. Click OK.

The report file downloads to your PC where you can save, open, or print the report.

5. In the File Download dialog that appears, click Save if you want to save the report file on
your computer.

6. Click Open if you want to open it immediately for viewing or printing.

PowerUser Procedures
Use these steps for PowerUser.

To build a report:

1. Choose between two options:
l Select the folder in the Folders view that contains the documents you want the report

to contain.
l Select the documents that you want the report to contain in any Navigation view or

saved search.

Click Select All on the Editmenu or press Ctrl+A to select all documents in the current
view.

2. Right-click the folder name or selection and select Build Report from the Folder or
Documentmenu, respectively.

The Select Report dialog box appears, listing the available report definitions.

3. Click the name of a report definition from the list and then click Select.

The Build Report dialog box appears.

4. Select options using the descriptions in the following table and click Generate. The report
data is output to a file or the application, depending on the format selected.

All of the output formats produce a report that contains mostly metadata about the
documents in the scope of the report except for Microsoft Word templates. These
templates can include additional formatting, text, graphics, and even thumbnail images of
the documents. Microsoft Word report templates can only be configured by a System
Administrator.

Confidential and Proprietary © 2022 349 www.accruent.com



Note:
The Text File output format can be used to create scripts for use by other applications
such as AutoCAD. Such scripts can be used to process batches of vault documents for
plotting, conversion, and other automation tasks.

Option Description

Select the scope
of the report

Select the documents that will be included in the report. If you want to include the
documents contained within sub-folders of the current selection, select the
(Recursively) option.

Select the
format of the
report

Lists the standard output formats and any Microsoft Word report templates defined.
Select one output format.

Save report in Enabled if one of the output formats that create an output file (as opposed to
sending output to the application) is selected. Type or select a location for the report
output file.

Add to existing
report

Adds output from the current report to existing output from a previous report.

Open report
when done

If one of the output formats that create an output file (as opposed to sending output
to the application) is selected, opens the resulting file in its default application.

Copy
documents to
Local
Workspace

Copies the documents that are within the scope of the report to your local
workspace so that you can work with them.

Report generation options
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View And Save the Audit Log
The audit log is a record of the significant events that have occurred in the vault over time. Each
event in the log contains the date, user, action, item, and additional details. It can be useful to
track user, document, project activity and more.

As of the 2022 release, separate events are added to the audit log for each document in a batch,
regardless of whether authentication succeeded, failed, or if you exited out of the authentication
dialog without attempting to authenticate.

If enabled for a vault, the Meridian Enterprise FDA Module allows you to view and save audit log
data if you have the appropriate permission. You do so by opening the audit log viewer from
within Meridian Enterprise. The audit log viewer opens in a new browser window. There you can
filter and sort the data to meet your needs. You can then save the data as a file that you can open
in other programs such as Microsoft Excel to format and print the data.

Note:
You must have the View Audit Log privilege to use this command as described in the Security
Privilege Descriptions article in theMeridian Enterprise Configuration Guide.

(PowerWeb) View Audit Log Data
Use these steps for PowerWeb.

To view the audit log data:

l In the Vault ribbon, in the View group, click Audit Log.

A new window containing your audit log data opens.

(PowerUser) View Audit Log Data
Use these steps for PowerUser.

To view the audit log data:

l On the Tools menu, click View Audit Report.

A page titled Audit Log opens in a browser window similar to the following figure.

The log entries are sorted on the column indicated by the arrow icon in the column
heading. Your privileges to view the audit log are shown at the bottom of the page.
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(PowerUser) Change Sort Order or Select a Filter
Use these steps for PowerUser.

To change the sort order or select a filter:

l

Point to a column heading, click the arrow button that appears, and click the sort option
or filter that you want on the shortcut menu that appears.

If you selected a sort option, the arrow icon appears in that column heading. If you selected
a filter, the filter icon appears in that column heading.

Save Current Audit Log Data
Use these steps for PowerUser and PowerWeb.

To save the current audit log data:

1. If necessary, arrange, sort, and filter the data as described in the preceding task.

2. Click Export.

Your web browser will attempt to download the file to your computer. If your browser's
security settings block the download, you might need to adjust the settings and retry this
procedure.

3. Accept the default location and filename or specify a different location or filename, if
necessary.

The file is saved.

4. Open the file in any program that is compatible with .xlsx files to format and print the
data.
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Folders
A Meridian vault may contain an unlimited number of folders. Meridian Enterprise folders work
very similar to Windows folders. Anything that you can do to a Windows folder, you can do to a
Meridian folder:

l Create and rename
l Copy and move
l Delete and restore
l Assign inheritable security to the contents

But Meridian folders are also capable of doing much more than Windows folders:

l The name can be calculated automatically
l The properties of a document can be determined by its parent folders
l They can have custom properties, such as Project Number
l Commands run on a selected folder can apply to all of the documents in the folder
l A special type of folder called a project folder can have a workflow associated with it similar

to a document workflow. The workflow can be interlocked with the workflow of the child
documents or with the workflow of the parent folder. This requires the Meridian Advanced
Project Workflow Module.

l They can be linked to a shared network location where multiple users can edit copies of the
same files with certain multi-user applications. The files are automatically synchronized with
the vault copies.
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Create a Folder
This article describes how to create a folder.

You must have the Create folder of this type privilege to create folders using custom types as
described in the Security Privilege Descriptions article in theMeridian Enterprise Configuration
Guide.

PowerWeb Procedures
Use these steps for PowerWeb.

To create a new folder:

1. Navigate to the folder that you want to be the parent of the folder you are about to create.

2. Right-click the folder, point to New, and then click New Folder on the shortcut menu.

The Create New Folder dialog box displays the path of the current folder, which will become
the parent of the new folder.

3. Type the new folder name and click OK.

The new folder is created and selected.

PowerUser Procedures
Use these steps for PowerUser.

Create New Folder
To create a new folder:

1. Navigate to the folder that you want to be the parent of the folder you are about to create.

2. Right-click the folder and select New Folder on the shortcut menu.

The new folder is created and the name is editable.

3. Type the new folder name and press Enter.
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Configure Shared Workspace Folder Options
To configure the options for a shared workspace folder:

l Edit the options in the Sharing details group on the Folder tab of the folder as described in
the Configure Shared Workspaces article in theMeridian Enterprise Configuration Guide .

You must have the Edit shared workspace settings privilege to modify the options as
described in the Security Privilege Descriptions article in theMeridian Enterprise
Configuration Guide.
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Rename Folder
This article describes how to rename a folder. You cannot change a folder name if it is included in
a field-path definition or if any document contained in the folder is under change or locked.

PowerWeb Procedures
Use these steps for PowerWeb.

To rename a folder:

1. Choose one of the following options:
l From the ribbon:

a. Select the folder you want to rename.

b. In the Edit ribbon, in the Organize group, click Rename.

The Confirm Folder Rename dialog box displays.
l From the context menu:

a. Navigate to the folder that you want to rename.

b. Right-click the folder and point to Edit > Organize > Rename.

The Confirm Folder Rename dialog box displays.
l From the Thumbnails view:

a. Right-click a thumbnail of a folder.

b. Point to Edit > Organize > Rename.

The Confirm Folder Rename dialog box displays.

2. Type the new folder name in New name of the folder.

3. Click Yes.

The folder is renamed.

PowerUser Procedures
Use these steps for PowerUser.

To rename a folder:

1. Select the folder that you want to change.

2. Click the Editmenu in the toolbar and select Rename.

Alternatively, you can press F2 on your keyboard.
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The folder name becomes editable.

3. Rename the folder.

4. Click off the folder or press Enter on your keyboard.

The folder is renamed.
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Assign Security Roles To a Folder
Folder security may be inherited from its parent folder or explicitly defined for the folder. All of
the role assignments for a folder and its sub-folders may be exported, cleared, and imported as a
batch.

For information on configuring security roles, seeManage Security Roles in theMeridian
Enterprise Configuration Guide and Role-Based Security in theMeridian Enterprise Administrator's
Guide.

Assigning roles to a folder is typically reserved for System Administrators who know what
privileges have been enabled for each role in a vault. If you do not know the capabilities of each
role, consult a System Administrator before proceeding.

You must be a member of a group that has the Assign Roles privilege to perform this task.

Notes About Functionality
l If no roles are assigned to a vault, then no security restrictions are applied and everyone has

full access to all documents in the vault. As soon as one role is assigned to the vault, that is
the only role with access to the vault until other roles are assigned. We recommend that
you first assign at least yourself to the role with the most privileges for the root level of the
vault before assigning any other roles. This will prevent locking yourself out of the vault or
from not being able to modify roles and role assignments. The role should have the Change
configuration privilege in the Vault group and the Assign roles privilege in the Folder group.

l If Inherited from parent folder is enabled, the roles list is empty, and the folder has the
same role assignments as its parent. This parent folder might inherit its roles from its
parent, and so on, all the way up the folder tree to the root of the vault.

l If your Meridian environment has many groups and users and selecting them in the task
below is tedious, a web server setting can be configured that will show an alternative Assign
Roles dialog. This dialog allows you to filter the list before selecting the users or groups to
assign to a role. The setting to enable this feature is AddRoleAssignmentsInDialog and it
must be set to 1 in the PowerWeb profile file of the user that will use the dialog. The setting
applies only to PowerWeb. For information about editing the profile file, see the Configure
Default PowerWeb User Settings article in theMeridian Enterprise Administrator's Guide .
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PowerWeb Procedures
Use these steps for PowerWeb.

Assign Roles to Folder
To assign roles to a folder:

1. In the Folders navigation view, select the folder to which you want to assign roles.

2. Choose between two options:
l In the view bar, click Role Assignments.
l In the Folder ribbon, in the Information group, click Role Assignments.

The list of current role assignments appears.

3. To disable role assignment inheritance and explicitly assign roles to the folder, disable
Inherit from parent folder.

The Add to List button becomes enabled.

4. Above the Apply button, select the name of the user or group from the left list to which you
want to assign a role.

5. Select the role from the right list that you want to assign to the selected user or group and

then click Add to List .

The new role assignment is added to the list of current role assignments.

6. Click Apply.

Remove Roles from Folder
To remove roles from a folder:

1. In the Folders navigation view, select the folder from which you want to remove roles.

2. Choose between two options:
l In the view bar, click Role Assignments.
l In the Folder ribbon, in the Information group, click Role Assignments.

The list of current role assignments appears.

3. In the roles list, place a check mark in the leftmost column of the role that you want to
remove and then click Remove.

4. If you accidentally remove a role that you want to keep, click Undo Remove.

5. Click Apply.
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Export Security Assignments from Folder and Sub-Folders
Security assignments are saved in XML format. You can open the file in a web browser to view or
print the information. The file contains a reference to an example XSLT file named security
report.xslt that, if copied to the same folder with the output, will transform and format the
output using the styles that are defined in the XSLT file.

By default, the security assignments file is installed in the Meridian Enterprise folder at
C:\Program Files (x86)\BC-Meridian\Program. You can modify the XSLT file to
meet your own requirements. We recommend that you not modify the XML output file.

To export the security assignments of the current folder and its sub-folders:

1. In the Folders view, select the top-level folder from which you want to export roles.

2. Choose between two options:
l In the view bar, click Role Assignments.
l In the Folder ribbon, in the Information group, click Role Assignments.

The list of current role assignments appears.

3. Click Export.

The file <FolderName>.xml downloads to your browser where you can save it.

Remove Existing Security Assignments

Note:
If the vault has many roles assignments, this operation can take a long time (hours). We
recommend that you perform this operation after production hours.

To remove all existing security assignments:

1. In the Folders view, select the top-level folder from which you want to remove all role
assignments.

2. Choose between two options:
l In the view bar, click Role Assignments.
l In the Folder ribbon, in the Information group, click Role Assignments.

The list of current role assignments appears.

3. To disable role assignment inheritance and explicitly assign roles to the folder, disable
Inherit from parent folder.

The Clear button becomes enabled.
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4. Click Clear.

A dialog box opens, asking you to confirm your choice.

5. Click Yes.

The role assignments are removed.

Import Role Assignments from XML

Note:
l If the XML file contains references to folders that do not yet exist in the current vault, the

folders will be skipped and not created automatically.
l The role assignments that are imported will replace all existing role assignments for each

folder, not add to them. Be sure that no critical role assignments will be lost if you
proceed.

l If the vault from which the XML file was created has many roles assignments, this
operation can take a long time (hours). We recommend that you perform this operation
after production hours.

To import role assignments from an XML file that was previously exported:

1. In the Folders view, select the top-level folder to which you want to import roles.

2. Choose between two options:
l In the view bar, click Role Assignments.
l In the Folder ribbon, in the Information group, click Role Assignments.

The list of current role assignments appears.

3. To disable role assignment inheritance and explicitly assign roles to the folder, disable
Inherit from parent folder.

The Import button becomes enabled.

4. Click Import.

The Choose File to Upload dialog box appears.

5. Select the file that contains the role assignments that you want to import and then click
Open.

A dialog box opens, asking you to confirm your choice.

6. Click Yes.

The role assignments are imported.
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PowerUser Procedures
Use these steps for PowerUser.

Assign Roles to Folder
To assign roles to a folder:

1. In the Folders view, select the folder to which you want to assign roles.

2. Select Assign Roles from the Foldermenu.

The Assign Roles dialog box appears.

3. To disable role assignment inheritance and explicitly assign roles to the folder, disable
Inherit from parent folder.

The Add button becomes enabled.

4. Click Add.

The Add User Role Assignment dialog box appears.

5. Select a role from Add to role.

6. To assign a group to the selected role, enable Group and type or select a group name from
the adjacent list.

7. To assign a user to the selected role, enable User and type or select a user name from the
adjacent list.

8. Click Check Name to validate the selected name.

9. Click OK.

The role assignment is added to the list.

10. Repeat steps 4 through 8 to assign more roles to the folder.

11. Select a role assignment and click Remove to remove the role assignment.

12. Click OK.

The current role assignments are applied to the current folder.

Export Security Assignments from Folder and Sub-Folders
Security assignments are saved in XML format. You can open the file in a web browser to view or
print the information. The file contains a reference to an example XSLT file named security
report.xslt that, if copied to the same folder with the output, will transform and format the
output using the styles that are defined in the XSLT file.

Confidential and Proprietary © 2022 362 www.accruent.com



By default, the security assignments file is installed in the Meridian Enterprise folder at
C:\Program Files\BC-Meridian\Program. You can modify the XSLT file to meet your
own requirements. We recommend that you not modify the XML output file.

To export the security assignments of the current folder and its sub-folders:

1. In the Folders view, select the top-level folder from which you want to export roles.

2. Select Assign Roles from the Foldermenu.

The Assign Roles dialog box appears.

3. Click Export.

The Save As dialog box appears.

4. Specify a location and filename for the file and click Save.

The role assignments are exported.

Remove Existing Security Assignments

Note:
If the vault has many roles assignments, this operation can take a long time (hours). We
recommend that you perform this operation after production hours.

To remove all existing security assignments:

1. In the Folders view, select the top-level folder from which you want to remove all role
assignments.

2. Select Assign Roles from the Foldermenu.

The Assign Roles dialog box appears.

3. Click Clear.

A dialog box opens, asking you to confirm your choice.

4. Click Yes.

The role assignments are removed.

Import Role Assignments from XML

Note:
l If the XML file contains references to folders that do not yet exist in the current vault, the

folders will skipped and not created automatically.
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l The role assignments that are imported will replace all existing role assignments for each
folder, not add to them. Be sure that no critical role assignments will be lost if you
proceed.

l If the vault from which the XML file was created has many roles assignments, this
operation can take a long time (hours). We recommend that you perform this operation
after production hours.

To import role assignments from an XML file that was previously exported:

1. In the Folders view, select the top-level folder to which you want to import roles.

2. Select Assign Roles from the Foldermenu.

The Assign Roles dialog box appears.

3. Click Import.

The Open dialog box appears.

4. Select the file that contains the role assignments that you want to import and then click
Open.

A dialog box opens, asking you to confirm your choice.

5. Click Yes.

The role assignments are imported.
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View Document Thumbnails in Folder
As of the 2022 release, you can preview the contents of a folder without having to navigate into
the folder. If you do not have permission to view the document, you cannot see the document's
thumbnail.

To preview document contents:

1. In the Folders navigation view, select the folder you want to preview.

2. In the view bar, click the Thumbnails button .

The Thumbnails button is only available if you have the appropriate permissions to see the
contents of the folder.

A preview pane appears. This preview pane contains thumbnails for documents and folders
contained in the folder.

3. Choose between two options:
l To open a document, click the thumbnail for the document.
l To perform an action on the document:

a. Right-click the thumbnail for the document.

The context menu appears.

b. Select the appropriate action from the context menu.
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Delete and Undelete Documents and Folders
Deleting a document or folder removes it from view. However, it does not remove it permanently
from the vault. The item can be restored to its original location, similar to restoring files from the
Windows Recycle Bin. The difference is that Meridian does not store all deleted documents in one
location but rather tracks deleted documents according to their parent folder.

Notes About Functionality
l Folders are deleted recursively by both PowerUser and PowerWeb, similar to Windows. This

means that deleting a folder that contains sub-folders will also delete the sub-folders and
the documents they contain. The confirmation dialog box shows how many child items
would be deleted if the user proceeds.

l Folders and their contents are undeleted recursively by PowerUser but not undeleted
recursively by PowerWeb. Undeleting a folder in PowerWeb only restores the folder, not its
contents. You must undelete the child folders and documents individually.

l Deleted documents that have never been released in the vault cannot be undeleted. In
other words, new documents cannot be undeleted until after they have been released at
least once.

l References to deleted documents are not restored by Undelete.

PowerWeb Procedures
Use these steps for PowerWeb.

Delete a Document or Folder
To delete a document or folder:

1. Choose one of the following options:
l Right-click the document or folder that you want to delete, point to Edit and then click

Delete.

A dialog box opens, asking you to confirm your choice.
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l From the ribbon:

a. Select the document or folder that you want to delete.

b. In the Edit ribbon, in the Organize group, click Delete.

A dialog box opens, asking you to confirm your choice.
l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Select Edit > Delete.

A dialog box opens, asking you to confirm your choice.

2. Click OK.

The document or folder is deleted.

Undelete a Document or Folder
To undelete a document or folder:

1. Choose one of the following options:
l Right-click the folder from where the document was deleted, then select Edit >

Organize > Undelete.

The Deleted folders and documents dialog box appears.
l From the ribbon:

a. Select the folder from where the document was deleted.

b. In the Edit ribbon, in the Organize group, click Undelete.

The Deleted folders and documents dialog box appears.
l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Select Edit > Organize > Undelete.

2. Select the items that you want to undelete.

3. Click Undelete.

The items are restored.
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PowerUser Procedures
Use these steps for PowerUser.

Delete a Document or Folder
To delete a document or folder:

1. Select the document or folder you want to delete.

2. Choose one of the following options:
l On the Editmenu, select Delete.
l Right-click the item and select Delete on the shortcut menu.
l Press Ctrl+D.
l Press Delete.

You are prompted to confirm that you want to delete the item. If the item is a
document and it has incoming references, you are prompted to confirm that you want
to delete the document.

3. Click Yes.

Undelete a Document or Folder
To undelete a document or folder:

1. Select the parent folder of the item that was deleted.

2. On the Document or Foldermenu, select Undelete.

The Deleted Folders and Documents dialog box appears, listing items that have been
deleted from the selected folder but have not yet been purged from the vault.

3. Select the item you want to restore and click Undelete.

4. Click Close.

The item is restored to its original location.
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Project Folders
Meridian Enterpriseincludes a set of features namedManaged Change that is a subset of the
project management features of the Meridian Advanced Project Workflow Module. Manage
Change (and the Meridian Advanced Project Workflow Module to a greater degree) allows you to
create project folders in the Main area of a vault to contain in-progress documents. Those
documents are called project copies and are made frommaster documents that reside elsewhere
in the vault. Master documents can be considered as-built documents.

The Managed Change features are recommended for those organizations that work with many
projects.

The differences between Managed Change and the Advanced Project Workflow Module are
compared in the following table.

Managed Change Advanced Project Workflow Module

Project folders do not include workflow. Project workflows are fully configurable.

Project folders may not contain subprojects. Project folders may contain subproject folders.

Project folders do not have workflows and
therefore may not be interlocked.

Project workflows may be interlocked with other
project workflows and document workflows.

Documents may be copied to only one
project folder at a time.

Documents may be copied to multiple project folders
for concurrent changes.

Project folder differences

In all other respects, the project document management features of Managed Change are the
same as in the Advanced Project Workflow Module.

The following topics describe the common tasks that can be performed with the Managed Change
commands.

Confidential and Proprietary © 2022 369 www.accruent.com



Waiting Lists
If your organization uses concurrent engineering, they can configure the waiting list process for a
document type. This allows multiple engineers to create project copies of a document and edit
the document when it's their turn in the queue. When a waiting list is in use, the project copy is
locked.

The priority column indicates where the position of the waiting project copy in the waiting list.
Priority 0 indicates that the project copy is the one currently being edited. Priorities greater than
0 are waiting to be edited.

When a document is a project copy in a waiting list and is not at the top of that list with priority 0,
these actions are unavailable:

l modify content
l modify rendition
l annotate rendition
l change workflow state
l create a sub project copy
l modify references
l associated commands

Depending on your privileges, you can manage the waiting list for a document on the Master and
Project Copies page.
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Manage a Waiting List
You can manage a waiting list on the Master and Project Copies page of the selected document
including:

l Change the priority of a waiting project copy
l Discard a waiting project copy
l Transfer to next – make the next in the waiting list the active project copy when the active

project copy was released to master and there is now no active project copy.

Change the Priority
If your user is assigned the Change Waiting List privilege, you can change the priority of a waiting
project copy.

To change the priority of a waiting project copy:

1. Scroll to the bottom of theMaster and Project Copies page of the document you want to
change.

2. Click Change Priorities.

The Priority column becomes editable.

3. Select the waiting project copy that you want to change.

The Set priority dialog box opens.

4. Optionally, enter a comment to be recorded in the Document Log.

5. Select the priority you want using one of these methods:
l Use the up or down arrow buttons to increase or decrease the priority.
l Select a priority number button.
l Click Other, enter the number, then click Apply.

TheWaiting PC Priority column shows your selection.

6. Repeat the last three steps for each waiting project copy that you want to change.

7. Click Apply.

Discard a Waiting Project Copy
You can discard waiting project copy from the Project tab. When you do so, the priorities of the
other waiting project copies in the list are adjusted. If you discard the active project copy, the
priorities of the documents in the waiting list are unchanged.
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To discard a waiting project copy:

1. Select the waiting project copy that you want to discard.

2. Choose between two options:
l Select the Project then click Discard from Project.
l Right-click the document in the waiting list then select Project > Discard from Project.

The Discard from Project dialog box opens.

3. Click OK.

If the document is not the active project copy, it is discarded and the priorities on the
waiting list are updated to reflect the fact the project copy is discarded.

If the document is the active project copy, a warning dialog box opens.

4. Click Yes.

The active project copy is discarded, but the waiting list priorities remain unchanged. In this
scenario, the next document is not made the active project copy as that must be manually
selected using the Transfer to Next option.

Transfer to Next
Depending on the way in which your vault and project folders are configured, when you release
the active project copy as master, the next waiting project copy remains as a waiting project copy.

Your vault can be configured so that when a user releases the active project copy as master, the
next waiting project copy becomes the active project copy in the waiting list with the priority
zero. However, this not the default behavior.

You can use the transfer to next option to make that project copy the active project copy and set
its priority to zero.

To transfer to the next project copy:

1. Select the master document.

2. Choose between two options:
l Right-click the document and then select Project > Transfer to Next in the context

menu that appears.
l In the Project ribbon, click Transfer to Next.

The waiting project copy that is first in the waiting list becomes the active project copy and
its Priority is set to zero. The priority of the other waiting project copies is adjusted to
match.
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Project Definitions
All of the functionality of project folders revolves around project definitions. Project definitions
are the elementary building blocks upon which project folders are created to contain project
copies of master documents for revision. Project definitions are the templates from which project
folders can be made in a vault. Project definitions are created by a System Administrator with the
Meridian Enterprise Configurator tool.

Project definitions determine the following characteristics of a project folder:

l The associated custom folder type that can have custom properties and can limit where
project folders may be created within the vault's folder structure.

l Project workflow states and transitions that model the project life cycle.
l Sub-project folders that may be created within the project folder to represent subordinate

engineering processes.
l Workflow interlocks (rules) on the documents within a project folder that must be met

before the project's workflow can change.
l Workflow interlocks (rules) on the parent project, peer projects, or sub-projects that must

be met before the project's workflow can change.

Although project definitions can be complex, using project definitions is relatively
straightforward. Any project definitions available in a vault are listed on menus alongside
available folder types and document types for easy selection. Consult a System Administrator for
information regarding the project definitions available in your vault(s).

For information on creating project definitions, see Create a Project Definition in theMeridian
Enterprise Configuration Guide.
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Create a New Project Folder
Depending on your vault configuration, you may have one or more project types (templates) from
which to choose.

Copying a project folder to another location in the vault (via drag and drop or the Clipboard) will
create a normal folder containing only the documents that were originally created in the project
folder, not any project copies. Project copies residing in the source project folder are not copied
to the new folder because copying documents with active workflows would violate workflow
integrity.

PowerWeb Procedures
Use these steps for PowerWeb.

To create a new project folder:

1. Right-click the parent folder where you want the project folder to be located, point to New
Project, and then click the name of a project template.

Available project types are indicated by the project type icon  . Consult your System
Administrator for the names of project types that have been configured in your vault.
Depending on the project template selected, wizard pages may appear for input of project
information.

2. Complete any wizard pages that appear and click Finish.

The project folder is created within the selected parent folder.

PowerUser Procedures
Use these steps for PowerUser.

To create a new project folder:

l Choose between two options:
o To create a folder by right-clicking the parent folder:

1. Right-click the parent folder where you want the project folder to be located,
point to New, and then click the name of a project template.

Available project definitions are indicated by the project definition icon  .
Consult your System Administrator for the names of project definitions that have
been configured in your vault.
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Depending on the project template selected, wizard pages may appear for input
of project information.

2. Complete any wizard pages that appear and click Finish.

The project folder is created within the selected parent folder.
o To create a folder using the Vault menu:

1. Select the parent folder where you want the project folder to be located.

2. On the Vaultmenu, point to New, and then click the name of a project template.

Depending on the project template selected, wizard pages may appear for input
of project information.

3. Complete any wizard pages that appear and click Finish.

The project folder is created within the selected parent folder.
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Project Folder Properties
The Folder property page of a project folder will display two groups of properties.

l The properties in the Folder Details group are the same properties as those displayed for
normal (non-project) folders.

l The properties in the Project Details group are similar to those displayed for document
workflow except that the Type property displays the project type from which the project
folder was created and no To Do property is shown.
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Sub-Projects
Sub-projects are simply normal project folders that can be created within another existing project.
Sub-projects allow a very large project to be broken down into more manageable pieces. For
example, a large commercial construction project could be managed in one project folder
containing numerous sub-project folders for managing individual trade projects.

Sub-projects can also contain other sub-projects any number of levels deep. Project workflow
interlocks can help synchronize sub-project workflows with their parent project workflow.

Depending on your vault's configuration, not all project definitions may be able to be created as
sub-projects. Consult a System Administrator for more information on the project definitions that
be used to create sub-projects in your vault.
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Reassign Project Managers
Reassigning project managers changes the persons who are authorized to run a project's
workflow transitions. This can be useful if a current manager is unavailable to continue the
project's workflow or to assign additional managers.

PowerWeb Procedures
Use these steps for PowerWeb.

To reassign project managers:

l Choose one of the following options:
o From the ribbon:

1. Select the project folder for which you want to reassign its managers.

2. In the Folder ribbon, in theWorkflow group, click Reassign Project Managers.

The Project Workflow - Reassign Project Manager dialog appears.

3. Select the desired managers.

4. Optionally, type a comment to be added to the project workflow log.

5. Click OK.
o From the context menu:

1. Right-click the project folder for which you want to reassign its managers.

2. Point toWorkflow and then click Reassign Project Managers.

The Project Workflow - Reassign Project Manager dialog appears.

3. Select the desired managers.

4. Optionally, type a comment to be added to the project workflow log.

5. Click OK.

PowerUser Procedures
Use these steps for PowerUser.

To reassign project managers:
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1. Select the project for which you want to reassign managers.

2. From the Foldermenu, select Project Workflow, and click Reassign Project Manager(s).

The Reassign Project Manager(s) dialog appears.

3. Select the desired managers.

4. Optionally, type a comment to be added to the project workflow log.

5. Click OK.

The names of the new managers will appear in theManager property on the Folder
property page.

Confidential and Proprietary © 2022 379 www.accruent.com



Run a Workflow Transition on a Project
Every project folder in a vault has a workflow configured by a System Administrator. A project's
workflow determines the states through which the project must proceed from start to finish. It
also determines the transitions that users can run to route the project from one state to the next
in that workflow.

PowerWeb Instructions
Use these steps for PowerWeb.

Run a Workflow Transition
If the transition is valid, it will be run and the project’s Status property will change to indicate the
new workflow state.

Running a transition might also cause wizard pages to appear or property values to be
automatically assigned. If wizard pages appear when you run a transition, type as much
information as you know or as required and complete the wizard just as you would a wizard that
is shown when creating a new document. After the transition has been run, properties of the
project folder may have been automatically assigned by the transition. Consult a System
Administrator for more information on transition wizard pages and property assignments
configured for your vault.

To run a workflow transition:

l Choose one of the following options:
o From the ribbon:

1. Select the project to route.

2. On theWorkflow ribbon, select a workflow transition or click Reroute Projects.
o From the context menu:

1. Right-click the project folder.

2. Point toWorkflow and select a workflow transition.
o From the Thumbnails view:

1. Right-click the thumbnail of the project folder.

2. Point toWorkflow and select a workflow transition.
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Run a Workflow Transition for a Batch of Files
To run a workflow transition for a batch of files:

1. Conduct a search.

2. Select the Search Results heading.

This will apply the command you select to all results in your search, including results on
subsequent pages.

3. Select a workflow transition from theWorkflow tab.

The transitions that are available are those that are available for the first document in the
search results.

If the command is applicable for all files in the search results, the operation succeeds.
Otherwise, the system executes the command for the files where the command is
applicable.

If the transition is valid, it will be run and the project’s Status property will change to
indicate the new workflow state.

Running a transition might also cause wizard pages to appear or property values to be
automatically assigned. If wizard pages appear when you run a transition, type as much
information as you know or as required and complete the wizard just as you would a wizard
that is shown when creating a new document. After the transition has been run, properties
of the project folder may have been automatically assigned by the transition. Consult a
System Administrator for more information on transition wizard pages and property
assignments configured for your vault.

PowerUser Instructions
Use these steps for PowerUser.

To run a workflow transition:

1. Select the project to route.

2. From the Foldermenu, choose Project Workflow, and click the name of the transition you
want to run.

The name of the transition is configured by a System Administrator in the project's
definition. The Project Workflow dialog box appears.

3. If managers have been configured for the project definition, select the appropriate names
from the list.

4. Optionally, type a comment to be added to the project log and click OK.
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If the transition is valid, it will be run and the project’s Status property will change to
indicate the new workflow state.

Running a transition might also cause wizard pages to appear or property values to be
automatically assigned. If wizard pages appear when you run a transition, type as much
information as you know or as required and complete the wizard just as you would a wizard
that is shown when creating a new document. After the transition has been run, properties
of the project folder may have been automatically assigned by the transition. Consult a
System Administrator for more information on transition wizard pages and property
assignments configured for your vault.

Depending on the configuration of the project, conditions or interlocks might prevent a
transition from being run. Running a transition on a batch of documents may cause some of
the documents to advance to a different state than expected due to transition equivalence.
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Transition Conditions And Interlocks
A project definition may have conditions or interlocks configured that control when its transitions
may be run.

l Conditions are rules based on the values of certain folder properties of the project itself or
on programming expressions that a System Administrator may have defined.

l Interlocks are rules based on the values of certain properties of project folders or of
documents. Project interlocks apply to the current project or its subprojects; that is,
downstream from the project folder. Document interlocks can apply to all, any, or no
documents contained with a project folder. Document interlocks can affect the project
itself, its parent project, or the topmost project of a project hierarchy; that is, upstream
from the project folder.

Transition conditions and interlocks can be simple or very complex. Consult a System
Administrator for more information on the transition conditions and interlocks configured in your
vault.
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Transition Equivalence
Transition equivalence is the equality of a transition in one document workflow to a different
transition in a different document workflow. This makes it possible to run a transition for one
document in a batch of documents and have it run transitions in other documents within the
batch even if the transitions don't have the same name.

For example, consider a batch of three documents. The next and final transition of the first
document is named Release and completes the workflow. The final transition of the other two
documents is named Issue, but the Issue transition is not the next transition in their workflows.
Also assume that a System Administrator has defined the first document's Release transition to
be equivalent to the other documents' Issue transition. After the first document's Release
transition has been run, the other two documents' Issue transitions will run as well, completing
the workflows of all three documents in one step.

A System Administrator can define transition equivalence between:

l All transitions to the same destination state
l All transitions with the same tag name
l All transitions from the same source state
l No other transition

Transition equivalence can cause seemingly inexplicable changes in a document's workflow.
Consult a System Administrator for more information on the transition equivalence configured for
workflow definitions in your vault.

Confidential and Proprietary © 2022 384 www.accruent.com



Create a Project Copy
You can create a project copy from a master document. This copies an existing master document
to a project folder, optionally locks the master document, and links the project copy to the master
document.

This is similar to creating a new document as a derivative of an existing document. The copy can
be further developed during the project and released as a new revision of the master document.
For example, a master facility drawing may need to be modified as part of a facility upgrade or
expansion. Yet, facility managers need access to the master drawing until the project is complete.
You can do so by creating a project copy of the current master drawing.

You can also lock the master drawing against other revisions. The project copy may then be
modified as necessary without affecting the master drawing.

If the Advanced Project Workflow Module has been enabled for the vault, multiple project copies
can be made from the same master document to allow for concurrent engineering with the ability
to track each project copy. If your organization uses the Waiting Lists and a project copy already
exists, when you create a project copy a waiting project copy is created instead. If the project
copy is a waiting project copy, it cannot be edited until the priority reaches zero or the priority is
changed. Waiting project copies are created in the workflow state Unchanged. If you have the
privileges to do so, you can manage a waiting list.

If the concurrent engineering rule is set to serial change on the selected project copy, you cannot
create a project copy or a for info copy.

Note:
To use this command in PowerWeb, you need the normal Managed Change privileges plus Start
Quick Change.
In Meridian 2021 PowerWeb, when the action to create a waiting project copy or a for info copy
runs, the Initialize New Document command runs twice. This issue was resolved in 2021 R2.
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PowerWeb Procedures
Use these steps for PowerWeb.

To copy a document to an existing project:

1. Choose one of the following options:
l From the ribbon:

a. In any navigation view, select the master document you want to copy.

b. In the Project ribbon, in the Assign group, click the down arrow next to Create
Project Copy.

c. Select one of the following options:
o Create Project Copy
o Create Project Copy and Lock
o Create Project Copy with References

l From the context menu:

a. Right-click the master document you want to copy.

b. Point to Project and then select one of the following options:
o Create Project Copy
o Create Project Copy and Lock
o Create Project Copy with References
o Create Project Copy for Information— creates a copy in the project folder

you select. The copy is not shown on theMaster and Project Copies page.
In addition, you cannot:
n change the content natively, on renditions, or annotate it
n change the properties
n start a workflow
n release to master
n transfer to another project
n transfer to next waiting project copy.
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l From the Thumbnails view:

a. Right-click a thumbnail of a document.

b. Point to Project and then select one of the following options:
o Create Project Copy
o Create Project Copy and Lock
o Create Project Copy with References
o Create Project Copy for Information— creates a copy in the project folder

you select. The copy is not shown on theMaster and Project Copies page.
In addition, you cannot:
n change the content natively, on renditions, or annotate it
n change the properties
n start a workflow
n release to master
n transfer to another project
n transfer to next waiting project copy.

The Select Project dialog box appears. If the list of project folders is very long, you can filter
the list by typing part of the desired folder path in the text box.

As of the 2022 release, you can create a new folder or project from the Select Project
dialog. This functionality does not work in ActiveX mode.

To create a new folder or project:

a. Click New Folder.

The Create Folder / Select Folder Type dialog opens.

b. Choose between three options:
l If you want to create a regular folder:

i. Select the Regular Folder option.

ii. Click Next.

iii. Type the new folder name and click OK.

The new folder is created.
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l If you want to create a folder with a specific folder type:

i. Select the Folder of Type option.

ii. Select the type of folder you want to create from the menu.

You must have the Create folder of this type privilege to create folders
using custom types as described in the Security Privilege Descriptions article
in theMeridian Enterprise Configuration Guide.

iii. Click Next.

iv. Type the new folder name and click OK.

The new folder is created.
l If you want to create a new project:

i. Select the Project of Type option.

ii. Select the type of project you want to create from the menu.

iii. Click Next.

iv. Complete any wizard pages that appear and click Finish.

The project folder is created within the selected parent folder.

For more information about creating project folders, see Create a New
Project Folder.

Note:
l The root folder that is shown in this dialog box can be controlled by vault

customization. This can be done to limit project copies to be made only in certain
project folders depending on your organization's business processes. The folder that
you last selected in this dialog box may or may not be selected by default depending
on that customization.

l The vault might be configured to automatically create sub-folders below the folder
that you select and the project copy might be created there.

2. Select the folder where you want to copy the document and click Next.

If the document type is configured to use waiting lists and there is already an active project
copy, a dialog box opens indicating that a project copy cannot be created, but you can
create a waiting project copy instead. This also applies if you selected several documents in
a batch.

If concurrent engineering is not allowed for the document type, you can opt to create a
read-only project copy for information purposes.

If the master document has references, the assembly copy page appears. It lists the master
document and its reference documents of the TagObjectReference and manual reference
types. Documents that will be copied are indicated with a green checkmark icon (the
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default is none). Documents that will not be copied are indicated with a magenta equals
sign icon (the default is all).

By default, the project copy will reference the original reference documents and copies will
not be made of them. Alternatively, you can copy the reference documents together with
the master document and the master document will references the project copies of the
reference documents (and copies of them made in the same project).

3. To copy specific reference documents to the project folder and reference them, click the
icon to change it to .

If you select any part of the assembly without first selecting the parent assembly, the parent
will be selected automatically.

Note:
l Some parts might not be selectable for copying due to the configuration of the

reference type that links them to the parent assembly.
l Additional documents that are invisible in this dialog might also be copied, parts of

sub-assemblies, for example.

4. Click Start Copy to begin copying.

The Create project copy for <assembly> dialog box appears and shows the results of
copying each file.

The master document is copied to the destination project in the Unchanged state.

5. Click Close.

PowerUser Procedures
Use these steps for PowerUser.

To copy a document to an existing project:

1. Select the master document to be copied to a project folder.

2. From the Documentmenu, point toManaged Change (Master/Project Copy) and then click
Assign to Folder (Create Project Copy or Create Project Copy and Lock).

The Select folder dialog box appears.

Note:
l The root folder that is shown in this dialog box can be controlled by vault

customization. This can be done to limit project copies to be made only in certain
project folders depending on your organization's business processes. The folder that
you last selected in this dialog box may or may not be selected by default depending
on that customization.
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l The vault might be configured to automatically create subfolders below the folder
that you select and the project copy might be created there.

3. Select an existing project folder to copy the document to and click OK.

Click New Folder to manually create a new folder, if necessary.

Note:
If the master document was last released from the same folder, a warning message will
appear and the document cannot be reassigned to the same folder.

If the master document has references, the Meridian Enterprise Reference Explorer appears
similar to the following figure. It lists the master document and its reference documents.
Documents that will be copied are indicated with a green checkmark icon . Documents
that will not be copied are indicated with a magenta equals sign icon .

By default, the project copy will reference the original reference documents and copies will
not be made of them. Alternatively, you can copy the reference documents together with
the master document and the master document will reference the project copies of the
reference documents (and copies of them made in the same project). If you do not have the
Create Project Copy From privilege for reference documents in sub-folders, the references
are not made. This behavior is different than in PowerWeb.

a. Choose between two options:
l To also copy specific reference documents to the project folder and reference

them, right-click the document name that you want to copy and click Select for
Copy.

l To copy the selected document and all of its child reference documents and
reference them, click Select Entire Branch for Copy.

b. Click OK to begin copying.

For more information about using the reference browser dialog, see Showing project
copies.

Depending on the document type of the document being added to the project folder, wizard
pages may appear for input of document information.

4. Complete any wizard pages that appear and click Finish.

The master document is copied to the destination project in the Unchanged state.

Note:
l The Created By and Created At properties of the project copy are who and when the

copy was created, respectively. TheModified By andModified At properties of the
project copy are the same values as for the master document.

l Depending on the configuration of the vault, subfolders might be created
automatically in which to store the project copy.
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If you selected the Create Project Copy and Lock command, in addition to creating the
project copy, the master document is locked by the project copy. If the master document is
already locked by a previous project copy, it will remain locked by that copy.
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Copy a Project Copy To Another Project Folder
Copying a project copy from one project to another creates a new project copy in the destination
project from the content of the source project copy. However, the reference created to the new
project copy may not be what you would expect. Unlike Create Project Copy, which creates a
reference between the master document (source) and the project copy, Transfer to Project
creates a reference between the master document (not the source) and the project copy even
though the source of the new project copy is another project copy in this case. The reason for this
is so that the new project copy can ultimately be released as a new revision of the master
document, not a new revision of the project copy from which it was made. This distinction is
important to enable as-built projects. Transfer to Project can be used to create project copies for
other purposes so long as the reference to the master document is taken into consideration and
the intention is not to release the project copy to become a new revision of its source project
copy.

Transfer to Project can be useful when the organization's process for resolving concurrent
engineering projects is to use an as-built project. For example, assume multiple project copies
have been made from a master document into different project folders and each project copy has
undergone different changes. Assume a new project folder is created in which all of the changes
should be merged together into a new document that should be released as the new master
document revision. Rather than start with a fresh copy of the master document, which contains
none of the changes made in the project copies, Transfer to Project can be used to create a copy
in the new as-built project from one of the project copies instead, presumably, the one with the
most changes. Changes in the other project copies can then be merged manually into it until the
as-built project copy contains all of the changes and can then be released as the new master
document revision.

This task is only available if the Advanced Project Workflow Module has been enabled for the
vault.
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PowerWeb Procedures
Use these steps for PowerWeb.

Note:
Copying documents that have no master document and folders is not supported.

To copy a project copy from one project to another:

1. Choose one of the following options:
l From the ribbon:

a. Select the project copy that you want to be the source of the copy.

b. In the Project ribbon, in the Assign group, click Transfer to Project.

The Select Project dialog box appears.
l From the context menu:

a. Right-click the document you want to be the source of the copy.

b. Point to Project and select Transfer to Project.

The Select Project dialog box appears.
l From the Thumbnails view:

a. Right-click a thumbnail of a document.

b. Point to Project and select Transfer to Project.

The Select Project dialog box appears.

2. Select an existing project folder to copy the document to and click Next.

Depending on the document type of the document being added to the project, wizard pages
may appear for input of document information.

3. Complete any wizard pages that appear and click Finish.

The Transfer to Project dialog box shows the progress and results of the command as the
project copy is copied to the destination project and placed under change for you.

PowerUser Procedures
Use these steps for PowerUser.

To copy a project copy from one project to another:

1. Select the project copy that you want to be the source of the copy.

2. From the Documentmenu, selectMaster/Project Copy, and click Transfer to Project.

The Select folder dialog box appears.
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3. Select an existing project folder to copy the document to and click OK.

Click New Folder to create a new normal folder, if necessary.

Depending on the document type of the document being added to the project, wizard pages
may appear for input of document information.

4. Complete any wizard pages that appear and click Finish.

The project copy is copied to the destination project and placed under change for you.

This completes copying a project copy to a project. You can now edit the document or
manage it as described in any of the following topics.
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Release a Project Copy as a New Master Document
Releasing a project copy as a new master document causes a new revision of the master
document to be created from the content of the project copy that is being released. The project
copy remains in the project for future reference, though inactive.

Notes About Behavior
l After project a copy is released, another project copy can be created from same master

document in same project. You can create a workaround for this using VBScript. For more
information about VBScript, see theMeridian Enterprise VBScript API Reference Guide.

l Master document hybrid parts will not be replaced by renamed project copy hybrid parts
unless the content of the project copies has also been changed.

l If this command is run on a selection of documents, only the documents that meet the
preceding conditions will be released. The other documents will not be released until the
conditions have been met and the command run on them again.

General Requirements
In order to release a project copy as a new master document, the following conditions must be
met:

l The project copy must be in a released document workflow state.
l The master document must not be locked or it must be locked by the project copy being

released. If the project copy cannot be released as a new master document revision because
the master document is locked by a different project copy, you must unlock it first. See
Unlock a Master Document.

l The master document must not have been changed since the project copy was created. If
the project copy cannot be released as a new master document revision because the master
document has been changed, you must reconcile the project copy with the master
document first. See Reconcile With an Updated Master Document.
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Security Requirements
l You must have the following privileges to use this command if the master document already

exists:
o Document privileges: Edit in Application, View Content, Release as Master Revision,

Lock Master Document, Update Master Document, Unlock from Project
o Folder privileges: List Content
o Workflow privileges: Start Quick Change, Release Quick Change

l If the master document does not already exist you must have the following privileges in
addition to the preceding privileges:

o Folder privileges: Create Document

For more information about privileges, see Security privilege descriptions.

PowerWeb Procedures
Use these steps for PowerWeb.

Important!
When any dependency of the selected document cannot be released as master, this action will
fail.

If the following conditions are true and you cancel the operation, the document will be released
unexpectedly. If these conditions are not true, the document will remain its current state.

l Site cache mode option is enabled as described in Personal Preferences
l The document uses a custom workflow
l A custom property page is shown during the transition

To release a project copy to master:

l Choose one of the following options:
o From the ribbon:

1. Select the project copy.

2. In the Project ribbon Assign group, select Release as Master Revision.
o From the context menu:

1. Right-click the project copy.

2. Point to Project and select Release as Master Revision.

Confidential and Proprietary © 2022 396 www.accruent.com

SecurityPrivilegeDescriptions.htm


o From the Thumbnails view:

1. Right-click the thumbnail of the project copy.

2. Point to Project and select Release as Master Revision.

A new revision of the master document is created using the project copy.

If the document type is configured to use waiting lists, the Master and Project Copies page
no longer shows that project copy. Depending on the way in which your vault and project
folders are configured, the next waiting project copy remains as a waiting project copy. If
this occurs, you can Transfer to next, which activates next waiting project copy and sets its
priority to zero.

PowerUser Procedures
Use these steps for PowerUser.

To release a project copy to master:

1. Select the project copy to be released.

2. From the Documentmenu, select Managed Change (Master/Project Copy) .

3. Click Release from Folder (Release as Master Revision).

A new revision of the master document is created from the content of the project copy and
the project copy becomes inactive.
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Reconcile With an Updated Master Document
When the master document of a project copy has changed since the project copy was made, the
master document may contain more or less information than the project copy, possibly making
the project copy obsolete.

You can reconcile the difference between the two documents by one of the following commands:

l Discard from Folder (Project)— This assumes that because of whatever changes were
made to the master document, the project copy is now obsolete and the project copy
should be destroyed. This command cannot be undone.

l Confirm Superseded by Master— This assumes that because of whatever changes were
made to the master document, the project copy is now obsolete. In this situation, the
system retains the project copy and its reference to the master document for future
reference, but makes the project copy obsolete. The system also prevents the project copy
from being released as a new master document revision. This command can be undone with
the Undo Make Obsolete command.

This command is only available if the Advanced Project Workflow Module has been enabled
for the vault.

l Confirm Merged with Master— This assumes that the changes made to the master
document have also been made to the project copy. This option should be used after you
have physically merged changes in the master document with the project copy. In this
situation, the system retains the project copy and its reference to the master document for
future reference. The system will allow the project copy to be released as a new master
document revision (possibly after additional changes are made to the project copy) after
which the project copy becomes inactive. This command can be undone with the Require
Merge command.

This command is only available if the Advanced Project Workflow Module has been enabled
for the vault.
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PowerWeb Procedures
Use these steps for PowerWeb.

Reconcile a Project Copy
To reconcile a project copy of a changed master document:

l Choose between two options:
o From the ribbon:

1. Select the project copy you want to reconcile.

2. Choose between two options:
n In the Document ribbon, in the Assign group, click Discard from Project.
n In the Document ribbon, in theMerge group, click Confirm Superseded by

Master or Confirm Merged with Master.
o From the context menu:

1. Right-click the project copy you want to reconcile.

2. Choose between two options:
n Point to Project, and then click Discard from Project.
n Point to Project, point toMerge, and then click Confirm Superseded by

Master or Confirm Merged with Master.
o From the Thumbnails view:

1. Right-click the thumbnail of the project copy that you want to reconcile.

2. Choose between two options:
n Point to Project, and then click Discard from Project.
n Point to Project, point toMerge, and then click Confirm Superseded by

Master or Confirm Merged with Master.
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Reverse Effects of Confirm Superseded by Master Command
To reverse the effects of the Confirm Superseded by Master command:

l Choose one of the following options:
o From the ribbon:

1. Select the project copy that you want to reactivate.

2. In the Document ribbon, in theMerge group, click Undo Make Obsolete.

This command is only available if the Advanced Project Workflow Module has
been enabled for the vault.

o From the context menu:

1. Right-click the project copy that you want to reactivate.

2. Point to Project, point toMerge, and then click Undo Make Obsolete.
o From the Thumbnails view:

1. Right-click the thumbnail of the project copy that you want to reactivate.

2. Point to Project, point toMerge, and then click Undo Make Obsolete.

Reverse Effects of Confirm Merged with Master command
To reverse the effects of the Confirm Merged with Master command:

l Choose one of the following options:
o From the ribbon:

1. Select the project copy that you want to re-merge.

2. In the Document ribbon, in theMerge group, click Require Merge.

This command is only available if the Advanced Project Workflow Module has
been enabled for the vault.

o From the context menu:

1. Right-click the project copy that you want to re-merge.

2. Point to Project, point toMerge, and then click Require Merge.
o From the Thumbnails view:

1. Right-click the thumbnail of the project copy that you want to re-merge.

2. Point to Project, point toMerge, and then click Require Merge.
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PowerUser Procedures
Use these steps for PowerUser.

Reconcile a Project Copy
To reconcile a project copy of a changed master document:

1. Select the project copy to be reconciled.

2. From the Documentmenu, point toManaged Change (Master/Project Copy) and click
Discard from Folder (Discard from Project, Confirm Superseded by Master, or Confirm
Merged with Master).

Reverse Effects of Confirm Superseded by Master Command
This command is only available if the Advanced Project Workflow Module has been enabled for
the vault.

To reverse the effects of the Confirm Superseded by Master command:

1. Select the project copy that you want to reactivate.

2. From the Documentmenu, click Undo Make Obsolete.

Reverse Effects of Confirm Merged with Master command
This command is only available if the Advanced Project Workflow Module has been enabled for
the vault.

To reverse the effects of the Confirm Merged with Master command:

1. Select the project copy to be re-merged.

2. From the Documentmenu, click Require Merge.

Confidential and Proprietary © 2022 401 www.accruent.com



Discard a Document From a Project Folder
Discarding a document from a project folder deletes the project copy. This is essentially the same
as revoking a revision under change in a document workflow. The project copy is destroyed along
with all changes made to it and cannot be restored. As such, you should only discard a project
copy from a project folder when you are absolutely certain that it will not be needed.

Notes about Functionality
l Discarding a project copy from a project folder is similar to, but different than, deleting a

project copy from the project folder. They both delete the project copy and unlock the
master document. But deleting the project copy breaks its incoming references whereas
discarding the project copy reroutes its incoming references to the master document and
maintains the referential integrity of the related documents.

For this reason, you should always discard project copies, not delete them unless you know
that no incoming references will be broken.

l By default, this action also removes any references to the discarded project copy. However,
this behavior can be configured differently by a System Administrator. Depending on how it
is configured, references between project copies might be redirected to the master
document if a project copy is discarded from the project. If the remaining project copy is
released from the project, both master documents will then be related by a reference that
did not exist prior to the project copies being made.

In some scenarios, such as assembly relationships, this might be desirable. In other
scenarios, such as custom references, this might not be desirable. Before using this
command, carefully consider its effect on references with respect to your business
processes and consult a System Administrator if the result is uncertain.
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PowerWeb Procedures
Use these steps for PowerWeb.

To discard a project copy document from a project folder:

l Choose one of the following options:
o From the ribbon:

1. Select the project copy that you want to discard.

2. In the Project ribbon, in the Assign group, click Discard from Project.

A dialog box opens, asking you to confirm your choice.

3. Click OK.
o From the context menu:

1. Right-click the project copy that you want to discard.

2. Point to Project and then click Discard from Project.

A dialog box opens, asking you to confirm your choice.

3. Click OK.
o From the Thumbnails view:

1. Right-click the thumbnail of the project copy.

2. Point to Project and then click Discard from Project.

A dialog box opens, asking you to confirm your choice.

3. Click OK.

PowerUser Procedures
Use these steps for PowerUser.

To discard a project copy document from a project folder:

1. Select the project copy to be discarded.

2. From the Documentmenu, selectManaged Change (Master/Project Copy) , and click
Discard from Folder (Discard from Project).

A dialog box opens, asking you to confirm your choice.

3. Click Yes.
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Lock a Master Document
Locking a master document prevents it from being revised either directly by document workflow
or indirectly by a project copy other than the one that is locking it. A locked master document
may only be revised by the project copy from which the lock was placed.

A master document can be locked by either of two methods:

l With the Create Project Copy and Lock command while creating a project copy as described
in Create a Project Copy.

l With the Lock Master Document command if the project copy has already been created
without a lock as described in the following task.

Note:
l Locking is recursive. This means that locking a master document will also lock any

referenced documents. If locks on the references have been removed by other changes,
you can refresh the locks by running this command again.

l This command is only available if the Advanced Project Workflow Module has been
enabled for the vault.

PowerWeb Procedures
Use these steps for PowerWeb.

To lock a master document to an existing project copy:

l Choose one of the following options:
o From the ribbon:

1. Select the project copy.

2. In the Project ribbon, in the Locks group, click Lock Master Document.
o From the context menu:

1. Right-click the project copy.

2. Point to Project, point to Locks, and then click Lock Master Document.
o From the Thumbnails view:

1. Right-click the thumbnail of the project copy.

2. Point to Project, point to Locks, and then click Lock Master Document.
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PowerUser Procedures
Use these steps for PowerUser.

To lock a master document to an existing project copy:

1. Select the project copy for which you want to lock its master document.

2. From the Documentmenu, point toMaster/Project Copy, and click Lock Master Document.

A red lock icon will appear next to the master document in the Navigation view to indicate
that it has been locked in a project folder. Its Locked property will also be set to Locked in
project. The master document may then not be revised until the project lock has been
removed.

The lock may be removed by either releasing the project copy as a new revision of the
master document or by manually unlocking it as described in Unlock a Master Document.
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Unlock a Master Document
Unlocking a master document removes the lock placed on it by a project copy. You might want to
unlock a master document in order to start a document workflow on the master document or to
create another project copy. However, the master document was probably locked for a good
reason and you should first find out why it was locked before unlocking it.

A master document may be unlocked from either of two places:

l The project copy from which the master document was locked
l The master document itself

Note:
Unlocking is recursive. This means that unlocking a master document will also unlock any
referenced documents.
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Unlock a Master Document From the Project Copy
To unlock a master document from a project copy, you must first know from which project copy
the master document was locked in order to select it. If you don't know the name of the project
copy or the project folder where it is located, you can find out easily with the Show Project
Copies command described in Show Master And Project Copies.

PowerWeb Procedures
Use these steps for PowerWeb.

To unlock a master document from the project copy:

l Choose one of the following options:
o From the ribbon:

1. Select the project copy to which the master document is locked.

2. In the Project ribbon, in the Locks group, click Unlock Master Document.
o From the context menu:

1. Right-click the project copy to which the master document is locked.

2. Point to Project, point to Locks, then click Unlock Master Document.
o From the Thumbnails view:

1. Right-click the thumbnail of the project copy to which the master document is
locked.

2. Point to Project, point to Locks, then click Unlock Master Document.

PowerUser Procedures
Use these steps for PowerUser.

To unlock a master document from the project copy:

1. Select the project copy to which the master document is locked.

2. From the Documentmenu, selectManaged Change (Master/Project Copy), and click
Unlock Master Document.

The red lock icon next to the master document in the Navigation view will disappear and its
Locked property will be set to No, indicating that the document has been unlocked.
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Unlock a Master Document From the Master
Document
To unlock a master document from the master document itself, you don't need to know from
which project copy it was locked. However, you can find out easily with the Show Project Copies
command described in Show Master And Project Copies.

PowerWeb Procedures
To unlock a master document from the master document itself:

l Choose one of the following options:
o From the ribbon:

1. Select the project copy to which the master document is locked.

2. In the Project ribbon, in the Locks group, click Unlock from Project.
o From the context menu:

1. Right-click the project copy to which the master document is locked.

2. Point to Project, point to Locks, then click Unlock from Project.
o From the Thumbnails view:

1. Right-click the thumbnail of the project copy to which the master document is
locked.

2. Point to Project, point to Locks, then click Unlock from Project.

PowerUser Procedures
Use these steps for PowerUser.

To unlock a master document from the master document itself:

1. Select the master document to be unlocked.

2. From the Documentmenu, selectManaged Change (Master/Project Copy), and click
Unlock from Folder (Unlock from Project).

The red lock icon next to the master document in the Navigation view will disappear and its
Locked property will be set to No, indicating that the document has been unlocked.
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Show Master And Project Copies
You can create multiple project copies from a single master document. The Show Project Copies
command allows you to see both master documents and all of the project copies made from
them in a single view. This enables you to locate the project copies and the master document
from which they were created.

PowerWeb Procedures
Use these steps for PowerWeb.

TheMaster and Project Copies page shows the current document and its references to the other
documents in its family. The row of the selected document is highlighted to indicate its location in
the family.

If your document type uses the concurrent engineering waiting list, the priority column indicates
the position of the project copy in the waiting list. You can manage a waiting list on this page.

Status Icons
The icons on theMaster and Project Copies page indicate the status of a document:

l — Locked document from which project copies have been created. This might be the
master document or a project copy.

l — active project copy
l —Waiting project copy. The document is in a waiting list and is read-only because it has

not yet reached the top of the list. You cannot:
o change the document type
o change the workflow state
o create a sub project copy
o download the document
o modify or annotate renditions
o modify references
o release the waiting project copy to master
o replace content.

l —Unchanged document.
l — Document under change or quick change.

Confidential and Proprietary © 2022 409 www.accruent.com



l — An information project copy. The document is located in a project folder, but is not
shown on theMaster and Project Copies page. You can add the document to a package for
information, but you cannot:

o change the content natively, on renditions, or annotate it
o change the properties
o start a workflow
o release to master
o transfer to another project
o transfer to next waiting project copy.

View Master and Project Copies Page
To view the Master and Project Copies page:

1. Choose one of the following options:
l From the ribbon:

a. Select either a master document or a project copy.

b. In the Project ribbon, in the Show Master and Project Copies group, click Show
master and project copies.

l From the context menu:

a. Right-click either a master document or a project copy.

b. Point toManaged Change (Project), and then click Show master and project
copies.

l From the Thumbnails view:

a. Right-click the thumbnail of a master document or a project copy.

b. Point to Project and then click Show master and project copies.
l From the view bar:

a. Select either a master document or a project copy.

b. In the view bar click theMaster and project copies icon .
l On the Document page:

a. Select either a master document or a project copy.

b. On the Document page next to the document name, click the Show master and
project copies icon .
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TheMaster and Project Copies page appears and shows the current document and its
references to the other documents in its family. The row of the current document is
highlighted so that you know where you are within the family.

The work-in-progress icon is red for master documents, blue for project copies, and

crossed shovels for inactive project copies.

2. Choose one or more of the following options:
l To see the path of a document, hover your cursor over the document name.
l To use the shortcut menu for the document, right-click the document name.
l To hide obsolete project copies, click Hide inactive project copies.

o Active project copies are those project copies that have not yet been reconciled
with the master document. That is, either superseded by the master document
or merged with the master document.

o Inactive project copies are those project copies that have already been reconciled
with their master document.

l To go to a different document in the family, click the document name.

If the document cannot be shown in the current view, it is shown in the Folders view.
l To compare two copies, select the copies that you want to compare and then in the

Project ribbon, in theMaster and Project Copies group, click Compare or Compare
Renditions.

PowerUser Procedures
Use these steps for PowerUser.

To view the references between master documents and project copies:

1. Select either a master document or a project copy.

2. On the Documentmenu, point toManaged Change (Master/Project Copy) and click Show
Project Copies.

A reference browser dialog will appear similar to the following figure. The reference
browser can also be displayed by clicking the work-in-progress icon on the Document
page of the selected document.

Note:

The work-in-progress icon is red for master documents, blue for project copies, and

crossed shovels for inactive project copies.
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Active project copies are those project copies that have not yet been reconciled with the
master document. That is, either superseded by the master document or merged with the
master document.

Inactive project copies are those project copies that have already been reconciled with their
master document and are shown in gray in the reference browser. Inactive project copies
may be hidden from viewing in the reference browser by disabling the Display inactive
project copies option in the Options dialog accessed by the Options button.

3. Select a document in the upper-left pane to view its path in the upper-right pane.

4. Click Go to to close the reference browser and make the selected document the selected
document in the Navigation view.

Click Close to close the reference browser and return to the selected document in the
Navigation view.

Following are descriptions of the three panes of the reference browser dialog.

l The upper-left pane displays a tree view of the master document and each of its project
copies. Project copies are listed below and indented from the master document. The
selected document is shown in bold text. Documents under change by you are shown in
blue text. Inactive project copies are shown in gray text.

If the master document is locked in a project folder, a red lock icon is shown next to the
master document's name and a blue lock icon is shown next to the name of the project
copy to which the master document is locked.

l The upper-right pane displays the path of the document selected in the upper-left pane.
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l The lower pane displays those properties that have been configured by a System
Administrator to appear in the reference browser. If a thumbnail image is available for the
selected document, it also appears in the lower pane.

Note:
Right-click a document in the upper-left pane to display the document context menu.
Document commands that are valid for the current context, project workflow state, and
document workflow state are available for use.

The toolbar buttons are described in the following table.

Option Description

Opens the selected document in a new viewer window.

Compares two selected documents.

Shows the revisions of the selected document.

Show the property pages of the selected document.

Refreshes the Reference Explorer to display the most recent changes.

Shows outgoing CAD external reference types.

Shows incoming CAD external reference types and custom reference types.

Shows Derived From and Derived To reference types.

Shows project copies and their master documents. Requires the Advanced Project
Workflow Module.

When creating copies, shows the assembly copy options. When viewing references,
shows visibility options for manual references and inactive project copies:

l Display manual references— Show only references that can be created manually
and are not created automatically by application links. Enabled by default.

l Display inactive project copies— Along with active project copies, also show
project copies that have been released as new master revisions, have been
superseded by the master document, or have been merged with the master
document. Enabled by default.

Reference Explorer toolbar buttons
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Link To a Master Document
Linking to a master document can be useful when you import a new document into a project
folder from outside the vault. In this scenario, the document should have become a project copy
of a master document that resides in the vault, but it was not copied from the master document
using a managed change command. Linking the new project copy will create a reference to the
master document that you select and will create a revision of the master document when the
linked copy is released.

Note:
The command is unavailable if:

l You select the two documents in the reverse order.
l One of the documents is under change.
l The imported document is already linked to a master document.
l The imported document is not in a project folder.
l The master document is not in a higher folder level than the project folder.
l The master document already has a project copy.

PowerWeb Procedures
Use these steps for PowerWeb.

To link an imported document to a master document:

1. Choose one of the following options:
l From the ribbon:

a. Select the imported document.

b. In the Project ribbon, in the Links group, click Link to Master Document.

The Find Master Document dialog box appears.
l From the context menu:

a. Right-click the imported document.

b. Point toManaged Change (Project), and then click Link to Master Document.

The Find Master Document dialog box appears.
l From the Thumbnails view:
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a. Right-click the thumbnail of the imported document.

b. Point to Project and then click Link to Master Document.

The Find Master Document dialog box appears.

2. Select options and type values to find the master document and then click Find Now.

3. Select the master document in the list and click Link to Master.

The imported document is made a project copy of the selected master document. On the
Document page of both documents, the reference icon appears next to the document name
(if it did not already) and the project copy status icon appears next to the label
Workflow. The new reference can be viewed as described in Show Master And Project
Copies.

PowerUser Procedures
Use these steps for PowerUser.

To link an imported document to a master document:

1. Select the master document to which you want to link to the imported document.

2. Select the imported document.

3. From the Documentmenu, point toManaged Change (Master/Project Copy), and select
Link to Master Document.

4. Select the master document and click Link to Master Document.

The imported document is made a project copy of the selected master document. On the
Document page of both documents, the reference icon appears next to the document name
(if it did not already) and the project copy status icon appears next to the label
Workflow. The new reference can be viewed as described in Show Master And Project
Copies.
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Unlink From a Master Document
Unlinking from a master document can be useful if the project copy was originally made from a
master document but the project copy should no longer be released as a revision of the master
document but instead released as a new master document. Unlinking the project copy will
remove from the master document the reference that was created when the project copy was
made from the master document. Unlinking will also unlock the master document if it was locked
when the project copy was made.

PowerWeb Procedures
Use these steps for PowerWeb.

To unlink a project copy from a master document:

l Choose one of the following options:
o From the ribbon:

1. Select the project copy that you want to unlink.

2. In the Project ribbon, in the Assign group, click Unlink from Master Document.

A dialog box opens, asking you to confirm your choice.

3. Click Yes.

The project copy is unlinked from the master document.
o From the context menu:

1. Right-click the project copy that you want to unlink, point toManaged Change
(Project), and then click Unlink from Master Document.

A dialog box opens, asking you to confirm your choice.

2. Click Yes.

The project copy is unlinked from the master document.
o From the Thumbnails view:

1. Right-click the thumbnail of the project copy.

2. Point to Project and then click Unlink from Master Document.

A dialog box opens, asking you to confirm your choice.

3. Click Yes.

The project copy is unlinked from the master document.
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PowerUser Procedures
Use these steps for PowerUser.

To unlink a project copy from a master document:

1. Select the project copy that you want to unlink.

2. From the Documentmenu, point toManaged Change (Master/Project Copy), and click
Unlink from Master Document.

A dialog box opens, asking you to confirm your choice.

3. Click Yes.

The project copy is unlinked from the master document.
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Subscribe To Changes
When you are responsible for important documents that could be changed by others, you might
want to be notified when changes occur of which you are not aware. You can subscribe to those
documents to receive email messages when events occur that you are interested in. You may also
subscribe to receive reminders for specific documents for which a System Administrator has
configured periodic reminders. If you have the Allow Management of Subscriptions for others
privilege, you can add or remove subscriptions for other users.

Notes About Functionality
l You might also receive event notifications or reminders for documents to which you did not

subscribe. These could be the result of automatic notifications configured by a System
Administrator.

l For folder subscriptions you can subscribe to events that occur on documents contained in
the folder at that moment. If a document is added to the folder later, you are not
automatically subscribed to that document. For project subscriptions, you can subscribe to
events that occur on the project, such as project workflow transitions.

l Subscriptions require some configuration by a System Administrator. Also, you must be a
member of a group that has been granted the Allow Subscriptions or Allow Management
of Subscriptions for others privileges in the folder containing the documents that you want
to subscribe to. See the Security Privilege Descriptions section of theMeridian Enterprise
Configuration Guidefor more information.

l Notifications are only sent to your primary email address as set by a System Administrator
and as described in the Create and edit user accounts article in theMeridian Enterprise
Administrator's Guide.

PowerWeb Procedures
Use these steps for PowerWeb.

Subscribe to Document or Folder
To subscribe to changes on a document or folder:

1. In any navigation view, select the documents or folders that you want to change
subscriptions for.
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2. Choose one of the following options:
l In the Document or Folder ribbon, in the Action group, click Subscribe.
l Right-click anywhere within your selection, point to Document, and then click

Subscribe on the shortcut menu that appears.

The Subscribe dialog box appears and lists the available events and reminders that you
can subscribe to. The events to which you have already subscribed are selected.

l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Choose between two options:
o Select Folder > Subscribe.
o Select Document > Subscribe.

3. Select events you want to subscribe to for the selected documents or folders.

4. Click Next.

The next page of the dialog box opens.

5. Choose between two options:
l If you have the Allow Management of Subscriptions for others privilege, select the

users who should receive notifications about the selected documents.

You can only deselect yourself if at least one other user is selected.
l If you do not have the Allow Management of Subscriptions for others privilege,

proceed to step 6.

6. Click Next.

The next page of the dialog box opens. This page lists the changes you have made and asks
you to confirm them.

7. Click OK.

Unsubscribe from Document or Folder
To unsubscribe from changes on a document or folder:

1. In any navigation view, select the documents or folders that you want to change
subscriptions for.

2. Choose one of the following options:
l In the Document or Folder ribbon, in the Action group, click Unsubscribe.
l Right-click anywhere within your selection, point to Document, and then click

Unsubscribe on the shortcut menu that appears.
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The Unsubscribe dialog box appears and lists the available events and reminders that
you can unsubscribe from.

l From the Thumbnails view:

a. Right-click a thumbnail of a folder or document.

b. Choose between two options:
o Select Folder > Unsubscribe.
o Select Document > Unsubscribe.

3. Select events you want to unsubscribe from for the selected documents or folders.

4. Click Next.

The next page of the dialog box opens.

5. Choose between two options:
l If you have the Allow Management of Subscriptions for others privilege, select the

users who should no longer receive notifications about the selected documents.

You can only deselect yourself if at least one other user is selected.
l If you do not have the Allow Management of Subscriptions for others privilege,

proceed to step 6.

6. Click Next.

The next page of the dialog box opens. This page lists the changes you have made and asks
you to confirm them.

7. Click OK.

Subscribe to Project
To subscribe to changes on a project:

1. In any navigation view, select the projects that you want to change subscriptions for.

2. Choose one of the following options:
l To take action from the Folder ribbon:

a. In the Folder ribbon, in the Action group, click the down arrow next to Subscribe.

b. Select Subscribe to Project from the menu that appears.
l Right-click anywhere within your selection, point to Folder, and then click Subscribe to

Project on the shortcut menu that appears.

The Subscribe dialog box appears and lists the available events and reminders that you
can subscribe to. The events to which you have already subscribed are selected.
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l From the Thumbnails view:

a. Right-click a thumbnail of a folder.

b. Select Folder > Subscribe to Project.

3. Select events you want to subscribe to for the selected projects.

4. Click Next.

The next page of the dialog box opens.

5. Choose between two options:
l If you have the Allow Management of Subscriptions for others privilege, select the

users who should receive notifications about the selected documents.

You can only deselect yourself if at least one other user is selected.
l If you do not have the Allow Management of Subscriptions for others privilege,

proceed to step 6.

6. Click Next.

The next page of the dialog box opens. This page lists the changes you have made and asks
you to confirm them.

7. Click OK.

Unsubscribe from Project
To unsubscribe from changes on project:

1. In any navigation view, select the project that you want to change subscriptions for.

2. Choose one of the following options:
l To take action from the Folder ribbon:

a. In the Folder ribbon, in the Action group, click the down arrow next to
Unsubscribe.

b. Select Unsubscribe from Project from the menu that appears.
l Right-click anywhere within your selection, point to Folder, and then click Unsubscribe

from Project on the shortcut menu that appears.

The Unsubscribe dialog box appears and lists the available events and reminders that
you can unsubscribe from.

l From the Thumbnails view:

a. Right-click a thumbnail of a folder.

b. Select Folder > Unsubscribe from Project.

3. Select events you want to unsubscribe from for the selected documents.
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4. Click Next.

The next page of the dialog box opens.

5. Choose between two options:
l If you have the Allow Management of Subscriptions for others privilege, select the

users who should no longer receive notifications about the selected documents.

You can only deselect yourself if at least one other user is selected.
l If you do not have the Allow Management of Subscriptions for others privilege,

proceed to step 6.

6. Click Next.

The next page of the dialog box opens. This page lists the changes you have made and asks
you to confirm them.

7. Click OK.

PowerUser Procedures
Use these steps for PowerUser.

To subscribe to or unsubscribe from changes:

1. In any navigation view, select the documents that you want to change subscriptions for.

2. On the Document or Foldermenu, select Change Subscription.

The Change Subscription dialog box appears and lists the available events and reminders
that you can subscribe to. The events to which you have already subscribed are selected.

Changes to the selected events in this list are not saved if you click the Subscribers button
and will be reset when that dialog is closed. If you want to change the subscriptions of other
users, select the subscribers in the next step first and then change the events to which they
are subscribed.

3. To change the subscriptions of other users:

a. Click Subscribers.

The Subscribers dialog box appears and lists all system users. By default, your name is
selected to change only your subscription options.

b. Select or clear user names to change their subscriptions to the selected items.

c. Click OK.

4. Select or clear events and reminders to change the subscriptions to the selected items for
the users that you selected.

The check boxes shown by this dialog box can represent three states that indicate how
many of the selected subscribers are subscribed to the corresponding event.
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5. To view the names of the subscribers for a specific event, select the event and click
Subscribers.

The Subscribers dialog box appears and lists the users that are subscribed to the selected
event.

6. Click OK.

Confidential and Proprietary © 2022 423 www.accruent.com



View And Remove Subscriptions
You can view all of your subscriptions at once with the subscriptions viewer in a web browser.
There you can filter and sort subscriptions to meet your needs and remove unwanted
subscriptions.

Note:
A System Administrator must install and configure subscriptions to use this command.

PowerWeb Procedures
Use these steps for PowerWeb.

To open the subscriptions viewer:

1. In any navigation view, select the documents or project folders that you want to change
subscriptions for.

2. In the Document or Folder ribbon, in the Actions group, click Change Subscription.

A page titledMeridian: Subscriptions viewer opens in a new tab. The subscriptions are
sorted on the column indicated by the arrow icon in the column heading. Your privileges to
manage the subscriptions are shown at the bottom of the page.

3. To change the sort order or select a filter:

a. Point to a column heading.

b. Click the arrow button that appears.

c. Click the sort option or filter that you want on the shortcut menu that appears.

If you selected a sort option, the arrow icon appears in that column heading. If you
selected a filter, the filter icon appears in that column heading.
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PowerUser Procedures
Use these steps for PowerUser.

Open Subscriptions Viewer
To open the subscriptions viewer:

1. In the Tools menu, click View Subscriptions.

A page titledMeridian Enterprise 2022: Subscriptions viewer opens in a browser window.
The subscriptions are sorted on the column indicated by the arrow icon in the column
heading. Your privileges to manage the subscriptions are shown at the bottom of the page.

2. Continue as described in step 2 above.

Remove Subscriptions
To remove subscriptions:

l Select the subscriptions that you want to remove, select Unsubscribe in the command list,
and click Execute.

The view refreshes to show the subscriptions removed.
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Shared Workspace Folders
By default, when you work on documents in a vault folder, copies are made in your local
workspace folder for best performance and compatibility with the applications that you use. For
more information about local workspace, see Local Workspace. However, some applications
require multi-user access to project and other data files that is incompatible with local workspace.
For those applications, Meridian provides shared workspace folders.

Notes about Functionality
A shared workspace is a custom type of folder in a vault that Meridian manages in special ways:

l Instead of downloading to the local workspace folder on your computer for you to view and
edit exclusively, the documents download to a shared network location for shared viewing
and editing.

Note:
With PowerWeb, documents that are viewed or edited are first downloaded to your local
workspace before they are copied to the shared workspace folder. Renditions are also
downloaded to your local workspace but are not copied to the shared workspace folder
because renditions are read-only.

Important!
If a document is locked in the shared folder but changed in a local workspace, the version
in the shared folder is considered as the correct version and can overwrite the changes
made otherwise. For this reason, you should not attempt to circumvent the system and
you should use workflows to make all document changes to ensure proper
synchronization.

l The contents of the shared workspace can be automatically synchronized with its
corresponding vault folder if configured by a System Administrator. You can manually
synchronize the folder (download) from the vault with the Lock Documents and Sync
Workspace command on the Foldermenu in PowerUser. You can synchronize the vault
from the folder (upload) with the Sync Workspace command.

When synchronization occurs:
o Documents in the shared folder that are in a writable workflow state are updated with

any changes in the vault.
o Documents in the vault that are in a writable workflow state are updated with any

changes in the shared folder.
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o New documents in the folder are created in the vault. If the folder option Default
document type for new documents is set, the documents are assigned that type.
Otherwise, they are assigned the default document type for the file extension. During
manual synchronization, if the folder option Show wizard on creation of new
documents is enabled, the wizard for the document type of each new document is
shown for input. If the wizard is canceled, the document is not created.

o During manual synchronization, if the folder option Delete documents from
workspace when released from workflow is enabled, released documents are deleted
from the folder. Released documents are copied to the shared folder if they are
viewed or if they are referenced by other documents in the folder that are opened for
editing.

l Shared workspace folders can be created and configured as described in Configure Shared
Workspaces if you have the Edit shared workspace settings privilege as described in
Security Privilege Descriptions. Both of these articles are in theMeridian Enterprise
Configuration Guide. For information about how shared workspaces are configured in your
organization, consult a System Administrator.

l A shared workspace can also be a project folder as described in Project Folders.

Best Practices
To work with documents in a shared workspace folder:

l One person (the workgroup leader or project manager, for example) should be assigned as
the shared workspace manager.

l Only the shared workspace manager should place the shared workspace documents under
change and release them as they normally would.

l Any person may synchronize the workspace with the vault.
l Any person may edit the documents in the shared network location that is associated with

the parent vault folder.

Configure Options
To configure the options for a shared workspace folder:

l Edit the options in the Sharing details group on the Folder tab of the folder as described in
the Configure Shared Workspaces article in theMeridian Enterprise Configuration Guide .

You must have the Edit shared workspace settings privilege to modify the options as
described in the Security Privilege Descriptions article in theMeridian Enterprise
Configuration Guide.
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Packages
A package in Meridian Enterprise is a set of documents contained in an archive (ZIP) file. There
are two types of packages available: export packages and import packages. Packages are similar
to briefcases but simpler. However, the two are different and are not interchangeable.

You can use export packages to send documents to people who do not have access to Meridian
Enterprise, for example, as simple transmittals. The most important way that export packages are
different from briefcases is that export packages are sent by Meridian Enterprise Server to a
different storage system (Windows file system, FTP site, cloud service, etc.), not to a person by
email. Meridian Enterprise Server uses the Publisher system links to transfer the packages for
you. The rest is automatic but you can monitor the status of the package in Meridian Explorer to
verify that it was sent. You may also view packages that have already been sent and search for
documents inside packages.

An import package is a set of documents contained in an archive (ZIP) file and an accompanying
MS Excel workbook that contains metadata about the package documents. Import packages can
be imported into a Meridian Enterprise vault through Meridian Explorer.The packages can be
created by Meridian Explorer, manually by users, or by some other system and sent to Meridian
Enterprise Server.

The following topics describe the different ways that you can work with export packages in
Meridian Enterprise. For information about working with import packages in Meridian Explorer,
see Import With Packages in theMeridian Explorer User's Guide .
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View Related Packages
Meridian vault documents can be published to Meridian Explorer repositories for viewing by
other users in the Meridian Explorer web application. Meridian Explorer users can also export the
documents (if the repository is configured to do so by a System Administrator) to export packages
for use by business partners.

Conversely, Meridian Explorer users can import documents into the Meridian Enterprise vault
with import packages.

Meridian keeps track of all these relationships so that you don't have to. From within PowerUser
or PowerWeb, you can easily see the names of the export packages and import packages that
contain a selected document.

For information about working with packages in Meridian Explorer, see Packages in theMeridian
Explorer User's Guide .

Note:
l The Export Packages and Import Packages pages are disabled by default and must be

enabled by a System Administrator as described in the Property Page Events article in the
Meridian Enterprise VBScript API Reference Guide.

l The dates shown for import package in PowerWeb and Meridian Explorer are shown in
GMT format. In PowerUser the are converted to the local time zone.

PowerWeb Procedures
Use these steps for PowerWeb.

View Import and Export Packages Related to a Document
To view the import packages and export packages related to a document:

1. Select the document for which you want to view its related packages.

2. Click the Export Packages or the Import Packages tab.

The Export Packages page lists the export (outgoing) packages that include the selected
document. The Import Packages page lists the import (incoming) packages from which the
selected document was imported.

3. To view an individual package, click the name of the package that you want to view.

The Collections view opens in Meridian Explorer in a new browser window with the selected
package highlighted.
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View All Import Packages in System
To view all the import packages in the system:

Choose between two options:

l In the Vault ribbon, in the Package group, click Import Packages.
l In any navigation view, right-click any document, point to Vault, and then click Show Import

Packages.

The Import Packages page opens in Meridian Explorer in a new browser window.

View All Export Packages Related to the Current Vault
To view all the export packages related to the current vault:

Choose between two options:

l In the Vault ribbon, in the Package group, click Export Packages.
l On the Export Packages page of any document, click See all packages.

The Collections view opens in Meridian Explorer in a new browser window.

PowerUser Procedures
Use these steps for PowerUser.

View Import and Export Packages Related to a Document
To view the import packages and export packages related to a document:

1. Select the document for which you want to view its related packages.

2. In the Properties pane, click the Export Packages or the Import Packages tab.

The Export Packages page lists the export (outgoing) packages that include the selected
document. The Import Packages page lists the import (incoming) packages from which the
selected document was imported.

3. To view an individual package, right-click the row of the package that you want to view and
then click Show package on the shortcut menu that appears.

The Collections view opens in Meridian Explorer in a new browser window with the selected
package highlighted.
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View All Import Packages in System
To view all the import packages in the system:

l On the Tools menu, click Show Import Packages.

The Import Packages page opens in Meridian Explorer in a new browser window.

View All Export Packages Related to the Current Vault
To view all the export packages related to the current vault:

l On the Tools menu, click Show Export Packages.

The Collections view opens in Meridian Explorer in a new browser window.
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Add Documents To Packages
Meridian Explorer users can export documents to export packages for use by business partners.
You can add documents to these packages from within Meridian Enterprise or create new
packages for export by Meridian Explorer users.

Notes About System Behavior
l When you add documents to a package, only the current revision of the document is added

and the package will only appear on the Export Packages property page of that revision.
Subsequent revisions of the document will not show the package unless you view the prior
revision of the document as described in View Prior Revisions.

l Depending on the configuration of the publishing job that is assigned to a package,
documents that you add to the package might be locked after the package is sent. For
information about unlocking such documents, see Lock And Unlock Documents.

l Adding documents to a package can fail for a variety of reasons including:
o Document properties do not pass validation by the vault's configuration. Edit the

properties of the document to set any required values and correct any invalid values in
Meridian first, then add the documents to a package.

o Documents do not pass assembly reference validation. Be sure to include all
referenced documents in your selection before adding them to a package.

PowerWeb Procedures
Use these steps for PowerWeb.

Create a New Export Package
To create a new export package:

1. On the Export Packages property page of any document, click New Package.

The New Package dialog box appears.

2. Complete the following fields:
l Name— The name of the package as it should appear to others.
l Recipient— The email addresses of the persons that will be notified about the

package. Separate multiple email addresses with commas (,).
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l Description— A description of the package as you want others to see it.
l Include Content— Select which document content to include in the package: the

source document, the rendition, or both.
l Related Project— If this document is associated with a project, this field will auto-

populate with the project the document is associated with. If this document is not
associated with a project, you can choose to select a project from this field. You are
not required to choose a project from this field.

l Export Destination— Select a destination where to create the package.

3. Click Create.

The package is created and can be selected in the preceding task.

Add Documents to an Existing Package
To add documents to an existing package:

1. Choose one of the following options:
l From the context menu:

a. Select the documents that you want to add to a package.

b. Right-click anywhere within your selection, point to Vault, and then click Add to
Export Package on the shortcut menu that appears.

The Add to Export Package/Select Package dialog box appears.
l From the ribbon:

a. Select the documents that you want to add to a package.

b. In the Exchange ribbon, in the Package group, click Add to Export Package.

The Add to Export Package/Select Package dialog box appears.
l From the Thumbnails view:

a. Right-click a thumbnail of a document.

b. Select Document > Add to Export Package.

The Add to Export Package/Select Package dialog box appears.

2. Select the package to which you want to add the documents.

3. If you want to include CAD references, select the check box.

4. Click OK.

A progress dialog box appears and shows the results of adding the documents to the
package. If any documents fail property value validation or assembly reference validation,
they are not added to the package.
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Add Search Results to Existing Export Package
To add a batch of files to an existing export package:

1. Conduct a search.

2. Select the Search Results heading.

This will apply the command you select to all results in your search, including results on
subsequent pages.

3. Select the Add to Export Package command from the Exchange tab.

The Add to Export Package/Select Package dialog box appears and lists the existing export
packages.

4. Select the package to which you want to add the documents.

5. If you want to include CAD references, select the check box.

6. Click OK.

A progress dialog box appears and shows the results of adding the documents to the
package. If any documents fail property value validation or assembly reference validation,
they are not added to the package.

PowerUser Procedures
To add documents to a new or existing package:

1. Select the documents that you want to add to a package.

2. Right-click anywhere within your selection and then click Add to Export Package on the
shortcut menu that appears.

The Select Package dialog box appears and lists the existing export packages.

3. If the package you want to add the documents to does not yet exist and you want to create
a new package:

Note:
If you proceed, you will not be able to assign the package to a project. If you want to
assign the package to a project, create the package first and assign it to the project and
then add the documents to the package.

a. Click Create new package.

The Create new package dialog box appears.

b. Click options or type values using the descriptions in the preceding table.

Confidential and Proprietary © 2022 434 www.accruent.com



c. Click OK.

The new package appears in the package list.

4. Select the package to which you want to add the documents and then click OK.

A progress dialog box appears and shows the results of adding the documents to the
package. If any documents fail property value validation or assembly reference validation,
they are not added to the package.
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Tags
Meridian links asset information obtained from a maintenance management system to
documents shown in Meridian Enterprise. This provides convenient access to asset data to
engineering users to manage the links.

In PowerUser, tag management appears as an additional property page for documents:

l Tags— shows the assets that are linked to a selected document.

The tags reside in the Meridian Enterprise vault and can be related to the documents or
other tags. The tags act as proxies for the maintenance management system assets. The
tags are created and periodically updated by Meridian from data that resides in your
maintenance management system. You explicitly link them to documents in Meridian
Enterprise based on the relationships between the document data and tag data.

You can link documents or tags to tags or vice versa; both methods are supported. The
configuration of the linking is done in Meridian Enterprise Configurator by a System
Administrator. This page is also used to find and link tags to documents.

And one or more additional property pages for tags (assets):

l Where Used— shows the documents that are linked to a selected tag. This page is also
used to find and link documents to tags.

l Tags— shows the other tags that are linked to a selected tag. This page is also used to find
and link tags to tags.

This page is optional and must be registered and configured in the vault by a System
Administrator as described in Property Pages And Wizard Pages.

This page is optional and must be registered and configured in the vault by a System
Administrator as described in Property Pages And Wizard Pages in theMeridian Enterprise
Configuration Guide.

Meridian also provides a Find Tags command that can be used to perform simple searches for
tags.

In PowerWeb, the same Related Tags andWhere Used pages are available if configured by a
System Administrator.

The columns and search fields that are shown by Meridian are configured by a System
Administrator. For more information about configuration, see Configure Column Display in the
Meridian Enterprise Configuration Guide.
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Note:
Many of the following topics instruct you to click theManage Links button on property pages in
PowerUser to create and edit the relationships with tags. Typically, to edit the information
shown on property pages, you must first click the Edit button on the property page.
This is not necessary for the Meridian property pages in PowerUser. However, it is necessary to
first click the Edit button on the property page in the PowerWeb.
In PowerWeb, the links are created or removed immediately after clicking the appropriate
button, not after clicking OK or Apply as is usual. Also, clicking Cancel in PowerWeb does not
revoke the actions that you have taken while in edit mode.
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Maximo Integration
Even without Meridian, Maximo provides a Linked Documents page that shows documents that
are linked to the selected tag. However, Maximo provides no formal revision control, workflow,
or approval processes for these documents. You are never sure if you are looking at an up-to-date
or obsolete document. This can lead to costly errors in both the maintenance and engineering
departments because the incorrect revision of a document can been linked.

Meridian provides the necessary control over documents, their revisions, workflow, and approval
along with managing links to externally referenced documents. When integrated with a
maintenance management system, the two systems work together to provide a comprehensive
solution that eliminates costly errors caused by working with incorrect or obsolete tag
information or documents.

If you are a maintenance department user, little change to your work methods is required; you
can continue to use Maximo normally. But you will notice additional information on the Attached
Documents or Linked Documents page or an Engineering Documents button on certain forms.
When the button is clicked, the related document information is shown in Meridian Explorer in a
web browser window. This additional functionality is provided by the Meridian and the
information that is shown resides in a Meridian Explorer repository that is synchronized with a
Meridian Enterprise vault.

Note:
In the remainder of this document, the term Linked Documents refers to the corresponding
page described above, depending on the version of Maximo installed by your organization.

The integration and configuration of Maximo with Meridian Enterprise is described in the
Integrate With Maximo 7 article in theMeridian Enterprise Configuration Guide. This section only
describes the Meridian features that are shown in Maximo. This functionality may be similar to or
may be absent from other maintenance management systems integrated with the Meridian.
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Integration With Other Systems
The integration of the Meridian with maintenance management systems other than Maximo (for
example, SAP Plant Maintenance or Ultimo) is much the same as for Maximo. Instead of a Linked
Documents page, typically a Linked Documents button is added to one or more other pages.
When the button is clicked, the related document information is shown in Meridian Explorer in a
web browser window.

Note:
Integration of the Meridian is specific to each maintenance management system. Therefore
professional services are needed to meet your organization's specific requirements.
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View Linked Tags
If revisions to tags are controlled by the management of change features of Meridian Enterprise,
that is, changes must be made to a copy in a project, all master and project copies of the tags will
appear in the Tags page so that you can see the all of the dependencies on the document.

Use these steps for PowerUser and PowerWeb.

View Linked Tags
To view linked tags:

l View the Tags property page.

The tag information appears in tabular format so that you can easily identify many tags.

Sort Tags
To sort the tags:

l Click the header of the column by which you want to sort the tags.

To reverse the sort order, click the header again.

Filter Tags by Property Values
To filter the tags by property values:

1. Click the arrowhead button in the column header by which you want to filter the tags.

2. Select a predefined filter from the list that appears.

You may select filters in multiple columns.

3. To clear a filter, select the All filter.

View Linked Tag Information in Property Pages
To view linked tag information in property pages instead of tabular format:

l Double-click the row of the tag that you want to view or select the row and click Go to Tag.

The selected tag becomes the active tag and you can view its property pages.
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View Linked Documents
You can view each dependency of a tag on theWhere Used page.

If document revisions are controlled by Meridian Enterprise change management and changes
must be made to a project copy, all master and project copies appear on theWhere Used page.

View Linked Documents
Use these steps for PowerUser and PowerWeb.

To view linked documents:

1. Select the tag that you want to view linked documents for.

2. Select theWhere Used page.

The document information appears in tabular format so that you can easily identify many
documents. The current path filter is shown below the document list.

To view document information in property pages instead of tabular format, select the row
of the document that you want to view.

(PowerWeb only) View Tag in Rendition
Use these steps for PowerWeb.

To view the tag in a rendition:

1. Select the tag you want to view.

2. On theWhere Used page, in the row of the document that you want to view, select the
View Rendition icon .

The viewer opens with the document zoomed in on the selected tag.

Filter Documents by Different Path
Use these steps for PowerUser and PowerWeb.

To filter the documents by a different path:

1. Click Path Filter.

2. Select the folder that contains the documents that you want.

The new path filter appears in the text box and the list of linked documents is updated to
show only the documents that reside in the selected path and its sub-folders.
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Sort Documents
Use these steps for PowerUser and PowerWeb.

To sort the documents:

1. On theWhere Used page, select the header of the column you want to sort the documents
by.

2. If you want to reverse the sort order, select the header again.

Filter Documents by Property Values
Use these steps for PowerUser and PowerWeb.

To filter the documents by property values:

1. Click the arrow head button in the column header by which you want to filter the
documents.

2. Select a predefined filter from the list that appears.

If you want to clear a filter, select All. You can select filters in multiple columns.

View Document Information in Property Pages
Use these steps for PowerUser and PowerWeb.

To view document information in property pages instead of tabular format:

l Double-click the row of the document that you want to view or select the row and click Go
to Document.

The document is selected and you can view its property pages.

View Selected Documents in Viewer Window
Use these steps for PowerUser and PowerWeb.

To view selected documents in a viewer window:

1. Select the row of a document that you want to view.

2. Click Show Viewer.

A viewer window opens with the selected document loaded.

The viewer window will remain open until you close it and it will show whichever document
you select in theWhere Used page. To close the viewer window, click Hide Viewer.
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To prevent the viewer window from being hidden behind other windows:

a. Right-click the title bar of the viewer window. A shortcut menu appears.

b. Click Always on top.

View in Full-Screen
Use these steps for PowerUser and PowerWeb.

To view a document full-screen:

1. Select the row of a document that you want to view.

2. Click View Full-Screen.

A viewer window opens full-screen with the selected document loaded.

3. To close the viewer window and return to PowerUser, click the Close button.
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Search For Tags
You can search for tags using several methods, depending on what information you know about
the tags that you want to find and your preferences:

l If you know values for the properties that are available in the Quick Find list in the Find
toolbar, you can search with that method as described in Quick Find

l If you don't want to use the Quick Find list in the Find toolbar and you want to use more
powerful search features, you can search with the Find command as described in Find.

l If you want to find tags in the same way as in theManage Document Links dialog, you can
search with the Find Tags command as described in the remainder of this topic.

Search for Tags with Find Command
Use these steps for PowerUser and PowerWeb.

To search for tags with the Find command:

l Perform the task described in Find and select Tag Object as the document type.

(PowerUser only) Search for Tags with Find Tags
Command
Use these steps for PowerUser.

If this property is part of a Field-Path definition, it is possible that when this command is used for
the first time, the full list is not shown. In this case, first select a document in PowerUser and retry
the Find Tags command.

To search for tags with the Find Tags command:

1. From anywhere in the vault, on the Toolsmenu click Find Tags.

The Find Tags dialog box appears.

2. Type search criteria in the text boxes in the top part of the dialog and click Find.

Any matching tags appear in the lower part of the dialog.

3. To make one of the tags the selected tag, double-click the tag in the list or select the tag in
the list and click Go to Tag.

The dialog box closes and the selected tag becomes the selected tag.

Confidential and Proprietary © 2022 444 www.accruent.com



Link Tags To a Document
Linking a tag to a document creates a Meridian Enterprise reference between the selected
document and the selected tags in the vault. The reference is made with the TagObject Reference
type. The reference becomes the link between document data in the vault and asset data in the
maintenance management system that enables users of either system to view the data in the
other system.

Linking tags to a document and linking documents to a tag as described in Link Documents To a
Tag accomplish the same thing. The only difference is the point of reference, a tag or a document.
You can use either method depending on which is more convenient for you.

Note:
You must have the Edit Tag Assignments privilege to perform this task and the current
document must the be latest revision of the document.

PowerWeb Procedures
Use these steps for PowerWeb.

To link tags to a document:

1. Select the document to which you want to link tags.

2. View the tags that are currently linked to the document as described in View Linked Tags.

Confirm that the tags that you want to link are not already linked.

3. Click Find Tags.

The Find Tags dialog box appears.

The dialog box contains two sections. You use the top section to search for tags to link to
the current document. The bottom section shows all of the tags that match the search
criteria and that are not yet linked to the current document. You can only see 250 results at
a time for performance reasons, unless you filter the Find Tags dialog box.

4. Type or select search criteria and click Find.

Any matching tags appear in the bottom section.

To refine your search, type or select search criteria and click Find Now.

Only the first page of tags is shown. To view more tags, use the page controls at the bottom
of the search results list.
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5. Select the tags in the bottom section of the dialog box that you want to link to the current
document and click Link.

The tags are removed from the bottom section of the dialog box.

Click the icons in the header row to add or remove all of the found tags from your selection.

The links are created immediately after clicking the button. Also, clicking Close does not
revoke the actions that you have taken.

6. Click Close.

PowerUser Procedures
Use these steps for PowerUser.

To link tags to a document:

1. Select the document to which you want to link tags.

2. View the tags that are currently linked to the document as described in View Linked Tags.

Confirm that the tags that you want to link are not already linked.

3. ClickManage Links.

TheManage Document Links dialog box appears.

The dialog contains three sections. You use the top section to search for tags to link. The
middle section shows all of the tags that match the search criteria and that are not yet
linked to the selected document. The bottom section shows the currently linked tags.

4. Type search criteria in the top section of the dialog.

If an Enable filtering check box is visible in the top section, you can select it to filter the
results using criteria that have been configured by a System Administrator. This can be
helpful to exclude non-relevant documents. Click Find.

Any matching tags appear in the middle section. Only the first 250 tags are shown. To view
more tags, click Next.

5. Select the tags in the middle section of the dialog that you want to link to the selected
document and click Create Links.

The tags are moved to the bottom section of the dialog.

Press and hold the Ctrl key while clicking to add or remove tags from your selection. Press
and hold the Shift key while clicking to select consecutive tags.

6. Click Close.
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Link Documents To a Tag
Linking a document to a tag creates a Meridian Enterprise reference between the selected tag
and the selected documents in the vault. The reference is made with the TagObjectReference
type. The reference becomes the link between document data in the vault and asset data in the
maintenance management system that enables users of either system to view the data in the
other system.

Linking documents to a tag and linking tags to a document as described in Link Tags To a
Document accomplish the same thing. The only difference is the point of reference, a tag or a
document. You can use either method depending on which is more convenient for you.

Note:
You must have the Edit Tag Assignments privilege to perform this task and the current
document must be the latest revision of the document.

PowerWeb Procedures
Use these steps for PowerWeb.

To link documents to a tag:

1. Select the tag to which you want to link documents.

2. View the documents that are currently linked to the tag as described in View Linked
Documents.

Confirm that the documents that you want to link are not already linked.

3. Click Find Documents.

The Find Documents dialog box appears.

The dialog box contains two sections. You use the top section to search for documents to
link to the current tag. The bottom section shows all of the documents that match the
search criteria and that are not yet linked to the current tag.

4. Type or select search criteria and click Find.

Any matching documents appear in the bottom section.

To refine your search, type or select search criteria and click Find Now.

Only the first page of documents is shown. To view more documents, use the page controls
at the bottom of the search results list.
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5. Select the documents in the bottom section of the dialog box that you want to link to the
current tag and click Link.

The documents are removed from the bottom section of the dialog box .

Select the check box in the header row to add or remove all of the found documents from
your selection.

The links are created immediately after clicking the button. Also, clicking Close does not
revoke the actions that you have taken while in edit mode.

6. Click Close.

PowerUser Procedures
Use these steps for PowerUser.

To link documents to a tag:

1. Select the tag in PowerUser to which you want to link documents.

For information on finding tags, see Search For Tags.

2. Click theWhere Used tab.

TheWhere Used property page lists the documents that are already linked to the selected
tag. Confirm that the documents that you want to link are not already linked.

3. ClickManage Links.

TheManage Tag Links dialog box opens.

The dialog box contains three sections. You use the top section to search for documents to
link. The middle section shows all of the documents that match the search criteria and that
are not yet linked to the selected tag. The bottom section shows the currently linked
documents.

4. Type search criteria in the top section of the dialog box.

If an Enable filtering check box is visible in the top section, you can select it to filter the
results using criteria that have been configured by a System Administrator. This can be
helpful to exclude non-relevant documents.and click Find.

Any matching documents appear in the middle section.

5. Select the documents in the middle section of the dialog that you want to link to the
selected tag and click Link.

The documents are moved to the bottom section of the dialog.

Press and hold the Ctrl key while clicking to add or remove documents from your selection.
Press and hold the Shift key while clicking to select consecutive documents.

6. Click Close.
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Unlink Tags From a Document
Unlinking a tag from a document removes the reference to the tag so that the document will no
longer appear on the Linked Documents page of the tag in the maintenance management
system.

You must have the Edit Tag Assignments privilege to perform this task and the current document
must the be latest revision of the document.

PowerWeb Procedures
Use these steps for PowerWeb.

To unlink a tag from a document:

1. Select the document to which the tag is linked that you want to unlink.

2. View the tags that are currently linked to the document as described in View Linked Tags.

Confirm that the tag that you want to unlink is listed.

3. Select the tags that you want to unlink and click Unlink.

The links are removed immediately and the tags are removed from the list.

Click the icons in the header row to add or remove all of the tags from your selection.

PowerUser Procedures
Use these steps for PowerUser.

To unlink a tag from a document:

1. Select the document to which the tag is linked that you want to unlink.

2. View the tags that are currently linked to the document as described in View Linked Tags.

Confirm that the tag that you want to unlink is listed.

3. ClickManage Links.

TheManage Document Links dialog box appears.

4. Choose between two options:
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l Select the tags that you want to unlink and click Remove Link.

The tags are removed from the list.
l Double-click the tag that you want to unlink.

The tag is removed from the list.

Press and hold the Ctrl key while clicking to add or remove tags from your selection.
Press and hold the Shift key while clicking to select consecutive tags.

5. Click Close.
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Unlink Documents From a Tag
Unlinking a document from a tag removes the reference to the document so that the document
will no longer appear on the Linked Documents page of the tag in the maintenance management
system.

Note:
You must have the Edit Tag Assignments privilege to perform this task and the current
document must the be latest revision of the document.

PowerWeb Procedures
Use these steps for PowerWeb.

To unlink a document from a tag:

1. Select the tag to which the document is linked that you want to unlink.

2. View the documents that are currently linked to the tag as described in View Linked
Documents.

Confirm that the document that you want to unlink is listed.

3. Select the documents that you want to unlink and click Unlink.

The links are removed immediately and the documents are removed from the list.

Click the icons in the header row to add or remove all of the documents from your selection.

PowerUser Procedures
Use these steps for PowerUser.

To unlink a document from a tag:

1. Select the tag in PowerUser to which the document is linked that you want to unlink.

2. View the documents that are currently linked to the tag as described in View Linked
Documents.

Confirm that the document that you want to unlink is listed.

3. ClickManage Links.

TheManage Document Links  dialog box appears.
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4. Select the documents that you want to unlink and click Remove Link.

The documents are removed from the list.

Press and hold the Ctrl key while clicking to add or remove documents from your selection.
Press and hold the Shift key while clicking to select consecutive documents.

5. Click Close.
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Link a Tag To Other Tags
Linking one tag to other tags creates Meridian Enterprise references between them in the vault.

You must have the Edit Tag Assignments privilege to perform this task.

PowerWeb Procedures
Use these steps for PowerWeb.

To link one tag to another tag:

1. Select the tag to which you want to link other tags.

For information on finding tags, see Search For Tags.

2. Click the Tags tab.

This Tags property page is similar to, but different than, the Tags property page that appears
when a document is selected. This page shows an additional icon that indicates the direction
of the references between the tags, either incoming or outgoing. The page lists the other
tags that are already linked to the selected tag. Confirm that the tag that you want to link is
not already linked.

3. Click Find Tags.

The Find Tags dialog box appears.

The dialog contains two sections. You use the top section to search for tags to link to. The
bottom section shows all of the tags that match the search criteria and that are not yet
linked to the selected tag.

4. Type search criteria in the top section of the dialog and click Find Now.

Any matching tags appear in the bottom section.

5. Select the tags in the bottom section of the dialog that you want to link to the selected tag
and click Create Incoming Links or Create Outgoing Links.

6. Click Close.

The Tags page refreshes to show that the tags are linked.
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PowerUser Procedures
Use these steps for PowerUser.

To link one tag to another tag:

1. Select the tag to which you want to link other tags.

For information on finding tags, see Search For Tags.

2. Click the Tags tab.

This Tags property page is similar to, but different than, the Tags property page that appears
when a document is selected. This page shows additional columns of icons that indicate the
direction of the references between the tags, either incoming or outgoing. The page lists the
other tags that are already linked to the selected tag. Confirm that the tag that you want to
link is not already linked.

3. ClickManage Links.

TheManage Tag to Tag Links dialog box opens.

The dialog box contains three sections. You use the top section to search for tags to link to.
The middle section shows all of the tags that match the search criteria and that are not yet
linked to the selected tag. The bottom section shows the currently linked tags.

4. Type search criteria in the top section of the dialog and click Find.

Any matching tags appear in the middle section.

5. Select the tags in the middle section of the dialog that you want to link to the selected tag
and click Create Incoming Links or Create Outgoing Links.

The tags are moved to the bottom section of the dialog.

Press and hold the Ctrl key while clicking to add or remove documents from your selection.
Press and hold the Shift key while clicking to select consecutive tags.

6. Click Close.
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Unlink a Tag From Other Tags
Unlinking one tag from another tag removes the reference between the tags.

PowerWeb Procedures
Use these steps for PowerWeb.

To unlink one tag from another tag:

1. Select the tag to which the tag is linked that you want to unlink.

2. View the tags that are currently linked to the tag as described in View Linked Tags.

Confirm that the tag that you want to unlink is listed.

3. Select the tags that you want to unlink and click Unlink.

The tags are removed from the list.

PowerUser Procedures
Use these steps for PowerUser.

To unlink one tag from another tag:

1. Select the tag to which the tag is linked that you want to unlink.

2. View the tags that are currently linked to the tag as described in View Linked Tags.

Confirm that the tag that you want to unlink is listed.

3. ClickManage Links.

TheManage Tag to Tag Links  dialog box appears.

4. Select the tags that you want to unlink and click Remove Links.

The tags are removed from the list.

Press and hold the Ctrl key while clicking to add or remove tags from your selection. Press
and hold the Shift key while clicking to select consecutive tags.

5. Click Close.
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Create New Tags
Creating a new tag in the vault creates a new proxy to represent an asset. However, the new tag
will not be synchronized with the maintenance management system and will not be available to
maintenance users. Therefore, you should contact a maintenance management system user to
add the desired tag to the system for you. The tag will then become available in the Meridian
Enterprise vault after the next synchronization with the maintenance management system.

PowerWeb Procedures
Use these steps for PowerWeb. This functionality was updated in the 2022 release.

To create a new tag:

1. Select the document in PowerWeb to which you want to link the tag that you will create.

2. Click the Tags property page.

3. Choose between two options:
l Click Drawing Tags.
l Click Text Tags.

The appropriate window opens. If there is a tag in the document which does not exist
in the vault, the Status column contains a value of No matching object found.

4. Click the icon to the left of the Object Number column.

The Add Document / Select Folder window opens.

5. Select the folder where you want to create the tag.

6. Click Next.

The Tag Details window opens. Some of the tag information may have already auto-
populated in this window.

7. Complete any necessary fields in the Tag Details window.

8. Click Finish.

The page refreshes. The tag is created in the location you specified. You can also view the
tag on the Tags property page for the document.
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PowerUser Procedures
Use these steps for PowerUser.

To create a new tag:

1. Confirm that the tag does not already exist.

For this, you can use the Find Tags command described in Search For Tags.

2. Select the document in PowerUser to which you want to link the tag that you will create.

3. View the tags that are currently linked to the document as described in View Linked Tags.

4. ClickManage Links.

TheManage Document Links dialog box appears.

5. Click New Tag.

New tag data appears at the bottom of the linked tags list. You can add data to the tag in a
later step.

6. When you are finished creating tags, click Close.

7. Select the new tag that you created and click Go to Tag.

8. Click Edit.

The property pages become editable.

9. Select or type information just as you would for a document.

10. Click OK.
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Upload Files
A System Administrator might have configured your system to allow you to upload files to the
Meridian Enterprise vault that are related to tags in the maintenance management system. When
the files are uploaded, they are automatically linked to the selected tag. You can know whether
the configuration has been done by an Upload button available in the toolbar on the Related
Documents page.

If the file already exists in the vault, it will be uploaded with the name like <OriginalFileName>
(1).

Use these steps for PowerUser.

To upload files to the Meridian Enterprise vault:

1. On any view page, select the tag in the results list that you want to upload files for.

2. In the results pane toolbar, click Upload.

The Add Document/Select Files dialog box appears.

3. Click Add.

4. Select a file to upload.

5. Click Open.

The file name is added to the file list. Select a file and click Remove to remove it from the
list.

6. Repeat step 3 to select all of the files you want to upload and then click Next.

The Progress dialog box appears while the files are uploaded, showing the results.
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Folders
If the tags in a vault are organized in a folder structure that reflects a plant breakdown structure
(PBS) and if the tags in each folder are typically related to the same document, it might be more
efficient to manage the links between the tags and the document using the tags' parent folder.
Meridian supports implicitly linking a document to all of the tags that reside in the same folder.
This feature requires that the vault be properly configured by a System Administrator.

Meridian provides this functionality through amain tag that resides in any folder that contains
other tags. You manually link the main tag to the document (that typically resides elsewhere in
the vault) that you also want to be linked to the other tags that reside in the same folder with the
main tag. The main tag acts in the place of the folder in the relationships with the tags. This is
because references are not supported for folders in Meridian Enterprise. Then, when you add or
remove tags from the folder, they are assumed by Meridian to also be linked to the document.
No literal references exist between the normal tags and the document. It is only by the
association of the normal tags with the parent folder that the references are implied.

The reverse is also possible. That is, linking a tag to all of the documents that reside in the same
folder. This scenario is supported by the presence of a special proxy document in a folder that
contains other documents. The proxy document does not necessarily need to be an actual
document. For example, it can be a virtual document that is not actually part of the set of other
documents in the same folder.

Working with main tags and proxy documents is described in the following topics.
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Create And Link Proxy Documents
A proxy document represents its parent folder in relationships with asset tags. You can also think
of the proxy document as representing all of the normal documents that are contained within the
parent folder. Tags that you link to the proxy document are considered by Meridian to be linked
to the parent folder and thereby to all of the normal documents that reside in that folder.

Create and Link a Proxy Document
Use these steps for PowerUser.

To create and link a proxy document:

1. In the folder that you want to link to a set of tags, create a new document of the proxy
document type.

Consult with a System Administrator if you do not know which document type to use.
Create only one proxy document in any folder.

2. Link the proxy document to the tags that are related to all of the other documents that will
reside in the same folder as the proxy document.

For more information on linking documents to tags, see Link Tags To a Document.

The tags that are listed on the Related Tags page of the proxy document should also now
appear on the Related Tags page of the parent folder. Every non-proxy document that
resides in the folder (including new documents) will now be associated with the same set of
tags as are linked to the proxy document. This is even though the Related Tags page does
not appear for the normal documents. You can manage the links to the proxy document by
clicking theManage Links button on the Related Tags page of either the folder or the proxy
document itself.

Locate Proxy Document for a Folder
Use these steps for PowerUser.

To locate the proxy document for a specific folder:

1. In the Explorer view, select the folder for which you want to find its proxy document.

2. On the Related Tags property page, click Go to Proxy Document.

Focus shifts to the proxy document.
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Main Tags
A System Administrator may have configured your vault to use main tags. A main tag is typically
one tag within a folder that is considered the most important or that is the parent of the other
tags. The precise definition of a main tag depends on the design of your environment. Consult a
System Administrator if you do not know how main tags are used in your organization.

When a vault is configured to support main tags, besides being shown for the tags themselves,
theWhere Used property page is shown for the parent folder of the main tag. The page lists the
documents to which the main tag is linked. You can click the Go to Main Tag button on the page
to shift focus to the main tag. You can manage the document links of the main tag with the
Manage Links button on theWhere Used page of either the folder or the main tag itself. For
more information about managing links, see Link Tags To a Document and Link Documents To a
Tag.
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Build a Drawing Tags Report
Meridian can build a report in Microsoft Excel that lists the drawing tags that are linked to a
selected document or vice versa.

You must have Microsoft Excel installed on your computer to build a report.

Build Report of Linked Tags
Use these steps for PowerUser.

To build a report of linked tags:

1. View the Tags property page in PowerUser for the document upon which you want to build
the report.

2. Select any row in the tags list.

The command buttons become enabled.

3. Select a report definition from the Template list.

The report definition must be configured by a System Administrator.

4. Click Create.

Microsoft Excel opens and the tag data appears in a new worksheet.

5. You may format, print, and save the worksheet to meet your needs.

Build Report of Linked Documents
Use these steps for PowerUser.

To build a report of linked documents:

1. View theWhere Used page for the tag upon which you want to build the report as
described in View Linked Documents.

2. Select any row in the documents list.

The command buttons become enabled.

3. Click Report.

Microsoft Excel opens and the document data appears in a new worksheet.

4. You may format, print, and save the worksheet to meet your needs.
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Meridian Portal
Meridian Enterprise can be configured with special features that allow you to easily exchange
documents with Meridian Portal. This integration supports two usage scenarios:

l Changing documents in Meridian Portal.

In this scenario, the Meridian Enterprise vault is simply an as-built repository for documents
created and revised by external business partners and exchanged through Meridian Portal.

l Changing documents in Meridian Enterprise.

In this scenario, documents are created and revised in the Meridian Enterprise vault and
delivered to external business partners through Meridian Portal.

You can use the scenario that best matches your business process and needs. To learn how to
configure this integration, see Integrate Meridian Enterprise with Meridian Portal.
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Change Documents In Meridian Portal
In this usage scenario, master documents that reside in a Meridian Enterprise vault and that
require revision by external business partners can be sent to Meridian Portal as illustrated in the
following figure. This is done by creating working copies of the master documents and placing
them in Meridian Enterprise project folders. These folders are linked automatically to
corresponding Meridian Portal project repositories.

The working copies can then be sent (copied) to Meridian Portal where they can be downloaded
by external business partners, revised, and uploaded back to the project repository along with
new documents that are also part of the same project. The revisions and new documents can be
checked for standards compliance, reviewed for technical accuracy, and then released back to the
originating project folder in the Meridian Enterprise vault. From there, they can be released as
new revisions of the master documents.

To learn how to configure the integration with Meridian Cloud, see Integrate Meridian Enterprise
with Meridian Portal in theMeridian Enterprise Administrator's Guide.

These special features can be found in the PowerUser application and in PowerWeb.
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Link Folders To Meridian Portal
You can link Meridian Enterprise folders to Meridian Portal projects in these ways:

l Create Projects In Meridian Portal
l Link existing folders created in Meridian Enterprise as described in this task

Meridian folders can be linked to a Meridian Portal project only when:

l The Meridian folder is a folder type that has its Can be linked to Meridian Portal projects
option enabled in the vault configuration. To learn how to enable this setting, see Create
And Edit Folder Types in theMeridian Enterprise Configuration Guide.

For information about your vault configuration, ask a System Administrator.
l Documents in the folder are not already linked to a different Meridian Portal folder.
l The Meridian Portal project that you want to link to is a Standard Project type project.

Packages Only type projects cannot be linked to Meridian Enterprise.

PowerWeb Procedures
Use these steps for PowerWeb.

Link a Meridian Folder to a Meridian Portal Project
To link a Meridian folder to a Meridian Portal project:

1. Select the folder you want to link.

2. Choose between two options:
l Right-click the folder then select Folder > Link To Meridian Portal in the context menu

that appears.
l In the Folder ribbon, in the Action group, click Link To Meridian Portal.

TheMeridian Portal Projects dialog box appears and lists the available projects.

3. If you want to link to an existing project, select the project you want then click OK.

4. If you want to create a new Meridian Portal project:

a. Click New Project.

The New Meridian Portal Project dialog box appears with the Project Number and
Project Name fields filled in with the Project Name from the vault.
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b. If required, edit the Project Number and Project Name fields for the new Meridian
Portal project that you want to create.

5. Click OK.

The folder is linked to the project and the project name is shown on the property page of
the folder with a hyperlink button that will open the project.

Unlink a Meridian Folder from a Meridian Portal Project
To unlink a Meridian folder from a Meridian Portal project:

1. Choose between two options:
l Right-click the folder that you want to link, point to Folder, and then click Unlink From

Meridian Portal on the shortcut menu that appears.
l In the Folder ribbon, in the Action group, click Unlink From Meridian Portal.

A dialog box opens, asking you to confirm your choice.

2. Click Yes.

The folder is unlinked from the project.

PowerUser Procedures
To link a Meridian folder to a Meridian Portal project:

1. Right-click the folder that you want to link, point toMaster/Project Copy, and then click
Link To Meridian Portal on the shortcut menu that appears.

TheMeridian Portal Projects dialog appears and lists the available projects.

2. Select the project to which you want to link and click OK.

A dialog box opens, asking you to confirm your choice.

3. Click Yes.

The folder is linked to the project and the project name is shown on the property page of
the folder.
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Send Documents To Meridian Portal
Meridian Portal provides a project type named Standard Project that supports a simple
document revision workflow outside of the vault. This makes it possible for new revisions to be
made by business partners without access to the Meridian vault.

You can easily send copies of vault documents to these projects through the Meridian Enterprise
integration with Meridian Portal. When the revisions (and any new documents) are approved in
Meridian Portal, they are automatically imported back into the vault.

Notes about Functionality
l This command requires a Package export type publishing job definition in Meridian

Enterprise Server. For information about configuring publishing jobs, see Configure a
Publishing Job in theMeridian Enterprise Server Administrator's Guide.

l When a document is sent to Meridian Portal:
o 'For information', it is not locked.
o 'For revision', it is locked.

l Documents sent to Meridian Portal remain locked to the export package in which they were
sent until they are returned from Meridian Portal. If the package transfer fails, you can
unlock the documents from the package as described in Lock And Unlock Documents.
Documents must be unlocked from PowerUser or from PowerWeb with a site cache
configured and the ActiveX compatibility mode option disabled.

l When documents are imported back into the vault, they are subject to the Field-Path
definition of the vault's configuration like any other document. This might place the
documents in other folders than where they originated.

l Documents sent to Meridian Portal must first be synchronized to a Meridian Explorer
repository. This will be done automatically, if necessary, but it might delay the documents'
availability in Meridian Portal.

l If the Existing documents option of the import profile that is used to return documents
from Meridian Portal to the vault is set to New revision and the source document is in a
custom workflow but not in the Released state when the document is imported back to the
vault, the import will fail. If this happens, change the state of the vault document to
Released and restart the import job.

l The folder used in this task must be of a folder type that has its Can be linked to Meridian
Portal projects option enabled. If you are unsure of the configuration of the folder types in
your system, contact a System Administrator.
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l To include a transmittal sheet with the package, ensure that you have your Transmittal
Document Type configured. To learn how to configure a Transmittal Document Type, see
theManage a Meridian Enterprise Vault section in theMeridian Enterprise Server
Administrator's Guide.

Prerequisites
Do the following prerequisite tasks:

1. If it does not exist already, create a folder in the vault to represent the Meridian Portal
project as described in Create a Folder.

2. Link the folder to a Meridian Portal project as described in Link Folders To Meridian Portal.

3. If they do not exist already, create project copies of the master documents (and any
required CAD references) into the folder as described in Create a Project Copy.

PowerWeb Procedures
Use these steps for PowerWeb.

If a document is created in PowerWeb and is sent to Portal, the document number and revision
number generated in PowerWeb will also be used in Portal. The Document Range for these
documents will be set to Automatic.

To send documents to Meridian Portal:

1. Select the project copies that you want to send.

2. In theWorkflow ribbon, in theManage group, click Send to Portal.

The Send to Meridian Portal dialog appears and lists the members of the Meridian Portal
project that is linked to the vault project folder. The command is unavailable if no parent
folder in the document path is linked to a Meridian Portal project.

3. Click options using the descriptions in the following table.

4. Click OK.

A dialog box shows the progress as the documents are sent to Meridian Portal in an export
package and locked in the folder (if sent for the Issue Reason of For Revision). If you
enabled the Include CAD references option, the referenced documents are sent also, even if
they were not selected.

If the Export Packages property page is enabled in your system, it shows information about
the export package in which the documents were sent. If the document already exists in the
Meridian Portal project, the document is added as a new revision.

The package includes documents referenced by a reference belonging to a Reference Type
configured with the option Include to a Portal package.
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PowerUser Procedures
Use these steps for PowerUser.

To send documents to Meridian Portal:

1. Select the project copies that you want to send.

2. Right-click over your selection, point toMaster/Project Copy, and click Send to Portal.

The Send to Meridian Portal dialog appears and lists the members of the Meridian Portal
project that is linked to the vault project folder.

3. Click options using the descriptions in the following table.

4. Click OK.

A dialog box shows the progress as the documents are sent to Meridian Portal in an export
package and locked in the folder. If you enabled the Include CAD references option, the
referenced documents are sent also, even if they were not selected.

If the Export Packages property page is enabled in your system, it shows information about
the export package in which the documents were sent. If the document already exists in the
Meridian Portal project, the document is added as a new revision.

Document Export Options

Option Description

Recipient Select the recipients that you want to work with the documents in Meridian Portal.
You may select a recipient that has the Document Controller role or the special Project
Document Control recipient that makes the package available to all users with the
Document Controller role in the project. It will also cause the documents to skip the
Acknowledge and Accept states of the workflow in Meridian Portal and go directly to
the For Routing state. A notification email message will also be sent.
This feature assumes that all document compliance checks have already been
performed in Meridian such as if the Meridian user who is sending the documents is
also the person who will receive them in Meridian Portal.
If the recipient has the Contractor role:
1. The recipient is notified by email,

2. A package of the documents is assigned to the recipient, and

3. The recipient can acknowledge receiving the package, which notifies the sender
by email.

Document export options
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Option Description

Package
description

Type a description of the package for the recipient.

Include CAD
references

Also send any CAD reference documents to Meridian Portal that reside in the same
project folder as the selected parent documents.
In PowerWeb, when the user sends the document to Portal with CAD references for
revision:

l editable reference documents are included for revision

l non-editable reference documents are included for information

If the project copy has CAD references to documents outside the project, these
referenced documents are included in the package for information.
In PowerWeb, when the user sends the document to Portal with CAD references for
information:

l reference documents are included for information

Purpose Select the purpose for sending the package: 
l For revision — documents that are editable for the user are sent for revision and

can be updated in Portal. All other documents are sent for information.
l For information — all documents are sent for information to a project member

with the Contractor role, and are read-only in Portal. Since the document is not a
part of the workflow, it should not be sent to internal project members in Portal.

The latest
released
revision

When selected, the latest released revision of the document is sent to Meridian Portal
instead of the working copy (default).
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Send References for Information to Portal
The integration between PowerWeb and Portal has the option to include CAD reference for
information when CAD drawings are sent to Contractors. This function is only available for
MicroStation and AutoCAD references and does not apply to other CAD references, manual
references, or asset references.

The preferred way to send AutoCAD and MicroStation references to Contractors in Portal is by
using the option to include CAD references for information. Using this method, the AutoCAD and
MicroStation references are directly copied from the Master document and references for
information don't need to be copied to a project.

If reference documents also need to be updated by the Contractor, then you must create a
project copy for the reference documents and send the copied reference documents to the
Contractor with the purpose of For Revision.

You can also send other documents in a PowerWeb project to a Contractor for information. See
also send the documents as a package to Portal.
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Change Documents In Meridian Enterprise
In this usage scenario, after documents are created or revised in Meridian, then they can be
either sent to Meridian Portal in packages as transmittals or they can be exchanged bidirectionally
in review packages as illustrated in the following figure.

In either case, the packages can only be sent to one specific project in Meridian Portal regardless
of which project they originated from in Meridian Enterprise. These special features can be found
in the PowerUser application and in PowerWeb.

When review packages are returned to Meridian Enterprise from Meridian Portal:

l If package documents (or only hybrid parts) were changed while they were in Meridian
Portal, the source project documents are updated and the workflow status of the
documents is set to Review. You may then review the changes to the documents and their
properties.

If you accept the changes, the incoming revisions become the latest revision of the master
documents from which they were copied. If the current revision in Meridian Enterprise is a
PDF file, it will become the rendition of the revision.

l If package documents were not changed while they were in Meridian Portal, the source
project documents are not updated and the workflow status of the documents is set to
Under Change.
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Create Projects In Meridian Portal
Creating a new project in Meridian Enterprise creates a new project folder in the vault to hold
sub-folders and project documents. If it is integrated with Meridian Portal, it also automatically
creates a corresponding Meridian Portal project where you can share the project packages and
Quick Shares with others. To create a new Meridian Portal project without also creating a
Meridian Enterprise vault folder, see Create projects.

Use these steps for PowerUser and PowerWeb.

To create a project:

1. In the navigation pane, right-click the parent folder where you want to create the new
project folder.

2. Point to New and then point to New Project.

3. Click the name of the project type that has been configured to work with Meridian Portal.

If you are unsure of what type to choose, ask a System Administrator. The Project dialog box
appears.

4. Click options or type values using the descriptions in the Project properties table below.

Required fields are indicated by the asterisk (*) character.

5. Click Next.

TheMeridian Portal dialog box appears.

6. Click options or type values using the descriptions in theMeridian Portal table below.

7. Click Finish.

Your new project folder appears in the navigation view.

Property Description

Project ID Type a number to assign to the project

Project Name Type the name of the project

Project properties
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Property Description

Create Project Enable this option to create a new Meridian Portal project with the information
you entered.

Project Owner Select a name from the list to be the owner of the Meridian Portal project.

Meridian Portal options
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Create Review Packages
A Meridian Portal review package is represented in Meridian Enterprise as a transmittal sheet
(Microsoft Excel workbook) with Meridian Enterprise references to the other vault documents
that are contained in the review package. The transmittal sheet also contains the document
properties that accompany the documents to Meridian Portal.

The selected documents are linked to the transmittal sheet with references of the
refM360PackageReference type. You can view these references and use them to navigate to the
transmittal sheet as described in View References. The documents are also placed under change
by theMeridian360 account in the workflow that is configured for the document type of each
document.

Use these steps for PowerUser and PowerWeb.

Create New Review Package
To create a new review package:

1. Select the documents that you want to add to a package.

2. Right-click your selection.

The shortcut menu appears.

3. Point to Commands, pointMeridian360, and then click Add to New Review Package.

The Add to New Review Package dialog box appears.

4. Click options or type values using the descriptions in the following table.

5. Click Finish.

Group Option Description

Package Type The type of package.

Package Name The name of the package.

Package Description The description or instructions for the package recipients.

Package Send out
immediately

Sends the package immediately after you click Finish.
Otherwise, the package is sent at the next scheduled interval.

Package Notify
Reviewers

Send an email notification to the members in the Reviewers list that the
package has been sent.

Package options
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Group Option Description

Package Update
transmittal on
send

Updates the property values in the transmittal sheet to reflect the
current values of the package documents, for example, revision
numbers.

Details Due date Select a date when you expect a response from the recipient.

Details Distribution
code

Select a distribution code from the list.
The Reviewers list refreshes to show the names of the reviewers that
are assigned to the selected distribution code.

Details Reviewers The Meridian Portal project members that will be assigned to review the
documents in the package.

Add Documents to Existing Review Package
To add documents to an existing review package:

1. Select the documents that you want to add to a package.

2. Right-click over your selection.

The shortcut menu appears.

3. Point to Commands, point toMeridian360, and then click Add to Existing Review Package.

The Add to Existing Review Package dialog box appears.

4. Select the name of the package from Package Code and then click Finish.
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Create Packages
A Meridian Portal package is represented in Meridian Enterprise as a transmittal sheet (Microsoft
Excel workbook) with Meridian Enterprise references to the other vault documents that are
contained in the package. The transmittal sheet also contains the document properties that
accompany the documents to Meridian Enterprise.

Use these steps for PowerUser and PowerWeb.

Create a New Package
To create a new package:

1. Select the documents that you want to add to a package.

2. Right-click your selection.

The shortcut menu appears.

3. Point to Commands, point toMeridian360, and then click Add to New Transmittal Package.

The Add to New Transmittal Package dialog box appears.

4. Click options or type values using the descriptions in the following table.

5. Click Finish.

Group Option Description

Package Type The type of package.

Package Name The name of the package.

Package Description The description of the package.

Package Send out
immediately

Sends the package immediately after you click Finish.
Otherwise, the package is sent at the next scheduled interval.

Package Notify
recipient

Sends an email message to the package recipients to alert them about
the package.

Package options
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Group Option Description

Package Update
transmittal on
send

Updates the property values in the transmittal sheet to reflect the
current values of the package documents.
The Meridian Enterprise internal properties (for example, revision
number) are not affected by this option and are always updated when
transmittals are sent.

Details Issue reason Select a reason from the list for which you are issuing the package .

Details Due date Select a date when you expect a response from the recipient.

Details Include source Includes the document source files in the package.

Details Include
rendition

Includes the document rendition files in the package.

Details Include
transmittal
sheet

Includes the transmittal sheet in the package.

Details Send read-
only

Locks the documents in the package from being overwritten by changes.

Details Assign to Select a recipient of the package from the list.

Details Distribute to Select a distribution list for the package from the list.

Add Documents to Existing Package
To add documents to an existing package:

1. Select the documents that you want to add to a package.

2. Right-click over your selection.

The shortcut menu appears.

3. Point to Commands, point toMeridian360, and then click Add to Existing Transmittal
Package.

The Add to Existing Transmittal Package dialog box appears.

4. Select the name of the package from Package Code and then click Finish.

The selected documents are linked to the transmittal sheet with references of the
refM360PackageReference type. You can view these references and use them to navigate
to the transmittal sheet as described in View References. The documents are also placed
under change by the userMeridian360 in the workflow that is configured for the document
type of each document.
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Send Packages
When you have finished adding documents to a package, you can send it to Meridian Portal
where it can be downloaded by the package recipients.

Use these steps for PowerUser and PowerWeb.

To send a package:

1. Right-click the transmittal sheet for the package that you want to send.

The shortcut menu appears.

2. Point to Document Workflow, and then click Send Out.

The Execute transition ‘Send Out' dialog box appears.

3. Click options or type values using the descriptions in the following table.

4. Click Finish.

The transmittal sheet and its linked documents (the package contents) are routed in a
workflow to theMeridian360 account and the Status is changed to Sent Out. You can view
the workflow as described in View the Current Workflow.

After a few minutes, the recipient of the package will receive an email notification that
contains a link to the package in Meridian Portal. They can see the package as described in
View packages and work with it like any other package.

Group Option Description

Package Type The type of package.

Package Name The name of the package.

Package Description The description of the package.

Package Send out
immediately

Sends the package immediately after you click Finish.
Otherwise, the package is sent at the next scheduled interval.

Package Notify
recipient

Sends an email message to the package recipients to alert them about
the package.

Package Update
transmittal on
send

Updates the property values in the transmittal sheet to reflect the
current values of the package documents, for example, revision
numbers.

Package options
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Group Option Description

Details Issue reason Select a reason from the list for which you are issuing the package.

Details Due date Select a date when you expect a response from the recipient.

Details Package
number

The unique identifier of the package.

Details Include source Includes the document source files in the package.

Details Include
rendition

Includes the document rendition files in the package.

Details Include
transmittal
sheet

Includes the transmittal sheet in the package.

Details Send read-
only

Locks the documents in the package from being overwritten by changes.

Details Assign to Select the primary recipient from the list.

Details Distribute to Select additional recipients from the list.
This option is available only if Send read-only is enabled.
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Reject Packages
After a review package has been returned to Meridian Enterprise from Meridian Portal and you
have reviewed the returned documents, you can reject the package if the documents are not
correct.

You can see the response that the lead reviewer selected in Meridian Portal in the Approval
status property on the Details page of the documents.

This performs several actions:

l Comments that were added on the Remarks page of the documents during review are
added to theManagement Remarks column in the transmittal sheet.

l The status of the documents in the package is set to Rejected.
l The status of the package in Meridian Enterprise and in Meridian Portal is set to Rejected.
l The package is reassigned to the recipient in Meridian Portal.

Use these steps for PowerUser and PowerWeb.

To reject a package:

1. Right-click the transmittal sheet that corresponds to the package that you want to reject.

The shortcut menu appears.

2. Point to Document Workflow and click Reject.

The package is rejected.
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Update Transmittal Sheets
After you create a review package as described in Create Review Packages, you might not send it
immediately. If any document properties change before you send it that are shown on the
transmittal sheet and if the Update Transmittal on Send option is disabled, the transmittal sheet
might be inaccurate. You can update the transmittal sheet just before you send the transmittal so
that it is accurate.

Note:
The Meridian Enterprise internal properties (for example, revision number) are not affected by
the Update Transmittal on Send option and are always updated when transmittals are sent.

Use these steps for PowerUser and PowerWeb.

To update a transmittal sheet:

1. Right-click the transmittal sheet that corresponds to the package that you want to send.

The shortcut menu appears.

2. Point to Commands, point toMeridian 360 and click Update Transmittal.

The transmittal sheet is updated and its revision number incremented.
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Briefcases
A briefcase is a file that you can use to transmit documents and selected property data to external
parties as a single file. Briefcases are similar to popular archive files such as ZIP and RAR except
that, in addition to containing other files, a briefcase file also contains metadata about the
documents it contains.

Meridian has features that work with exclusively with briefcases to aid in creating revisions to
documents remotely and then importing those revisions back into a vault. You can copy
documents to a briefcase for reference purposes only, or you can check out and lock documents
to a briefcase so that no one can work on these documents until they are unlocked.

A completed briefcase consists of a single file with the .brc extension. You can open a briefcase
file using the Meridian View Briefcase command.

You can also create briefcases in open standard formats, such as ZIP or RAR, if the vault has been
configured to make use of this feature. Such briefcases can be opened using the format's default
application, such as WinZIP and WinRAR. Document metadata is stored in these briefcases in
Excel, Access, or XML format, depending on the configuration of the briefcase template. Consult a
System Administrator for information about the briefcase templates configured for your system.

Note:
Briefcases are not supported in PowerWeb. Consider using packages instead as described in
Packages.
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View a Briefcase
Viewing a briefcase allows you to see:

l The documents contained within the briefcase
l The vault properties copied to the briefcase for each document
l The briefcase properties (size, date modified, password, comments, template, and

document count)

Use these steps for PowerUser.

To view a briefcase:

1. On the Vaultmenu, select View Briefcase.

The Select Briefcase dialog box appears, listing all known briefcases to which you have
access. The properties of each briefcase are also displayed in columns.

2. Select a briefcase to view and click Select.

The briefcase opens in the Briefcase dialog from which you can perform all other briefcase
actions.
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Create a Briefcase
You can add documents to an existing briefcase or create a new one from a template configured
by a System Administrator.

Consult with a System Administrator for the purposes of each briefcase template and the names
of briefcase templates that are configured to use custom formats such as ZIP or RAR.

Create New Briefcase
Use these steps for PowerUser.

To create a new, empty briefcase:

1. On the Vault menu, click View Briefcase.

The Select Briefcase dialog box appears.

2. Click the downward-pointing arrowhead button next to the Create Briefcase button

.

A list of briefcase templates opens under the button.

3. Select a template from the list.

The Create Briefcase dialog box appears.

4. Select a destination folder, type the name of the new briefcase, and click Create.

The briefcase is created and you can now add documents to it.

Add Documents to Briefcase
Use these steps for PowerUser.

To add documents to a new or existing briefcase:

1. Select the documents to add and then click Add to Briefcase on the Documentmenu. The
Select Briefcase dialog box appears.

Note:
To add the entire contents of a folder to a briefcase, first select the folder and then click
Add to Briefcase on the Foldermenu.
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l To add the documents to an existing briefcase:

a. Select the briefcase from the list and click Select.

The Add to Briefcase dialog box appears.

b. Select options using the descriptions in the following table and click OK.

The documents are added to the briefcase and the Briefcase dialog box appears,
showing the current contents.

l To add the documents to a new briefcase:

a. Click the downward-pointing arrowhead button next to the Create Briefcase

button .

A list of briefcase templates opens under the button.

b. Select a template from the list.

The Create Briefcase dialog box appears.

c. Select a destination folder, type the name of the new briefcase, and click Create.

The Add to Briefcase dialog box appears.

d. Select options using the descriptions in the following table and click OK.

The documents are added to the briefcase and the Briefcase dialog box appears,
showing the current contents.

2. If the briefcase uses a custom format, click the Archive Briefcase button to save the
contents of the briefcase in the custom format.

See the following table for descriptions of the buttons in the Briefcase window.

3. Choose between two options:
l Click Close to close the briefcase without selecting a different document in the vault.
l Select a document in the briefcase and click Go to to close the briefcase and

automatically select the source document in the vault.

Option Description

Check out and
include current
revision

The current revisions of the selected documents are locked to the briefcase.
Documents in this state cannot be edited unless you unlock them with the correct
security privileges or return them with the Import Briefcase command. An entry is
added to the Comment document log to indicate the action taken.

Add to Briefcase options
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Option Description

Only include
current
revision

The current revisions of the selected documents are copied to the briefcase and are
not locked. An entry is added to the Comment document log to indicate the action
taken.

Only include
last released
revision

Only the last released revisions of documents are added to the briefcase. Documents
in workflows are ignored.

Include CAD
references

Copies CAD external reference files to the briefcase.

Include
drawing and
presentation
files

Copies Autodesk Inventor drawing and presentation files to the briefcase.

Include
custom
references

Copies documents that use custom reference types to the briefcase.

Check out
referenced
documents

Checks out all referenced documents that are copied to the briefcase.

Include
dependent
support files

Adds AutoCAD support files to the briefcase that the drawings in the briefcase are
dependent upon for accurate display and plotting:
*.dst,*.ttf,*.fmp,*.ctb,*.stb,*.pc3,*.shx,*.shp. These file types
reside outside the vault and are installed with or created by AutoCAD. Only the
support files for the default installation of AutoCAD are included. Different files may
exist if multiple versions of AutoCAD are installed on your PC.
The following support files are not included due to technical
limitations: *.dws,*.dwt. The files are not included in the transmittal made for the
briefcase as described in Create a Briefcase Transmittal Document. They should be
manually excluded from import if the briefcase is imported into another vault.
The path of each file (but not the drive letter or share name) is also stored in the
briefcase so that the files can be easily extracted manually to the correct locations on
the destination PC. Whether to extract the files and whether they are compatible with
the destination installation of AutoCAD is the responsibility of the briefcase recipient.
This option is only supported by briefcases in the open standard (.zip,.rar)
formats, not in the.brc format.

Content Adds the document's native file to the briefcase.

Rendition Adds the document's rendition file to the briefcase. To include any redlines of the
rendition, also select Rendition redlines.

Thumbnail Adds the document's thumbnail image to the briefcase.
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Buttons in the Briefcase Window
The following table describes the purposes of the buttons in the Briefcase window.

Button Description

Select a briefcase to open.

Display the properties of the briefcase, including its password, comments, template, and
document quantity.

Select documents to add to the briefcase.

Delete selected documents from the briefcase.

Open the selected documents in the viewer.
Viewing some document formats (for example, Autodesk Inventor) in a briefcase might
create lock files (*.lck) in the briefcase.

Compare the selected document in the briefcase with the revision currently in the
Meridian Enterprise vault.

Display all of the vault properties of the selected document.

Display which of the vault properties are included in the briefcase.

Update the briefcase properties from the vault.

Generates a transmittal sheet (report) listing the briefcase contents. The report is
created in the briefcase and stored in the vault. The report can be configured to be
updated if the contents of the briefcase changes. Consult a System Administrator for
information on the configuration of transmittal reports.

Saves the contents of the current briefcase in a standard archive format.

Opens the default email program, allowing you to send a message with the briefcase as
an attachment.

Exports the database structure of a briefcase for use with other briefcase templates.
Only supports Microsoft Access.

Import the database structure from a database file. Only supports Microsoft Access.

Briefcase window buttons
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Create a Briefcase Transmittal Document
A Meridian transmittal document is a Meridian report that contains information about the
documents in a briefcase such as their names, revision numbers, comments, and so on. The
report format is determined by a System Administrator. A transmittal can be included in a
briefcase to help the recipient of the briefcase better understand its contents and a copy can be
stored in the vault as a permanent record. The vault copy of the report is linked to the briefcase
source documents by Meridian references.

Use these steps for PowerUser.

To create a briefcase transmittal document:

1. On the Vaultmenu, click View Briefcase.

The Select Briefcase dialog box appears.

2. Select an existing briefcase for which you want to create the transmittal and click Select.

The Briefcase dialog box appears, showing the contents of the briefcase.

3. Click the Generate transmittal button .

The Generate Transmittal Sheet dialog box appears.

4. Select options using the descriptions in the following table.

5. Click OK.

The Select Folder dialog box appears.

6. Select a destination folder in the vault to store the new transmittal document.

7. Click OK.

What happens next depends on how the System Administrator has configured the briefcase
template that was used to create the briefcase.

The transmittal document is generated from the report template that is assigned to the
briefcase template from which the briefcase was created. If the briefcase template specifies
a document type for the report that uses wizard pages for user input, those pages are
displayed during report generation similar to any other document being added to the vault.
The transmittal is then stored in the folder that you selected. If you selected the Include
transmittal in Briefcase option, a copy of the transmittal is also placed in the briefcase.

8. You can view the transmittal document by selecting it in the briefcase and clicking the View

button .

The transmittal opens in a new viewer window.
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Option Description

Include
transmittal in
briefcase

Includes a copy of the transmittal document in the briefcase for the recipient's use.
Enable Include transmittal in report if you want the transmittal report itself to appear
as a row in the report as proof that it was included in the briefcase.

Save
document
list as
collection

Saves the list of documents in the briefcase as a static collection. The lists your current
static collections. If you select an existing collection, the documents are added to the
collection. If you select the default <New collection>, you are prompted for a name for
the new collection.

Briefcase transmittal options
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Import Documents From a Briefcase
Meridian allows you to import documents from an existing briefcase into a vault. This can be
useful for importing documents provided by business partners or generated at remote sites.

Use these steps for PowerUser.

To import from a briefcase:

1. On the Vaultmenu, click Import from Briefcase.

The Select Briefcase dialog box appears.

2. Select a briefcase from the list or click the Open Briefcase button and browse to
locate the briefcase you want to import.

The Import from Briefcase dialog displays the documents contained in the briefcase.

The documents are grouped by their change status as compared to the source documents in
the vault. The various types of status are described in the following table.

3. To change the import action for any of the documents:

a. Right-click the document and point to Change Action.

b. Select a different action from the shortcut menu.

4. When you are satisfied with all of the actions to be performed, click OK.

The Briefcase Template dialog box appears.

5. Select the briefcase template that is configured with the property import mappings you
want to use and click OK.

In most cases, you should choose the same template as the one from which the briefcase
was made. You may choose other templates to import more or fewer properties. The
documents in the briefcase are imported depending on the actions you chose. The Import
from Briefcase dialog box appears.

6. Click options or type values using the descriptions in the following table.

If the briefcase contains any new documents, the Select Folder dialog will appear for each
document so that you can choose a destination folder in the vault to store the new
documents.

7. Select the appropriate folder and click OK.

8. If the document types of the new documents display any wizard pages, complete the pages
and click Finish.
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Status Meaning

Not changed The document has not changed since it was added to the briefcase. Importing the
document is not necessary, so Do Nothing is the default for Action.

Properties
Changed

One more properties of the document in the briefcase have changed since the
document was added to the briefcase. The default for Action is Update, which will
update the vault properties (but not the file) from the briefcase.

Documents
Changed

The briefcase document has changed (is newer than the corresponding document in the
vault) and should be checked in. Check In is the default for Action.

New
Documents

The document was added to the briefcase from another vault or added by Accruent
View. It should be added to the vault, so Import is the default for Action.

Briefcase status values

Option Description

Use relative path If selected, imports the documents to a folder in the vault that is relative to the
active folder using the document paths stored in the briefcase. If not selected,
imports the documents to an absolute path calculated from the root folder of the
vault.

Sync properties
from file

Synchronizes the vault properties from the imported documents after the import
has finished.

Native Imports the documents' native files from the briefcase.

Rendition Imports the documents' rendition files from the briefcase. To include any redlines
of the renditions, also select Rendition redlines.

Thumbnail Imports the documents' thumbnail images from the briefcase.

Skip reference
information

If selected, prevents resolving any references after the import has finished.

Briefcase import options
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Property Values Of Imported Documents
When a new document is imported to a vault from a briefcase, the property information can
come from several sources:

l The properties stored in the briefcase
l The values of title block attributes
l The wizard pages completed by the user when the new document was added

To make sure the property information is added correctly, the following order is used to add
properties to new documents imported from a briefcase:

1. The properties stored in the briefcase are read first.

2. If so configured, the properties are synchronized from the document's title block attributes
using the Synchronize Properties from File command. This overwrites any existing briefcase
property values that have the same name.

3. The resulting property values are presented to the user as defaults in wizard pages.  The
user may choose to accept or override these values.

Note:
If a new document is added to a briefcase with Accruent View, imported into a vault, modified,
and then checked out to the same briefcase, an odd situation arises. Meridian uses the GlobalID
value of the Meridian system as part of the document ID that is stored in the briefcase. This
allows documents to be moved between different Meridian systems and maintain their
association with their source vault.
When a document is added to a briefcase using Accruent View, it has no such identifier. Hence
in the situation described above, after the modified document is checked out again to the
briefcase, the user will see two copies of the document.
The one shown with the status New Document is the original copy added by Accruent View and
should be deleted from the briefcase because it does not contain the changes made to the copy
in the vault. The correct revision to keep is the one checked out from Meridian. It will be listed
with the Checked Out status.

Confidential and Proprietary © 2022 493 www.accruent.com



Application Links
Meridian includes application links for the most popular applications used for engineering. The
links can also be used in remote mode with PowerWeb.

Meridian integrates extensively with popular CAD applications. The CAD application links support
powerful features such as automatic bidirectional title block data exchange, plotting sheet set
support, external reference management, solid modeling assembly management, advanced
viewing capabilities, and more.

Meridian also integrates well with the Microsoft Office family of products. You can store files
created in any of the Office applications in a Meridian vault, even Outlook email messages and
attachments, and view most of them without the need for the Office applications themselves or
special viewers. Hyperlinks between Office documents are maintained throughout the document
life cycle.

Notes about functionality
The application links are only available when they have been correctly installed on your
computer. The links are installed by default if the linked application is already installed at the time
that you install Meridian Enterprise on the PC. If you install the application after installing
Meridian, the link will not be installed. You must then run the Meridian setup program and select
theModify option to install the link for the new application.

If you upgrade the linked application later (including updates to AutoCAD via the Communications
Center) and a new version of the link is required to function correctly with the upgrade, you must
also upgrade Meridian.
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View References
When a document, the documents that reference it (parents), and all of the documents that it
references (children) reside in the same vault, Meridian creates its own references that can be
used to find and select related documents (an assembly) for processing with Meridian. The
Meridian references can be viewed like any other Meridian reference with the following
commands:

l Show References (children)
l Show Assembly Structure (parents and children)
l Show Where Used (parents)

For more information on using these commands, see View References and Reference Explorer.
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Application Links In Remote Mode
The Meridian Enterprise application links feature special support for working remotely. This
remote mode can be useful when working with these applications on a WAN or from remote
offices with modest network bandwidth. Remote application links require at least a full time
Internet connection to the PowerWeb server and are not the same as working in Offline mode,
which does not require a full time connection.

Note:
Using application links remotely is different than using remote session support to run the
Meridian client applications with remote access software such as Windows Remote Desktop or
Citrix Delivery Center. For remote application links, no third-party software is required.
However, PowerWeb must be installed on a web server and you must have an active
connection to it.

In remote mode, the links manage document metadata and references using the same protocol
(HTTP) as PowerWeb together with document copies in your local workspace instead of from the
vault. This mode requires less bandwidth to the Meridian server than when working normally in
Online mode.

To enable Remote mode:

1. Right-click the Accruent Application Integration icon in the system tray.

A shortcut menu appears.

2. Point toMode (Online) and select Remote.

There are some limits to the kind of references that are supported by the application links in
Remote mode:

l Documents that have been replaced (by the Replace command) are not detected.
l References are only resolved for documents that exist in local workspace.
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AutoCAD Link
The Meridian application link for AutoCAD provides basic functionality for most of the discipline-
specific editions of AutoCAD such as AutoCAD Land Desktop, AutoCAD Map 3D, and AutoCAD
Architecture. Specific functionality is supported for other editions of AutoCAD such as AutoCAD
Plant 3D, and AutoCAD Electrical.

Summary of Functionality
Basic link functionality includes:

l Title block (attribute) data exchange
l File property data exchange, including custom properties
l Sheet set references
l External reference file management
l Redline import to AutoCAD layers

Application-specific functionality includes:

l Project file management
l Assembly/subassembly/part structure management

The most important of these features are title block data exchange and external reference
management because they can affect the integrity of your drawings. Some features, such as
external reference file management, are automatic and don't require any action on your part.
Other features, such as redline import, are activated at your discretion.

Title block data exchange between AutoCAD and Meridian occurs by a link between Meridian
properties and AutoCAD attributes. If your drawing title blocks (static or dynamic) use attributes
for the title block text, that text can be synchronized with properties in a Meridian vault. Normal
AutoCAD text cannot be linked with Meridian. Meridian can support multiple title block standards
simultaneously. Title block data exchange is configured by a System Administrator as described in
Configure Standard Title Block Synchronization in theMeridian Enterprise Configuration Guide.

External reference file (X-Ref) management by Meridian entails automatically detecting and
tracking AutoCAD X-Refs regardless of where the files may reside in a vault, including local
workspace. This means that Meridian can maintain the referential integrity of X-Refs as you
import drawings into a vault, move them, create revisions, and even exchange drawings with
other parties using briefcases. When you open a drawing in AutoCAD that has X-Refs, the
AutoCAD link finds the current location of the X-Ref files in the vault and updates the locations of
the X-Refs in the drawing. The link will even detect if the X-Ref files have been renamed in the
vault and will resolve them correctly in AutoCAD.
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The AutoCAD link automatically creates and maintains Meridian references between drawings
and their X-Refs (attached, overlaid, and underlaid). These links can be used to view X-Ref
drawings that might be effected by changes to a parent drawing and for other uses.

Note:
OLE objects inserted into AutoCAD drawings (for example, Excel spreadsheets) are shown by
the viewer. However, references between the documents are not automatically created by the
AutoCAD link. You can create references manually as described in Create References.

Together with the basic integration provided by Application Integration, any file created or used
by AutoCAD can be managed in a Meridian vault. Conversely, AutoCAD commands that request a
file can access Meridian vaults for document selection.

The functionality provided in AutoCAD by Application Integration is subject to the general
limitations of Application Integration described in Application Integration.

Enable Accruent Ribbon
The Accruent ribbon in AutoCAD is disabled upon startup and must be enabled manually.

To enable the Accruent ribbon:

1. Edit the following DWORD registry key.

HKEY_LOCAL_MACHINE\SOFTWARE\Cyco\AutoManager
Meridian\CurrentVersion\AutocadLink

2. Set the TurnOnMenuBar value to 1.

Accruent Ribbon Display Modes
The commands for using the AutoCAD link features can be found in the Document group of the
Accruent ribbon in AutoCAD. The Accruent ribbon in AutoCAD supports two display modes.

With rows as shown in the following figure.

Or without rows as shown in the following figure.

Confidential and Proprietary © 2022 498 www.accruent.com



To configure the display mode:

1. Edit the following DWORD registry key.

HKEY_LOCAL_MACHINE\SOFTWARE\Cyco\AutoManager
Meridian\CurrentVersion\AutocadLink

2. Choose between two options:
l Set the UseRowRibbon value to 1 to show the page with rows.
l Set the UseRowRibbon value to 0 to show the page without rows.
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Edit Properties In AutoCAD
Synchronizing Meridian properties from title block attributes is an easy way to update some
Meridian properties, but you may encounter circumstances where you want to edit Meridian
properties that are not linked to a title block. Rather than opening a Meridian client application,
you can edit properties without leaving AutoCAD.

Note:
If the properties that you want to edit are for an AutoCAD drawing that contains multiple
layouts that represent separate drawing sheets, each with a title block, a special property page
titled Title Blocks may be available if it is enabled by a System Administrator. This page lets you
enter different values for the title block in each layout.

To edit properties from within AutoCAD:

1. On theMeridianmenu or in theMeridian page of the ribbon in AutoCAD, select Edit
Properties.

You may also type AMMEDIT at the AutoCAD command line. The Meridian property pages
appear just as they would from within Meridian.

2. Click Edit.

3. Edit the properties.

4. Click OK.

The Meridian properties are updated.
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Manage Redlines In AutoCAD
Electronic redlines created in Meridian can be imported into an AutoCAD drawing where they can
be shown or hidden. They can be useful to guide drawing changes without the need to view the
redlines in Meridian. When the redlines are no longer needed in AutoCAD, you can delete (hide)
them or save them with the drawing as a record of the requested changes.

Note:
Only redlines created by the ICViewPlugIn viewer are supported by the AutoCAD link. Redlines
created by the AutoVue viewer are not supported.

Import and Show Redlines
To import and show the redlines for a drawing:

1. Open a drawing that has existing Meridian redlines.

2. On theMeridianmenu or in theMeridian page of the ribbon in AutoCAD, select Show
Redlines.

You may also type AMSHOWRED at the AutoCAD command line. The redlines appear in the
drawing.

Note:
Meridian redline memo objects cannot be shown inside AutoCAD.

Meridian redlines are imported to AutoCAD layers named AMWREDL_<LayerName> where
<LayerName> is the name of the Meridian layer where the redlines were created. The
Meridian layer names and colors are set in the vault configuration by a System
Administrator. For example, the default redline layer name is Exchange, so the
corresponding AutoCAD layer name is AMWREDL_Exchange. You can manipulate these
layers by turning them on or off, freezing and thawing them, or locking and unlocking them
the same as any other layer.

Meridian redline objects are created in AutoCAD using standard AutoCAD entities and as
such can be edited like any other entities.

Hide Redlines
To hide the redlines in a drawing:

l On theMeridianmenu or in theMeridian page of the ribbon in AutoCAD, select Hide
Redlines.
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You may also type AMHIDERED at the AutoCAD command line. The redlines disappear from
the drawing.

When you hide Meridian redlines, the redline entities and redline layers are deleted from
the drawing. To recreate the redlines, import them again.
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Save And Release Drawings
After you have checked out a drawing as described in Route a Document In a Workflow and
edited it, you can easily finish working with the drawing from within AutoCAD using the single
command Save & Release.

The command performs several actions for you:

l Saves your changes to the file in your local workspace.
l Closes the drawing in AutoCAD.
l Synchronizes your local workspace with the Meridian vault.
l Routes the drawing to the released state of its workflow. If the next state in the drawing's

workflow is not the released state, this action is not performed and you must route the
document manually as described in Route a Document In a Workflow.

To save and release a drawing:

l On theMeridian page of the ribbon in AutoCAD, select Save & Release .

If the workflow transition that executes is configured to show any property pages for you to
input additional information, they appear just as they would from within PowerUser.

Note:
o This command is not available on theMeridianmenu or at the command prompt

because it attempts to close the drawing, which prevents releasing it.
o If the current drawing is the parent in an assembly and the Releases the assembly

document and all its references option is enabled as described in Actions Options,
only the current drawing is released. The other documents in the assembly must be
released manually, if necessary.
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AutoCAD Sheet Sets
The AutoCAD link supports sheet sets created by the AutoCAD Sheet Set Manager. The AutoCAD
link manages sheets sets similar to the way that it manages X-Refs. The application link creates
and maintains Meridian references between the sheet set (DST) file and all AutoCAD drawing files
referenced by the sheet set file. The link can also exchange Meridian property values in both
directions between the sheet set document stored in the vault and the Sheet Set Manager. This is
useful so that you can work with the same drawings in Meridian that are referenced by the sheet
set. Storing the sheet set file as a document in a Meridian vault keeps it securely organized
together with the drawings that it references.

The following topics describe how to use the AutoCAD link to work with sheet sets.
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Create a Sheet Set
The best way to create a sheet set document in Meridian is to create it from a template in
PowerUser. Consult a System Administrator for the names and purposes of the sheet set
templates in your system.

To create a sheet set document:

1. On the Vaultmenu, point to New, point to the name of the sheet set document type, and
select a sheet set template.

If the document type you selected has property pages associated with it, they will appear
for you to type any known information.

2. Complete each property page.

3. Click Next or Finish.

The sheet set document is created in the current folder or in the folder calculated by the
Field-Path definition of the vault configuration.

If the document type you selected performs automatic document naming, Meridian assigns
a calculated name to the sheet set file. If not, a default document name is assigned that you
may overwrite with any name you want.

When you open the sheet set document in AutoCAD, its properties can be updated from
Meridian if they have been configured to do so by a System Administrator. Layouts can also
be added to the sheet set in AutoCAD as described in Add Layouts To a Sheet Set.
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Add Layouts To a Sheet Set
To add layouts of vault drawings to an existing sheet set:

1. Open the sheet set in AutoCAD.

At least one drawing must also be open. If necessary, open or create a drawing to enable
the Import Layout as Sheet command in Sheet Set Manager.

2. In Sheet Set Manager, click the Sheet List tab to display the Sheets list.

3. Right-click the name of the sheet set in the Sheets list and select Import Layout as Sheet.

The Import Layouts as Sheets dialog box appears.

4. Click Browse for Drawings.

The Select Drawings dialog box appears.

5. Click the Browse the Meridian Enterprise Vault button in the toolbar.

The ‘Select Drawing' from Meridian Enterprise dialog box appears.

6. Browse the vault, select a drawing that contains a layout that you want to import, and click
Open.

The name of the drawing, the names of the layouts found, and the status of the layouts are
added to the layouts list.

7. Select the layouts that you want to import.

8. Repeat steps 4 through 7 for each drawing containing layouts that you want to import.

9. Click Import Checked when finished.

The layouts are added to the Sheets list.

When the sheet set is saved, Meridian references are created between the sheet set
document and each drawing for which layouts were imported to the sheet set.
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View References
When a document, the documents that reference it (parents), and all of the documents that it
references (children) reside in the same vault, Meridian creates its own references that can be
used to find and select related documents (an assembly) for processing with Meridian. The
Meridian references can be viewed like any other Meridian reference with the following
commands:

l Show References (children)
l Show Assembly Structure (parents and children)
l Show Where Used (parents)

For more information on using these commands, see View References and Reference Explorer.
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Route a Sheet Set
The Meridian sheet set references make it easy to initialize workflows for the drawings in a sheet
set from within AutoCAD.

To route an entire sheet set:

1. Open the sheet set file in AutoCAD and open one of the drawings.

2. On theMeridianmenu or in theMeridian page of the ribbon in AutoCAD, select Route All.

If the drawing is not currently checked out (in a writable state), you are prompted to
confirm that you want to start the workflow.

3. Click Yes or click Yes to All to check out the entire sheet set.

The type of workflow initiated for the sheet set drawings depends on the configuration of
their document types and your security privileges. The drawings might be routed in a Quick
Change, a document type workflow, or a workflow definition. Consult with a System
Administrator about the configuration of your system.
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Synchronize Sheet Set Data
If you use Sheet Set Manager to manage the properties of sheet sets and some of those
properties are also linked to Meridian properties, the AutoCAD link includes additional AutoCAD
commands on theMeridianmenu and in theMeridian page of the ribbon in AutoCAD that you
can use to synchronize Meridian with the current sheet set properties.

Whenever the Sheet Set Manager is closed, the properties are synchronized automatically.

The following table lists the AutoCAD link commands for synchronizing data with Meridian
properties.

Menu Item Function

Update Project Updates the sheet set open in AutoCAD with Meridian properties in the vault.

Update Vault Updates Meridian properties in the vault from the sheet set open in AutoCAD.

Update References Updates Meridian with the current sheet set references.

Sheet set synchronization commands
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AutoCAD Plant 3D
The AutoCAD link provides specific functionality for use exclusively with AutoCAD Plant 3D. This
functionality is in addition to the basic functionality provided for AutoCAD as described in
AutoCAD Link.

When a project file, related data files, and all drawing files that are referenced by the project file
are stored in a Meridian vault, the link can retrieve Meridian property values from the AutoCAD
Project Manager. This exchange is one way only, from AutoCAD to Meridian Enterprise. Data
exchange to AutoCAD Plant 3D projects is not supported.

The link also creates and maintains Meridian references named AcadPnID Project Part between
the project file and the related data files. The link creates references named AcadPnID Project
Reference between the project file and the drawing files. This is useful so that you can work with
the same sets of files in Meridian that are referenced by the project file.

If you are part of a team working on projects, contact a System Administrator about configuring
the project folders in the vault as shared workspaces as described in Configure Shared
Workspaces in theMeridian Enterprise Configuration Guide.
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Prepare an AutoCAD Plant 3D Project
AutoCAD Plant 3D projects consist of a project file (.xml), drawing files (.dwg), and numerous
data files (.xml,.dcf,.dcfx, and so on). The Meridian AutoCAD link refers to the data files
as parts in the sense that they are parts of the project data other than the drawings. These parts
should not be confused with Meridian hybrid document parts or mechanical assembly parts.
Because of the complexity of AutoCAD Plant 3D projects, they require some initial preparation
before you can start working with them in Meridian.

Configuration Notes
For full functionality, property synchronization should be configured as described in the
Configuring the AutoCAD Plant 3D link article in theMeridian Enterprise Configuration Guide.

If AutoCAD Plant 3D is used with the Meridian Asset Management Module, the AutoCAD Plant 3D
link that is included with that module should be used instead of the basic AutoCAD Plant 3D link.
It provides functionality for linking AutoCAD Plant 3D drawing tags (not just the standard Asset
Management Module tags) to Meridian documents and managing synchronization states.

To enable the AutoCAD Plant 3D link tag functionality, consult a System Administrator about
setting the AcadPnIDConfig registry setting described in HKEY_CURRENT_
USER\Software\Cyco\AutoManager Meridian\CurrentVersion\AutocadLink in theMeridian
Enterprise Administrator's Guide.

Prepare a Project
To prepare a project:

1. Import the project with the Meridian Assembly Import Wizard as described in Import
Assemblies.

2. Create the file MeridianLinkSearchRules.txt in the project folder of the vault as
described in the Configuring project file synchronization article in theMeridian Enterprise
Configuration Guide.

3. In AutoCAD Plant 3D Project Manager, open the project.xml file from the Meridian
vault.

Open any drawing to enable the Accruent ribbon.

4. In theMeridian ribbon, click Attach Custom.

The Select documents description file dialog box appears.
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5. Navigate to and select the MeridianLinkSearchRules.txt file that you created in
the vault.

The AutoCAD Plant 3D link creates a reference from the project file to the search rule file
with the type AcadPnID Custom Part. It then uses the rules in the file to find the other files
and to create references from the search rule file to them. If the search rule file is not
locked, the link creates a [Log] section at the end of the file and a list of all of the files that
were found and linked to the search rule file. You can view this list to confirm that all of the
project files are correctly linked in Meridian.

6. Close the project.
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Open a Project
You must manipulate the project files in Meridian before you can open the project in AutoCAD.
How much you need to manipulate the files depends on the task that you want to perform with
the files as described in the following table.

Task Description

View
project
files

Prepare the project files by downloading them to your local workspace and synchronizing
the paths in the files with their new locations.

Edit
project
files

Prepare the files as in the preceding task plus route the project files in a workflow so that
your changes can be saved and synchronized with the vault.

Project file management tasks

Prepare Project Files for Viewing
To prepare project files to be opened for viewing:

1. In AutoCAD with the project file closed, in the Accruent ribbon, click Prepare Project.

The AutoCAD Open dialog box appears.

2. Click the vault button in the toolbar.

The Meridian Enterprise Application Integration window appears, as described in
Application Integration.

3. Navigate the vault, select the project file, and click Open.

The project files are downloaded to your local workspace and the paths in the files are
updated to their new locations.

Prepare Project Files for Editing
To prepare project files to be edited:

Confidential and Proprietary © 2022 513 www.accruent.com



1. Prepare the files to be opened for viewing as in the preceding procedure.

2. In the Accruent ribbon, select Route All.

If the project files are not currently checked out to you (in a writable state), you are
prompted to confirm that you want to start the workflow.

3. Click Yes.

The project files in the vault are checked out to you for editing and routed to the first
writable state in their respective workflows.

4. If the project files were not initially in a writable workflow state, reopen the project in
AutoCAD to make the properties editable.

Note:
l The first writable state of each workflow might not be the first available state in the

workflow. Beginning the workflow at that state might violate your organization's
business process. If so, route the files using the workflow transitions in the
PowerUser instead, which do not skip any states.

l After you are finished editing a drawing, use the Save & Release command in the
Document group of the Accruent ribbon as described in Save And Release Drawings.

The type of workflow that is initiated for the project files depends on the configuration of
their document types and your security privileges. The files might be routed in a Quick
Change, a document type workflow, or a workflow definition. Consult with a System
Administrator about the configuration of your system.
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Synchronize Project Properties
If you use Project Manager to manage the properties of projects (including title blocks) and some
of those properties are also linked to Meridian properties, the AutoCAD includes additional
commands in the Project Management group of the Accruent ribbon in AutoCAD that you can
use to synchronize Meridian with the current project properties and references. In this case, use
those commands instead of the commands in the Document group of the Accruent ribbon in
AutoCAD.

Whenever the Project Manager is closed, the properties are synchronized automatically.

The following table lists the AutoCAD link commands for synchronizing project properties and
part references with Meridian properties and references.

Menu Item Function

Update Project Updates the project file open in AutoCAD with Meridian properties in the vault.

Sync to Vault Updates Meridian properties in the vault from the project file open in AutoCAD.

Update References Updates Meridian with the current project file references.

Project property synchronization commands
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Upload a Project
If an AutoCAD project is closed while using the link in Remote mode as described in Application
Links In Remote Mode, the project files are not automatically synchronized with the vault as they
normally would be in Online mode. To resolve this, you should synchronize the vault with your
local workspace with the Upload Project command.

To upload a project:

l On theMeridianmenu or in the Accruent group of the ribbon in AutoCAD, select Upload
Project.
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View References
When a document, the documents that reference it (parents), and all of the documents that it
references (children) reside in the same vault, Meridian creates its own references that can be
used to find and select related documents (an assembly) for processing with Meridian. The
Meridian references can be viewed like any other Meridian reference with the following
commands:

l Show References (children)
l Show Assembly Structure (parents and children)
l Show Where Used (parents)

For more information on using these commands, see View References and Reference Explorer.
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Create New Drawings
If the AutoCAD Plant 3D project for which you want to create a new drawing does not reside in a
shared workspace, you do not have to do anything special to create new drawings. Create them
as you normally would. For more information about shared workspaces, see Shared Workspace
Folders.

Special care must be taken when creating new drawings in a project that resides in a Meridian
Enterprise vault. Due to a technical limitation in AutoCAD, when Meridian Enterprise calculates
the filename for a new drawing, the filename cannot be sent to AutoCAD like it can be sent to
other applications. This applies only to vaults that have been customized to show a wizard for
new documents and that calculate the name using scripting. If you are unsure about the
configuration of your vault, consult a System Administrator.

To create a new drawing:

1. Ensure that the folder structures in the AutoCAD Plant 3D project and in the vault are the
same.

If necessary, synchronize the vault with the Folder Structure command in the Accruent
ribbon.

2. Create the new drawing using the AutoCAD New command, not with Project Manager.

Do not select an AutoCAD Plant 3D drawing template.

3. Save the drawing in the appropriate location in the vault.

4. In AutoCAD Plant 3D Project Manager, invoke the Copy drawing to the project command on
the folder menu.
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Drawing Tags
A special link for AutoCAD Plant 3D can be configured to load in AutoCAD Plant 3D as described in
Configure the AutoCAD Plant 3D Link in theMeridian Enterprise Configuration Guide. It makes
additional commands available to you besides those in the base AutoCAD Plant 3D link. The
synchronization commands are designed to work specifically with the drawing tags created by
AutoCAD Plant 3D when they are linked to asset tags in the Meridian.

Command Description

Folder Structure Creates missing sub-folders in the (local or shared) workspace location to match the
folder structure of the project in the vault.

Tags Dialog Opens the Tags dialog box so that you can view the status of the drawing tags as
described in View Drawing Tags.

Update Drawing Synchronizes the tags in the drawing from the corresponding asset tags in the vault.
The tag properties must be mapped to Meridian Enterprise properties by a System
Administrator.

Update Vault Synchronizes the asset tags in the vault from the corresponding tags in the drawing.
The tag properties must be mapped to Meridian Enterprise properties by a System
Administrator.

AutoCAD Plant 3D commands
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AutoCAD Electrical
The AutoCAD link provides specific functionality for use exclusively with AutoCAD Electrical. This
functionality is in addition to the basic functionality provided for AutoCAD as described in
AutoCAD Link.

Note:
AutoCAD Electrical projects consist of a project file (.wdp), drawing files (.dwg), and numerous
data files (.wdl,.wdt,.wdn,.wdw,.ww1, and so on). The AutoCAD link refers to the data
files as parts in the sense that they are parts of the project data other than the drawings. These
parts should not be confused with Meridian hybrid parts or mechanical assembly parts.

When an AutoCAD Electrical project file and all drawing files referenced by the project file are
stored in a Meridian vault, the link creates and maintains Meridian references named AcadE
Project Reference between the AutoCAD Electrical project file and the related drawing files. The
link also creates and maintains Meridian references named AcadE Project Part between the
project file and the related data files. This is useful so that you can work with the same sets of
files in Meridian that are referenced by the project file.

You can import AutoCAD Electrical projects using the Meridian Assembly Import Wizard as
described in Import Assemblies.

If you are part of a team working on AutoCAD Electrical projects, contact a System Administrator
about configuring the project folders in the vault as shared workspaces as described in Configure
Shared Workspaces in theMeridian Enterprise Configuration Guide.
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Prepare an AutoCAD Electrical Project
An AutoCAD Electrical projects consist of a project file (.wpd) and drawing files (.dwg). Because
of the complexity of AutoCAD Electrical projects, they require some initial preparation before you
can start working with them in Meridian.

To prepare a project:

1. Choose between two options:
l (PowerUser only) Import all of the project files to the vault as described in Document

Import Tool.
l (PowerWeb only) Duplicate the project folder structure in the vault.

Import the contents of each project folder to the vault as described in Upload
Documents.

2. Release all the project files as described in Route a Document In a Workflow.

3. Configure the main project folder as a shared workspace as described in Configure Shared
Workspaces in theMeridian Enterprise Configuration Guide.

For guidelines on working in a shared workspace, see Shared Workspace Folders.

4. Start all project files in a workflow as described in Route a Document In a Workflow.

5. Open the project in AutoCAD Electrical to work on the project.
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Open a Project
You must manipulate the project files in Meridian before you can open the project in AutoCAD.
How much you need to manipulate the files depends on the task that you want to perform with
the files as described in the following table.

Task Description

View
project
files

Prepare the project files by downloading them to your local workspace and synchronizing
the paths in the files with their new locations.

Edit
project
files

Prepare the files as in the preceding task plus route the project files in a workflow so that
your changes can be saved and synchronized with the vault.

Project file management tasks

Prepare Project Files for Viewing
To prepare project files to be opened for viewing:

1. In AutoCAD with the project file closed, in the Accruent ribbon, click Prepare Project.

The AutoCAD Open dialog box appears.

2. Click the vault button in the toolbar.

The Meridian Enterprise Application Integration window appears, as described in
Application Integration.

3. Navigate the vault, select the project file, and click Open.

The project files are downloaded to your local workspace and the paths in the files are
updated to their new locations.

Prepare Project Files for Editing
To prepare project files to be edited:
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1. Prepare the files to be opened for viewing as in the preceding procedure.

2. In the Accruent ribbon, select Route All.

If the project files are not currently checked out to you (in a writable state), you are
prompted to confirm that you want to start the workflow.

3. Click Yes.

The project files in the vault are checked out to you for editing and routed to the first
writable state in their respective workflows.

4. If the project files were not initially in a writable workflow state, reopen the project in
AutoCAD to make the properties editable.

Note:
l The first writable state of each workflow might not be the first available state in the

workflow. Beginning the workflow at that state might violate your organization's
business process. If so, route the files using the workflow transitions in the
PowerUser instead, which do not skip any states.

l After you are finished editing a drawing, use the Save & Release command in the
Document group of the Accruent ribbon as described in Save And Release Drawings.

The type of workflow that is initiated for the project files depends on the configuration of
their document types and your security privileges. The files might be routed in a Quick
Change, a document type workflow, or a workflow definition. Consult with a System
Administrator about the configuration of your system.
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Synchronize to Vault
When you make changes in AutoCAD Electrical, they are not automatically uploaded to your
vault. You must use the Synchronize to Vault command.

To synchronize to the vault:

1. From theMeridianmenu, select Synchronize electrical project to vault.

You are prompted to select which project file you want to synchronize.

2. Select the AutoCAD Electrical project you want to synchronize and click Open.

The project you selected is synchronized to the vault.
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Update References
In AutoCAD Electrical, you can update your references from the project to the project parts. This
function is required when you add a new drawing to your project because of the separation of the
files in your file system. The Update References command will import the drawing to the vault
and update the references.

To update references:

1. Prepare your project files for editing.

2. On theMeridian ribbon, click the down arrow below the Project Management button and
select Update References.

3. Select the project you want to update.

4. Click Open.

The references are updated. If necessary, the drawing is added to your project in the vault.
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View References
When a document, the documents that reference it (parents), and all of the documents that it
references (children) reside in the same vault, Meridian creates its own references that can be
used to find and select related documents (an assembly) for processing with Meridian. The
Meridian references can be viewed like any other Meridian reference with the following
commands:

l Show References (children)
l Show Assembly Structure (parents and children)
l Show Where Used (parents)

For more information on using these commands, see View References and Reference Explorer.
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Add a Drawing To a Project
Perform the following task to allow Meridian to manage the references correctly when adding
existing drawings to a project.

The project must be properly initialized as described in Prepare an AutoCAD Electrical Project.

To enable the synchronization commands in PowerWeb for AutoCAD Electrical project files, the
WDP file extension must be added to value of CADLinkExtensions in the following registry key on
the Meridian web server as described in Registry Keys section of theMeridian Enterprise
Administrator's Guide.

HKEY_LOCAL_MACHINE\SOFTWARE\Cyco\AutoManager
Meridian\CurrentVersion\WebLink

To add an existing drawing to a project:

1. Copy the drawing to the shared workspace folder.

2. In AutoCAD Electrical, add the drawing to the project.

3. Open the drawing for editing. This will import it to the vault automatically.

4. Synchronize the references from the project file (.wdp) as described in Synchronize
References.
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AutoCAD Civil 3D
Meridian provides basic functionality for AutoCAD as described in AutoCAD Link.

AutoCAD Civil 3D drawings can contain data shortcuts (.xml files). You can take advantage of the
local workspace synchronization feature of Meridian to share your data shortcuts with other
users who work on the same projects. The following topics describe how to do this.

If you are part of a team working on AutoCAD Civil 3D projects, contact a System Administrator
about configuring the project folders in the vault as shared workspaces as described in Configure
Shared Workspaces in theMeridian Enterprise Configuration Guide.
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Prepare Your Local Workspace
Preparing your Meridian local workspace to work with an AutoCAD Civil 3D project involves the
following steps.

l TheWorkSpaceNoUserName registry value in the following key must be set to 1 to prevent
appending your user account name in the local workspace path:

HKEY_CURRENT_USER\Software\Cyco\AutoManager
Meridian\CurrentVersion\Client\Settings

l The following settings can be configured to control working folder synchronization:
o Civil3DHideWCDialog to automatically create working copies of data shortcuts and not

prompt users to select them.
o Civil3DSyncWorkingFolder to synchronize the entire working folder, not just the data

shortcuts folder (default)
o Civil3DSyncType to control automatic synchronization of the working folder
o ReleaseNewCivil3DDataShortcuts to allow the release of Civil 3D data shortcuts from

their workflows when they are imported to the vault by working folder
synchronization

The following locations will be searched for these settings in the order listed and the value
of the first location where it is found will be applied:

o HKEY_LOCAL_MACHINE\Software\Cyco\AutoManager
Meridian\CurrentVersion\AutocadLink (affects all users of the PC)

o HKEY_CURRENT_USER\Software\Cyco\AutoManager
Meridian\CurrentVersion\AutocadLink (affects only the current user of
the PC)

o The [Civil_3D] section on the AutoCAD tab of the Application Link Settings in the
Environment branch of the vault configuration (affects all users of the vault)

For more information about these settings, see the Registry Keys section in theMeridian
Enterprise Administrator's Guide .

To prepare your local workspace:

1. Identify the folder in the vault that contains the project files that you want to work with or,
if necessary, create a new folder as described in Creating a folder.

2. Right-click the Accruent Application Integration icon in the system tray, point to Local
Workspace, and then click Open Local Workspace Folder.
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The folder is opened in Windows Explorer. If the folder does not yet exist, open the vault
and open any document from any project. This will automatically create the local workspace
folders.

3. Open the sub-folder that corresponds to the vault that contains the project folder from step
1.

The vault name is part of the sub-folder name, which has the form
<ServerName>,<VaultName>.

4. Create a new folder there to synchronize with the project folder in the vault, for example,
Civil 3D Projects.

5. In AutoCAD Civil 3D, set the working folder to the new local workspace folder that you
created in step 4.

6. In AutoCAD Civil 3D, create a new data shortcut folder in the working folder that you set in
step 5.

It should appear in the Prospector tree.
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Data Shortcuts
How you work with data shortcuts in AutoCAD Civil 3D depends on whether you are the creator
of the shortcut or the shortcut has already been created by another user.

Note:
Data shortcuts contain references to source drawings. The best practice is to keep those source
drawings in the same data shortcuts folder that you created in Prepare Your Local Workspace.
This will guarantee that the source drawings will be synchronized to your local workspace with
the data shortcuts. To help identify data shortcut files after they are imported to the vault, we
recommend that a Meridian System Administrator create a dedicated document type for them
that will be assigned to files with the .XML file extension as described in Assign Document Types
To Imported Documents in theMeridian Enterprise Configuration Guide.

Work with Data Shortcuts
To work with data shortcuts:

1. Start AutoCAD Civil 3D and prepare a project folder as described in Prepare Your Local
Workspace.

2. If a data shortcut that you want to work with already exists in the Prospector tree and you
open an existing drawing from there, you will be prompted to synchronize the data
shortcuts to your local workspace. If you create a new drawing, you can synchronize them
manually as described in the following task.

If the data shortcuts that you want to work with do not already exist, create new ones as
necessary. This will first create the XML files in a new folder structure in your local
workspace. These files and folders will be automatically copied to the vault project folder
when you save or close the drawing and your local workspace is synchronized with the
vault. The data shortcuts will be synchronized to the local workspaces of other users when
they also configure their local workspaces as described in Prepare Your Local Workspace
and open project drawings from the vault.

If you need to edit the data shortcuts:
l In the Accruent menu, click Edit Data Shortcuts to create working copies.

We recommend that a single user be responsible for modifications to the
ShortcutsFolders.xml file that resides in the project folder and that it not be
modified by multiple users.
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Manually Synchronize Data Shortcuts
To manually synchronize data shortcuts:

l In AutoCAD Civil 3D, in the Accruent menu, click Synchronize Data Shortcuts to Local (local
workspace) or Synchronize Data Shortcuts to Vault.

The Synchronize Data Shortcuts to Vault command only synchronizes new or modified
shortcuts. To synchronize all shortcuts in legacy projects, use the Synchronize All Data
Shortcuts to Vault command instead. The command is invisible by default.

To make it available, set the AcadBaseConfig registry value on the your PC as described in
HKEY_CURRENT_USER\Software\Cyco\AutoManager Meridian\CurrentVersion\AutocadLink
in theMeridian Enterprise Administrator's Guide. Depending on the quantity of shortcuts,
this command can take considerably longer to complete than Synchronize Data Shortcuts
to Vault and so it is not recommended for use in Remote mode.
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Inventor Models
The AutoCAD VIEWBASE command can be used to insert a read-only view of an Inventor model
into AutoCAD paper space. The Meridian AutoCAD link can automatically create Meridian
references from the AutoCAD drawing to the Inventor project to show and help manage this
dependency. For these references to be created, the Inventor model and the AutoCAD drawing
must both reside in the vault before the model view can be inserted into the drawing.

After a reference has been made, the AutoCAD drawing can be opened as normal with these
limitations:

l The Inventor model must be downloaded to your local workspace before the drawing is
opened. When the drawing is opened, an unresolved reference error can occur. You can
either click Change the active project and then select the Inventor project or you can click
Ignore unresolved references and continue.

l If you rename or move the Inventor model, the reference will not be automatically updated,
you must do it manually.

The Assembly Import tool does not support importing an AutoCAD drawing with references to an
Inventor model that resides in the vault. After the drawing is imported, open the drawing in
AutoCAD and save it. References to the Inventor model will then be created.

This functionality requires the setting InventorRefSupport be set to 1 in the vault configuration as
described in Configuring advanced settings in theMeridian Enterprise Configuration Guide.
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Drawing Tags
If your drawings contain tag IDs either as plain text or as AutoCAD attributes, Meridian can
extract that information (if configured to do so by a System Administrator) and store it in the
vault. The information is stored as a list of drawing tags for each document. The information can
then be used to match with tags that also reside in the vault. You can link the matching tags to
the document that contains the drawing tags or create new tags that are missing in the vault.
Meridian can also generate graphical hotspots (in AutoCAD drawings only) for the drawing tags in
the viewer window that you can click to navigate to linked tags in the vault. Specifying how
drawing tag information is extracted and stored and how it relates to tags in the vault must be
configured by a System Administrator as described in Configure the AutoCAD Link and Configure
the MicroStation Link in theMeridian Enterprise Configuration Guide.

Meridian provides drawing tag management commands in AutoCAD and MicroStation that help
when working with drawing tags in Meridian Enterprise. The commands are installed in AutoCAD
and MicroStation when the Meridian components are selected during Meridian Enterprise
installation on your computer.

Using each of the drawing tag management commands is described in the following topics.
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View Drawing Tags
Viewing drawing tags is easy and is the first step before you can link the drawing tags to vault
documents.

If revisions to tags are controlled by the management of change features of Meridian Enterprise,
that is, changes must be made to a copy in a project, all master and project copies of the tags will
appear in the Tags page so that you can see the all of the dependencies on the document.

To view the current drawing tag information for a document:

1. Choose between two options:
l In Meridian Enterprise:

a. Select the document that contains tag information that you want to view.

For information on finding documents, see Searches.

b. View the tags that are currently linked to the document as described in View
Linked Tags.

c. To view the drawing tags found as block attributes in a drawing, click Drawing
Tags.

To view the tags found as plain text in other file types (if configured by a System
Administrator), click Text Tags.The corresponding page or dialog box appears and
shows the tags that are found in the document.

The Drawing Tags button is disabled in PowerWeb if the document is locked in
the local workspace. This is because the document can be modified without
detection by PowerWeb and invalidate the information shown by the dialog box.

l In AutoCAD and MicroStation:

a. On the Accruentmenu, select Tags Dialog.

The Drawing Tags dialog appears.

The following table contains descriptions of each column.

By default, a document's tag list is updated whenever the document is saved in
AutoCAD or the Text Tags or Drawing Tags dialog is shown. To view updated
Status information, such as after editing tag properties, click Refresh.

b. To filter the list of tags on a specific value, select the value from the column
heading's list.

c. To see the equipment in the drawing that is associated with the selected tag
data, click Zoom.

2. When you are finished viewing asset tags, click Close.
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Column Description

Tag Name The text or attribute value found in current document by the last tag extraction. The
value might have a prefix or postfix applied as configured by a System Administrator.
Consult a System Administrator for the names of blocks and attributes or text patterns
that are configured for asset tag extraction.

Tag Type The tag type assigned to the asset.

Status The status of the asset tag in relation to a matching vault tag. The possible values are
described in the following table.

Inserted Indicates an asset tag that was found in the current document.

Linked Indicates that the current document is linked to the matching vault tag.

Tag The name of a matching vault tag. These names are the same as the tags listed on the
Related Tags property page.

Tag columns

The following table contains descriptions of the possible Status column values.

Value Description

No
matching
tag found

No matching vault tag could be found. To create and link a matching tag, see Create Vault
Tags From Drawing Tags.

Not linked A matching vault tag was found but the document has not yet been linked. To link the
matching tag, see Link And Unlink Documents And Tags.

Mismatch
found

A matching vault tag was found but the vault tag is not linked to the document and the
tag type assigned to the vault tag does not match the asset tag type.
To ignore the tag type comparison, disable Compare tag types (PowerUser) or enable
Ignore tag types (PowerWeb).
To correct the vault tag type, see View And Edit Vault Tag Properties.

Ok A matching vault tag is linked to the document.

Coerced
reference

A matching vault tag is linked to the document, but the tag type assigned to the vault tag
does not match the asset tag type.
To ignore the tag type comparison, disable Compare tag types (PowerUser) or enable
Ignore tag types (PowerWeb).
To correct the vault tag type, see View And Edit Vault Tag Properties.

Status columns
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Value Description

Only in
vault

A matching vault tag was found but the vault tag is not linked to the document and the
tag type assigned to the vault tag does not match the asset tag type. To correct the vault
tag type, see View And Edit Vault Tag Properties.
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View And Edit Vault Tag Properties
After documents and tags have been linked as described in Link And Unlink Documents And Tags,
you can use drawing tags to identify and then view and edit the properties of the corresponding
vault tags.

To view or edit the properties of a vault tag that is already linked to the current document:

1. Select the document that contains the tag information that you want to view.

2. Display the drawing tags as described in View Drawing Tags.

3. Select a row that contains a vault tag that you want to view or edit.

4. Click Properties.

The property pages for the selected vault tag appear.

5. Click Edit.

The property pages become editable.

6. Modify the properties as you normally would.

7. Click OK.
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Link And Unlink Documents And Tags
When the Meridian extracts drawing tag information, it searches the vault for matching tags. The
tags that it finds might or might not be linked to the current document. They might be linked if
the tag was created from the tag information as described in Create Vault Tags From Drawing
Tags or they might be linked because another user performed the following procedure.

PowerWeb Procedures
Use these steps for PowerWeb.

To link or unlink a document from tags that match drawing tags:

1. Select the document that contains the drawing tags that you want to use.

2. Display the drawing tags as described in View Drawing Tags.

3. Place or remove a tick from the check box in the left column.

4. Click Apply.

The tags are linked or unlinked accordingly.

Click the icons in the header row to add or remove ticks from all of the tags in the list.

5. Click Close.

The list on the Tags page refreshes to show the resulting links.

PowerUser Procedures
Use these steps for PowerUser.

To link or unlink a document from tags that match drawing tags:

1. Select the document that contains the drawing tags that you want to use.

2. Display the drawing tags as described in View Drawing Tags.

3. Select the rows that contain matching tags that you want to link to or unlink from the
current document.

In PowerUser you can easily select multiple rows:

a. Hold down the Ctrl key and click to select individual documents.

b. Select one row and then hold down the Shift key and click another row to select a
range of rows.

c. Click and drag your cursor across rows.
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4. To link the selected tags, click Link.

The tags are linked to the selected document. The check box in the Linked column is
selected to indicate that a link (Meridian Enterprise reference) has been created between
the tag and the current document. The Status value of the asset tag displays OK.

5. To unlink the selected tags, click Unlink.

The tags are unlinked from the selected document. The check box in the Linked column is
cleared to indicate that the links (Meridian Enterprise references) have been removed
between the tags and the current document. The Status value of the asset tags display Not
linked.
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Update the Drawing Tag List
The Meridian Enterprise vault stores a drawing tag list for each drawing that contains attribute
tags that are configured to use drawing tag integration. You can update a drawing's list from
within PowerUser as described in View Drawing Tags or you can update the list from within
AutoCAD and MicroStation. Updating the list from within AutoCAD and MicroStation ensures that
the next user to view the drawing tags in Meridian Enterprise will immediately see all of the
current tags and not have to refresh the list first (if the Meridian is configured to not update the
list every time a drawing is saved).

To update a drawing's tag list:

1. With the drawing open in AutoCAD or MicroStation, on the Accruentmenu, select Update
Tag List.

The Update Tag List dialog shows the results.

2. Click OK.
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Analyze Drawing Tags
Whenever drawing tag information is extracted from drawings, Meridian logs which tags have
matching vault tags and which tags do not. You can display this information to confirm that the
drawing tag integration is configured properly and that the tags contain the correct information.

To analyze a drawing's tags:

1. With the drawing open in AutoCAD or MicroStation, on the Accruentmenu, select Analyze
Tags.

The Analyze Tags dialog shows the results. 

2. Click OK.
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Create Vault Tags From Drawing Tags
If you want to link documents to tags in the vault that represent drawing tags in the document,
the tags must exist first. Depending on its configuration, Meridian might create tags automatically
from data in your maintenance management system. If not, you will need to create them
manually. Meridian makes this relatively easy by using the information that is stored in the
drawing tags.

To create vault tags from asset tags:

1. Select the document in PowerUser that contains the drawing tags for which you want to
create vault tags.

2. Display the drawing tags as described in View Drawing Tags.

3. Select the rows that contains the tags for which you want to create vault tags.

To select multiple rows:

a. Hold down the Ctrl key and click to select individual tags.

b. Select one row and then hold down the Shift key and click another row to select a
range of rows.

c. Click and drag your cursor across rows.

4. Click New Tag.

If the vault tag type is configured to show a property wizard for new tags, the
wizard appears for the first new tag to be created.

5. Select or type the appropriate values in the property wizard.

If you selected multiple rows and you want the values to be applied to all of the new tags,
select Skip this wizard for all other objects of this type.

6. If present, click Next and complete the remaining pages of the wizard.

7. When you are finished entering values on the last page of the wizard, click Finish.

A new tag is created using the property values that you typed in the wizard. The name of
the new tag appears in the Tag column and the check box in the Ref column is selected to
indicate that a link (Meridian Enterprise reference) has been created between the tag and
the current document. The Status value of the asset tag displays OK.

If you selected Skip this wizard for all other objects of this type, new tags are created for
each of the selected rows using identical property values that you typed in the wizard. If
not, the wizard reappears for each new tag so that you can type values for that tag.

No further action is necessary to link the tags to the current document.

8. Click Close.
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Update Drawing Tag Hotspots
A hotspot is an area in a document that can perform some action when the mouse cursor is
moved into that area. Meridian can create graphical hotspots where blocks that represent plant
equipment have been inserted in AutoCAD drawings. The blocks must contain an attribute that
represents the equipment's physical tag. These hotspots can be shown in the PowerUser viewer
window and users can click them to navigate to the vault tags that represent the asset.

The AutoCAD blocks for which you want to create hotspots must be configured correctly in the
Meridian settings of the vault by a System Administrator as described in the Configure Standard
Title Block Synchronization article in theMeridian Enterprise Configuration Guide.

Note:
Viewing hotspots requires that AutoVue be the active viewer for the selected document.

To update drawing tag hotspots:

1. Select the document in PowerUser that contains the drawing tags for which you want to
update the hotspots.

For information on finding documents, see Searches.

2. Display the drawing tags as described in View Drawing Tags.

3. Click Update Hotspots.

4. Click Close.
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MicroStation Link
The Meridian Enterprise application link for MicroStation provides the features of:

l Title block data exchange
l File property data exchange, including custom properties
l External reference management

The most important of these features are title block data exchange and external reference
management because they can affect the integrity of your drawings. Some features, such as
external reference management, are automatic and don't require any action on your part.

Title block data exchange between MicroStation and Meridian Enterprise occurs by a link
between Meridian properties and MicroStation tagsets. If your drawing title blocks use tagsets for
the title block text, that text can be synchronized with properties in a Meridian vault. Normal
MicroStation text cannot be linked with Meridian. Meridian can support multiple title block
standards simultaneously. Title block data exchange is configured by a System Administrator. The
MicroStation Link can also exchange property data between Meridian and the file properties of
drawings.

MicroStation reference management by Meridian entails automatically detecting, tracking, and
updating MicroStation references regardless of where the files may reside in a vault, including
local workspace. This means that Meridian can maintain the referential integrity of MicroStation
references as you import drawings into a vault, move them, create revisions, and even exchange
drawings with other parties using briefcases. When you open a drawing in MicroStation that has
references , the MicroStation link finds the current location of the reference file in the vault and
updates the location of the reference in the drawing. The link will even detect if the reference file
has been renamed in the vault and resolve it correctly in MicroStation.

Together with the basic integration provided by Application Integration, any file created or used
by MicroStation can be managed in a Meridian vault. Conversely, MicroStation commands that
request a file can access Meridian vaults for document selection.

Note:
l The functionality provided in MicroStation by Application Integration is subject to the

general limitations of Application Integration described in Application Integration.
l To enable Application Integration in the MicroStation file dialog boxes, MicroStation must

be configured to use the Windows versions of these dialog boxes as described in the
MicroStation documentation.

The commands for using the MicroStation link features can be found on the Accruentmenu in
MicroStation. Some commands are also available within the PowerUser application. The following
topics describe each feature.
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Edit Properties In MicroStation
Synchronizing Meridian properties from title block tags is an easy way to update some Meridian
properties, but you may encounter circumstances where you want to edit Meridian properties
that are not linked to a title block or file properties. Rather than open a Meridian application, you
can edit properties without leaving MicroStation.

To edit properties from within MicroStation:

1. On theMeridianmenu in MicroStation, select Properties.

The Meridian property pages appear just as they would from within Meridian.

2. Click Edit.

3. Make your changes.

4. Click OK.

The Meridian properties are updated.
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Autodesk Inventor Link
The Meridian Enterprise link for Autodesk Inventor provides the following features:

l Automatic management of file references.
l Automatic re-linking of replacement parts.
l TheMeridian Derive command inside Autodesk Inventor.
l An add-in to Autodesk Inventor to exchange Meridian Enterprise properties to and from

Autodesk Inventor iProperties from inside Autodesk Inventor.

The most important of these features are property data exchange and file reference management
because they can affect the referential integrity of your assemblies. Some features, such as file
reference management, are automatic and don't require any action on your part. Other features,
such as theMeridian Derive command, are only activated at your discretion.

Property data exchange between Autodesk Inventor and Meridian Enterprise occurs by a link
between Meridian Enterprise properties and Autodesk Inventor iProperties. If your drawing title
blocks use iProperties for the title block text, that text can be synchronized with properties in a
Meridian Enterprise vault (PowerUser client only). Normal Autodesk Inventor text cannot be
linked with Meridian. iProperty data exchange is configured by a System Administrator as
described in Configure Autodesk Inventor Link Options in theMeridian Enterprise Configuration
Guide.

File reference management by Meridian Enterprise entails automatically detecting and tracking
Autodesk Inventor references to related files regardless of where the files may reside in a vault,
including local workspace. This means that Meridian Enterprise can maintain the referential
integrity of files as you import assemblies into a vault, move them, create revisions, and even
exchange files with other parties using briefcases. When you open an assembly in Autodesk
Inventor that has file references, the Autodesk Inventor link finds the current location of the files
in the vault and updates the locations of the files in the assembly. If you edit a part within the
assembly, the link will place the part under change by you, if necessary. The link will even detect if
the files have been renamed in the vault and will resolve them correctly in Autodesk Inventor.

The Autodesk Inventor link automatically creates and maintains Meridian Enterprise references
between related Autodesk Inventor files. These links can be used to view the files that might be
effected by changes to a related file and for other uses.

Together with the basic integration provided by Application Integration; assembly, part,
parameter, finite element analysis, presentation, and drawing files created or used by Autodesk
Inventor can be managed in a Meridian Enterprise vault. Conversely, Autodesk Inventor
commands that request a file can access Meridian Enterprise vaults for document selection. For
example, in an assembly, the Autodesk Inventor Create Component command lets you create
local components in that assembly. With the Autodesk Inventor link installed, Meridian
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intervenes and offers the Application Integration dialog to store the new component. If so
configured, the wizard pages will appear just as if you were creating the document in PowerUser.
The Field-Path definition may automatically determine the vault location of the new component.

Note:
The functionality provided in Autodesk Inventor by Application Integration is subject to the
general limitations of Application Integration described in Application Integration.

Some of the commands for using the Autodesk Inventor link can be found on theMeridianmenu
in Autodesk Inventor and some on the Accruent browser shortcut menu. Some commands are
also available within the PowerUser application. The following topics describe each feature.
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Link Options
The Autodesk Inventor link options control how the link behaves during actions that affect the
document in the vault.

This option dialog box can also be shown by clicking the Options button in the Autodesk Inventor
Open and Save dialogs.

Note:
These options can also be configured by a System Administrator in the Windows registry on
your computer and may be unavailable for you to configure.

To set the link options:

1. In Autodesk Inventor, on theMeridianmenu, select Options.

The Options dialog box appears.

2. Click options or type values using the descriptions in the following table.

3. Click OK.

Scenario Option Description

On document
open

Activate
BC browser

Shows the Accruent browser whenever a component is
opened from a vault so that you can see the related
components, their locations, and workflow status.
In Inventor 2018, you must activate the Accruent browser
manually by clicking the + icon at the top of the Inventor
Browser.

On document
open

Show file open
options dialog

Shows the Autodesk Inventor File Open Options dialog when
opening assemblies.

On document
change

Show a message if
the document is
read-only

If an open component needs to be updated, shows a warning
message if it is not checked out to you. Select one of the
available options to control what action is performed for
read-only components.

On document
change

Use the Under
Change state to
modify the
document

If an open component needs to be updated, it is first routed
automatically to the Under Change state of the document
type workflow that is assigned to the document type. If a
workflow definition has been assigned to the document type,
this option is cleared.

Autodesk Inventor link options
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Scenario Option Description

On document save Save or update
DWF file

When an open component is saved, also creates or updates
its rendition to reflect the current design of the component.
Select For current document only or For all modified
documents to specify which renditions to update. This option
is relevant only if the vault is configured to generate
renditions. Otherwise, this option is ignored. The update will
be added to the Publisher queue and will be processed
according to the publishing job that is assigned to the vault.

On document save Show file save
options dialog

Shows an Options button in the Inventor Save Copy As dialog
when saving assemblies. You may click this button to show
the Inventor File Save Options dialog.

On document save No automatic
upload

Disables automatic upload of your drawing when you save or
close. If this setting is enabled, you must click the Upload
Drawing button in the Link ribbon to upload your drawing to
the vault.
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Accruent Browser
When the Autodesk Inventor link is installed, it adds a Accruent browser to the Autodesk Inventor
browser panel. This gives you access to vault documents while working in Autodesk Inventor. You
can use the Accruent browser to explore the structure of an assembly that is stored in a vault.
The Autodesk Inventor browser menu then contains commands that let you switch between the
Accruent browser and Autodesk Inventor'sModel view.

Important!
While an assembly is open in Autodesk Inventor, it is possible for any user to change the
Meridian properties of any part of the assembly that is unlocked in local workspace. This
includes properties that may determine the location of the part in the vault, in effect, moving
the part. In the Accruent browser in Autodesk Inventor, this will appear as if the part is not
stored in the vault.
For this reason, you should only change properties that are included in the Field-Path definition
of the vault with great care. For information about how the Field-Path definition is configured in
your vault, consult a System Administrator.

When the Accruent browser is active, the vault status of the assembly, subassemblies, and parts
are shown by icons in the leftmost column similar to the following figure that identifies the
various areas of the browser. For descriptions of the status icons, see Navigation View Icons.
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The following table describes each area of the browser.

Number Name Description

1 Tooltip When the mouse cursor is hovered over a status icon, shows the current
Status and To-Do Person of the file. When the mouse cursor is hovered
over a document icon, shows the document name and vault path.

2 Toolbar The browser toolbar button icons are described in the following list.

l Refresh — Refreshes the tree structure in the browser.

l Rebuild — Rebuilds the model in theModel view. This can be
useful when multiple people are working on an assembly at the
same time.

l Highlight in BC Browser— In theModel view, highlights the
selected part or subassembly in the Accruent browser.

l Highlight in Model View— In the Accruent browser, displays
the selected document in theModel view.

Features of the Accruent browser
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Number Name Description

3 Assembly
structure
view

Shows all related files that reside in the vault, their relationships to one
another, and their current workflow status. For descriptions of the status
icons, see Navigation View Icons.
Right-clicking a document in the view shows the document shortcut
menu described in Shortcut Menus.
If files have not been added to the vault yet (that is, they only exist in the
local workspace, or represent a part from Content Center that is placed
on the local drive), they are shown in red, indicating that the files need
to be imported to the vault.
When Application Integration is in Remote mode, the shortcut menu
that is shown in the Accruent browser does not support the Derive
command.

You can use the Accruent browser to drag and drop items into Autodesk Inventor. If you drop a
file on the Autodesk Inventor title bar, the file will be opened. If you drop a file into the drawing
pane, the file will be inserted into the assembly. The Accruent browser shows a shortcut menu
that you can use to run common commands.

Note:
When Meridian Enterprise Application Integration is in Remote mode, the Accruent browser is
not available. Likewise, when it is in Offline mode, the vault browser, Accruent toolbar, and
Meridianmenu are all unavailable.
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Edit Properties In Autodesk Inventor
Synchronizing Meridian properties from title block properties (PowerUser client only) is an easy
way to update some Meridian properties, but you may encounter circumstances where you want
to edit Meridian properties that are not linked to an iProperty. Rather than opening a Meridian
application, you can edit properties without leaving Autodesk Inventor.

To edit Meridian properties from within Autodesk Inventor:

1. On theMeridianmenu in Autodesk Inventor, select Properties.

The Meridian property pages appear just as they would from within PowerUser.

2. Click Edit.

3. Edit the properties.

4. Click OK.

The Meridian properties are updated.

Confidential and Proprietary © 2022 554 www.accruent.com



Rename Components Using Properties
The Autodesk Inventor link provides a command named Rename Components on the shortcut
menu when an assembly is selected. You can use this command with a Meridian property to
rename the components shown in the Autodesk InventorModel pane. This can be useful if want
to see more meaningful names than the Autodesk Inventor file names.

The name may use the following syntax:

<Prefix><PropertyValue><Suffix>

This command is cleared unless the name elements have been configured by a System
Administrator. The feature may also be configured to automatically rename components when
they are either opened or saved. Consult a System Administrator for the name of the property
and other details of how the naming standard is configured. The Meridian property that will be
used in the names must already exist and contain non-empty values.

To rename the components of an assembly:

1. In theModel pane of Autodesk Inventor, right-click the assembly that you want to rename.

The Autodesk Inventor link shortcut menu appears.

2. Select Accruent Rename Components.

All nodes in the selected assembly are renamed according to the configuration of the
command.
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Replace Components
If an assembly contains subassemblies or parts that do not reside in the vault, you can easily
replace them with their vault equivalents. This can be useful to be sure the assembly uses the
latest standard parts. The Autodesk Inventor link provides a command named Get Accruent
Replacement on the shortcut menu in the Autodesk InventorModel pane. The command is
enabled when the selected component does not reside in the vault but a component with the
same name does reside in the vault. You can use this command to swap the components in one
step.

To replace a component with one from the vault:

1. In theModel pane of Autodesk Inventor, right-click the component that you want to
replace.

The Autodesk Inventor link shortcut menu appears.

2. Select Get Accruent Replacement.

The selected component is replaced with the vault equivalent, using the same insertion
point.
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Meridian Derive Command
TheMeridian Derive command is a feature of the Autodesk Inventor application link. The
command is added to the shortcut menu of all parts and assemblies inside Autodesk
Inventor. Meridian Derive allows you to create a new derived component on the fly and replace
the existing occurrences of the source component with the newly derived component in the
active model assembly.

For example, suppose that you want to make a new assembly that is exactly the same as an
existing one but is longer. You can use the Derive command in Meridian Enterprise to copy the
existing assembly to a new assembly that initially uses all subassemblies and parts of the original
assembly. Then, you can open the new assembly in Autodesk Inventor and useMeridian Derive
to create copies of the parts or subassemblies that will change. This also replaces any references
to the original parts or assemblies with the new parts or assemblies.

Autodesk Inventor lets you derive a part or assembly from another base component using its
Derived Component command. This clones a design so that changes to the base part are
represented in the derived part. You can break the link between the base part and the derived
part. TheMeridian Derive command in Autodesk Inventor is very different from the Autodesk
Inventor Derived Component command in that changes to the original part are not reflected in
the derived part.
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Manage Autodesk Inventor Iparts
Autodesk Inventor allows you to create a single part drawing called an iPart that can be used to
generate a family of similar components. The general design of the part is the same but the sizes
change from one family member to another.

We recommend that you store iParts in folders in a Meridian vault separate from other Autodesk
Inventor documents (projects, standard parts, and so on) that use the iParts. To place an iPart
into an assembly drawing that is managed by Meridian, select it from the vault using Application
Integration. For an example of this folder structure, see the Mechanical vault that can be created
from the Mechanical.met configuration file that is included with Meridian.
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Display Iparts Variations In Reference Explorer
The Meridian Show Assembly Structure and Show Where Used commands display different
views in the Meridian Reference Explorer. By default, the Meridian Reference Explorer shows the
names of iParts and the sizes of the variations used in the assembly. In many cases, it is more
convenient to show other information, such as the part number of the variation, instead of the
size.

To display other iPart data in the Reference Explorer:

1. Create the iPart drawing in Autodesk Inventor as usual.

2. In the Other tab in iPart Author, add a new parameter that you want to display in the
Meridian Reference Explorer, for example, Part No.

3. In the Parameters tab, type values in the table for the new parameter for all variations.

4. Right-click the new parameter column and select File Name Column.

5. Save the iPart.

When you place the iPart into an Autodesk Inventor assembly, choose which variant to use from
the table. The new parameter will be shown in the Autodesk Inventor browser instead of the file
name and various size values. The new parameter will also be shown in Meridian in the Reference
Explorer as well as in other reference dialogs.
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Resolve Checked Out Files
Under certain circumstances, documents may incorrectly appear checked out in Autodesk
Inventor regardless of their correct Meridian workflow status. When documents are in this state,
the File Status properties on the Autodesk Inventor Status page will appear similar to the
following figure:

If these properties are set, then you will not be able to save the documents in a single user
project even if they are checked out to you.

Note:
The files can be saved in a shared project, but shared projects are being phased out by
Autodesk, so we do not recommend using them.

This problem will also become apparent if you attempt to save the files. An error message may
display or the Save dialog may display the status of documents as Checked out to another user.

To resolve this problem:

1. Open the file in Autodesk Inventor.

2. On the Filemenu, select Save As.

3. Select a location on your computer.

4. If a dialog box appears warning that the selected location is not in the active project, click
Yes to continue.

5. Close the file in Autodesk Inventor.

6. Drag and drop the newly saved file from your computer onto the original file in the Meridian
vault.

A shortcut menu will appear.

7. Select Replace Document Content.

The File Status properties will now be cleared and you can save the file as expected.
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Autodesk Inventor Project Files
By default, Autodesk Inventor uses project files to organize the files that are referenced within a
specified set of models. However, the document management features in the Meridian product
suite minimize the need for using project files to several specific scenarios:

l When Pack and Go is used to export assemblies created by other users, and local workspace
is enabled on the vault

l When Content Center components are stored in the vault

If neither situation applies, all Autodesk Inventor users should then select the Default project
installed with Autodesk Inventor. If a project file must be used to support these scenarios, then all
Autodesk Inventor users should utilize a single common project file that is placed in the root
folder of the Meridian vault.

Important!
If you do not use a common project file, you may experience problems if you use Pack and Go
when local workspace is enabled. This is because Pack and Go will try to resolve references to
the last active reference, which may be in the local workspace folder of a different computer.

The common project file options must be configured as in the following table:

Option Description

Type Single user

Workspace . (period)

Old Versions To Keep On Save 0

Autodesk Inventor project file options
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Configure the Autodesk Inventor Project File To Use
Content Center
When the Autodesk Inventor project file, the Meridian vault, and your local workspace have been
configured correctly, all Content Center placements and references will automatically use the
specified folder in either the central Meridian vault or your local workspace.

To configure Content Center for use with Meridian:

1. Create a folder in the Meridian vault specifically for storing the Autodesk Inventor Content
Center components, for example, Inventor Library Components.

2. In Windows Explorer, navigate to your local workspace folder (C:\BC-Workspace is the
default location).

3. Open the subfolder with your user name (for example, C:\BC-Workspace\Joe
Engineer).

4. Open the sub-folder with the name of the server and vault name (for example, C:\BC-
Workspace\Joe Engineer\MeridianServer,D-EngVault).

5. In this folder, create a subfolder with the same name as the folder created in the vault for
Content Center storage (for example, C:\BC-Workspace\Joe
Engineer\MeridianServer,D-EngVault\Inventor Library
Components).

6. Open the common project file for editing.

7. Expand the Folder Options section.

8. Edit the Content Center Files option and select the folder that you created in your local
workspace in step 5.

9. Save the changes to the project file.

The path will appear truncated because the local workspace location where you created the
folder refers to the vault (for example, .\Standards\Inventor Library
Components).

10. Synchronize your local workspace.

Note:
After making the common project file the default, all other Autodesk Inventor users of this
configuration must synchronize their local workspace once to create the local folder.
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Import Autodesk Inventor Files
Autodesk Inventor assemblies often have complex relationships with other Autodesk Inventor
subassemblies and parts. Importing these relationships correctly requires special attention.
Following are recommended guidelines for importing Autodesk Inventor files.

l Before you import Autodesk Inventor assemblies, resolve all subassemblies and part
references first. There should not be any explicit references to local drive folders.

l There are two methods for importing Autodesk Inventor assemblies into Meridian: drag and
drop, and the Assembly Import Wizard described in Import Assemblies.

l When migrating Autodesk Inventor files between versions (for example, Autodesk Inventor
2008 to Autodesk Inventor 2009), the same fundamental principle applies: you must ensure
the integrity of the assembly references first.

Manually open the assemblies in the new version of Autodesk Inventor and save them. This
is fine for small quantities of assemblies and parts, but be aware that Autodesk Inventor can
display warnings about property data not being stored due to related assemblies or parts
not being migrated first. If you doubt that the data was saved, use the Synchronize
Properties to File command to ensure that data stored in Meridian is synchronized to the
Autodesk Inventor drawing.
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Autodesk Inventor Dialogs
Some actions in Autodesk Inventor show Meridian application link dialogs instead of the default
Autodesk Inventor dialogs because the action involves documents in Meridian. Some of the
dialogs are explained here.

Update Replaced Documents Dialog Box
If the Update Replaced Documents dialog box appears when you open an assembly or
subassembly, it means that your assembly contains references to part drawings that have been
replaced by newer versions.

l To keep the reference to the old version (now retired in the vault), click Cancel.

A message will appear to remind you that you cannot edit retired parts.
l To update the reference to the newer version, click Update.
l To update only some references, clear the check boxes for the references you do not want

to update, and then click Update.

This dialog also appears if you open a drawing view containing views of an assembly with
replaced references that have not been updated.

Meridian Save Dialog Box
AMeridian Save dialog box appears when you save changes to an assembly file because
Autodesk Inventor wants to write changes to the files that the assembly references. The dialog
lists the files and their current vault status. The documents must be checked out to you to be able
to save changes. Meridian filters out the documents that are either not under change by you or
under change by another person, so that no errors will occur when Autodesk Inventor attempts
to write to a document that you do not have the access to edit.

Note:
Depending on the revision methodology you use (document workflow or derived documents),
changing a part may update all of the assemblies that reference it.

l Autodesk Inventor informs you that a referenced document is read-only.
l Another user attempts to edit a referenced document.

Meridian can also be configured to start a Quick Change when you need to check out
components, to redraw title blocks when properties are synchronized, and to apply specific
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document types to new library components. Learn more about these options in the Configure
Autodesk Inventor Link Options article in theMeridian Enterprise Configuration Guide.
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SolidWorks Link
The Meridian Enterprise application link for SolidWorks provides similar functionality to the other
CAD application links:

l Property data exchange
l Assembly/subassembly/part structure management

These features are important because they can affect the data integrity of your drawings.
Assembly structure management is automatic and doesn't require any action on your part.
Property data exchange is also automatic or it can be activated at your discretion.

Besides these features, the SolidWorks link is unique in that it shows a Meridian vault browser
inside SolidWorks that you can use to find and work with SolidWorks files that reside in a vault.
For information about using this browser, see Meridian Enterprise Browser.

Property data exchange between SolidWorks and Meridian occurs by a link between Meridian
properties and SolidWorks properties (evaluated values). If your SolidWorks files contain
properties that are used in title blocks, for example, that text can be synchronized with properties
in a Meridian vault (PowerUser client only). Normal SolidWorks text cannot be linked with
Meridian. Meridian can support multiple property sets simultaneously. Property data exchange is
configured by a System Administrator and described in Configure SolidWorks Property
Synchronization in theMeridian Enterprise Configuration Guide.

Assembly/subassembly/part management by Meridian Enterprise entails automatically detecting
and tracking SolidWorks files regardless of where the files may reside in a vault, including local
workspace. This means that Meridian can maintain the referential integrity of SolidWorks files as
you import them into a vault, move them, create revisions, and even exchange them with other
parties using briefcases. When you open a file in SolidWorks that has references to other files, the
SolidWorks link finds the current location of the reference files in the vault and updates the
locations of the reference files in the current file. The link will even detect if the reference files
have been renamed in the vault and will resolve them correctly in SolidWorks.

The SolidWorks link automatically creates and maintains Meridian references between
assemblies, subassemblies, and parts. These links can be used to view files that might be effected
by changes to a different file and for other uses.

Together with the basic integration provided by Application Integration, any file created or used
by SolidWorks can be managed in a Meridian vault. Conversely, SolidWorks commands that
request a file can access Meridian vaults for document selection.

The commands for using the SolidWorks link features can be found on theMeridianmenu and in
the Accruent toolbar in SolidWorks. Some commands are also available within the PowerUser
application.
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l The easiest way to correctly import SolidWorks assemblies while maintaining their
references is described in Import Assemblies.

l For viewing SolidWorks files in PowerUser, we recommend that you install the SolidWorks
eDrawings viewer on your computer and set it as the default viewer for SolidWorks files as
described in Change Viewers.

l For the best performance when loading SolidWorks assemblies, enable the SolidWorks
Performance option Automatically load components lightweight.

By default, the option is disabled.
l If you work on SolidWorks models with PowerWeb in Remote mode, consider setting the

ReadOnlyReferences registry value to improve the performance of saving assemblies with
read-only sub-assemblies or parts. The value is described in HKEY_CURRENT_
USER\Software\Cyco\AutoManager Meridian\CurrentVersion\AmSldWorksEx\Settings in
theMeridian Enterprise Administrator's Guide .

Note:
l SolidWorks note annotations that are linked to SolidWorks properties will also show the

value of Meridian properties if the properties are mapped to one another. However, this
synchronization is only in one direction from the SolidWorks property to the annotation.
Manual changes to the annotation will not be synchronized to the Meridian property.

l Property and reference synchronization does not work in SolidWorks lightweight mode
because external references are not resolved by SolidWorks.

l The functionality provided in SolidWorks by Application Integration is subject to the
general limitations of Application Integration described in Application Integration.

l Do not copy references in PowerUser while any of the files to which the references refer
are open in SolidWorks. The references might not be updated correctly due to the files
being held open by SolidWorks. For more information about copying references and the
configurable options, see Duplicate References.

l Meridian uses SolidWorks itself to update properties. Because Meridian will start and
close SolidWorks for each document, this will add a significant delay to actions that
involve multiple documents, for example releasing an entire assembly. To improve
performance significantly, simply launch SolidWorks and keep it running in the
background before starting the action.

The following topics describe each feature.
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Meridian Enterprise Browser
When the Meridian Enterprise application link for SolidWorks is installed on your computer, the
Meridian browser appears in SolidWorks similar to the following figure that identifies the various
areas of the browser.

The following table describes each area of the browser.

Number Name Description

1 Quick Find
bar

Use to search the currently open vault for documents. The results of
the search will appear in the Navigation view (2). This toolbar works
similar to the Quick Find toolbar as described in Quick Find.

Features of the Meridian Enterprise browser
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Number Name Description

2 Navigation
view

One of the defined views of the vault contents. These are the same
views that are shown as described in Navigation Views.
To select another view, click the Navigation view button (6).
Right-clicking a document in the view shows the document shortcut
menu described in Shortcut Menus. For descriptions of the status icons,
see Navigation View Icons.

3 Meridian
browser tab

When a different browser is visible, click this tab to show the Meridian
browser.

4 Refresh
button

Refreshes the current view to show recent changes.

5 Vault button Click to open a different vault.

6 Navigation
view button

Click to open a different Navigation view (2).

You can use the Meridian browser to drag and drop items into SolidWorks. If you drop a file on
the SolidWorks title bar, the file will be opened. If you drop a file into the drawing pane, the file
will be inserted into the assembly.

Note:
When Meridian Application Integration is in Remotemode, the Meridian vault browser is not
available. Likewise, when it is in Offlinemode, the vault browser, Accruent toolbar, and
Meridianmenu are all unavailable.
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Edit Properties In SolidWorks
Synchronizing Meridian properties from SolidWorks properties is an easy way to update some
Meridian properties, but you may encounter circumstances where you want to edit Meridian
properties that are not linked to file properties. Rather than open a Meridian application, you can
edit properties without leaving SolidWorks.

To edit properties from within SolidWorks:

1. On theMeridianmenu in SolidWorks, select Properties.

The Meridian property pages appear just as they would from within Meridian.

2. Click Edit.

3. Make your changes.

4. Click OK.

The Meridian properties are updated.
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Revit Link
The Meridian Enterprise application link for Autodesk Revit supports all of the Revit editions:
Architecture, MEP, and Structure. The link provides:

l Meridian Enterprise property editing
l Title block data exchange (PowerUser clinet only)
l File property data exchange, including custom properties
l Automatic presentation file generation and import
l Automatic vault import of files exported by Revit
l Worksharing
l External reference management

Note:
Resolving modified references requires read/write access. The model cannot be under change
by any user. Reference resolution is not supported for models that are transmitted and
workshared.

Property data exchange between Revit and Meridian Enterprise occurs by a link between
Meridian Enterprise properties and Revit properties. If your drawing title blocks use properties for
the title block text, that text can be synchronized with properties in a Meridian Enterprise vault.
Normal Revit text cannot be linked with Meridian.

Meridian Enterprise supports a limited set of Revit properties:

l ProjectIssueDate
l ProjectStatus
l ClientName
l ProjectAddress
l ProjectName
l ProjectNumber

Property data exchange and worksharing is configured by a System Administrator as described in
Configure Revit property synchronization and Configure Revit Worksharing in theMeridian
Enterprise Configuration Guide .

Together with the basic integration provided by Application Integration, any file created or used
by Revit can be managed in a Meridian Enterprise vault. Conversely, Revit commands that request
a file can access Meridian Enterprise vaults for document selection.
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Note:
l The functionality provided in Revit by Application Integration is subject to the general

limitations of Application Integration described in Application Integration.
l Meridian uses Revit itself to update properties. Because Meridian will start and close Revit

for each document, this will add a significant delay to actions that involve multiple
documents, for example releasing an entire assembly. To improve performance
significantly, simply launch Revit and keep it running in the background before starting the
action.

If you are part of a team working on Revit projects, contact a System Administrator about
configuring the project folders in the vault as shared workspaces as described in Configure Shared
Workspaces in theMeridian Enterprise Configuration Guide.

The commands for using the Revit link features can be found in the Accruent group of the Add-Ins
menu in Revit. Some commands are also available within the PowerUser application. The
following topics describe each feature.
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Edit Properties In Revit
Synchronizing Meridian properties from Revit properties is an easy way to update some Meridian
properties, but you may encounter circumstances where you want to edit Meridian properties
that are not linked to Revit properties. Rather than open a Meridian application, you can edit the
properties without leaving Revit.

Note:
If the properties that you want to edit are for a Revit drawing that contains multiple sheets,
each with a title block, a special property page titled Title Blocks may be available if it is
enabled by a System Administrator. This page lets you enter different values for the title block
in each sheet.

To edit properties from within Revit:

1. In the Accruent group of the Add-Ins menu in Revit, select Properties.

The Meridian property pages appear just as they would from within Meridian.

2. Click Edit.

3. Make your changes.

4. Click OK.

The Meridian properties are updated.
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Export To the Vault
The Revit link integrates with the Revit Export command to easily import the exported files to the
vault. The link automatically stores the files as new documents. If the current model is a project
copy, the imported documents are linked to the master building model. This makes the building
model easier to view since most of the exported file types are supported by the viewer, but Revit
building model files are not supported.

To export a model to the vault:

1. In Revit, open the building model that you want to export.

2. Run the Revit Export command as normal and select the destination vault folder.

The exported files are imported automatically.
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Create a Presentation Document
The Revit link provides a command for conveniently creating a presentation document (.dwf file)
for the current building model. The link automatically stores the document as a hybrid part of the
current model. This makes the presentation easy to find and associates it with the same property
values as the building model from which it was made. It also makes the building model easier to
view since .dwf files are supported by the viewer, but Revit building model files are not
supported.

Note:
For the presentation to be attached correctly, the document type that is assigned to building
model files must be configured properly by a System Administrator as described in Configure
the Revit Document Type in theMeridian Enterprise Configuration Guide.

To create a presentation document:

1. In Revit, open the building model for which you want to create the presentation file.

2. In the Accruent group of the Add-Ins menu in Revit, select Create Presentation.

A presentation file is generated for you automatically from the current view and attached to
the open building model document in the vault.
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Worksharing
The Revit link supports worksharing by detecting when a local copy of a model is synchronized
with the central file in a vault. During synchronization, the link can behave differently depending
on how it is configured by a System Administrator.

The link can:

l Check the central file out to you in either the Quick Change or the Under Change workflow
state. You might be prompted to accept or decline the routing.

l Check the central file out to a virtual user (for example, Design Team) in either the Quick
Change or the Under Change workflow state.

l Release the central file automatically after synchronization has finished.

In vaults created by Meridian Enterprise 2017 and prior, one user must click the Release
Shared Central button in Revit. Vaults created by Meridian Enterprise 2018 and higher do
not have this requirement and the command is not available.

l Update Meridian properties of the central file with synchronization information such as the
names of editable worksets, synchronization date and time, reload date and time.

l Maintain a Meridian Enterprise reference between the local copy and the central file.

After synchronization, you can easily clean up your local workspace of Revit backup files by
clicking Remove backup files.

For details about how the Revit link is configured in your system, consult a System Administrator.
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Sheet Sets
The Revit link can be configured by a System Administrator to automatically import sheet sets
when they are exported from Revit. It can also be configured to create a Meridian reference
between each sheet set file and the model from which it was exported. If those references are
created and there are also external references between the sheet set files themselves, Meridian
references will also be created for them. These references can be useful for finding all of the
documents in a sheet set and navigating among them as described in View References.

For details about how the Revit link is configured in your system, consult a System Administrator.

Limitations
This feature has the following limitations:

l If exporting the sheet set results in multiple files, the last file in the set is not imported
automatically and must be imported manually. This is due to a defect in the Revit API and
might be resolved in a future release.

l If exporting the sheet set will result in multiple files, Meridian will create a temporary empty
document with the name that is specified in the Revit Save dialog box as the prefix of the
exported files. If the document type that is assigned to this file is configured to show wizard
pages, they will appear but can be ignored. The temporary document will be automatically
revoked after the export has completed.

l Before re-exporting the same sheet set, you must place all existing documents in the sheet
set under change in a workflow. This is so that the files can be updated and new revisions
created and not imported as duplicate documents.
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View Family File Changes
Complex Revit model can use many family files and multiple instances of those family files.
Meridian provides a Family Inspector command to help you track the instances, their current
status, and location.

Note:
The FamilyInspector value of the following registry value on the PC must be set to 1 to make
the command available:
HKEY_LOCAL_MACHINE\SOFTWARE\Cyco\AutoManager
Meridian\CurrentVersion\RevitLink

To view the family file changes:

1. In Revit, open the building model for which you want to see its family files.

2. In the Accruent group of the Add-Ins menu in Revit, select Family Inspector.

The Document Families dialog box appears and lists information about the families used in
the current model. Families that have changed since you last viewed the list appear in red
text.

Note:
Changed families are only highlighted in red text once. If you close and reopen the Family
Inspector, the previously red families will then appear black even if they have not actually
been changed.
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Office Link
The Meridian application link for Microsoft Office supports automatic property value exchange
between the Meridian vault and Office document properties (PowerUser client only). When the
link is installed, a Accruent toolbar is added to Word, Excel, Outlook, and PowerPoint versions
2003 and later for manually synchronizing and editing Meridian properties. In the Office 2013 and
later applications, the commands appear on the menus and ribbons.

The link also provides automatic hyperlink and reference file management regardless of where
the files may reside in a vault, including local workspace. This means that Meridian can maintain
the referential integrity of file links as you import files into a vault, move them, create revisions,
and even exchange files with other parties using packages. When you open a document in an
Office application that has a link to another file, the Office link finds the current locations of the
file in the vault and updates the location of the files in the parent document. The link will even
detect if the linked files have been renamed in the vault and will resolve them correctly in Office.

The Office link automatically creates and maintains Meridian references between documents and
their linked files. These links can be used to view documents that might be effected by changes to
a parent document and for other uses.

Together with the basic integration provided by Application Integration, any file created or used
by Office can be managed in a Meridian vault. Conversely, Office commands that request a file
can access Meridian vaults for document selection.

Meridian also works with Office documents even without Application Integration installed:

l Open Office documents as described in Open a Document From Within Meridian.
l Create new Office documents as described in Create a New Document From A Template.
l Import existing Office documents as described in Import Files Using Drag And Drop and

Import Documents.

Features for storing Outlook email messages and attachments in a vault are also provided by the
link.

Notes About Functionality
l Opening documents in the Office applications and synchronizing with Meridian Cloud

requires the Meridian Cloud Connector.
l The functionality provided in Office by Application Integration is subject to the general

limitations of Application Integration described in Application Integration.
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l The link to MS Visio must be enabled by setting registry values that are described in HKEY_
LOCAL_MACHINE\Software\Microsoft\Visio\AddIns\AMOfficeAddIn.AMOfficeAddIn in the
Meridian Enterprise Administrator's Guide .

l The Accruent toolbar can be found on the Add-Ins tab of the ribbon in Office versions 2007
and later (except Visio).

l The vault Browse command on the Open and Save As pages in the Office 2013 and later
applications requires that a default vault be set for the Set Default Context option as
described in Application Integration Options.

l In PowerWeb with Application Integration set to Remote mode:
o If a vault document is modified and saved in an Office application, the file will not be

uploaded to the Meridian server as might be expected. The document will not be
uploaded until the document is closed. This is due to a technical limitation in Office.
Until the limitation is resolved, users should always save the document in Word before
closing the document

o When a document is imported and the Select Document Type dialog box or wizard
page is invoked, if the PowerWeb Personal Preference option Create thumbnails on
import of document option is selected, the new file is created when you save to the
workspace, but it is empty.
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Edit Properties In Office
Synchronizing Meridian properties from Office properties is an easy way to update some
Meridian properties, but you may encounter circumstances where you want to edit Meridian
properties that are not linked to Office properties. Rather than open a Meridian application, you
can edit properties without leaving the Office applications.

To edit properties from within Office applications:

1. On the Accruent toolbar in the Office application, select Properties.

The Meridian property pages appear just as they would from within Meridian.

2. Click Edit.

3. Make your changes.

4. Click OK.

The Meridian properties are updated.
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Link Files
The Microsoft Office applications make it relatively easy to share data between them and other
files without importing the data. You can do this using Object Linking and Embedding (OLE) links.
For example, you can link a picture to a cell in an Excel spreadsheet or link a spreadsheet into a
Word document. The linked data will appear in the linking document but not be stored there.
Whenever the picture or spreadsheet is updated, the linking documents will be updated
automatically.

You can determine if an Office document has links to other documents by the presence of the
Edit Links to Files command in the Prepare group of the Office menu.

Note:
Although OLE objects inserted into non-Office documents (for example, Excel spreadsheets
inserted into AutoCAD drawings) are shown for some file formats by the viewer, references
between the documents are not automatically created by the application links. You can create
references manually as described in Create References.

Best Practices
The keys to creating links with corresponding Meridian references are:

l Use the Office application's Link to File option.
l Do not use Meridian Application Integration to select the linked file. Because of its universal

application, it will create an insertion (embedded object) instead. Therefore, the linked file
must reside outside the vault, at least temporarily, so that you can select it with the Office
application's file dialog, which cannot browse vault contents.

l After inserting the link, save the linking file so that the link can be read by the Office link.
l Use the Synchronize References from File command in PowerUser to read the link from the

linking document and create the reference.

The following procedures use the example of linking a picture into a Word document. For
instructions for other combinations, refer to the Office Help. The procedure will be similar but the
commands to use in the Office applications are different.
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Link Office Files Outside of Vault
To link Office files that reside outside the vault and to import them into the vault:

1. Open the file in Word which you want to create the link.

2. On the Insert tab of the ribbon, click Picture.

The Insert Picture dialog box appears.

3. Select the picture that you want to insert, click the down arrow in the Insert button, and
select Link to File.

The picture appears in the open file.

4. Save and close the file.

5. Import both files into the vault as described in Import Files Using Drag And Drop.

The documents appear in the vault. However, the Meridian reference has not yet been
created.

6. Select the linking (Word) document and then on the Document menu, select Synchronize
References from File.

Reference icons appear on the Document property page of both documents. An
Microsoft Word Reference type link has been made from the Word document to the
picture file that you linked and imported. The name of the reference is the file name of the
linked picture. The direction of the reference is from the Word document to the picture
document. You can view the reference as described in View References.

Link Office File in Vault to File Outside of Vault
To link an Office file that is already in the vault to a file that is not in the vault:

1. Open the vault document in Word in which you want to create the link.

2. Browse to your local workspace folder where the open document is cached and place a copy
of the picture file there to which you want link.

3. On the Insert tab of the ribbon, click Picture.

The Insert Picture dialog box appears.

4. Select the picture file outside the vault, click the down arrow in the Insert button, and select
Link to File.

The picture appears in the open file.
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5. Save and close the file.

The picture appears in the vault document in the viewing pane. However, it still resides
outside the vault and other users will not be able to see the picture when they view the
vault document.

Note:
The Application Integration icon in the system tray of your desktop may begin to alternate
with a warning icon. This is because the file that you copied there has been detected by
Application Integration and a corresponding vault document cannot be found. Therefore,
your local workspace is not synchronized with the vault.

6. Import the linked file into the vault as described in Import Files Using Drag And Drop.

Although there is now a copy of the linked file in the vault, the linking document is still
linked to the copy outside the vault.

7. Open the local workspace log and import the picture file as described in Resolve Local
Workspace Conflicts.

The picture file appears in the vault and the local workspace should now be re-synchronized
with the vault. However, because you saved the Word document while the picture file
resided in the local workspace, no reference has yet been created.

8. Select the linking (Word) document and then on the Document menu, select Synchronize
References from File.

Reference icons appear on the Document property page of both documents. An
Microsoft Word Reference type link has been made from the Word document to the
picture file that you linked and imported. The name of the reference is the file name of the
linked picture. The direction of the reference is from the Word document to the picture
document. You can view the reference as described in View References.

Link Office Files in a Vault
To link Office files that both reside in the vault:

1. In PowerUser, view both files that you want to link so that they are cached in your local
workspace.

2. In your local workspace, locate the file to which you want to link.

To find where the picture file is located in the local workspace on your computer:

a. Right-click the Application Integration icon in the system tray, point to Local
Workspace, and select Open Local Workspace Folder.

A new Windows Explorer window opens with your local workspace folder selected.
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b. Open the folder that is named for the Meridian Enterprise server and vault where the
linking document resides.

c. Navigate the subfolders to find the cached picture file.

It will be in the same path in your local workspace as the path where it resides in the
vault.

3. Open the vault document in Word in which you want to create the link.

4. On the Insert tab of the ribbon, click Picture.

The Insert Picture dialog box appears.

5. Navigate in your local workspace and select the cached picture file, click the down arrow in
the Insert button, and select Link to File.

The picture appears in the open file.

6. Save and close the file.

The picture appears in the vault document in the viewing pane. Reference icons appear on
the Document property page of both documents. AnMicrosoft Word Reference type link
has been made from the Word document to the picture file that you linked. The name of
the reference is the file name of the linked picture. The direction of the reference is from
the Word document to the picture document. You can view the reference as described in
View References.
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Outlook Email Integration
Meridian Enterprise integrates with Microsoft Office Outlook 2003 or higher to help you store
important email messages and attachments in a vault. The Outlook link adds a Accruent toolbar
with commands for storing messages and their attachments and for configuring the link options.

A unique feature of the Outlook email integration is virtual folders. These are locations that you
select within vaults that are then shown as folders in a special branch of theMail Folders tree in
Outlook. You can use virtual folders two ways:

l Drag and drop messages onto a virtual folder to store the messages in the corresponding
vault location

l Select a virtual folder to open it in the PowerWeb interface in the folder contents pane of
Outlook. You may then use PowerWeb the same as if you had opened it in a web browser.

Note:
l The Outlook application link only supports storing messages and attachments. It does not

support storing Outlook contacts, appointments, tasks, distribution lists, and so on.
l Microsoft disabled virtual folders in Outlook 2010. It can be re-enabled as described in

Home Page tab not available in Folder Properties. Microsoft discontinued all support for
virtual folders in Outlook 2016.

You use the buttons on the Accruent toolbar to work with messages and attachments.

To show the Accruent toolbar:

1. Choose between two options:
l In Outlook 2010 and later, click the Add-Ins tab of the ribbon.
l In Outlook versions prior to 2010, from the Tools menu, select Customize.

The Customize dialog box appears.

2. On the Toolbars page, select Accruent.

The Accruent toolbar appears.

3. Click Close.
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Store Outlook Messages And Attachments
Meridian guides you through the process of selecting the destination and document types for
messages and their attachments that you store in the vault.

To store Outlook messages and attachments:

1. Choose between two options:
l If you have not yet configured vault contexts as described in Configure Outlook Email

Integration Options:

a. In Outlook, select the email messages that you want to store in a vault.

b. On the Accruent toolbar, click Store Message.

The Open Vault dialog box appears.

c. Select the vault where you want to store the messages and click OK.

The Select Folder dialog box appears.

d. Select the folder where you want to store the messages and click OK.

The Document types dialog box appears.
l If you have already configured your favorite vault contexts and enabled the Support

Meridian Virtual Folders option as described in Configure Outlook Email Integration
Options:

a. Select the email messages that you want to store in a vault.

b. Drag and drop the messages onto one of the contexts listed under Accruent in
the OutlookMail Folders tree that appears similar to the following figure.
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The Document types dialog box appears. The Document types dialog lists the
messages that you selected, the default document type that will be assigned to
the messages, and the destination folder that you selected. The selected
messages appear in a list with any attachments listed beneath each message as
parts of the message.

The name for each message is generated as described in Configure Outlook Email
Integration Options. Attachments will be saved with their original file names. The
dialog box will be empty if you have not selected any messages.

To view the email and file properties for a message or attachment, right-click the
file. The Properties dialog box appears.

c. Clear the check boxes in the X column for any messages or attachments that you
do not want to save in the vault.

You should clear all unnecessary attachments such as footer images, signatures,
and so on so that they are not saved in the vault. A System Administrator might
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have configured the Office link to automatically filter out these attachments
already.

2. Verify that the document types shown in the Document types column are correct.

To select a different document type, click the current value and select a different type from
the list that appears.

3. Verify that the locations shown in Destination Folder are correct.

To select a different destination:

a. Hover your cursor over the location that you want to change and click the Ellipses
button .

The Select Folder dialog box appears.

b. Select a destination folder and click OK.

The selected folder appears in Destination Folder.

Note:
Scopes have no effect in Outlook email integration.

4. When all information in the window is correct, click OK.

The message and its attachments are saved in the vault. If the message included
attachments, the attachments are saved in the same folder as the message and linked with
an Email Attachment type reference similar to other referenced documents.

Note:
If a System Administrator has configured the vault with a Field-Path definition that uses
any properties that are also used by the Outlook email integration, your message will be
stored in a folder controlled by the Field-Path definition instead of the folder that you
selected when you stored the message. Contact a System Administrator for assistance.
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Add Reference IDs To Messages
When many email messages that have the same or similar properties are stored in a vault, it can
become difficult to identify particular messages. Meridian can help by appending a unique
identifier onto the end of the subject text during message creation. This identifier can make it
easier to refer to specific messages when communicating with other users or when creating
references to related documents.

To add a reference ID to a message subject:

1. Choose between two options:
l To add the reference ID after typing your subject:

a. When creating a new message in Outlook, type text in Subject and save the
message.

You must save the message or else your text will be replaced by the text entered
by Meridian.

b. On the Accruent toolbar, click Create RefID.

The text - RefID: NNNN-NNNN is appended to the end of your subject text where
NNNN-NNNN is a unique eight character hexadecimal number based on the
current date and time.

l To add the reference ID before typing your subject:

a. When creating a new message in Outlook, before you type text in Subject, on the
Accruent toolbar, click Create RefID.

The text - RefID: NNNN-NNNN is set as the subject text where NNNN-NNNN is a
unique eight character hexadecimal number based on the current date and time.

b. Type your own subject text in Subject preceding the text entered by Meridian.

2. Complete and send the message as usual.
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Configure Outlook Email Integration Options
You can configure Outlook email integration to work the way you want. For assistance configuring
these options, consult a System Administrator.

To personalize your Outlook application link configuration:

1. Open Microsoft Outlook.

2. On the Accruent toolbar, click Options.

The User Options dialog box appears.

3. Click options or type values using the descriptions in the following table.

4. Click OK.

Option Description

Accruent
vaults

Lists the vault contexts that you have selected for display in the OutlookMail Folders
tree. Each context that you select appears as a folder in the tree onto which you can
drop messages to quickly store in that location in the vault.
To add a context:
1. Click Add.

The Open Vault dialog box appears.
2. Select the vault that you want add and click OK.

The Select Folder dialog box appears.
3. Select the folder where you want to store messages and click OK.

The location is added to the Context list.
4. If the name of the context in the tree is too long or if you would like to give it a

different name, type a name in the Alias column for the context.

To remove a context:
l Select the context that you want to remove and click Remove.

The context is removed.

Support
Accruent
Virtual
Folders

Displays the contexts listed in Accruent vaults as folders within the OutlookMail Folders
tree for drag-and-drop importing of email and attachments. For instructions, see Store
Outlook Messages And Attachments.

Outlook integration options
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Option Description

Message
name
builder

Use the lists to construct a naming standard for messages that you save in the vault.
Each list contains message properties from which you can select. Type separator
characters to format the naming standard for best readability. Only valid Windows file
name characters are allowed. The Example field displays a sample name based on your
current settings.
All users of a vault should configure the same naming standard so that they can identify
all messages.
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Lotus Notes Link
Meridian Enterprise integrates with Lotus Notes in the form of an Email Export button for
exporting messages and their attachments to a Meridian vault. The process allows you to choose
a destination Meridian server, vault, and folder as well as document types for each file exported
to the vault.

Before you can export messages to a vault, a Lotus Notes administrator must first configure the
vault to receive messages. The administrator will send you an email message containing a button
you must click to create the Email Export button in Lotus Notes.

Note:
You must have eitherManager access or Designer and Create LotusScript/Java agents access
to your mail database to install the integration.
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Export Lotus Notes Messages And Attachments
You must install the integration using the button in the email message sent to you by a System
Administrator before you can export messages and attachments from Lotus Notes.

To export messages and attachments from Lotus Notes:

1. Open Lotus Notes and open your email database.

2. Select the messages that you want to export.

3. Click the Email Export button on the Universal toolbar.

The Lotus Notes Export dialog box appears.

4. Click the Browse buttons to select locations or type locations using the descriptions in the
following table.

5. Click Proceed.

Another Lotus Notes Export dialog will appear, listing the messages and attachments that
will be exported to the selected vault.

6. Confirm that the correct messages and attachments are listed and select a document type
for each one in the Document Type column.

Note:
l You should clear all unnecessary attachments such as footer images, signatures, and

so on so that they are not saved in the vault.
l The document types listed for your selection are configured by a System

Administrator.

To view the email and file properties for a message or attachment, right-click the file. The
Properties dialog box appears.

7. Click Export.

The messages and their attachments are exported to the vault. The Export summary
statistics dialog opens to show the results.

8. Click Close.

Option Description

Server name The name of the Meridian Enterprise server that hosts the vault to which you
want to export the messages.

Lotus Notes export options
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Option Description

Vault name The name of the vault where you want to export the messages.

Imported messages
folder

The name of the folder where you want to export the messages.

If the exported messages included attachments, the attachments were saved in the same folder
as the message and linked with an Email Attachment type reference, similar to other referenced
documents.

Note:
If your System Administrator has configured the vault with a Field-Path definition that uses any
properties that are also used by the Lotus Notes email integration, your messages will be stored
in a folder controlled by the Field-Path definition instead of the folder you selected when you
stored the message. Contact your System Administrator for assistance.
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Glossary

A

Active Directory
A Microsoft directory service that provides central authentication and authorization
services for Windows-based computers.

AMFS
The InnoCielo File System service that makes vaults available through the Windows file
system.

approved
A workflow status that indicates that a document that has been approved for
reproduction, distribution, manufacture, or construction.

archive
When used as a noun, a repository of obsolete documents kept for possible future
reference. When used as a verb, the process of exporting obsolete documents from a
repository.

assign to work area
The process of creating a copy of a document in a work area to isolate its changes from
the original revision in the Main area.

attribute
When used to describe a file system, it is a property of a file such as Hidden, System, or
Read Only. When used to describe an AutoCAD drawing, a named object in a drawing that
is included in a block definition and used to store alphanumeric data.

audit log
A system-generated record of the date and time of user actions that create, modify, or
delete critical business data.

audit trail
A system-generated record of the date and time of user actions that create, modify, or
delete critical business data.

authorization key
The ten character hexadecimal code generated by BlueCielo ECM Solutions that
authorizes a software license indefinintely. Authorization keys are generated based on
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the license serial number, license key, and return key specific to each installation.

B

baseline
When used to describe Meridian Enterprise, a named moment in time in the history of a
vault, such as a milestone.

Basic Authentication
A method designed to allow a web browser, or other client program, to provide
credentials – in the form of a user name and password – when making a request from a
server.

briefcase
An Accruent portable document package. A briefcase is a single file in an archive format
that may contain multiple discrete documents. Briefcases may be in open standard
formats such as ZIP and RAR, the Accruent BRC format, or custom formats. A briefcase
may also contain document metadata in a data file and, in the Accruent BRC format,
document redlines.

C

client
A computer, object, or program that obtains data or services from a server.

COM
Component Object Model - an interface standard for software componentry by Microsoft
used to enable interprocess communication and dynamic object creation by programs.

content
The electronic data associated with a document.

content indexing
The process of extracting and indexing text data from documents for full-text searching.
See also "full text search".

context
When used to describe Meridian Enterprise, a frame of reference comprised of a specific
compartment of a vault and a moment in time for viewing the content of a vault.

criterion
A search filter condition comprised of a property name, operator, and value.
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current
In general, the object that a user has selected or an object that is currently within the
scope of a programming expression. When used to describe the history of a document,
the latest revision of a document, which might not yet be released.

D

data source
An external data file or database that provides data that is presented by or imported into
a Accruent system.

database
A structured set of document metadata used by a Accruent system. The database may be
managed by Hypertrieve, SQL Server, or Oracle depending on the system.

DB
An Oracle database.

DCOM
Distributed Component Object Model - a Microsoft proprietary technology for software
components distributed across several networked computers to communicate with each
other.

derive
To create a new document based on an existing document. Also the name of a Meridian
Enterprise command.

destination state
The state of a Meridian Enterprise workflow that follows a workflow transition.

details page
A type of property page that displays the properties of a document.

digital signature
A digitized image of a person's handwritten signature. See also "electronic signature".

discard
When used to describe Meridian Enterprise, to cancel the process of revising a document
and delete the file copy that is being edited.

document
Information recorded on a medium (paper, digital media, and so on) for communication
to others.
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document controller
A person within a facility owner/operator organization that is responsible for the
management of project documents.

document type
A classification of documents that share one or more document management
characteristics such as format, purpose, or security.

document type workflow
A predetermined sequence of steps through which a document must be processed to
generate a new approved revision in Meridian Enterprise. The workflow is defined by the
document type from which the document was created.

document view
A view of a Meridian Explorer repository that displays documents.

document workflow interlock
A rule consisting of specific document types and property filters that limit when a
project’s workflow may proceed. Interlocks are configured by a System Administrator
with the Meridian Enterprise Configurator application. Interlocks are available only with
the Meridian Advanced Project Workflow Module.

domain controller
A server that responds to security authentication requests (logging in, checking
permissions, and so on) within a Windows Server domain.

dynamic collection
A Meridian Enterprise saved search in which the search criteria are reevaluated and the
results are updated whenever the collection is displayed.

E

e-signature
An electronic indication that a person adopts the contents of an electronic message. See
also "digital signature".

ECM
Engineering Content Management. Content management as it applies specifically to
engineering.

EDM
Engineering Document Management. Document management as it applies specifically to
engineering documents.
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effectivity
An attribute of a Meridian Enterprise property that determines when changes to its value
apply within the life cycle of a document.

electronic signature
An electronic indication that a person adopts the contents of an electronic message. See
also "digital signature".

environment
An organization's overall computing platform.

Explorer view
The view of a Meridian vault that displays documents organized within the Field-Path
Relation.

external page
A type of property page that displays a web page that is hosted on a different information
system.

F

Field-Path Relation
A hierarchical structure defined by properties that determines the folder structure of a
vault and the locations of documents according to the values of the properties.

Folders view
The view of a Meridian Enterprise vault that displays documents organized by the vault's
Field-Path definition.

FS
An acronym for file system.

full-text search
A method of searching for text contained in document content as opposed to searching
document metadata. See also "content indexing."

G

grid view
Name of a Meridian Explorer view mode that displays search results in tabular format.

GUID
An acronym for Globally Unique Identifier.
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H

history
A configurable option of a Meridian vault that causes it to save changes to documents
and metadata over time. Allows users to view prior revisions of documents and their
property values at specific moments in the past.

History mode
A configurable option of a Meridian vault that causes it to save changes to documents
and metadata over time. Allows users to view prior revisions of documents and their
property values at specific moments in the past.

HTTP
An acronym for Hypertext Transfer Protocol.

hybrid drawing
A drawing composed of both vector graphics and raster image files.

I

import
The process of creating a new file in a vault from a file outside the vault or repository .

inactive user
A user account that has been deactivated. The account is not deleted but the user cannot
use the application. The account can be reactivated later.

initiate
The act of starting a new revision of a document by performing the first step of a
workflow.

issue code
The name of a Meridian Transmittal Management Module property that stores a standard
keyword or phrase. The issue code describes the reason why a transmittal was issued.

L

layout
A configurable arrangement of items on a form or page.

LDAP
An acronym for Lightweight Directory Access Protocol.
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Local Workspace
A portion of disk space on a user's computer reserved for caching documents when they
are viewed or edited. Using Local Workspace improves performance when working with
very large documents. Meridian Enterprise's local workspaces can be synchronized with
the vault at a configurable interval.

lookup list
A list of predetermined values for a property that is presented to the user for selection.
Lookup lists can be either managed in the application or linked to an external database or
query.

M

Main area
The area of a Meridian vault where released documents reside.

manager
The Meridian user who initiated the current document workflow and the only person
with permission to change the current To-Do Person.

master document
In Meridian Enterprise, a released document from which one or more project copies are
made that become either independent documents or new revisions of the master
document. Master documents are designated by Meridian Enterprise and the Meridian
Advanced Project Workflow Module. In Accruent Project Portal, a document to which a
master file is attached.

Meridian Enterprise Server application server
The Meridian Enterprise Server data access and business services running on a server
computer. May also be used to refer to the server hosting the services.

Meridian Explorer client
The Meridian Explorer application installed on the Meridian Enterprise Server web server.

metadata
Information that classifies, supplements, or describes a document. Metadata is commonly
used to find documents as opposed to searching for data within documents (see “full-text
search”). Metadata may also be used for a variety of other purposes.
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N

NAT
An acronym for Network Address Translation.

Navigation view
A view of a Meridian vault that displays documents organized in a hierarchical structure
according to a predefined set of properties.

O

OS
An acronym for operating system.

OU
An acronym for organizational unit.

P

package
A set of files that are used together for a common purpose. The files are often bound
together in a single archive file for convenience when transporting, such as .zip and .msi
files. Examples of file packages are software distribution packages and submittal
packages. See also “briefcase.”

pane
A separate area of a split or single window used to display related data.

performance counter
Stores the count of specific program activities on a computer to conduct low-level
performance analysis or tuning.

PowerUser
The Meridian desktop client software. Not related to the Windows administrative group
Power Users.

PowerWeb
The Meridian Enterprise web browser-based client application.

preselection
A property filter that can be applied to a Meridian Explorer view to limit the number of
visible items.
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privilege
The right of a user to view specific data or execute a specific command. Privileges are
assigned by a System Administrator.

project copy
A copy of a master document made for the purpose of creating a new independent
document or creating a new revision of the master document. Project copies can be
created in Meridian Enterprise.

project definition
A template used to create special folders in a vault that can represent design project
processes. Project definitions are configured by a System Administrator with the Meridian
Enterprise Configurator application. Meridian Advanced Project Workflow Module project
definitions consist of a custom folder type, a workflow, and optional project workflow
interlocks or document workflow interlocks. A project definition may restrict folders from
being created at the root of a vault and may restrict creation of subprojects (Meridian
Advanced Project Workflow Module only).

project folder
A folder created from a project definition template.

project workflow
The workflow of a project folder as defined by the project definition template from which
it was created. Configured by a System Administrator with the Meridian Enterprise
Configurator application.

project workflow interlock
A rule comprised of specific sub-project folder types and property filters that is applied to
a project or subprojects that limits when a project’s workflow may proceed. Interlocks are
configured by a System Administrator with the Meridian Enterprise Configurator
application. Interlocks are available only with the Meridian Advanced Project Workflow
Module.

property
Descriptive data used to identify, classify, and find documents. Properties are organized
into related groups called property sets.

property navigation
A dynamic search method in which a user progressively reduces the number of
documents found by selecting from additional property values.
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property page
A secondary window, usually displayed with a tab, that displays the properties of an
object such as a document.

property set
A group of related properties.

publish
To create a copy of a document in another information system, optionally in a different
electronic format.

purge
To completely and permanently delete data from a system.

Q

query
A search command comprised of one or more search criteria often expressed in
Structured Query Language (SQL) syntax.

Quick Change
A very simple document workflow consisting of only two steps, Start Quick Change and
Release Quick Change that may or may not increment the document's revision number
depending on the configuration of the document type.

R

reassign
To immediately assign a document to the current work area for additional changes after
discarding or releasing the current revision.

recovery log
The log of vault documents that can be executed in order to export the documents from a
vault to a specified location on the file system. The recovery log is created for use in the
event of a critical disaster to provide continued access to documents.

redline
Corrections to a drawing made graphically on a copy of the drawing. Redlines can be
created for electronic drawings with the InnoCielo viewer by a user with the appropriate
security privileges.
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reference
A link that represents a relationship between two documents. References can be created
automatically by Meridian (for example, AutoCAD External Reference) or manually by a
user.

reference type
A classification of references that share one or more document management
characteristics such as purpose, source or destination document types, or security.

references page
A type of property page that displays the references of a document.

related documents page
A type of property page that displays the documents that are related to the selected
object.

related tags page
A type of property page that displays the asset tags that are related to the selected
document.

release
The final step (transition) of a Meridian Enterprise workflow. When describing project
workflow, refers to a new revision of a master document that was created from the
content of a project copy. When describing document type or workflow definition
workflows, refers to a new revision of the document that was created by completing the
document’s workflow.

render
Rendition (noun) refers to a copy of a document in a format other than the original.
Render (verb) refers to the process of creating a rendition.

rendition
Rendition (noun) refers to a copy of a document in a format other than the original.
Render (verb) refers to the process of creating a rendition.

repository
The largest logical container of a document management system for storing documents
and metadata. A repository commonly contains all of the documents for a single
organization, division, department, workgroup, or other purpose, organized into folders
and sub-folders. The fundamental container of a Meridian Explorer system.

result grid
A configurable grid view used to display documents or tags found by a search.
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retire
To classify a document as obsolete and prevent it from being revised.

return code
A standard keyword or phrase that represents the reason why a submittal was issued.

review
The process of evaluating the accuracy and completeness of revisions to a document.

revision
A milestone in a document's history that represents approved information at particular
point in time identified by a number or letter.

revisions page
A type of property page that displays a list of the revisions of a document.

revoke
The act of canceling revision of a working copy of a document and deleting the copy being
edited.

role
A named set of privileges to which users or groups are assigned by an administrator.

RPC
Acronym for Remote Procedure Call.

S

saved search
A user-defined set of search criteria that is saved for future reuse.

scope
A Meridian Enterprise feature that limits vault functionality and the visible information to
named sets. A scope can be selected by users to make the system easier to use or to gain
access to different documents.

search layout
A configurable combination of repository navigation and search filter parameters used by
Meridian Explorer.

server
A centralized computer or application that provides services to one or more client
computers or applications in a network.
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shared workspace
A special folder in a Meridian Enterprise vault that is used to store files to support multi-
user applications. The vault folder is mapped to a shared network location outside the
vault that is used instead of local workspaces on the users' computers. Meridian
Enterprise synchronizes the contents of the shared network location with the vault folder.
Configurable options control other behaviors specific to using a shared workspace.

shortcut bar
The name of the accordion control containing shortcuts to views, vaults, and baselines
that can be displayed in the left pane of the Meridian Enterprise desktop application.

SID
An acronym for System Identifier. A name that identifies a specific instance of a running
Oracle database.

SMTP
An acronym for Simple Mail Transport Protocol.

snapshot
A read-only copy of metadata made so that slower data backup processes can occur while
the application continues writing to its data. Backing up a snapshot minimizes
maintenance downtime.

source state
The state of a workflow that precedes a workflow transition.

SSL
An acronym for Secure Sockets Layer or Transport Security Layer.

SSL/TLS
An acronym for Secure Sockets Layer or Transport Security Layer.

static collection
Saved search results that are displayed without reevaluating the search criteria.

sub-project
A Meridian Enterprise project folder contained within another project folder that can
represent a subordinate process. Subprojects are available only with the Meridian
Advanced Project Workflow Module.

submit
When used to describe a document, means to check in the working copy of a document
that is under revision. Equivalent to releasing a document from a workflow.
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submittal
A package of documents received by an organization for review, reference, modification,
or final delivery.

T

tag
A vault or repository record that represents a logical asset stored in a separate
maintenance management system. The logical asset represents a physical asset that is
present at a facility that is managed with the maintenance management system. A tag
may reference one or more documents, or the reverse.

tag type
The document type that is configured for use as asset tags.

thumbnail
A small preview image that is shown to assist the user in identifying a file.

TLS
An acronym for Secure Sockets Layer or Transport Security Layer.

To-Do List
The name of a navigation view in Meridian Enterprise.

transaction isolation
A property in a database system that defines how and when the changes made by one
operation become visible to other concurrent operations.

transition conditions
Property value filters and logical expressions that are evaluated to determine the validity
of a workflow transition to be executed by a user.

transition equivalence
The equality of a Meridian Enterprise transition in one document workflow to a transition
in another document workflow. Transition equivalence makes it possible to execute a
transition for one document in a batch of documents and have it also execute transitions
in the other documents within the batch even if the transitions don’t have the same
name, source state, or destination state. Configured by a System Administrator with the
Meridian Enterprise Configurator application. Transition equivalence is available only with
the Meridian Advanced Project Workflow Module.
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transmittal sheet
A cover letter for a submittal that lists the names and other property values of the
documents that are included in the submittal. It might also include comments about the
status of the documents or the project, instructions to the recipient, and a date by which
a response to the submittal is due back to the sender.

U

unretire
To reverse the effects of retiring a document so that it can be revised.

URL
An acronym for Uniform Resource Locator used to specify Internet and intranet
addresses.

V

vault
A Meridian repository for storing documents related by organization, division,
department, workgroup, or purpose.

VBScript
The Visual Basic scripting language (Visual Basic Scripting Edition).

version
A document derived or copied from another document of the same revision.

VPN
An acronym for Virtual Private Network.

W

WAN
An acronym for wide area network.

watermark
Textual or graphic information overlaid on a printed document used to indicate
authenticity or validity.

Web Access
The Meridian Enterprise web browser-based client application.
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web client
A client application that is presented in a web browser.

Work Isolation mode
The vault setting that defines how and when the changes made by one user become
visible to other concurrent users.

workflow
A predetermined sequence of steps used to produce standardized results.

working copy
A temporary copy of a document made for making changes as an alternative to document
workflow.

workstation
A personal computer used by an individual in a network. A workstation is the client in a
client/server system.

X

X-Ref
An AutoCAD drawing that is linked to, but not inserted into, the current drawing. Changes
made to referenced drawings (X-Refs) are automatically displayed in the current drawing
when the current drawing is opened.
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Index

A
Actions options for client applications 92

Add User Role Assignment dialog box 362

Advanced options 93

Advanced Project Workflow Module 12

All To-Do Lists view 28

AMM See Asset Management Module

analyze

drawing tags 542

Appearance options 91

Application Integration

about 494

Application Integration window 97

Offline mode

about 102

prepare to work offline 103

work offline 105

Online mode 102

options 99

synchronization 109

with Windows standard dialog boxes 22,
98

application links See Application
Integration

Approve command 57

APWF See Advanced Project Workflow
Module

archive

briefcases

create 485

ASCII files 184

assemblies

Assembly Import Tool 563

Autodesk Inventor link 547

duplicating references 231

Reference Explorer 282

Asset Management Module

automatic object creation 543

integration with maintenance
management systems 439

introduction 12

attach

parts to hybrid documents 292

Attached Documents page 438

audit log

logging e-signature authentication
attempts 208

viewing 351

audit trail See audit log

authentication

e-signatures 208

logon 69, 83

results 70, 84

AutoCAD 534

adding layouts to sheet sets 506

checking drawings in 503

editing properties in 500

link 497

managing redlines 501

routing sheet sets 508
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sheet sets

about 504

synchronize 509

title block data 214, 280

updating drawing tag list from 541

X-References

about 51

derived component 557

AutoCAD Electrical 520

AutoCAD Land Desktop 497

AutoCAD Map 3D 497

AutoCAD P&ID

commands 519

opening a project 513, 522

synchronizing project properties 515

uploading a project 516

AutoCAD Plant 3D

about 510

Autodesk Inventor 547

Accruent browser 551

and Derive command 557

checked out files 560

Content Center 562

dialogs, suppressing 564

editing properties in 554

iParts 559

libraries 65

migrating files 563

project files 561

renaming properties 555

replacing components 556

working with the Inventor link 549

Autodesk Revit

editing properties in 573

presentation document 575

sheet sets 577

worksharing 576

autohiding window panes 87

automatic naming of documents 45

automatic revision numbering 46

AutoVue Document Converter 168

B
baselines 25, 247, 249

batch

of documents 154

BRC files 483

briefcase

about 483

adding documents to 485

importing from 491

property values 493

transmittal documents 489

viewing 484

Briefcase Template dialog box 491

browsers

security 75

building reports 348

bulk imports 184

business purpose of documents

document types 44

EDM Principles 18
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buttons

Linked Documents 439

C
caching 109

calculating

document names 45

revision numbers 46

canceling

documents 342

Change Document Type command 237

Change Properties privilege 218

Change Revision Number Manually
privilege 268

changing

document types 237

positioning of Navigation view pane 28

property values 218

revision numbers 268

check-in and check-out workflow 56, 493

checking drawings in 503

collections 141

configuring dynamic 150

creating 144

deleting 152

editing 144

viewing 142

command-line arguments 95

compare

documents 250, 311

properties 212, 254

conditions

for searches 129

of transitions 383

configuration

logon 70, 84

configure

data source file settings 189

Document Import Tool settings 190,
192, 194

dynamic collections 150

Local Workspace 111

Outlook email integration options 591

PowerUser personal options 85

conflicts, Local Workspace 120

context menus 23

copy commands See copying, documents

copying

documents 221, 223, 231, 282

master documents 385

project copies 392

Create Reference dialog box 278

Create Working Copy command 56

creating

baselines 249

briefcases 483

transmittal documents 489

documents 169

in Offline mode 108

folders in PowerUser 354

folders in PowerWeb 354

hotspots 160

import data source files 184

Confidential and Proprietary © 2022 614 www.accruent.com



new objects 456

project definitions 373

project folders 374

references 277

sheet sets 505-506

CSV files 184

customize 23

PowerUser user interface

appearance options 91

application look 89

window layout 86

D
data, exchanging

with AutoCAD 497

with Autodesk Inventor 547

with MicroStation 545

with Revit 571

with SolidWorks 566

defining filters for Navigation views 35

deleting

collections 152

documents and folders 239, 366

Derive with References command 226,
231, 282

deriving documents 51, 226, 229

dialog boxes See dialogs

dialogs

Add User Role Assignment 362

Assembly Copy Options 233

Assign Roles 362-363

Briefcase Template 491

Build Report 348

Compare 252, 313

Compare property values 212, 254

Create Reference 278

Document Type 587

Document Workflow 202

Drawing Tags 535

Find Documents 133

Find Objects 444

Generate Transmittal Sheet 489

Go to Date and Time 247

Hotspot Information 160

Import from Briefcase 491

Local Workspace 120

Manage Document Links 446

Manage Object Links 448

Manage Object to Object Links 453-454

Options 90

Save Search 145

Select Folder 233

Select Report 349

Viewer Options 167

Windows standard 101

with Application Integration 98

discarding documents 402

disk management 110

docking window panes 86

Document Import Tool 183

configuration file for 186

controlling 187

creating data source files 184

data source settings 189
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Initialize Properties settings 192

Miscellaneous settings 190

monitoring import progress 188

Revisions settings 194

Document Property Page

Workflow Group

e-signature 208

document templates 47

Document Type-File Type view 28

document types 44

changing 237

configuring 53

hybrid 286, 298

security 44

templates 47

Document Types dialog 587

documents 18, 43

adding to briefcases 485

canceling 342

comparing 250, 311

copying 221

deriving 226

replacing 229

creating

from templates 169

in Offline mode 108

deleting

deleting and undeleting 239, 366

downloading in PowerWeb 174

editing

revisions 268

emailing 258

importing

data sources 184

from briefcases 491

into Local Workspace 122

with drag and drop 178

linking documents to an object 447

linking objects to a document 445

locking and unlocking 117

marking as obsolete 344

naming

Copy of Original file name 223

issuing a new file name 270

vault document names and
locations 45

opening 199

preview in folder 365

publishing

from a Windows folder 341

from Meridian Enterprise 338

purging 242

related packages 429

rename

PowerUser 271

PowerWeb 271

restarting 343

searching 125

security 49

restart a document 343

subscribing to 260, 418

thumbnails

preview in folder 365

unlinking from an object 451
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unmarking as obsolete 345

uploading in PowerWeb 122, 172-173

vault documents versus ordinary files 43

viewing 157

working with in batches 154

downloading files 174

drag and drop, importing files with 178

drawing tags 534

analyzing 542

creating objects from 543

updating drawing tag list 541

updating hotspots 544

viewing tag information 535

Drawing Tags dialog 535

drawings

hybrid 53

linking and unlinking drawings and
objects 539

DST files 504

duplicating references 231

dynamic collections 144

E
e-signatures

audit log 208

procedures 208

security 208

sign multiple documents 208

editing

object properties 538

properties 210

properties in CAD applications

AutoCAD 500

Inventor 554

MicroStation 546

Revit 573

SolidWorks 570

properties in Microsoft Office 581

electronic signatures See e-signatures

email

adding reference IDs 590

emailing documents 258

exporting 594

Lotus Notes 593

Outlook add-in 586, 591

sending documents from a desktop
app 258

storing 587

user account lockout 70, 84

engineering data management 18

equivalence of transitions 384

exchanging data with CAD programs

AutoCAD 497

Inventor 547

MicroStation 545

Revit 571

SolidWorks 566

executable files

BCAssemblyImport.exe 196

InstallPdfPrintDriver.exe 168

PowerUser.exe 95

PowerUserU.exe 95
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executing

workflow transitions 380

Explorer

introduction 12

Explorer view

availability 28

logical structure 33, 45

exporting

security role assignments from
folders 358

F
FDA Module 13

Field-Path definitions 45

Lotus Notes messages location 595

Field-Path Relation (FPR) 444

fields

properties 48, 209

files

data source for imports 184

executable files See executable files

file extensions 44

formats 165-166

names

about 45

when copying a document 223

when renaming 270

types

ASCII 184

BRC 483

CSV 184

DST 504

RAR 483

ZIP 483

uploading 458

filtering

Navigation Views 34

Publisher queue views 334

finding documents 125, 127, 130

Find command 436, 444

Find Objects dialog 444

Find Toolbar 127, 444

floating window panes 86

folder types 374

folders

assigning roles to 358

clearing security role assignments 358

create

in PowerUser 354

in PowerWeb 354

deleting and undeleting 239, 366

exporting security role assignments 358

importing security role assignments
to 358

preview contents 365

project 60, 369, 376

project folders 374

rename

PowerUser 356

PowerWeb 356

thumbnails 365

types See folder types
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G
Generate Transmittal Sheet dialog
box 489

GlobalID value 493

Go to Date and Time dialog box 247

H
hiding redlines 501

History mode 25, 48, 209, 247

hotspots

about 159

create 160

editing 160

hiding or showing 164

information dialog 160

navigating 164

updating 544

hybrid documents 286

attaching parts to 292

convert normal documents to
hybrid 298

downloading hybrid parts 291

remove hybrid parts 296

renaming hybrid parts 297

uploading hybrid parts 294

versus hybrid drawings 53

viewing hybrid parts 287

I
icons

document status 409

local workspace log toolbar 124

master and project copies 409

navigation view 38

property pages 39

viewer info bar 157

import

assemblies 196

data source files 184

documents

from briefcases 491

into vault 122

files with drag and drop 178

hybrid documents 288

monitoring import progress 188

redlines 501

security role assignments to folders 358

integrating

Maintenance Management Systems 439

interlocks 383

Internet Explorer 66

security 75

Inventor See Autodesk Inventor

issuing new file name 270

K
Key Find 125-126

L
layouts

adding to a sheet 506
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Linked Documents page

about the integration with Maximo 438

linking methods

project copy to master document 414

Local Workspace

add documents 122

configuring 111

conflicts, resolving 120

definition of 109

disk management 110

locking and unlocking documents 117

log toolbar 124

reference resolution 106

saving documents in 108

synchronizing 109, 114

locking

and unlocking documents 117

master documents 404

log off PowerWeb 80, 179

log on 69, 83

log window and toolbar

arrange window layout 86

toolbar buttons 124

Lotus Notes 593-594

M
Main area

referenced documents in 496

revisions 46

main tag 459, 461

maintenance management systems

integration with other MMSes 439

Manage Document Links dialog 446

Manage Object Links dialog 448

Manage Object to Object Links dialog 453-
454

managing

redlines 501

manipulating Navigation views 34

manually synchronizing Local
Workspace 114

marking documents as obsolete 344

master documents

copying 385

linking to 414

locking 404

properties 412

reconciling 398

releasing copies as new master 395

unlinking from 416

unlocking 406

from a master document 408

from a project copy 407

viewing references 412

Maximo

interface 438

Linked Documents page 438

menus

CAD applications

AutoCAD 498

Inventor 548

MicroStation 545
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Revit 572

SolidWorks 566

context or shortcut 23

Meridian Enterprise

[Meridian.ShortName] Object
Model See objects

about the product suite 10

basic concepts 18, 20

linking asset information using tags 436

publishing documents from 338

Meridian Enterprise Server

incompatibility with previous
versions 11

metadata

for importing documents 184

importance of accuracy 210

in vaults 43

storage of 48, 209

Microsoft Office

about the link 579

editing properties in 581

linking files 582

Microsoft Outlook

add reference IDs to messages 590

configure 591

integration 586

store messages and attachments 587

Microsoft Word

templates 47

MicroStation

about 545

editing properties in 546

monitoring

import progress 188

More Criteria search options 136

My To-Do List view 28

N
Name & Type search options 135

naming documents 45

how to issue a new file name 270

when copying documents 223

navigation views

configuration of 28

defaults 28

folders 33

History mode 25

manipulating 34

selecting 31

status icon 38

switching between 31

NetViewer 73

O
Object Model See objects

object properties

viewing and editing 538

objects

automatic creation of 543

creating from drawing tags 543

creating new 456

linked objects

building a report of 462
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linking an object to other objects 453

linking and unlinking drawings and
objects 539

linking objects to a document 445

unlinking an object 455

unlinking documents from an
object 451

viewing 440

searching for 444

Objects property pages 436, 453-454

obsolete documents 344-345

Office See Microsoft Office

Offline and Online mode

Application Integration 102-103, 105

creating documents in 108

PowerUser 103

PowerWeb 103

switching between 115

Open in Application command 109, 120

opening

an AutoCAD P&ID project 513, 522

documents 199

vaults in PowerWeb 155

operators 128

Options dialog box

Actions tab 92

Advanced tab 93

Appearance tab 91

options for

reports 349

ordinary files versus vault documents 43

organizing documents 18, 45

Outlook See Microsoft Outlook

P
partial word searches 136

parts of documents See hybrid documents

performance

and local cache 109

permissions See privileges

personal preferences See preferences

PowerUser

about 81

advantages of 18

application window 81

client interface 21

command-line arguments 95

differences between PowerWeb and
PowerUser 67

documents

rename 271

folders

create 354

rename 356

linking objects in 436

Main toolbar 90

Offline mode 103

preferences 85

actions 92

advanced 93

appearance 91

application look 89

general 90

window layout 86
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synchronizing data with AutoCAD 214,
280

troubleshooting 199

updating drawing tag list from 541

PowerWeb

browser security 75

building reports 348

differences between PowerWeb and
PowerUser 67

documents

download 174

rename 271

upload 172-173

folders

create 354

rename 356

introduction 66

logging off 80, 179

Offline mode 103

opening a vault in 155

read-only 76

sessions 66

setting personal preferences in 71

uploading files 173

preferences

PowerUser 85

Actions options 92

Advanced options 93

Appearance options 91

Application Integration options 99

Application Look 89

General options 90

window layout 86

PowerWeb 71

Application Integration options 99

preparing

to work offline 103

privileges See also security roles; security,
roles

Change Properties 218

Change Revision Number Manually 268

folders

Assign Roles 358

Set Property Value 218

project copies

copying 392

discarding documents from 402

reconciling 398

releasing as new master document 395

showing 409

unlocking master docs from 407

project definitions

about 373

transition conditions and interlocks 383

project folders

about 369

creating 374

discarding document from 402

in project workflows 60

properties 376

sub-projects 377

project managers

reassign 378
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project workflows See also workflows

about 60

workflow types 55

properties

about 48, 209

comparing 212, 254

editing

in AutoCAD 500

in Autodesk Inventor 554

in Microsoft Office 581

in MicroStation 546

in PowerWeb and PowerUser 210

in Revit 573

in SolidWorks 570

exchanging values 504

Key Find 126

object 538

project folders 376

property wizard for new objects 543

rendition properties 338

setting values of 218

source of values 493

updating 214

property pages 39, 48, 209

e-signature 208

Objects 436, 453-454

Where Used 436, 448

property values

set a property value 218

proxy document 459-460

Publisher

introduction 13

publishing

documents

from a Windows folder 341

from Meridian Enterprise 338

purging

documents 242

Q
queue

canceling documents in 342

filtering view of 336

marking documents as obsolete in 344

viewing Publisher queue 334

Quick Change 56

release 56

revoke 56

start 201

Quick Find 127

Quick Search 125

R
RAR files 483

raster files 250, 311

read-only PowerWeb 76

read-only properties 48, 209

reconciling project copies 398

redlines See redlining

redlining

AutoCAD 501

hide redlines 501
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Reference Explorer 282

PowerUser 412

reference types 273

references

copying 223

creating 277, 453

duplicating 231

external management 545

linking documents with 51

Offline mode 106

Remote mode 496

search options 139

updating 115, 226

viewing 274, 495, 507, 517, 526

when replacing documents 229

X-References 51, 497, 566

registry

registry files 165

resetting dialogs in 101

Release command 57

Release Quick Change command 56

releasing project copies 395

Remote mode 496

remove

parts of hybrid documents 296

rename

document

PowerUser 271

PowerWeb 271

file 270

folder

PowerUser 356

PowerWeb 356

Rename Components command 555

rendition properties 338

renditions 300

attaching 330

printing 329

unlocking 332

updating 327

uploading in PowerWeb 173

viewing 301

repair

corrupted file 199

Replace command 51

replacing documents

about derived documents 64

how to derive a document 226

how to replace a document 229

reports

building 348

definitions 348

of linked objects 462

options 349

transmittals 489

resetting application integration
dialogs 101

resolving Local Workspace conflicts 120

restarting documents 343

restoring

documents 239, 366

restricted properties 48, 209
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revisions

numbering

about 46

change revision number of a
document 268

phases 57

settings 46

viewing 244

Revit See Autodesk Revit

Revoke Quick Change command 56

Revoke Working Copy command 56

roles

security

document security 49

folder-level 33

routing

documents through workflow 205

sheet sets 508

S
Save Search dialog box 145

saving

searches as collections 144

scopes

about 26

selecting 27

scripts 350

search

about 125

conditions 129

context 128

Find Documents 130

for objects 444

Key Find 126

object types 138

operators 128

options 135-136, 139-140

partial word 136

Quick Find 127

results 128

saving as collections 144

security

browser security 75

e-signatures 208

Internet Explorer 75

logon 69, 83

permissions and privileges

folders 358

roles See also security roles; privileges

folders 358

security roles See also privileges; security,
roles

assigning to folders 358

clearing from folders 358

document security 49

exporting from folders 358

folder-level 33

importing to folders 358

Select Document Type dialog box 238

Select Folder dialog box 233

Select Report dialog box 349

session information 66

Set Property Value privilege 218
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Sheet Set Manager 504

synchronize project properties 515

synchronize sheet set data 509

sheet sets

adding layouts to 506

creating 505

exchanging property values 504

routing 508

synchronizing 509

shortcut menus 23

Show Assembly Structure command 282,
495, 507, 517, 526

Show Derivatives command 282

Show Project Copies command 282

Show References command 495, 507, 517,
526

Show Revisions command 25, 268

Show Where Used command 282, 495,
507, 517, 526

showing

project copies 409

site cache client

add documents 122

SolidWorks

browser 568

editing properties in 570

menus in 566

Start Change command 57

Start Quick Change command 56

Start Review command 57

startup 90

states

about 57

static collections 144

status

icons 38

Status-Person view 28

storing email 587

sub-projects 377

Submit command 57

Submit Working Copy command 56

submitted 107

subscribing to documents 260, 418

subscriptions

changing 260, 418

removing 266, 424

viewing 266, 424

suspend resume 199

synchronizing

AutoCAD P&ID project properties 515

data

with AutoCAD 214, 280

Local Workspace 109, 114

properties from a file 493

sheet sets 509

T
tables

data source settings 189

iParts 559

tags

title block 545-546
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technical support

about 17

templates

creating documents from 169

document

about 47

sheet set 505

third-party viewers 165

title blocks

application links

AutoCAD 497

MicroStation 545

import 493

Document Import Tool settings 190

property page 39, 210

synchronizing data

file properties 214

references 280

updating

file properties 216

references 280

toolbars

Find 127

Main 90

tools

Document Import Tool 183

control the import 187

create a import data source file 184

data source settings 189

initialize properties settings 192

load a configuration file 186

miscellaneous settings 190

monitor an import 188

revisions settings 194

Transfer to Project command 392

transitions

about 57

conditions 383

equivalence 382, 384

transmittals (briefcase) 489

types

document 44

U
undeleting documents and folders 239,
366

unlinking

documents from an object 451

from master document 416

objects from a document 449

unlocking

master documents 406

from a master document 408

from a project copy 407

unmarking document as obsolete 345

unrestricted properties 48, 209

updating

drawing tag hotspots 544

drawing tag list 541

properties 214

references 115

uploading

a project 516

documents in PowerWeb 172-173
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files 458

V
values

property values 218, 493

vault

about 24

configuration 61

Mechanical demo 558

opening in PowerWeb 155

purging documents from 242

read-only access 76

revisions 61

scopes 26

viewing history of 247

VBScript

calculate a value 220

VBScript Objects See objects

View Briefcase command 483

viewer

changing 166

order of 166

third-party 165

troubleshooting 199

Viewer Options dialog 167

viewing

briefcases 484

documents 157

drawing tags 535

linked objects 440

Meridian queue 334

object properties 538

references 274, 495, 507, 517, 526

revisions 244

vault history 247

workflow 202

views

Navigation views

configuration of 28

defaults 28

filtering 35

History mode 25

manipulating 34

status icon 38

switching between 31

W
Web Access See PowerWeb

Where Used property page 436, 448

window pane layout 86

window styles 89

Windows

folders

publishing documents from 341

standard dialogs 22, 98

wizards

create new tags based on property 543

Word See Microsoft Word

workflows

definitions 58

document type 57

editing hybrid documents 286
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project workflow types 60

Quick Change 56

revisions 46

routing documents 205

transitions

e-signature 208

executing 380

types 55

viewing 202

working copies 56

working offline 103, 105

X
X-References

about 51

AutoCAD 497

SolidWorks 566

Z
ZIP files 483
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